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Introduction 2

1 Introduction

1.1  About HIPAA Claim Master

The HIPAA Claim Master is an advanced tool for healthcare electronic claims.

The HIPAA act of 1995 mandates that every medical claim that is transmitted
electronically conforms to strict standards. These standards are developed by ANSI, the
American National Standards Institute, under the umbrella of the X12 committee for
Electronic Data Interchange (EDI). X12 contains standards for hundreds of electronic data
interchanges. Medical claims are contained in the 837-transaction set. X12 standards are
continuously developing. The HIPAA compliant versions are version 4010A1 and 5010.
The HIPAA Claim Master supports both versions.

There are four different flavors of the 837 transactions:

1. The institutional claim format 004010X096A1 and 005010X223A1
2. The professional claim format 004010X098A1 and 005010X222A1
3. The dental claim format 004010X097A1 and 005010X224A1
4. The reporting claim format 005010X225A2

The HIPAA Claim Master handles all four of them.

Electronic claims were introduced in the 1990's and made mandatory by 1/1/2003. During
the last decade, the adaptation of this electronic format was phenomenal. More than
90% of claims are now (2012) transmitted electronically. The HIPAA Claim Master was
first developed in 2001 and has undergone tremendous change over those years. In 2011,
a new version 4.0 was released based on Microsoft's .Net infrastructure.

The HIPAA Claim Master reads X12 837 EDI claim files and parses the claim information
with its built-in EDI translator into distinct claims. Each claim can then be rendered as an
image of a UB04, CMS-1500 and ADA 2006 form or the older formats UB92, HCFA-1500
or ADA2000.These images can be viewed on the screen, printed to paper or turned into
image files, PDF and TIFF formats, and added into an image management system.

In addition, the HIPAA Claim Master can export claim data to any database. Claim tables
can be created within any ODBC/0OleDB compliant database such as a Microsoft SQL
Server, Oracle or MYSQL. The claim data is then accessible to your own applications plus
you can search this data warehouse and even recreate the image.

© <2003> Martin Scholl Consulting, Inc.
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What is an EDI file?

X12 is an ASCII standard. This means that all the content of a transmission consists of
ASCII characters. ASCII or text files can be viewed and edited with a regular text editor
but since EDI does not use line feeds and carriage returns to mark the end of a line, an
EDI document is usually very hard to view.

B 8370PTST.edi - Notepad

File Edit Format WView Help

ISA™Q0= Ly w2gw 9B7654=28"

32. 36%UN*1-DTP*472* D8 200102 21~CLM* 987 790=85. 40" **13 (A1 "y asy™®
“1l—-AMT*C5*35~REF"EA% 321321 -3~-HI"BK 820, 21~HI*BH:29:08: 20010129~
wEE] AL MYRANY YRR EER RS L TP 34*RDE 20010214 -20010214-CL1**
212 34-PRV*OP*ZZ*203B501 00Y--REF*1G* AL 23 5~ X*1~SW2*I60*HC : 45331 %3
~HM1* DN L *CUTUM* JAMES = * ** 34 * 55465656 3~LX*1~-5V2*4 20"HC 1 97116%35%
STREET~MN4 *WASSIT*MD*1374 5-DMG*DE*1 91007 04 *F~NM1*PR*2*XYZ INTERM
*17 . 92~AMT*F3%4,. 4B~REF*EA®BT 5522=-3~HI*BK: 27 2. 0-NM1*DN*1*TESTOR™
wHEI4%654656563~LX*1~5V2*300*HC : 86023%60. 02*UN*1~DTP*472*DE* 200
ML*IL*1*HEKOSEN*SAM**=*MI*5876212554~M3%E MAIN ROAD-MI *NAMACHUT
TP*434*RD8* 20010214 -20010214-CL1**1-AMT*C5%111. 36-AMT*F 3527, B4~
72 DE*20010216~56*509°54321~GE*1*322~-TEA®1*112233446~

A view of raw EDI data

As you can see in the previous figure, it is quite difficult to discern the individual data
elements within the ASCII text file. One needs an EDI Editor to get a more meaningful
representation of an EDI file. The HIPAA Claim Master has a built-in EDI Editor. Here is
how this file is displayed in it:

© <2003> Martin Scholl Consulting, Inc.
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[ File: 837IPTST.edi

1 1SA™00* 00~ 29" 98765428 32112°010329*1430"U" 00407111 2233445 1°T™
2 (G5 HC™9587654"32112720010328714 30321 00401 0X096™
3 5T"837T6a322™
4 BHT*O019*00™1238*20010329*1310"CH™
5 REF*E7*0040710X096™ =
6 NMT*41*2"HEALING HOSPITAL OF ANYTOWN™ 45 X754275™
7 PER"IC*PHIL FIELD*TE*7365554321™
& NM1=40r2*xXYZ INTERMEDIARY SERVICES INC™ 46759654
9 HL*1=*20*1™
10 PRVBI*ZZ*282M00000N™
1T NMT*85"2"HEALING HOSPITAL OF ANYTOWN™ 24097654321
12 N3™1 HOSPITAL ROW™
13 NA*ANYTOWN*MD*21299™
14 REF*1C*895463™
15 HL®*2*1*22*0™
16 SBR*P*1§™"MA"™
17 NMTEIL*1=SMITHTESS*T="MI"0219954 32A™
18 N3*1 HOME STREET™
19 N4*"HOME CITY"MD*13746™
20 DMGTDE"19300202F~
27 NMT*PR*2*XYZ INTERMEDIARY SERVICES INC™PI*895674™
22 CLMSE7E544675 3411 AT Y =AY =Y DA N"
DTP*096*TM*1400™
t DTP*434*RDE"20010221-20010226™
> DTP*435"DT200102210800™
26 CL1"2*701™
7 AMTCS5*4035 34™
B AMT*F3%e40™
9 REF"EA™69375-9™
) HI"BK:820.21*Z2-820 21"BNEBB4 2™
1 HI"BR:79.35:D8-20010222™

Lad

B B3 B

g Lad Db B B B

2 HI"BH:05:08:20010221™
HI*"BE:01:::250™
34 QTYCA™"DA™
35 NMT*71*1*KILDARE"JAMES™34*321121234™
16 PRVCAT*ZZ=203BF0100Y™
37 REFF1G*A1234™
38 NMT*72*1T"WELBY*MARCUS™ 34337121234~
39 PRVOP~ZZ203BS0100%™
40 REF-1G*A1235™
41 L™
42 SVZ"120m1250"DAS 2507

The same data viewed with HIPAA Claim Master's built-in EDI Editor

When you view this ASCII data with a special EDI editor, the individual data segments are
visible but it is still difficult to understand the content of the form. EDI tries to
abbreviate complex descriptions into short codes; and without a translator only true
experts know what this means. This is where the HIPAA Claim Master is indispensable. Its
built-in translator parses the significant data elements from the EDI file and prints the
data into the well-accepted medical forms HCFA-1500 and UB92 as well as the ADA dental
forms. The program's output can be screen, paper or image file (TIFF and PDF) as well as
data rows in external tables.
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2 Getting Started
2.1  Starting the Application

Once the Claim Master is installed, you can launch it from the "Start” menu:

Start » Programs (All Programs) » HIPAASuite » HIPAA Claim Master.

FileZilla FTP Chent
Google Chrome
Help & Manual 5
HIPAASusEe
HIFAA Authorizer
HIPAS Claim Master
= HIP&A, Claim Master Manoal

(fd HIPAA Claim Master )
HIFAA Claim Payment Mastes
HIFAA Claim Stabus Responder
HIP&& Comnmm Cenber
HIFAA Ebgibibty Responder
HIPAS Errclimént Masker
HIFAA Premium Payment Master
HIPAAsukE

IEM L2

InstallShisld

1Z2&rc

Lexrnark

Lexmark Applications

Logitech

1 Back.

I |search programs and Files

=
11‘_’5!:“

The HIPAA Claim Master is launched from the "Start" menu

The following screen will appear:
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ol

Fle Forms View Search (ClamEntry/Edit DataBase CodeSets Logs Image Setup EDIExchange  Help
&= > (e’

" Printer

" Screen
" image Fle

[T Data Impont
- Qlaim Type
" Professional
& Institutional
" Dantal
" Reporing

Processing C:ProgramData\HIPAAsuite HIPAA Claim Master\Samples\837IPTST edi (14.93 kB) Processing time: 378.040 seconds per Record

The HIPAA Claim Master main window

Once the main program window is opened, the normal operation now would be to open
an EDI file. See:

¢ Processing an Electronic Claim

® Processing an Entire Directory

2.2 Familiarizing with the Interface

The Top Menu Bar
The menu bar at the top shows the following menu items:

¢ File — Contains all file-related activities such as opening a file or opening a
directory, printer selection, and exiting the program.

e Forms — Lets you see and print all of the 7 different claim forms that the HIPAA
Claim Master renders.

© <2003> Martin Scholl Consulting, Inc.
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e View — Gives you access to the built-in EDI Editor, and it lets you show or hide the
info bar.

e Search — Brings up the EDI search tool.

e Database — Gives you access to database setup and the claim database. See
Exporting the Data for details.

e Logs — Lets you see the logs of file processing. See Accessing Daily File Log.

e Setup — Gives you access to the different setup screens. See Configuring Program
Options, Configuring Specific Options, Configuring Claim Forms.

e Help — Shows the documentation and context sensitive help topics.

Note: There may be additional menu items if you have licensed modules. Each module adds a separate
menu. See Enabling Application Components.

The Task Bar

The taskbar has the most important functions accessible through quick launch icons.

The Info Bar

The info bar is located in the left part of the interface. This panel displays the file
information and has the "Run” button to start processing files. If you do not see the info
bar, there is the "Info Bar" menu item that shows it (the last button located on the task
bar also toggles the info bar). When you work with files, the info bar is indispensable,
but when working with a database, it is optional.

2.3 Processing an Electronic Claim

Follow the instructions below to open a single EDI file and display its details on screen in
easy-to-read table format.

1.Go to File » Open in the main menu.

© <2003> Martin Scholl Consulting, Inc.
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i HIPAA Claim Master - 32bit
(| Fie DForms  View Search  Claim
e

i Oipen Sample Fie

{F Open f_n]_ L/
Cinen Dirgetn,

Dpen Document
Select Printer

Exit

The "Open” menu

Alternatively, click on the "Open Document” icon shortcut located on the program
toolbar.

i HIPAA Claim Master - 32bit

Fle Forms ‘View Search  Claim Entry/Edit

g[%[; > 77

The "Open Document” button

2. Browse through the folders and select a file with . edi extension. Click "Open."

Note: Only claim files in "ANSI 837" format can be opened via the Claim Master. The program will display
an error message if you select a file in a different format.

S— — ,
L JL ) |} = LocalDisk(C:) ~ ProgramData ~ HIPAAsuRe  HIPAA Claim Master ~ Samples v §23 [ search Samples (2]

Organize *  New folder = ~ [ &
I Favorites d U=~ Date modified IIM ISlzs I |
B Deskiop .| B37TPTST.edi 9f26/2013 10:29 AM  EDI File 1SEB

& Downloads || 83TRCLM.edi 9f26/2013 10:23 AM  EDIFile 22KB
=] Recent Places )
iBJHIP‘mhITﬁa‘ZEFSelLD-mSI H3L2ME 1220 P Windowes Inctaller P, 19,977 KB

o Libraries
: Cocuments
o' Music
= Pictures
B videos

T Computer
£ Local Disk(C:)
- DATARPARTL (D:) —
S [ on CVK
=

File name: || 3 JNI files (%% EI

' Cpen I Cancel |

&
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Getting Started 10

The "Open” window

3. Make sure the program tool bar is displayed in the left area. To display the left
program bar with options, select View » Info Bar.

4. Select one of the following modes in the "Output Mode" box. The Output mode defines
the destination where the result file will be sent to. In our example, we select the
"Screen” mode.

e Screen — This is a default mode. Select this option to display the EDI file on screen
in a preview window.

¢ Printer — This option allows to print the opened EDI file. See also: Selecting a
Printer.

¢ Image File — This mode mode creates TIFF or PDF file. Read more in Creating
Image Files from EDI.

(s HIPAA Claim Master - B4bil
File Forms View  Saarch

= > 1

Dulput Mode
" | Prinker

# | Screen

| Image File

The "Output Mode" options

Note: You can choose the Output Mode, but not the Claim Type. The claim type is determined by the
EDI file. If you have the EDI exchange component licensed, you will have the option to run a HIPAA

compliance check before processing a file.
¢ Professional
¢ |nstitutional
¢ Dental
* Reporting

5. The file is now open. Click the "Run" button to process the file.

© <2003> Martin Scholl Consulting, Inc.
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{8/ HIPAA Claim Master - G4bit

File Forms View  Search  Claim
& (> 7

— Dutput Mode
" Printer

* Sereen

" Image File

[T Data Impost
— Claim Type
" Professiondl
" Instibutional
© Dental
" Reporting
— Counter -

Came[ |

The "Run" buttons

6. When you click on the "Run” button, the file will be parsed and the information
displayed. As in our example the output mode is "Screen,” the claim is displayed in a
separate window. See Displaying Claims.

© <2003> Martin Scholl Consulting, Inc.
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Print | Close | Next Claim +— 1f1 —+ | Claim | Addlinfo | COB info
1=

'HEALING HOSPITAL OF ANYTOWN = 5 987654 m

1 HOSPITAL ROW vee s | BIBTS-9 11

.P.H‘I‘TCMIN, MD 21299 €. FRE, T B0 ﬂ:;:l:nrl:::n:g"l TRGEH I? Cowme ba

097654321 ]I]2.|211'I]'l [021‘2501 | 5

2 PATIENT LAUE |n | 0219954324 % PATIENT Ab G RERS |=|| 1 HOME STREET

* | SMITH, TESS T * [ HOME CITY [FImp [ [ 13746 FI

10 BIRTH BATE |u‘:£- |‘: p-rE"'fﬁun:.r.oe - lsl-ullﬂ BTnil' i - o . -:n-:_:rlmfﬁ)asa . = . = = |§;\:§;E‘]:D

02/02/1930 0221 08:00 2 | | |

11 CCCERRENCE ¢ OCCURRENGE B OLCERRERCERFAR M CCCTRRENCEBFAN k3

[] 1E [=-11 1 BATE COpE (1= 1] THASD PO CORE Faoai THAGEOH
- | |
; I [ ] | | |

SMITH, TESS T T o aar toes AR

1 HOME STREET 201 $250.00

HOME CITY, MD 13746 b

[ ]

ATAEYCE 4 FESCRIPTIN i HE PCRRATENIP FECO BE 46 RERN . DATE o5 BERN. UNITE & TOTAL CRARGES 43 B0 0-COVED CHA RS 18_
v 120 $250.00 5 $1,250.00
= | 320 1 $1,006.00
.| 360 1 72200
. | 370 1 310,00
< | 450 1 $067.34
| 710 1 $400.00
~ [T PP P P PSP ey WO R I S

The di-sdplay of an 837 EDI claim

If you choose an output mode other than Screen, you will see the hourglass mouse
pointer until the parsing has been completed.

2.4 Processing an Entire Directory

You can process every file in an entire directory with the HIPAA Claim Master. This
feature is very useful when processing_through the Windows Scheduler. You can then
have the HIPAA Claim Master process all the files in a certain directory and move them to
a processed file directory in certain intervals.

Tip: The command line option can take a directory as input. The program decides whether the
command line argument is either a file or a directory and processes accordingly.

Follow the instructions below to open a batch of EDI files located in one folder.

1. Make sure the "Output Mode" option is not "Screen.” The Output mode defines the
destination where the result file will be sent to. It does not make sense to open every
claim in a directory one by one, so the directory processing is limited to "Print,” "Image
File" and "Data Import" option. The output modes are described in Processing_an
Electronic Claim.

Note: You cannot display a batch of EDI files on screen in a preview window, it is possible only for one
file. See Processing an Electronic Claim.
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HIPAA Claim Master

% HIPAA Claim Master - G4bit]

File Forms View Search
-

— Dutput Mode
* Prinker

T Screen

" Image File

The "Output Mode" options

& HIPAA Claim Master - 64bit

2. Go to File » Open Directory in the main menu.

|' File |JForms View Search  ClamEntry/Edit DataBase CodeSets Logs Image Setup  EDIExchange  Help

VEmr!

i Open Sample File
=
-
Select Printer
Esit:

The "Open Directory” menu

A9 Q

3. Browse for the folder containing EDI files. Click on that folder and then click "OK."

Note: Only claim files in "ANSI 837" format can be opened via the HIPAA Claim Master. The program will
display an error message if you select a file in a different format.

© <2003> Martin Scholl Consulting, Inc.
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Browse For Folder [ x|

|

HIFAS Claim Master

Configuration
Logs

. Scripks

HIFAS Claim Payment Masher
HIFAL Claim Stabus Responder
HIPAL Elighility Responder
HIFAA Enroliment Master

maketewfoder | ([ oc |

£

The "Browse for Folder" popup

4. Click on the "Run" button to send all files from the folder to the destination.

Note: The pre-defined settings will be applied. See also: Configuring Program Options.

14
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s HIPAA Claim Master - G4bit]

File Forms View  Search
&= >

- Dulput Mode
= Printer

" Screen

" Image File

™ Data Import
Claim Type

" Professional

™ Instiational

i Dental

" FReporting

Cams [ 1]
Total Amourt

| $4,675.34]

Run > |

The "Run” buttons

You can see the current status at the bottom pane.

Stop @

B with

ympliance check

'Pru-cessinq C:iProgramDataiHIPAAs ke HIPAA Claim Master| Samples\E37IPTST.edi (14,95 kB) Processing time: 0,000 saconds per Record

The Status pane

The file counter located at the bottom of the Info bar provides you the information
about the processed files in real time.
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[RE i
EDI files
oL I
Total Amount
| $10.119.98]

s

Hur itk

compliance check

Processing CiProgramDatalHIPAS:

The file counter at the bottom of the info bar

5. Once all files have been processed, the "Processing Results” popup will report the results
of the operation.

File "837IPTST ed’ processing started at 10/18/2013 8:59:03 AM
Trading Partner ID: 987654
ClaimType is |, Institutional
The file is marked Test
Clairms will be printed
25 claims were pninted,
Mumber of Claims in File: 25
Murmber of Line items in File: 90
Ittook B minutes, 27 568 seconds o process this file
The average time was 15.503 seconds perrecord

File '837PCLM adi' processing stanad at 10/18/2013 3:05:31 AM
Trading Partner ID: 987654
ClaimType is P. Professional
The file is marked Test
Clairns will be printed
48 claims were printed.
Mumber of Claims in File: 48
Mumber of Line iterms in File: 85
[t took 10 minutes, 19.851 seconds to process this file
The average time was 12.914 seconds per record

File "HIFAAClaimMasterSetup. msi' processing started at 101872013 91551 A
Segment ISA: Eror code - 1SAMNotFound
Mumber of Claims in File: 0

Mumber of Line items in File: 0
[ttook 7 minutes, 43 67 seconds to process this file

The "Processing Results” window

6. The number of processed files and records is displayed in the "Counter” pane.
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17 HIPAA Claim Master

-

FHur itk
compliance check

Processing CHiProgramDatalHIPAL:

The "Counter” pane

2.5 Displaying Claims

After opening a file and leaving the default output mode "Screen”, click on the "Run”

button.

The form type is indicated in the left pane, under "Claim Type."

s HIPAA Claim Master - G4bit

File Forms ‘View Search

B e laXKXOE

— Dutput Mode
" Prnder
i+ Sereen

" Image File

[T Data Import

-~ Claim Type
& Professional
™ Instibutional
" Dental

" Reporting

~Counter

s [ 1]

Total Amount

6500

The Claim Type menu

Claim Entry/Edt  DataBase (CodeSets Logs Image Setup  EDIEwchamge  Help

HIPAA Previews

: Print  Close

Gk Dok
03/29/2001%13:10 XYZ Ca

1500
HEALTH INSURANCE CLAIM FORM

AFPROVED BY NATIDOMAL UNIFORE BILLING COMNED N D205

[TT1
1. MEDICARE WEDICAID TRICARE CHANFYE, OTHER
K] ecicare &[] qecicaiain D@p%"uﬁ'r':"%?ﬁ [ et nnqu-ﬁ!ﬁ'ﬂ-?fwlj bk [ ae
2. FATIENT'S MAINE (Lt Maee Firsti s, B i35 I M 1 PATIENTS BIATH DATE  SEX
MNosmith, Harman 12/251920 WX [
5. PATIENTG A0 DR ESE No St ) E PATIENTS RELATIONSHIP TO NSURED
10 8th Avenue serr [ spoase [Jow [[] oner [
cmy STATH 2 PATIENTS STATUS
Nanachut MD|  suge [ wmanka [ oner []
ZIFCODE TELESHOKE
13747 epowa [ Enont [ Sadont
SUOTHER INSURED'S MAWE (LastF ket, Nk b FEa 10. 15 PATIENTS CONDITION RELATED TO:
2 OTHER INGURED'S: POLICY OR GROUP NUNBER . ENPLOVINENTT ( arsitor “m'-"ll-?'
| R 0o

Depending on the claim type (Institutional, Professional or Dental), a preview form will
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come up to display the claim in the standard UB92, HCFA-1500 or ADA2000 format.

© it

Cloie

Srkm
050572010

Multi-Page Document Part 1

HE&L'FH INSUR.#.NCE l’.‘-LAIM FIDRH

= 1J7 = | Chaim
wois BaooB5334
0699 RUSSELL ROAD STE 175

18

Addlinfe  (OH info

WESTLAKE VILLAGE, OR 7136273156

A Y AT, it
I'I_l_l [TT]
L MESRCAAE WEDKCAD TaeanE T "_'LT" N P Progrie e 1
Dusscrnn [Joumscsim [oowrs by [Jouwew cnPQawmwe L o 1:::1::1101!563
3 PATIENT § AU i e Pt e e e T GATENT GBMTS CATE | BER § ABLMED §SAUE e harma Prad ey aag naa
CHARLES, SUZETTE L o7osMeTd o1 X CHARLES, SUZETTE L
3 DATIENT 5 ACCMESS (%5 S B PATIENT 5 MELATIONSAIS TO MELAET T, PEUNED 5 ACIIERS [ ST e
849 BAKER ROAD sor O] soome[Jowe [] cvw [] | 849 BAKER ROAD
=0 WTATH B SATENT BATATLS = ATt
WANGEMN o sga [] wea [J] oe [0 WANGEN o
TEC00E TEESmCE TE 008 TEES=RE
91239 e 2 O20 O | 91239
B OT=ER acfuRES B A [ P MO TR W o BATENT | SONDITON REATER T w1 A RED | RO Y SR DR FECA n A BEN
ﬂ HARLES, SUZETTE L J03TETTI
e R T e ] B BRI TE (S o o B BSUMESTE SATE O ST =
Y R O [ 07061973 o] ‘X
T ETEm A b, MES § EATE S BT BEX B ATOACCCENT FLACK | e 3 B DvBA At B o eSSy, il
07/05/1873 O | Beu O
£ EMIDLOVEN 5 WAME O SO0 Pl arfuit Aoy PUBLIMANTE SN NRAPE DA SRMOGAA RS
D%s m-\.f
1 PUERANTE BLAN N O BRDGAAN NS Won MERERVES ROM LOTAL EE 1 1 THERE AN OTHER SEA T BENERTT BN
ANTHEM BCBS VA Wives  [Juo romores mird s e is
I3 RATIENT 5 0F ALT=OMTED SEMSCA § BGHAT JNE T W SMED 5 O ALTROATED PERSCA § BGRAT RS
Sawrce Apame e B S
en File ¥ ¥
1 DATE DR SUMMENT LB e Sy o | MAOF SWTENT AAS A BAIE DR SULANLLNESS | 0k SATES SMTENT LNASLE TO WORA N SRENT SOTATEN
08/15/2009 oo o v FsT AT . -
R A S SR R T 0 W RRPTIALEATER SRR ABATES T3 CoRRENT SETietd
SRADERS, MARISS =+'1 privr—
' MESENVED FOM LCCAL LS T e
D ves  [Ewo
ot STl DR WATRE OF LoERE OR T (M e 100 4 5O oM B T S -"';xﬁ-=3""5-.-!'-'ﬁ5:"\ S A
1 B45.09 T28.87 T DAL A T AT 6, ABEN
T19.47 i
A SATER OF BERCE [] 5 | 5 MRSCESLARE BERACEE OA ok, Y [} P 1=
Frecal T " g | commncs uoTe ot ¥ CmAMGES f:: -}H:‘EL SmoitER G s
1 | 040022010 11 47110 1,23 $55.00 (1 BT T
2 | 040212010 1 a7112 123 §100.00) 2 ol 148TEAR198.
3 | 04022010 11 497140 1,23 $60.00 (1 ol taATEAEAGE
4 | 40212010 1 97530 1,23 §55.00 |1 BT
5 | 04/08/2010 1| |e7110 123 $110.0002 | [ aeiies
6 | 04/06/2010 1| |s7112 1,23 $10000)2 | f——————-
T FECEMAL TAKLD NOuBER o B = AATENT B ACCOUNT N0 T ACCERT ABGGMMENTT | 35 TOTAL CrARGE B MAOUNTEAD | 30 SALANCEDUE
631133454 13 IWHSTIGCLMH llx] [
Nt REN DRSS SR SR BNl RAC T CAT i A CRALAT N iy S B L B
BISHOP, JULIE MARIE POSTROADIN "PHYSICAL THERAPY PARTNERS IN
. 251 00000X 1260 NORTH POST ROAD SUITEB 2544 SOLUTIONS CENTER
INDIAMAPOLIS, IN 46219 MENDOZA, IL 608223005

A professional claim form CMS-1500, the first page of two
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g gy e r Y R RE AW T =1 === -y
] 1 Emr ] Wi
- A — -
N ELTLENE] (1501
BET] Tan manr v [LETT)
w M G AT Bk
M3 wasn, saamar (1 (rry
T L EHJ.H
. = ey PR e o 1
T CHoRCL [ Xl ETCLE I T —
i T L S——
e —— - — s
e, jon [TREFETY Gropmama. AR
i
L

A institutional claim form UB04
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AT 1950

Ewrriai Sinies Foem

e, (RSN T Biue Cross g FL

e S, PO Bax 1TTT )
Jscksanville LT sz

;.wﬂ,w S ,ﬂﬂypp_-lfi!vl_ﬁl_ﬂ_" - - - - | _FL
+ | Doz | TERA3ETIN |@ o | | M

Hooarie LS ST RCDHHEG

Tobdeman, Mickasl - | ‘Gobleman, Michssl
' 514 Upgar Cotvww Dr. | naTsan -
+| Saranses L - -

- = - o a

CEED C L - TTrwas |

wniw:: l : ::vww :.r‘l: LT |
¥ _.l'lﬁh.

B - JEET

A dental claim form ADA2000
On the top of the preview form, there are three buttons:
¢ Print — Directs the individual claim to the printer.

e Next — Switches to the next claim.

e Exit — If you click on "Exit," you will be presented with the following dialog:

Choice!

Next Claim?

ves | m |

Choice between going to the next claim and stopping processing

You can go back to the preview form by clicking "Yes."” Otherwise, click "No" to cancel
the parsing. When you click "Cancel,” the parsing engine is still moving through the EDI
file until the end of the file is reached. Depending on the size of the file, this will take
from few seconds to more than a minute. When the end of the file (EOF) has been
reached, another dialog appears:
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HIPAA Claim Master

2.6

HIPAA Claim Prink x|

File: is finished

C o ]

The end of file (EOF) message

Facsimile Mode

We developed the display forms of electronic claims with readability in mind and added
dollar signs and commas to numbers, brackets and dashes to phone numbers, dots to
diagnosis codes and slashes to dates to name some of those liberties we took. We also
change fonts to get more information into a locator cell.

But strictly taken the medical claim forms as they were developed by the UB committee
and CMS have precise description of the location of values in the forms. Since the forms
were developed for DOT Matrix printers at 10 characters per inch, we end up with a
maximum of 80 characters per line. This format has been used since the earliest days of
tele-typing and computers. IBM standardized their punch card in 1928 to 80 character per
line, most early computer terminals had a 80 columns by 24 rows display and printers and
paper was geared to this format. There is also the well know UB format of electronic
claims which consists of just saving the spool file to the printer for the UB92 form. Then
it was easy to parse this file and import it into a database.

OOCOOOOOOOCOOOOCOOCOO0® xxxxx}c}cx}cxxxxxxxxnm{xm’:t.’{‘.lxxxxnxx}cx}c}cxxxxxnxnxgm
XXX X KX e D XX e [ X e X ]
X000 3OO0 OK KOO0 s ren macwe i el | 20D
X X X X e e D X XX X e PO 0 X 0]
B PATENT o [P OCOOOOOCOOO O ammer smoems = ROOOOOOOOCOCOCOOUOOOCOOOOOCOOOOUNOOOOOOOM]
|hhhhxxxxxnmnmmxxxxxmm OO OO0 |:«x:d |xx>q>a>ax>ax}c}d-|}cxx

p— CORDITION GODES
MEFR IR ®__m = o = R ] e |

. xxﬁhhﬁhhxxxx XAXXAXXKXXXN

TCOFERCE SPAN

ADVESSITN
10 R ”"’||:- nare {3HA 44 TYPE 5500

KKKKKKKKK 3 W% Wy pre
z : =

OCCURRENGE PRk

FEDW

THROUGH

FROW

THROUGH

(RO
XXK

XHX
XXX

ERESSEEEE LRSS ESLEE LR EEI L ELLEEEEL RS RS
KKKKKKkaxkkkkkhhhhhkkxkkkkkkkhhhhhxkkxxkk

WALUE CODES
BBICLPT

EREEEESSEES E )¢
O O 00O OO0 OO0 PO
c

OO OO0

RO OO

KKKKKKKKK XX

XﬁKKﬁKKKK
LEE 88804
XXKKKKKKK

KKKKKXXXX EEREE L EREEEE LE ST e S
OO K XKKXKK KKKXXXXXKKKKKKK

Gﬂl‘l:

Cones

X
K
KX

L

LRSS eS8
R XX
eSS 8201

LEES RIS e NN

Character Assignment for the UB 04 form

To emulate this formatting we developed the 'Facsimile’ mode.

paper.

In this mode the forms
appear just as they would have been filled with a Dot Matrix printer on tractor fed
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Print | Close | MextClaim «— 1f1 — | Claim | Addlinfo | COB info

Zerders BB Wumber: AF7E54
* HEALTHG HOSPITAL OF AWYTOWH z
1 HOSFITAL ROW

IAHYTOWH MD 21299 &l QI{JL;E!EITCO‘rEﬁ;tJEIJRG‘jND 7 Couered Days:
|p57654321  [022101  [022601 |5

= PATIENT NAME |a | = PATIENTADDRESS |a |1 HOME STREET

" [SMITH TESS T - [HME CITY [-pD [t [13746 [T

10 BIRTHRATE |"SE><||2 DATE nmi'ﬁl{o'uwpstssm S DHR 175“‘1 18 1= = 1 GO;ZDITIJI%ODB 2+ - F] = = E{:PIHI

02021930 7 [1a o1 |

31 0CCURRENGE
CODE DATE

(05 |022101

= QCCURRENGE 3 0CCURRENGE
CODE DATE oD E DATE

= TG URRENGESFAN OCCURRENGESPAN
CODE RO FROM

Ez]
THROUGH  [ConE THROUGH

=SMITH TESS T Tone " SRBINT AT
1 HOME STREET A 250 100 | |
HME CITY, MD 13746 b i i i
- : : :
’ : i :
#Z REVLCD. |+3DESCRIPTION +4 HCPCE/RATEHIPPECODE S =ERV. DATE S SERW. UNITS 7 TOTALCHARSES 2 NON-COWED CHARSES |+
120 £250.00 5 1250 .00 !
1320 5 1006 00 : ¢
1360 1 722 '00 : =
1370 1 310 '00 : R
5450 1 987 134 ! d
4710 1 400 '00 ! =

View of an Institutional claim in Facsimile Mode.
The image above shows a UB-04 in facsimile mode.

2.7 Working with Multi-Page Claims

Professional claims with more then 6 lines and institutional claims with more than 23 lines
do not fit on one form. The HIPAA Claim Master will display such claims on multiple
forms. The header of each form will indicate that this is a multi-part document as well as
which segment the present page is. The screen form has navigation buttons, so that you
can page forwards and backwards through the claim.
|

1/2 —  Claim | Addlinfo | COB info

S e BO K mﬁj#
XYZ Carrier Services Inc

Navigating through multi-page claim. The page number is indicated

Only the line information will differ on each form. The claim header information will be
identical. HIPAAsuite does not show page totals but will always display the claim total.

Multi-page claims will be printed on several sheets of paper.

The above figure also shows that this claim has additional info that does not fit on the
UBO4 and there is extra COB info.

© <2003> Martin Scholl Consulting, Inc.



23 HIPAA Claim Master

2.8 Printing Electronic Claims

If you want to print to a printer other than the computer's defined default printer, select the
desired printer. See Selecting a Printer.

Note: The HIPAA Claim Master Version 4.0 onwards does not need anymore third party software for the
creation of image files. Older versions of the HIPAA Claim Master needed to have the Peernet Tiff
Image Printer or PDF Image Printer driver installed.

Follow the instructions below to print the Electronic Claim.

1. Open an EDI file or directory containing the EDI files in the HIPAA Claim Master. Read
more in Processing an Electronic Claim, Processing an Entire Directory.

i HIPAA Claim Master - 32bit

File Forms View Search  Claim Entry/Edit

B> - =

Open Dodument

" Printer

The "Open Document” button

(3 HIPAA Claim Master - G4bit

iFiIa'ans View Search  ClaimEntry/Edit DataBase CodeSets Logs Image Setup EDIExchange Help

| Open Sample File X '
i B open LR, é‘ — @

Select Printer

Exit

The "Open Directory” menu

2. Select the "Printer” option in the "Output Mode" block.
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Getting Started

s HIPAA Claim Master - G4bi

File Forms View  Search
= > 1

Dutput Mode
G it

" Screen

" Image File

The "Printer” mode

3. Click on the "Run” button.

s HIPAA Claim Master - b4bit]
Fle Forms View  Search

= (> |

~ Dutput Mode
& Printer

" Screen

" Image File

[T Data Impaort

~ Claim Type
% Professional
" Imetibutional
" Dental
" Reporting
— Counter

] S—IC
Tootal Arount
| $2.175.90|

Processing CHiProgramDatalHIPAS:

The "Run” buttons

4. The "Processing Results” window displays the report.

24
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HIPAA Claim Master

2.9

Processing Results

File "837FCLM edi' processing started at 10/25/2013 410:31 P
Trading Partner ID: 987654
ClaimTvpe is P, Professional
The file is marked Test'
Claims will be panted
5 claims were printed

The "Processing Results” window

Requesting a Trial Extension

The HIPAA Claim Master comes with a free trial of 15 days. Once your trial period has
expired, the application will stop working. There are limitations to the trial version; for
example, you can only export the first 50 records of EDI files, and only 5 files per
directory processing. We are sorry to have to limit the experience, but we had instances
where organizations used the software for production purposes without purchasing it.

We do not mind extending your trial if you need extra time to evaluate the software.
You will only need to send us the registration number and we will gladly give you another
15 day trial. If your trial time has expired and you wish to continue your testing of the
software, please send an email to info@HIPAAsuite.com with the Registration number
and we will give you a trial extension.

If you need to continue your trial of the product, follow the instructions below.
1. Launch the application.

2. Click on the "Ask for Trial Extension” button on the displayed window.

(R ucense x|

HIPAA Claim Master

4210
Dayi{=) remaining for trial 0

This software is for evaluation purposes only and has limited

functionality
You will have to purchase this software if you want to continue using it
after a free evaluation has expired.
B4EC5448 Ask fortral extension || Order |  Register

The "Ask for Trial Extension” button
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Tip: You can see the registration number in the lower left hand corner. This number is needed for the
registration as well as trial extensions. It is unique to your computer and hardware. You can hover over
the registration number and copy it to the clipboard, so that you can easily paste it into the email. This
avoids human error. (The letter "0" is never used, only zeros.) Hovering over the number will give you the
following floating menu:

Registration Number.
EHE%‘ ‘m ==

| fortrial estension

Ask for frial extension

3. Clicking on the "Ask for Trial Extension” button will bring up the feature control

window.
x
HIPAA Claim Master
Evaluation version Enter License Key |
Product Features: Request Trial License
Image Creation * On  Of Licensed v
Work with Database & On © OFf Licensed
File Creation * On  Of Licensed ¥
Claim Entry/Edit “ On O Of Licensed
EDI Exchange:
Evaluation version Enter EDI Exchange Key |
© 0On © Of Reguest ED| Exchange License |
Save | Registration Mumber: B4EC5448 Close |
e

The "Features and Licenses” window
4. Select features you need and click on "Request Trial license.”

5. An email to HIPAAsuite will be created. The message will contain the registration
number so we can then create the extension key. For example, this will open Outlook
with the following data inserted:

e To: info@HIPAAsuite.com
e Subject: [HIPAA Claim Master][123456789]: Request for Trial License Extension
e Message: Volume ID: 123456789
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Fram = Martin.Scholl@HIPAAsuite.com

To... ofp BHIP Adguite, com
e,

= ‘.
Send
Bec...

Subject: [HIPAA Claim Master][FTEDCFEBF): Request for Trial License Extension

Request for Trial License Extension

Product: HIPAA Claim Master
Volume ID: 7TRDCFBBF

Already licensed features:
Image Creation,

File Creation,

Work with Database,
Claim Entry/Edit

Required new features: No new features selected to request for license

Current Key:
Trial Key: EIRNO-QOPO0-GHFIF-KBM5P-5A48Y-EGIGI-6D3WIKS

The trial extension request email
6. The response from the support team should include an activation key.

7. 0nce you have the activation/unlock key, click "Register” on the program welcome
window.

(Q icense x|

HIPAA Claim Master

4210
Day(z) remaining for trial 0

l

This software is for evaluation purposes only and has limited

functionality
You will have to purchase this software if you want to continue using it
after a free evaluation has expired.
B4EC5448 [ Askiortral extension | Order | Regster |

The "Register” button

8. Paste the activation key into the field on the Registration Form and then click
"Register.”
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Tip: The field is case-sensitive. The best thing to do is to copy and paste the License Key from our email.

x|
HIPAA Claim Master

The "Registration Form" window with entered license key and highlighted "Register” button

9. The success message will appear in the "Result” border. You will see what components
have been registered.

— Result

Thank you for evalsating HIFAA Claim Master!

Thiz iz a full functional version of HIFAA Claim Master for evaluation uze only.
This evalustion version expires in 15 days
EDI_Exchange componert is not registered.

3 Fl

The license activation result

Click "Close."

10.0nce the license key has been entered, click "Try" on the welcome window to continue
using the program for another 15 days.
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Q cense x|

HIPAA Claim Master

4210
Dayi{=) remaining for trial 0

This software is for evaluation purposes only and has limited
functionality
You will have to purchase this software if you want to continue using it
after a free evaluation has expired.

B4EC5448 Ty || oder  |[ Regeter |

The "Try" button

Once the product is registered with a permanent unlock code, future upgrades will find
this key and install without user action.

2.10 Enabling Application Components

With version 4.1 we split up the HIPAA Claim Master into components to make the
product more affordable and to allow the customers to license only the features that they
need. The following components can be licensed individually:

¢ A base version that displays claims on the screen and prints them to paper.

¢ Image file creation — See Creating Image Files from EDI.

e Database integration — See Exporting the Data.

e EDI creation — See Creating EDI Files.

¢ Claim edit/entry — See Using the Claim Entry/Edit Function.

There is also the EDI Exchange module that works across all HIPAAsuite products and has
a separate license so that it can be employed by multiple HIPAAsuite products without
requiring to be licensed for each one.
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Features and Licenses

HIPAA Claim Master
Evaluation version

Product Features: Request Tral License:
Image Creation # On C Of Licensed ¥
Work with Database ~ On  Off Licensed [+
File Creation “ On O Of Licensed
Claim Entry/Edit & On  Of Licensed ¥
EDI Exchange:
Evaluation version Enter EDI Exchange Key |
€ on € of Request EDI Exchange License |

Save |

Registration Mumber: B4EC5448

Close I
2

The "Features and Licenses” window

30
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3 Configuring the Application
3.1 Configuring Program Options

1. To configure the program options, select Setup » Options in the main menu.

=10l =
CodeSets logs Imagel| Setup |) EDIExchange Help

Spedific Options
Claim Forms
Configure Additional Info Pages

Company Setup
Create Company Setup Table

The "Options” menu

Alternatively, you can click on the "Setup” button located on the main toolbar.

w HIPAA Claim Master - 32bit
File Forms View Search  Claim Entry/Edit

= > 77

" Printer

The "Setup” button

2. The following screen will appear.
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=10 x|

" Processed Files

% Leave in Place

r Mweln| I

" Delets
™ Keep alog of every file processed I Mever check for update
I Record errars onlyto log. No Pap-ups Document Color

On Screen On Paper
* Red * Red
" Black " Black

Print Additional Pages
™ Additional Info
[ COBInfe

- Qutbox Directory Path

I Browse |
| Save I Help Cancel L’?

The "Setup” window

You can configure the options:
® Processed Files
e Log
e Update
e Print Additional Pages
e Document Color
e Outbox Directory Path
Detailed descriptions to follow.

3. Once you have finished editing the options, click "Save."

Processed Files

In order to prevent the duplicate processing of files, the HIPAA Claim Master can move or
delete files after they have been processed. Since the HIPAA Claim Master program can
be launched by the Window's scheduler (see Running the Application via Scheduler), it is
important to either move or delete processed files, so that they will not be picked up
again. You have the choice to either do nothing, move the processed files to a specific
folder or delete the files:
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e Leave in Place — Select this option to do nothing with processed files.

Tip: This option is not recommended.
e Move — Select this option to move the processed files to a specified folder.

e Delete — Select this option to delete the processed files.

Log

e Keep a log of every file processed — Determines whether the log entry should be
created for each file processed. By default, the log is only active in command line
use (without human interaction.) If you want a log entry created for each manual
processing, except viewing on screen, place a check mark here. See also: Accessing
Daily File Log.

Update

e Never Check for Update — To check the HIPAA Claim Master version update,
uncheck the "Never Check for Update” check box. If the check box is unchecked,
the application will automatically look for the new version available and a pop up
window displayed. On selecting the new version, the application will get updated to
the current version available. The lower right corner of the application window
displays information including alerts on version updates.

- |

Mo update avalable .:

The message on the bottom bar

Print Additional Pages

There may be additional pages with data that have no representation on the standard
forms.

This option determines whether the additional pages with either COB_information or
segments with additional_information that have no representation on the standard forms
should be printed on either paper or image files. This option helps you save paper. If you only
need the main claim form, there is no need to print 2 extra sheets.

If you only need the main claim form, there is no need to print these two (2) extra
sheets, in this case, leave the following options unckecked to save your paper.
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3.2

¢ Additional Info — There may be additional pages with segments containing
additional information that have no representation on the standard forms. If this
option is checked, then these additional pages will be printed on paper and image
files.

¢ COB Info — There may be additional pages containing COB information that have no
representation on the standard forms. If this option is checked, then the additional
pages will be printed on paper and image files.

Document Color

This section of the setup window is concerned with the output colors. You have the choice to

render the form in red or in black. The form background can be set to red to make the form
visually more appealing and to allow the use of a color filter for OCR software. The color can

be selected for the following media:

Note: The data is always black.
e On Screen — Choose a color for the form when displaying claims on screen.

e On Paper — Choose a color for the form when printing claims.

Outbox Directory Path

Define the destination folder where the result files will be stored.

Configuring Specific Options

You can set regional and other user-specific options that do not apply to all users. Follow
the instructions below.

1. To configure the program options, select Setup » Specific Options in the main menu.
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T -Iolx]
Image || Setup ’__ED: Exchange Help
.ﬁ Options
|" Spedfic Optians |
Claim Forms

-
" Configure Additional Info Pages

Company Setup
Create Company Satup Table

The "Specific Options” menu

2. The following screen will appear.

specific Options M=l E3
™ Do not use calculated Yalues in Claim Forms

™ Do not export POA and ICD version info with Diagnosis Codes, separated by a colon

™ Display Drug Information in accordance with MediCal NDC reporting requirements
(CMS-1500: in box 244 LUB-04: in box 43)

¥ Ch3-1800: Display procedure description in 24D

[~ CMS-15800: Display line remarks (NTE*ADD) in 240 (overrides description)
™ CMS-15800: Do nat display Pay-Ta Pravider information in Baox 33

[ CMS-15800: Copy Billing Provider to Facility if nat specified; box 33 to 32
[~ CM3-1800: Populate line praviders only if different from claim level

V¥ UB04: Show description of procedure code (revenue code is default)

Save Help Cancel

Y

The "Specific Options” window
3. You can enable/disable the following options:

¢ Do not use calculated Values in Claim Forms — The HIPAA Claim Master calculates
the Open Amount from charges minus previous payments and patient paid amounts
and some other values. If you prefer not to do this, check this option.

e Export POA and ICD Version information with Diagnosis Codes, separated by a
colon — You can opt out of writing POA and ICD version information to the
database. The default is now to write this information to the database. This option
changed. The default behavior is required to create valid claims.

Present on Admission (POA) information is now often required by insurers to exclude
"hospital infections” from coverage. These are diseases that are acquired by the
patient after admission to the hospital and often cause high costs and even death. In
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the SQL export the POA codes are colon separated from the diagnosis codes. If this
causes problems, you can deselect this here. With the introduction of ICD-10 it is
important to save the version of ICD codes that are in the claim to the database.
Since it is intrinsically linked to the Diagnosis code we decided against creating
another set of fields. It would mean creating another 80 or so fields for POA and ICD
version. Instead we opted to concatenate the ICD version qualifier and the POA
indicator with Diagnosis Code qualifier separated by a colon (:)

o Principal Diagnosis Code has POA and ICD version. Example:

Z77.22:Y:ABK with the diagnosis code in first position, followed by the POA indicator
Y' and the ICD-10 qualifier

0 Other Diagnosis Code has POA and ICD version. same as above
Example: J151::ABF Here the POA code is committed

0 E-Codes also have both POA and ICD version, same as above
Example E8600:Y:ABN

o Admit Diagnosis Code has no POA info. By definition is the diagnosis code under
which a patient was admitted present at admission.

Example L01.03:ABJ Only the ICD version qualifier is added to the diagnosis code
o Reason for Visit codes have no POA info. Same as Admit diagnosis

This way of connecting diagnosis information with POA and ICD codes is bi-directional,
meaning if you create 837 files from database, then the above example is the way to
do it. Internally HIPAA Claim Master will parse out the information and assemble the
respective HI segment within all applicable rules.

e Display Drug Information with accordance with Medical NDC reporting
requirements (CMS-1500: in box 24A, UB-04: in box 43) — The Medi-Cal NDC
reporting requirement is concerned with the transmission of drug data that belongs
to a specific procedure. In the 837, this information is in the LIN and CPT segments
of the 2400 loop. Here the display of NDC in the CMS-1500:

DATE o] OF SERVIGE - TCEDIHES SERVICES DR SOPFCr T —E F M oo
EHOM L " |ewa | crmmcecs MODIFIER “PONTER 3 CHARGES ‘JrT "~ lab FROY
N100075800120 ML000020000 ]
1 |osi01/2000 05012000 |11 J9170 1.2 $1,650.00 |3 <=| 1234567890
N400641244045 UND01000000 _ 1
2 |osm12000  o5m1/2000 |11 J1644 1,2 $5.00 |1 1| 1234567890
N$ ML000250000 ]
3 |osin12000 05012000 |11 J7050 1,2 $30.00 |3 1234567890
N400088120632 GRO00010000 e
4 |osm1/2008 05012008 |11 J1260 3 $200.00 |10 | |- |io54567g00

The NDC code is in the upper half of field 24 A. The quantity in 24 D.
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The format for the quantity is a full 10-digit number. The 10 digits consist of seven
digits for the whole number, followed by the three-digit decimal portion of the
number. In the example above line 1 indicates 20 milliliter, line 2 1000 units, line 3
250 milliliter and line 4 10 grams.

IZAEVCD. |43 DECCRIPTION TLHCPCWRATEHIPPS CODE WSDERU.DATE | 45 SERV. UNMS 47 TOTAL CHARGES 1S WD NCOVED CHARGES |45

0250 |N400409128331UN000001000 J1170 04/07/09 |1 $25.00

20250 [N400338802072ML0O00011000 J3490 040709 |11 $445.50

0250 |N400008092351UN000001000 S0164 04/07/09 |1 $40.50

W

. |0250 |N400173044202UN000001000 X7050 04/07/09 |1 $150.70

The NDC information in the UB04 form

In the UB04 the NDC information goes into the "Description” field 43 as one string
with quantities in the same format as in the CMS-1500.

e CMS-1500: Display procedure description in 24D — See Displaying the Revenue or
Procedure Code Descriptions.

e CMS-1500: Display line remarks (NTE*ADD) in 24D (overrides description)

e CMS-1500: Do not display Pay-To Provider information in Box 33 - When a Pay-
To provider is specified in loop 2010AB, the address information is usually displayed
in box 33.

e CMS-1500: Copy Billing Provider to Facility if not specified; box 33 to 32

e CMS-1500: Populate line providers only if different from claim level - Display
cleaned up in EDI files where the rendering provider is repeated on every line.

e UB 04: Show description of Procedure Code (Revenue code is default)

Field locator 43 will be populated with the procedure code description in case such
code is in SV2 segment

e Use Facsimile Mode in UB 04 and CMS-1500 - For the purists, this mode strives to
make the claim look like it has been filled with a Dot-Matrix printer. More here.

4. Once you have finished editing the options, click "Save."

3.3 Configuring Claim Forms

The introduction of the National Provider ID (NPI) brought new claim forms. Al three
types of claims now have a form that contains the NPI. The HCFA-1500 became the CMS-
1500, the UB92 was replaced with the UB0O4 and the ADA 2006 replaced the earlier
versions.
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You can choose which forms to use and it will give you the choice to either print the
form and the data or to suppress the form, so that only the data appears. This is
important if you want to print on pre-printed forms or use OCR to read the data.

1. To configure the program options, select Setup » Claim Forms in the main menu.

—-— =
Image(| Setup [) EDIExchange Help
"'\?'T___.-"

Configure Additional Info Pages

Company Setup
Create Company Setup Table

The "Claim Forms" menu

2. The following screen will appear.

@ comroms T

¥ Auto Form Selection.

IF NP is present in Billing Provider's
informaticn then choose new Forms with NP,
otherwise use forms specified below.
~ Dental Claims
[ Dom't Print Formm, just data
" ADA 2000
" ADA 2004 — {100 ¥ | % Scale
* ADA 2006 (NP1) -
~ Profeszsional Claims
™ Don't Print Form, just data

" HCFA 1500

* CMS 1500 (NP1} 100 | % Scale

 Institutional Claims

™ Don't Print Form, just data

" UB 92

* UB 04 (NP1) Imn vlaascaro

_swe | wep | conos |

The "Claim Forms" window

3. You can configure the following options:

e Auto Form Selection
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¢ Dental Claims

¢ Professional Claims

e Institutional Claims

They are described further below.

4. Once you have finished editing the options, click "Save."

Auto Form Selection

Check this option to automatically select the forms. The system selects the forms based
on the following logics. If NPI is present in Billing Provider's information, then choose new
Forms with NPI, otherwise use forms pecified below.

Tip:We recommend to activate this setting. Older Pre-NPI claim files will then be displayed in the old
forms while newer files with NPI will be rendered in the new forms.

Dental, Professional, Institutional Claims
Select the forms for the following claims:

¢ Dental Claims

¢ Professional Claims

e Institutional Claims
Specify the following settings:

e Scale — The UB04 form is bigger than the other claim forms. It is 12" x 9" instead
of the customary 8 1/2" x 11" and it usually does not print in its entirety due to the
print margins. For that reason it is possible to scale the form down to a printable
size.

e Don't print form, just data — Additionally, you have the choice to print just the

data and suppress the form.
Tip:This feature comes in handy when you want to print to pre-printed forms or if you have an OCR
system that does not need the forms.
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3.4

Using the EDI Viewer and Editor

EDI files are often hard to read, especially if they have no carriage returns and line feeds
to put each segment on a line of its own.

The EDI Editor available in the HIPAA Claim Master replaces all element separators with a

star ™", all sub element separators with a colon ":" and all segment separators with a
tilde "~" even if the original file uses different delimiters.

Tip: Changing EDI files can be a tricky undertaking. You should be experienced in the format of the 837
and understand that an 837 claim file could be a legal document that should not be altered without
the consent of the originator.

To Open EDI Editor

To access the EDI Editor, select the "EDI Editor” option under "View" menu item.

(3 HIPAA Claim Master - G4bit

File Forms(| View | Search  ClamEnkry/Edk  CataBase

: | Eoredtor
E F:_I Info Bar [' A

The "EDI Editor” menu

Alternatively, you can click on the "EDI" icon on the toolbar to invoke the EDI Editor.

This option is only enabled when you have opened an EDI file.

(S HIPAA Claim Master - G4bit

File Forms View  Search  Claim Entry/Edt  Data Base

o —

LA AL4 G

The "EDI Editor" button

The following screen will appear:
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[ File: B37IPTST.edi

1 I1SA™00" 00" *29* 987654"258" 32112*010329*1430*U00401%1 12233445 1° T~

2 GS*HC*A57654*32112*20010329*1430"321* X 00401 0X096™
3 ST"B37"54322~
4 BHTD019*00*1238*20010329*1310*CH™
5 REF*87*004010X096™ =
6 MM1"41*2"HEALING HOSPITAL OF ANYTOWN™ 46" XZ54275~
7 PER*IC*PHIL FIELD*TE*7 365554321

8 NM1T*4072*xYZ INTERMEDIARY SERVICES INC™46~739654™
9 HL*1*=20*1™

10 PRVEBI*ZZ"282M00000N™

11 NM1*85*2*HEALING HOSPITAL OF ANYTOWN™ 24097654321~
12 N3*1 HOSPITAL ROW™

13 N4"ANYTOWN*MD*21298™

14 REF*1C*895463™

15 HL*2*1*22"0™

16 SBAP™18™MA™

17 NMT*IL*1*SMITH*TESS* TMI"D21995432A™

18 N3*1 HOME STREET™

19 N4*"HOME CITY*MD*13746™

20 DMG*DE*19300202*F™

21 NMT*PR*2"XYZ INTERMEDIARY SERVICES INC™P[*895674~
22 CLM™S87654™4675. 34 1 T A 1Y ASY Y 0 AN~

23 DTP*096*TM*1400™

4 DTP*434*RDE"20010221-20010226™

25 DTP*435*DT*200102210800™

26 CLI=2*7*01~

27 AMT*C5*4035 34~

28 AMT'F3"640™

29 REF"EA"69875-9~

30 HI*BK-820.21*2Z:820.21*BN:ES84 2™

HI*BR:-79.35:D08-20010222™

iZ2 HI*"BH:05:D8:20010221™

33 HI"BE:01:::250™

4 OTY"CA"S"DA™

35 NMT*71*1*KILDARE*JAMES™34*321121234™

36 PRVCATZZ"203BF0100Y™

37 REF*1G*A1234™

38 NM1*72*1"WELBY*MARCUS*34"937121234™

19 PRVOP*ZZ"203850100Y™

40 REF*1G*A1235™

41 ™

42 SVZ12071250"DAS"250™

The EDI Editor window

[

To Cut, Copy, Paste

When you right-click anywhere in the text, a context menu will appear with typical test
edit options such as cut, copy and paste.
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[ File: 837IPTST.edi

H&hl

1 ISA™00D" o 29 987654%28" 32112*010329*1431
2 GS™HC*957654%32112*20010329"1430"321*X*004010x0%6™

3 ST"837"84322~

4 BHT*0019*00*1238*20010329*1 310 CH™

5 REF*87-004010x096™

6 NM1*41*2*HEALING HOSPITAL OF ANYTOWN™ 45" xZ54275™

{ PER®IC*PHIL FIELD*TE*F365554321™

8 NM1=40m2"xYZ INTERMEDIARY SERVICES INC™=46*739654™

9 HL*1™20™M1™

10 PRV*BI®ZZ=282N00000N™

IR LR HEALING HOSPITAL OF A8
12 N3"1 HOSPITAL ROW™
13 NA"ANYTOWN™MD=21298™ o Ty

A 0a7es4321™

14 REF*1C"895463™ (™*

15 HL*Z*1*22*0™ Copy

16 SBR*P*18™"MA"~ | Paste

17 NMTIL*T*SMITH* TESS* T**MI"021¢ | Delete y
18 N3™1 HOME STREET™ -

19 N4*HOME CITY*MD*13748™ Select All

20 DMG DE*19300202*F™

21 NMT*PR"2*XYZ INTERMEDIARY SE Find
22 CLM9576544675 341 1:A:1 A"
23 DTP*096™TM=1400™

24 DTP*434*RDE20010221-200102267
25 DTP*435*0DT*200102210800™
Context menu

FI*895674™

To Find and Replace

The "Find" and "Replace” utilities work as in a common text editor. To use them, right-
click somewhere in the document and then from the displayed context menu select the
"Find" or "Replace” command. Alternatively, you can press ctrl F simultaneously on your

keyboard to bring the text search utility.

O ox
—

Dection Cancel I
™ Malch case Lﬁ Up & Down |

The "Find" pop-up

Pressing arl Hsimultaneously will bring up the Replace utility.
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20
Fodwhat |
Replace with: |

™ Maichcasze

The "Replace” popup
To Save the Changes

As long as you don't save, there will be no changes to the file.

If you make changes to the file, the "Save" button becomes enabled and you can save any
changes. The HIPAA Claim Master will further work with those changed files, so you don't
have to open the file again.

Notice: Changing EDI files can be a tricky undertaking. You should be experienced in the format of the
835 and understand that an 835 claim file could be a legal document that should not be altered
without the consent of the originator.

[ File: B3512.edi =101 x|
b | (soe
1 ISA00" *00~ *ZZ*  123456789%20~ 610442%020518"1601*U"00401~229800002*0~ T~ _-|
2 GS*HP9998887766™39876564 200210261135 229800002*>}*004010X091™
i ST=835%229800002™
{ BPR*C*175.00*C*CHK 20020518™

The "Save" button

3.5 Selecting a Code Set

EDI relies on transaction code sets. These codes represent longer explanations and
descriptions.

At the onset of EDI one of the main design ideas was to make the EDI files as short as
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possible and to allow different languages to use the same descriptions by reducing long
verbose explanations to 2-3 byte long codes. Computer storage was incredibly expensive
and making any file larger than it absolutely had to was considered wasteful.

The code sets are stored in the file codesets. xn in the Confi guration subdirectory:

Windows XP: c:\Documents and Settings\All Users\Application Data\H PAAsuit e\ H PAA
Cl ai m Mast er\ Confi gurati on\

Windows 7, Vista: c:\ ProgranDat a\ Hl PAAsui t e\ Hl PAA Cl ai m Mast er\ Confi guration\

. Configuration

91\'_'} « Computer = Local Disk (C:) = ProgramData ~ HIPAAsulte ~ HIPAA Claim Master = Configuration

Organize *  Includein lbrary =  Sharewith =  Burn  New Folder

T Name - | Date modfied Type Size

Bl Deskbop £ ClaimEntry. xml 262013 10:29 AM  ¥ML Document 436 KB
& Dowrloads = Codesets, xml 9/26/2013 10:29 AM XML Documenit S KE
| Recent Places

The Configuration folder in Windows 7

Tip: The folder is hidden.

To view/edit transaction code sets in HIPAA Claim Master, follow the instructions below.

1. Go to the "Code Sets" item in the main menu.

(s HIPAA Claim Master - Gabit
File Forms View Search  ClaimEntry/Edt  DataBase || Code Sets | Logs

r ] E
:% !" LEB A :::P :

Qo ]

| — Dutput Mode
The "Code Sets" menu

2. From the sub-menu, select a code set name. The following menu items are available
via the "Code Sets" menu:

AtoE
¢ Adjustment Reason
e Adjustment Reason Group

e Admission Source
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e Admission Type

e Amount Qualifier Codes

e Attachment Report Type

e Certification Type

e Communication Codes

e DTP Codes

e Delay Reason Codes
FtoP

e Facility Type

e Filing Codes

e Filing Indicator Codes

e Gender

e ID Codes

¢ Info Release

e Marital Status

¢ Patient Location

e Pattern Codes

e Pricing Codes

e Prognosis Codes

¢ Provider Codes
QtoZ

e REF Codes

e Relationship

e REFCode

e Remark Codes

e Signature Source

46
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e Subluxation Codes
e Tooth Numbering
¢ Unit Codes

¢ Yes/No Codes

The following screen-shot illustrates how to select the "Patient Location” code set for
display.

(8 HIPAA Claim Master - G4bit

Fils Forms View Search  ClaimEntry/Edit  DakaBasel| CodeSets |Jlogs Image  Setup  EDI Exchange

: E AtoE ]
E b — é‘[ Ftap >|' Eaciity Type

~ Dutput Mode genl 202 ¢ e
& Prter iriasaiines : i v Filing Indicator Codes
 Screen B Gender

ID Codes
" Image File . Info Release
: = — Marital Stabus

™ Data Impont e Patient Location
Claim Type ' i
% Professional " Fricing Codes
T Institutional e Prognosis Codes
 Dental = Provider Codes

The "Patient Location" sub-menu

3. The Code Set configuration window will be displayed.
You can add, delete or edit codes. Read further how.
Below you can see this window for the Patient Location.

The window provides the following information:

e Number of records in codeset — The total number of codes. For example, for
Payment Location it is equal to 14.

e Codes and their corresponding descriptions. The codes are indicated in the source
EDI files. The descriptions are displayed instead of codes in the result easy-to-read
files. For example, for Payment Location, there are the following codes and
corresponding descriptions:
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e A — Acute Care Facility

e B — Boarding Home

e C — Hospice

e D — Intermediate Care Facility

e etc.

Patient Location

FPatient Location

Help I

Mumber of records
in codeset

14

Code | Dezcription

N peeecen

Boarding Home

Hozpice
Intermediate Care Facility

Lang_term

Mot Specified

MNurzing Home

Sub-acute care facility

| Other Location
ARehabilitation Facilite

OutPatient Facility

| Residential Treatment Facility
Skilled NMursing Horne

Slmanjo|zirz|enmoloo

RestHome

The "Patient Location” code set configuration window

4. Click on the "Save" button to save the changes.

Adding a New Row

To add, click on the last row. Now you can see the indicator in the first grey field.
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3.6

_ 0 | OutPatient Facilite

. R . Rezidential Treatment Facility
5
T

| Skilled Mursing Horme

Resz:t Home

The indicator

Click the field again to enter to the Edit mode. Now you can enter the text.

Note: Only after you leave this row, the changes will take place.

Deleting a Row

To delete, click the left margin. This action will highlight the whole row.

_ 0 | OutPatient Faclity
R | Residential Treatment Facility
g

Shilled Murzing Home

Highlighting a row by clicking the left margin

Now press the <DELETE> key on your keyboard.

Editing the Row

To edit, click two times the cell you want to change. Make your changes. Clicking or
moving outside this cell overwrites the cell contents with the new value. To make these
changes permanent, click the 'Save' button.

Notice: Don't forget to save the changes by pressing the 'Save' button.

Accessing Daily File Log

The HIPAA Claim Master can keep a log entry for each file that gets processed. This
feature is especially helpful when the HIPAA Claim Master is run through automated
processes. The log is essential in tracking errors and documentation.

Enabling Logging
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To enable logs, check the "Keep a log of every file proccessed” checkbox under Setup »
Options » Log.
B setup

~ Processed Files

% Leave in Place

M= E3

T Moveto |
" Delete
" Log — Update
I Never check for update

I~ Eeep a log of every file proceszzed

I Record errors only to log. No Pap-ups Document Color

On Screen  On Paper

Print Additional Pages s i

* R * R
™ Additional Info r Erdk lﬂ BI&dk
[ COB Info - -

~ Dutbox Directory Path

l

| Save | Help Cancel | P

The "Keep a log of every file processed” check-box

To record the errors only in the log, check the "Record errors only in log" box displayed in

the "Log" section.

B setup

~ Processed Files

% Leave in Place

M= E3

T~ Moveto |
" Delete
" Log — Update
™ Mever check for update

v Keep a log of evary file processed

¥ | Record errors only ta log. Mo Pop-ups Document Color

On Screen — On Paper

Print Additional Pages e =
* R = B

™ Additional Info ' Erdk (" BI&dk

I COBInfo = -

~ Qutbox Directory Path

l

| Save | Help Cancel | |

The "Record errors only in log" check-box
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Accessing Logs
Follow the instructions below to access the log files for your HIPAA Claim Master.

Click Logs » Daily Logs in the main menu.

".- HIPAA Clain Master - B4bit
File Forms ‘iew Search  ClaimEntryfEdit  DataBase Code Sebs!| Logs | Image  Seby

: : [ Daiy y
® > 49

The "Log" menu

If there is a log file for the current day, it will be displayed. If not, the page will be
blank. You can navigate to each date with the calendar control on top of the page.

Log files are simple text files, one for each day that are stored in date hashed folders.
Alternatively, access the Logs folder in the following directory:

Windows XP: c:\Documents and Settings\All Users\Application Data\H PAAsuit e\ H PAA
Cl ai m Master\ Logs

Windows 7, Vista: c:\ ProgranDat a\ Hl PAAsui t e\ Hl PAA Cl ai m Mast er\ Logs

€1 - Computer = Local Disk (C:) = ProgramDsta - HIPAAsute = HIPAA Claim Master - Logs = 2013 = July > & |

Organize »  |Open =  Prink  Burn  New folder

¢ Eavorites Name “ Date modified Type | Size
-l Deskbop . 20130710.log 7i10/2013 10:38 AM Taxk Document
4§ Downloads

| Recent Places
The directory structure for the daily logs

Tip: The folder is hidden by default. But if you type in the address in the top bar of the Windows
explorer, you will find that it exists. Or you can change the explorer settings to show hidden files and
directories.

Tip: The Progr anDat a folder contains all your application data, like program settings, user data, etc,
for all of the installed programs on the computer. The Pr ogr anDat a folder holds the same files that

were contained in the \ Docunents and Settings\All Users and \Docunents and Settings
\Al'l Users\Application Data folders in XP.

For each day that the HIPAA Claim Master is used (If logs are enabled), there will be a log
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file which carries the name in the filename.

Within the directory, find a folder for the year you are looking log for. Then find a sub-
folder for the necessary month with files for each day. Double-click a file which has the
name equal to the necessary date. The log will look like this:

Transaction Log

| Sunday . Mareh 03,2013 =] Get Log [ Help |

File 'BITPCLM. ed processing started at 37372011 11:18:57 AM
Trading Partner D 987654
ClamType i P, Professional
Number of Claims in File; 48
Humber of Line #ems in File: 85
43 claims were exported to a database
It took 0 minutes, 2 T68 seconds to procass this file
The average time was 0058 seconds per claim

The daily file log

This entry is for a problem free file. Out of this entry you will get:
® Process start time
e Filename
¢ Trading partner ID
e Claim type
e Number of claims
e Number of lines
e Number of exports/image files/ prints
¢ Processing time

e Average time per claim

An entry with errors might look like the following:
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3.7

=lolx|

| 171412006 <]  Getlog |

File '837-3551.tut’ proceszed at 12:41:17 P
ClaimType i P. Professional

Mumber of Claims in File: 1

Trading Partrer ID: 123456783

File "83700007 edl processed at 12:471:18 PM

ClairnType iz P, Professional

Mumber of Claims in File: 26

Trading Partrer ID: *CLROD

Emor 13, Type mizmatch in Function lcony

Errar -2147217887: Multiple-step OLE DB operation generated errors. Check each OLE DB statuz walue, if availablz. Mo wark was done. in Sub "wiite_SOL_Clair'
&nd with Provider's Claim Mumber: '014133004 77686

at Field Filinglndicator

withe the walue: Cl

Error -2147217887. Multiple-step OLE DB operation generated emors. Check each OLE DB ztatus value, if available. Mo work, was done. in Sub "wWite_SOL_Claim'
And with Provider's Claim Mumber: ‘047388004 77558

at Field BilProvlDT ype

withe the walue: 2

Thiz ¥12 document is not a 837 Claim but & 8
3. Processing will abort

File ‘83700007 edi.bak' processed at 12:41:22 Ph
Flaire T s i B Brnfassinm =l

The second entry shows a database export problem. The message contains details that
allow tracking of the problem. In this case a carriage return was in the file between the
2 and the 4.

Accessing Statistics

The HIPAA Claim Master stores the amount of claims processed per month. These usage
statistics are needed for a per-claim licensing model.

Follow the instructions below to access the statistics in your HIPAA Claim Master.

Click Logs » Statistics in the main menu.

(8 HIPAA Claim Master - G4bit

File Forms View Search  Claim Entry/Edt  DataBase CodeSets || Logs |/Image  Setup

B> AO oo

The "Statistics” menu

The following screen will display.
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[ claim Printer Usage Report | _ O] =]

Key created on, 10182013
Total Claims Processed: 244

Year: 2013
October  Claims processed: 244

y

The "Claim Printer Usage Report” window

The screen shows the number of claims processed in total and by year and month. The
data is stored as an encrypted key in the registry.

Clicking the "Send Usage Report for Billing Purposes” button creates an email that
contains this report and sends it to HIPAAsuite. The per-claim licensing model depends on
this report for billing purposes. If you have the unlimited Licensing Scheme, you do not
need to worry about this function.

3.8 Selecting a Printer

If you want to print to a printer other than the computer's defined default printer, you will need
to select the desired printer.

Note: The HIPAA Claim Master Version 4.0 onwards does not need anymore third party software for the
creation of image files. Older versions of the HIPAA Claim Master needed to have the Peernet Tiff
Image Printer or PDF Image Printer driver installed.

Follow the instructions below.

Go to File » Select Printer in the main menu.

{5/ HIPAA Claim Master - G4bit

i File | Forms View  Search  Claim Entry/Edt DataBase CodeSets Logs  Image  Sebup  EDIExchange  Help

Open Sampls File - S
I = AV Q

Open Direchory

s — 2

Exik

The "Printer" window will appear. Select the necessary printer.
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General |
~ Select Printer
2 Add Printer Lexmark X500 Series
sAdobe POF (redirected 2) = Micrasoft XPS Document W
% Fay (redirected 2) mMicrosoft PS5 Dooument W
1] |

Shatus: Ready T Firttafile Prefeiences
Locabon:
Comient: Find Printer...

~Page Range
= Al Number of copies: [1 =
= Selectior C Cumert F
r Fages I F Lillefe

[ Pin | cance | oy |

Selecting the Printer for output on paper

Though you do not have any documents in your print queue, click on "Print" to select this
printer for future output.
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4.1

Creating Image Files and PDFs
Creating Image Files from EDI

The greatest disadvantage of electronic claims is that they are near impossible to
understand in raw form. Storing an image associated with a claim makes a lot of sense
for the most HIPAA Claim Master's users. If you have an investment in a claim imaging
system, you can now create images from EDI files and treat them in your imaging system
just like scanned images from paper claims. If your staff can understand a claim on a
UB04 in a second, why not make it available in this form? Having an image file makes it
possible for case workers to call up an image of the claim in seconds.

The HIPAA Claim Master can also be used to create image files and PDFs of the EDI claims.
Image file creation is a component that can be licensed separately.

The HIPAA Claim Master displays the EDI document in a page that makes it easy to read
the 837 transactions. The following formats are supported:

e TIFF
e PDF — The PDF files have searchable meta information in them.

Note: Earlier versions of the HIPAA Claim Master used a third party image printer driver. This is no
longer necessary. The HIPAA Claim Master now has PDF and TIFF capabilities built-in.

Certain parameters of the formats are adjustable.

This is the same information that is in the image index files. This small subset of the
claim data plus the image path and filename serves most image libraries well.

Image filename is also exported to the claim_export. Here, we can also associate an
image filename with the more complete claim data.

You can create image files containing the data that you see in Screen mode. You can
create image files manually or automatically using the command line arguments and
Windows Scheduler. Read more in:

e Using Command Line Arguments (CLI)

e Running the Application via Scheduler

Before creating image files, make sure all settings are defined correctly. Read more in:

¢ Doing Image Setup
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e Configuring Image Index

e Creating Image Index Table

How to Create Image Files

Follow the instructions below to create an image file from EDI file.

Notice: The image file will be created based on the pre-defined settings. Read more in Doing Image
Setup, Configuring Image Index.

1. Open an EDI file or directory containing the EDI files in the HIPAA Claim Master. Read
more in Processing an Electronic Claim, Processing an Entire Directory.

i HIPAA Claim Master - 32bit

File Forms View Search  Claim Entry/Edit

B> o =

Open Document

" Priner

The "Open Document” button

e HIPAA Clain Master - B4bit
|' File |/Forms Wiew Search  ClaimEntry/Edit DataBase CodeSets Logs Image Setup  EDIExchange  Help

| Open Sample File = 1
| = A9 Q
B pen 2 o

Cpen Directory L Ot

Select Printer

=g ]
||

Exit;

The "Open Directory” menu

2. Select the "Image File" option in the "Output Mode" block.

— Dutput Mode -
" Prinker

" Screen

= Image File

The "Image File" mode

3. Click on the "Run” button.
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-1C

s HIPAA Claim Master - G4bil

Fle Forms Yiew  Search

- Dulput Mode
" Printer

" Screen

&+ |mage File

" Data Import
—Claim Type -
" Professional
T Instibutional
" Dental
" Reporting
~ Counter
0l
Cams [ 48]
Tatal Amourt
| $6.757.70]

Run _..!:

The "Run" buttons

4. The "Processing Results” window displays the report. You can find the resulting TIFF or

PDF files in the specified folder.

Processing Results

File "B37IPTET ed’ processing started at 10/2472013 2:57.52 PM
Trading Partner ID: 987654
ClaimType is L Institutional
The file iz marked "Test'
Claim Images will be created
25 claims were exported to a file 337IFTST pdf
Mumber of Claims in File: 25
Mumber of Ling iterms in File: 90
[ttook O minutes, 1.802 seconds to process this file
The average time was 0.072 seconds per record

The "Processing Results” window

M= E3
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4.2 Doing Image Setup

Before proceeding with image export, do the image setup as described further.

Select Image » Image File Options in the main menu to access the "Image File Options'
window.

% HIPAA Claim Master - B4bit

File Forms View Search  Claim Entry/Edit  DataBase  Code Sets chs]Imaga'SEh.p EDI Excharge  Help

| 4 Image File Oplions

Dutput Mode T ; Image Index Fis Options
& Printer : P e Create Image Index Table

The "Image File Options" menu

The following window will appear:
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-

Image File Cptions

Image File Ophions
Qutput Directory For Image Files  Cltemp'Claimlmages

7 Put all Images into the same File and use the name of the EDI file for the Image File

@ Create an Image file for each Claim Add time stamp to image file name
File ID Options:
Clearing House |ID - REF*D9 Provider's Claim |0 - CLM_01
Document Control Mo - REF*F2 T
Repriced Claim Mo - REF*84

image Format Image folder options Document Color On Images
@ TIFF Format : ] )

POF F t I:I None G Red Black

- erma @ Sub-Folders for Year, Month and Day

Print Additional Pages  _ Sub-Folders for Year and Week

e

Medical Record Mo - REFFEA
A Sequential ID - SeqlD 1

NTE*ADD segment - 17 bytes

7} Sub-Folders for Year and Day

Additional Info
[7] Use Date of Semvice for folder hash

COE Info
Options for TIFF

Color Depth: Compression: Image Resolution: Set default values

Horizontal resolution: 200 dpi

U

D) Black/White @ | 7w

© 4bpp ) Packbits

i@ Bbpp Vertical Resolution = Horisontal Resolution
@ 24 bpp Vertical resclution: 200 dpi

D 32bpp G

The "Image File Options” window

You can set the parameters for image file creation; they are described below.

Once the options have been set, click "Save."

Image File Options

e QOutput Directory for Image Files — Here you can set the path to the folder where
the image files will be saved to.

e Put All Images into the Same File and Use the Name of the EDI File for the
Image File — This option allows to create a multi-page file with all the claim images
in it using the EDI filename with a .tiff or . pdf extension.
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e Create an Image File for Each Claim — This option creates a separate image file
for each individual claim. You can specify how the filename will be generated (what
information will be included to the filename):

e Provider's Claim ID — The Provider's Claim ID from the CML_01 segment.
¢ Clearing House ID — The Clearinghouse ID from the REF*D9 value.

e Document Control No — The Medical Record Number (REF*F8).

e Repriced Claim No — The Repricer's Claim ID (REF*9A).

e Medical Record No — For example, REF*EA.

e A Sequental ID — A sequential number starting at one (SeqID).

e NTE*ADD Segment — 17 bytes.

You can create a hierarchy that determines which ID will be used for the filename. In the
picture below, you see that the document control number (REF*F8) is the preferred
filename. If such a segment is not present then the second option is the Clearing house
ID, third is the Medical record number. Since none of these segments are mandatory, you
might encounter claims that do not produce an image name. We strongly recommend to
also use the Provider's Claim ID (CLM_01) as a fall back option in the naming of the
image files.Your choice will then be stored in the Windows registry.

-

Image File Options R
Image File Options
Output Directory For Image Files  Cltemp'Claimlmages Browse
Put all Images into the same File and use the name of the EDI file for the Imaage File
@ Create an Image file for each Claim | Add time stamp to image file name
File |0} Options:
Clearing House |ID - REF*DS Provider's Claim 1D - CLM_01
Repriced Claim Mo - REF*8A Document Control Mo - REF*F2 T
MNTE*ADD segment - 17 bytes A Sequential ID - SeqlD
—— | Medical Record Mo - REF*EA
=) l

The image naming hierarchy

To prevent the overwriting of existing image files, the HIPAA Claim Master checks if a
file with that name already exists and starts to append enumerations to the filename.

For example, w34222_3. pdf would be the 4th instance of a file with WD34222 as the
Claim ID.
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Image Format

Choose either PDF or TIFF. These are the two most widely used image formats. TIFF
(Tagged Image File Format), historically derived from Telefax technology, has not been

updated since 1992. PDF (Portable Document Format) has been the open standard since
2008 and has become very popular, due to the ease of the format.

Print Additional Pages

This option determines whether the additional pages with either COB information or
segments with additional information that have no representation on the standard forms,
should be printed on either paper or image files. This option helps you save paper. If you
only need the main claim form, there is no need to create a multi-page image file with 2
extra pages.

Image Folder Options

When you create image files of claims, you could soon end up with thousands of images
in one folder. Windows has real problems with folders containing more than 1,000 files.
For this reason, the HIPAA Claim Master can hash the images over many folders to make
sure that file quantities per folder remain low.

Claimlmages z z Date modified

2010

ki "L 483.pdf
J” l = 12774 pdf
;”E : = 1288.pdf
n vk = 1483A.pdf
l -
| 1707 A.pdf

2
Folder Options Year, Month and Day

S AGAE A

You can see that there is a folder with the year 2010 under the Output directory, then
subdirectories with the Month which are, finally, further subdivided into days of the
moth. The 2010/September/1 folder contains all the images created that day.

Document Color on Images

This section of the setup window is concerned with the output colors. The form
background can be set to red to make the form more visually appealing and to allow the
use of a color filter for OCR software.
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Options for PDF

e Use Content Compression — Checking this option does result in considerably smaller
files. You can choose the option to compress the content, thereby reducing the file
size by roughly 50%.

Options for TIFF

Here you can adjust the settings of the Image files.

e Color Depth — You can change color depth of the image (black / white, 4 bpp /
8bpp / 24bpp / 32bpp).

Note: TIFF in Window's GDI library does not work with 16 bpp (bits per pixel). Color depths set lower
then 16 bpp results in some losses in image quality.

Reference: The black-and-white (bi-level) image means that for each pixel (picture element) in the
image we do not need three bytes as in the true color image (over 16.7 million colours), but only one
bit that is 1/24 part of the pixel size from the true colour image. The one-bit pixel can express only
black or white colors, nothing more.

e Compression — You can use compression with TIFF files: LZW and Packbits are used
for all Colors, CCITT4 for black-and-white.

e LZW — You can compress any type of TIFF image of any bit depth using LZW, a
lossless method. The application can store the compressed image in a TIFF 5.0
file or keep it in memory. An average 2:1 compression ratio is achieved with
LZW compression on images.

e Packbits — You can compress and decompress gray scale, palette, and bitonal
images using Packbits, a lossless method. Packbits are fast, widely-supported,
and provide good compression of sparse images, such as scanned documents.
The application can store the compressed image in a TIFF 5.0 file or keep it in
memory.

e Photometric Interpretation — For the black-and-white and grayscale images (when
"Black/White" or "4 bpp" options are selected as color depth), you can specify the
intended interpretation of the image pixel data. Select one of the following options:

e White is Zero — The minimum sample value is displayed as white.
¢ Black is Zero — Default value. The minimum sample value is displayed as black.

¢ Image Resolution — You can change horizontal and vertical resolution of images
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4.3

from 96 to 300 dpi (dots per inch). Default resolution is 200 dpi. The same rule
applies here: the larger the Resolution, the more computing time and power is
consumed and the larger the image file sizes.

Note: Theoretically we could use even higher resolutions, but it will slow down processing significantly
result in approximately the same result in quality.

Configuring Image Index

Many of HIPAAsuite's clients have Document Management Systems into which they scan
paper claims. Often the whole claim department is built around this imaging system.
With the prevalence of electronic claims, the need arises to create images of the EDI
claims as well. This is the whole reason behind the HIPAA Claim Master. These images
had to be imported with associated indexes into the document management system. The
image index capability was added for two different clients:

e The first client used an ASCIl flat file with the basic information of claims and
images to import into his image management system.

e The second used a database with basic information about the claim.

Both of these solutions are now part of the HIPAA Claim Master and most of our other
products.

Select Image » Image Index File Options in the main menu to access the "Image Index
Configuration” window.

(s HIPAA Claim Master - G4bit
File Forms Miew Search  ClsimEntry/Edit  DataBase CodeSets  Logs (| Image [l Setup  EDIExchange  Help

ﬁ .- % ‘J @ Image Wiewer

Image File Oplions —

Dutput Mode
1 Prirter

Index File {
o[ mage options |
1 | Creste Image Index Table

The "Image Index File Options” menu

You can define which fields to include and configure your database settings. Here are all
options:

Create Image Index

Check this option to create the image index. Select one of the following options to
specify the format:

e ASCII Text File — The image Index File is an ASCII text file that can be created
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together with claim images. It will contain tab-delimited fields and have one line
per claim.

In the "Text File with Image Files Path” field specify the output directory for image
index. Click "Browse" to select the destination place.

Note: The image index ASCII file currently works only when you save individual images for each claim.

Image Index Configuration

=] E3
I Create Image Index *_ASCH Text File
" Database Export
Text File with Image Files Paths
The Image Index File iz an ASCH texd file that can be created together with claim images. R wil
contain tab-delimied fislds and have one ine per claim.
Output Directory for Image Index
|I3 \id Browse
Save

The "ASCIl Text File" option

Then click "Save."

e Database Export — Select this option to save the image index through ODBC into
any database, independent of the database used for file downloads. The database

setup is similar to that of the claim data export. Specify the following database
connection parameters:

e Database Type

e Database Server Name or DSN
e Database
e Username

e Password

¢ Image Index Table Name
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[® 1mage Index Configuration

™ Create Image Index " ASCHText File
@m Export
~ Database Connection Parameters
Database Type Llsemame
IODEIC Connection j |
Data Source Mame Password
Imysql |
Database Image Index Table Name
I edi_B37imageindex
You can create
Test Connection Save Database Connection | the Image Index Table
(hrouigh a Seperate SCres;

The "Database Export” option

Once all database connection parameters have been specified, click "Test Connection” to
verify the connection.

[® 1mage Index Configuration ==k |

" ASCI Text File
* patabase Export

™ Create Image Index

— Database Connection Parameters

Database Type Llsemame

IODEIC Connection j |

Data Source Name Passwiord

[mysql |

Database Image Index Table Name

| edi_837imageindex

. Test Connection |} Save Database Connection | the Imane Index Table

—— through a seperate scree

The "Test Connection" button

The configuration is correct if you receive a message like this. Click "OK."

The success message

Then click "Save Database Connection.”
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@ Image Index Configuration

" ASCI Text File
* Database Export

I Create Image Index

— Database Connection Parameters -

Database Type Llsemame

|ODEIC Connection j |

Data Source Name Passwiord

|m1,r5ql I

Database Image Index Table Name

| edi_B37imageindex

You can create
Test Connection | Save Database Connection ] the Image Index Table

The "Save Database Connection” button

To create the image index table, click on the "You can create the Image Index Table
through a separate screen.” See Creating Image Index Table.

Selecting Fields to Be Included to the Image Index File

You can select the fields that get imported into the image index by selecting the check-
boxes in front of the field names.

i Fields to be included in Image Index File
Header
[l ECFilename -
[l emeserilenams
[ Craimida
[#] TradingParinesn
[] Receivelate
[ BiFrovD Test Field Configuration |
i [
[ BilPronFir=t
[ subseriberLast Save Field Configuration |
SubzcriberFist
[F] Subscriberiidde
[ SubscribenD
[ PatientLast T
[ PattientFirst
[ Patientiiddie
B patiertic
] PatientDOE
gi‘lﬂiwﬂ'iv ﬂ

| _Setectone | |
_tep_| __Close_|

The fields to be included in Image Index File
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Tip: As with the other field selectors, you can change the field names by clicking twice on them. This
is helpful if you have an existing database that you want to access with different names.

el Recerveliate
il oviD

[ EiliFs owFirst
[#] Subezcriberl ast

Changing the field names

For Database export, you can test the fields configuration by clicking on the "Test Field

Configuration” button.

- Fields to be included in Image Index File

Header
[¥] ECFilename
[#] mageFiename
[i#] Claimbio
[#] TradingParnenn
[#] Recenealate
[ BilProsdD
[ BaiPronLast
[#] BillProsFirst
[ subscriberLast
[#] SubzcriberFirst
[#] subscriberididde
(] SubzcribenD
[ PatientLast
[#] PatientFirst
[ Patientiidde
[#] Patierti
[#] PatientDoE
B3 Datird T

| _Setectone |

[ ]

Test Field Configuration I |

Save Field Configuration I

The "Test Field Configuration” button

You will receive a message like this. Click "OK."

H =

Setup checks okay!
(I )
~—

The success message

When ready, click on the "Save Field Configuration” button.
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~ Fields to be included in Image Index File
Header
[#] ECFiename —
[#] rnageFiename
[#] Craimiio
[#] TradingPartnesi
(A Recetvelate
[ BiProviD Test Field Configuration |
[ BaiPrond_ast
[+ BiiPronFirst
[ subscriberLast Save Field Configuration I |
[#] SubscriberFiest I
[#] subzcriberiddde
B SubscriberiD
[ PatientLast o
[#] PatientFirst
[ Patientiidde
[#] Patientin
PatientDOB
E L= = ﬂ

| Seloct Hon | |
e | __Glose_|

&

The "Save Field Configuration” button

Once all image index options have been defined and saved, click "Close."

4

The "Close" button

4.4 Creating Image Index Table

To create the table for the image index, follow the instructions below.

1. Select Image » Create Image Index Table in the main menu.

& HIPAA Claim Master - 64bit

File Forms View Search  ClaimEntry/Edit DataBase CodeSets Logs (| Image [)Setup EDIExchange  Help

f % — T, “ ‘:) @ ' Image Viewer

. - — Image File Options I
S Mode e e ; Image Index File Options
© : " frr [ Creske Tmage index Tatle

The "Create Image Index Table" menu

2. The following window will appear.
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:L‘J frmnCreatelmagelndexTable

— Database
* Microzoft SOL Server
 MySQLGeneric

Image Index Table script:

| CREATE TABLE [dbo).[edi_837imageindex]( -
2 [I0] [bigint] IDENTITY(1.1) NOT NULL,
3 [EDIFilename] [varchar]{100) MULL.
[ImageFilename] [varchar](100) NULL.

[ClaimMag] [warchar](35) NULL.
G [TradingPartnerlD] [char](15) NULL,
|Recevelate] [date] MULL.
8 [BillProvID] [varchar](80) NULL,
9 [BillProvLast] [varchar](55) MULL.

10 |[BillProvFirst] [varchar](35) MULL.

i1 [SubscriberdD] [varchar]{15) NULL,

12 [SubscriberLast] [varchar](55) NULL.
3 [SubscriberFirst] [varchar](35) NULL,

1

1 [SubscriberMiddie] [varchar](25) NULL,
15 [Patient| D] [varchar](15) NULL,

16 [PatientLast] [varchar](55) NULL,

17 [PatientFirst] [varchar]{35) NULL.

18 [PatientMiddle] [varchar]{25) MULL.

19 [PatientDOB] [varchar](50) MULL,

20 [FatientSex] [char](1) MULL. | |
21 [Amount] [decimal](10. 2) NULL,
2 [ServiceDateFrom)] [date] MULL.
23 [§er‘uiceDaleTn-]Jdate] MULL. =

Help | Save Execute Script |

4

The "Create Image Index Table" window
3. Select one of the necessary options:
* Microsoft SQL Server

e MySQL/Genetic

Note: We do not have table scripts for all databases. Most likely, only Microsoft SQL servers and
MySQL are supplied. And even here, different versions of the database behave differently. If you have
database expertise, please, modify the scripts accordingly. We invite you to submit improvements and
requests.

4. Then make sure the image index table script is correct.
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._".._-.: fronCreatelmageIndexTable

@ ;Micmwﬁ SQL Server

MySQL/Generic

Image Index Table script:

1 CREATE TABLE [dbo] [edi_837imageindex](

2 [ID] [bagint] IDEMTITY(1.1) NOT NULL,
[E DIFiI%n.ame] [varchar]{100) MULL.
[ImageFilename] [varchar]{100) NULL.
[ClaimMNo] [varchar](35) MULL.,
[TradingPartnerlD] [char](15) NULL,
|ReceiveDate] [date] MULL,
[BillPraviD] [varchar](80) NULL.
[BillProvLast] [varchar](55) NULL.
[BillProvFirst] [varchar](35) MULL.,
[SubscriberlD] [varchar](15) NULL.
[SubscriberLast] [varchar](55) NULL,
[SubscriberFirst] [varchar](35) MULL.
[SubscriberMiddle] [varchar](25) NULL,
[Patient|D] [warchar](15) MULL,
[PatientLast] [varchar](55) NULL,
[PatientFirst] [varchar]{35) NULL,
[PatientMiddle] [varchar](25) MULL.
[PatientDOB] [varchar](50) NULL,
[PatientSex] [char]({1) NULL.
[Amount] [decimal](10, 2) NULL,
[ServiceDateFrom) [date] MULL.
[ServiceDateTo] [date] MULL. |

Help | Save I Execute Sm‘ipll

The "Create Image Index Table" window with the "Microsoft SQL Server” option selected
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.i.._-.: fronCreatelmageIndexTable

— Database
" Microsoft SQL Server
@MyEQUGanaric

Image Index Table script:

1 CREATE TABLE "edi_837imageindex’(
2 *ID" bigint{20) NOT NULL AUTO_INCREMENT,
"EDIFilename” varchar{100) DEFAULT MULL,
‘ImageFilename’ varchar(100) DEFAULT NULL.
"ClaimMo’ varchar(35) DEFAULT NULL,
“TradingPartnerlD" char(15) DEFAULT NULL,
"ReceiveDate” date DEFAULT NULL,
"BillPrevlD” varchar{80) DEFAULT MULL.
"BillProvLast” varchar(55) DEFAULT NULL.
"BillProvFirst” varchar(35) DEFAULT NULL,
“SubscnberlD" varchar{15) DEFAULT NULL.
*SubscriberLast” varchar(55) DEFAULT MULL.
*SubscriberFirst” varchar(35) DEFAULT NULL.
4 *SubscriberMiddle’ varchar(25) DEFAULT MULL.
[15 ‘FatientlD” varchar(15) DEFALLT MULL.
[16 "PatientLast’ varchar(55) DEFALLT NULL,
[17 "PatientFirst” varchar(35) DEFAULT MULL,
s "PatientMiddle’ varchar(25) DEFAULT NULL.
[19 ‘PatientDOB" varchar(50) DEFAULT NULL,

0 "PatientSex” char(1) DEFAULT MULL,

L0 60 =) T LN fa L3 B

g p———p———
L P —

21 *Amount” decimal(10, 2) DEFALULT NULL.
22 "ServiceDateFrom” date DEFAULT NULL.,
23 ‘ServiceDateTo" date DEFAULT NULL.

-]

Help |

Save I Euemsmml

A

The "Create Image Index Table" window with the "MySQL/Generic" option selected

5. Click on the "Execute Script” button.
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[ frmCreatelmagelndexTable

~ Database
' Microzoft SOL Server
= MySQL/Generic

Image Index Table script:

| CREATE TABLE "edi_837imageindex’|
2 “ID" bigint(20) NOT NULL AUTO_INCREMENT,
3 "EDIFilename” varchar{100) DEFALULT MULL,
"ImageFilename’ varchar100) DEFALULT NULL,
‘ClaimMo” varchar(35) DEFAULT MULL,
“TradingPartnerlD™ char{15) DEFAULT NULL,
"ReceveDate’ date DEFAULT NULL.,
"BillProviD” varchar(80) DEFAULT MNULL.
"BillProvLast” varchar(55) DEFAULT NULL,
1 "BillProvFirst” varchan35) DEFAULT NULL,
11 “SubscnberlD” varchar(15) DEFAULT NULL,
12 *SubscriberLast” varchar(55) DEFAULT NULL.
13 *SubscriberFirst” varchar(35) DEFAULT NULL.
14 "SubscriberMiddle” varchar(25) DEFALULT NULL.,
15 "FatientiD” varchar(15) DEFALULT NULL.
16 "PatientLast” varchar(55) DEFALLT NULL,
17 "PatientFirst” varchar(35) DEFAULT NULL,
18 "PatientMiddle” varchan(25) DEFAULT NULL.
19 ‘PatientDOB" varchar(50) DEFAULT NULL,
20 "PatientSex” chan(1) DEFAULT MULL,
21 “Amount” decimal(10, 2) DEFAULT NULL.
. "ServiceDateFrom™ date DEFAULT NULL,
3 :%ewimDﬂteTn'Eﬂte DEFAULT MULL,

— WLTNULL

J T LN e

&0 -

=111

Save

=

1 .--E xecute Sr.'.ripl- ]'/

4

The "Execute Script” button
Then you will receive a notification like this. Click "OK."

Soccess

Table successfully oreated
o< D

The success message

6. Then click "Save."

Example

You can use the following MySQL/SQL script:

CREATE TABLE " edi _837i magei ndex" (
“ID bigint(20) NOT NULL AUTO_ | NCREMENT,
“EDI Fi | ename” varchar (100) DEFAULT NULL,
“I mageFi | ename”™ varchar (100) DEFAULT NULL,
“Clai mNo~ varchar (35) DEFAULT NULL,
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4.5

“Tradi ngPartnerI D char(15) DEFAULT NULL,
"Recei veDat e’ date DEFAULT NULL,
"Bill Provl D' varchar (80) DEFAULT NULL,
"Bill ProvLast ™ varchar(55) DEFAULT NULL,
“Bill ProvFirst® varchar(35) DEFAULT NULL,
" SubscriberlI D varchar (15) DEFAULT NULL,
" Subscri berlLast® varchar(55) DEFAULT NULL,
" SubscriberFirst® varchar(35) DEFAULT NULL,
" SubscriberM ddl e’ varchar(25) DEFAULT NULL,
“PatientI D varchar(15) DEFAULT NULL,
“PatientlLast® varchar(55) DEFAULT NULL,
“PatientFirst® varchar(35) DEFAULT NULL,
“PatientM ddl e’ varchar(25) DEFAULT NULL,
“Patient DOB” varchar (50) DEFAULT NULL,
“PatientSex® char(1) DEFAULT NULL,
" Amount ® deci mal (10, 2) DEFAULT NULL,
“Servi ceDat eFrom date DEFAULT NULL,
“ServiceDat eTo™ date DEFAULT NULL,
" Cl eari ngHousel D' varchar (100) DEFAULT NULL,
"OrigRef No© varchar(50) DEFAULT NULL,

UNI QUE KEY ID ('ID)

) ENGI NE=I nnoDB AUTO_| NCREMENT=6 DEFAULT CHARSET=l ati nl;

Tip: Make sure you use a correct symbol * and not ' in the script.

Tip: If you encounter errors running the script on MySQL or other database systems, then modify it
until it works or consult with your database administrator to make the modifications. SQL Scripts share
over all platforms a lot of syntax, but still each flavor demands its own adjustments.

Tip: If you encounter persistent errors with the script, we recommend working with the scripts within
the database environment. SQL Server Enterprise Manager or SQLyog, for example, have an SQL query
analyzer that helps you tweak the script until it runs.

Viewing Image Files

The HIPAA Claim Master has a built-in image viewer that uses light weight dlls to display
TIFF and PDF images. It also allows you to navigate through the folder structure that has
been set up.

Select Image » Image Viewer in the main menu to access the "Image Viewer" window.

© <2003> Martin Scholl Consulting, Inc.



Creating Image Files and PDFs 76

s HIPAA Claim Mastber - G4bit

File Forms View Search  Claim Entry/Edit  DataBase  Code Sets Lngs'( Image |)Setup EDIExchange  Help

5 | ke 0 - — =

: @ Lb — d et @ Image File Options -
Output Mode ———— Tt Image Index: File Options

Fh Prinker - Create Image Index Tabie

The "Image Viewer" menu

The following window will appear:

Image Viewer

) e
A B3TPCLM.tif HEALIRS HORPITAL OF AHTTCWN s
L 83TIPTST edi_1.pdf ANYTOWM, MO 31799 o i
=L B3TIPTST pdt piia N 2 LT e 1 HOME STREET —
= B37PCLM.pdt

RGN F RN e T T WM W
o T
SaaTe, TESS T

1 140ME STREET
HOBSE CITY, WD 13748

PAJE__| OF 4§ CREATION DATE  savawrmot T AT M

IV INTERMECLARY SERACES i EdTd ¥ L ] TR
{90 i

M ENTIIM

The "Image Viewer" window

The Viewer lets you navigate through multi-page documents with the navigation buttons
in the upper left corner of the image. You can adjust the display size according to your
monitor size or preferences in the upper right corner.

The left panel lists all generated TIFF and PDF files. Click a file name to display its
content.
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TIFF: Microsoft Windows has a Windows Photo Viewer that renders TIFF images.
Unfortunately, it is not that practical. It omits lines in lower magnification and makes
the image look sloppy, but is sufficient for most. There are much better TIFF viewers out
there but we will not make any recommendations.

PDF: PDF files can be opened with Acrobat_Reader by Adobe, which is available for free.
There are also other free PDF viewers and editors. We wil not make any
recommendations.
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5.1

Using the Database
Exporting the Data

The HIPAA Claim Master does not come with a database. But it can link to any ODBC- or
OleDB-compliant database. Database integration is a component of the HIPAA Claim
Master and can be licensed as add-in.

Most businesses that do HIPAA transactions have a database engine on their premises.
Microsoft SQL Server is probably the most widely used business database; Oracle or IBM
database also have broad acceptance. The open source and free database MySQL finds
more and more acceptance in the business world and is great for developers.

The HIPAA Claim Master uses two database tables for the claim information:
¢ a claim header table
¢ a claim detail table with the line item information.

Scripts are provided to create these tables for some database types. You might have to
modify the scripts to suit your actual taste of the SQL language.

Once these tables are created, claims from EDI files can be loaded into this database.
Your application can take the claim information from there and you can run your
business logic on these records. The HIPAA Claim Master can in turn read the database
record and re-create the claim image from the database. In the next implementation
you will even be able to create an 837 EDI file from those database records.

The HIPAA Claim Master lets you set up two connections, to a test and to a production
database. The deciding factor on which database is used is the ISA_15 data element of
the 837 file. This indicator is either a "P" for production or "T" for test. If you need only
one database, set up both connections identically.

(s HIPAA Claim Master - G4bit

File Forms Miew Search  ClsimEntryEdit | DataBase | CodeSebs Logs Image Setup  EDIExchange  Help
- @ "' Connection and Fields
- Claims in Database
Craabe SOL Tables

Dutput Mode a
1 Prirtar Code Look-up Table
© Sereen Create 837 EDI Files }

The "Data Base" menu

The sequence of actions to setup the data export is the following:
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e Setting up Database Connection

e Creating Tables

e Selecting Fields to Export

How to Save Data to the Database

The HIPAA Claim Master provides the "Data Import” option. You can import the claim
data to a database while printing or imaging claims (see Processing an Electronic Claim,
Printing Electronic Claims). In the "Screen” mode, the data import will does not work
since you can interrupt the viewing of EDI claims at any time and this might lead to
incomplete data import.

Notice: The image file will be created based on the pre-defined settings. Read more in

& HIPAA Claim Master - 32bi

File Forms Wiew  Search
= @

i Dutput Mode
™ Printes

" Scieen

" Image Fi=

. ¥ Data Impost

The "Data Import” check-box

The data is exported once the user clicks on the "Run” button. The data is written to the
database once the "Run” button has been clicked and only if the "Data Import" checkbox
is activated.

The "Processing Results” window will display notification about data export.

-loix]
File "837IPTST adi' processing started at 10/2472013 11:44:32 AM

Trading Partner ID; 987654

ClaimTvpe is |, Institutional

The file is marked Test'

Claim Records will be exported

25 claims were exported 1o a database

Number of Claims in File: 25

Mumber of Line iterns in File: 90

[t took 0 minutes, 6,158 seconds to process this file

The average ime was 0246 seconds perrecord
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The "Processing Results” window

Now you can browse exported data.

5.2  Setting up Database Connection

The HIPAA Claim Master relies on ODBC; or in the case of Microsoft SQL server on OleDB
to connect to a database.

Tip: If you use ODBC for the connection, you will need to set up the ODBC connection before using
HIPAA Claim Master with the database. Typically, ODBC connections are established in the Windows »
Control Panel ¥ Administrative Tools ¥ Data Sources (ODBC) setup screen. Setting up the ODBC
connection varies from database to database.

¢ 1 0DBC Data Source Administrabor 7 x|

User DS | System DSM | File DSN | Diivers | Tracing | Connection Pocling | About |

Llser Drata S ounces:
Name | Diives | [TAdd. J|
migsghprod MySOL ODBC 5.2 Unicode Divvet
mygsghtest  MySOL ODBC 5.2 Urscode Dirrver Bemoye |

An ODBC Uszer data source stores information about howve to connect to
the indicated data provader, A Ulser data souwce is only wisible bo pou,
and can only be used on the current machne.

[ ok | cance bk | Hee |

The "ODBC Data Source Administrator” screen in Windows

Select Data Base » Connection and Fields in the main menu.

s HIPARA Claim Master - 64bit

File Forms View Search  Claim Entry/Edt( | DataBase | Tode Ssts  Logs
B > = [ Camacin mdrc
: . - Claims in Database
0 Mode : Create SOL Tablas
| Soreen Creske 837 EDI Files

The "Connection and Fields" menu

2. You will be confronted with the following screen where you can set up the database
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[ Database Server Setup for OLE/ODBC Connection

— HIPAAsuite's Claim Extract Capabilities -
HIPAAsuite natively stores a Claim as a single Object.
HIPAAsuite can extract the claim data and write those into a
normalized Database such as Microsoft SOL Server or [BM
AS 400, Customizations are possible. Ask Vendor for details

Production Connection l Test Connection I

- Connection Properties
Database Type
[OD BC Connection EI
Data Source Name
|mysql-pr0ci
Test Connection |
Database
™ checked
Usermname
Pagsword
Claim Header Table Name
|EDI_CIa|ms
You can create the
Claim Detail Table Name Gt g
Al 1880

EDI_ClairmDetail

Save Connection Information |

—

Test Configuration |

[T Show selected Fields only

Save Field Configuration

Using the Database 82
=101 x|
1 [ Fields to be exported -
Header Detail
= [JFile Level Data a| = [service nformation -
OFilename [ CismiD (This: is Header Table's Key
Oversion O inehumiber
OirageFiename Ovine
OimaoeFieratn [ serviceDateFrom
O TradingPartnerDType O serviceDateTo
O TradingPartnent O azsessmentDate
O Tranzactionlate O FaciityCode
O transactionTime [ revenuecode
[ORecstveDate O ProcedureCode
O Subrmitt ertiame O amourt
O 5ubmitterio Oune
O submitterContact O cuantity
O subemitterTel O uritrste
O submitterTeExd [ noncovered
O] subsmitt erFac [ Piscectservice
[ Subenitt erEmai O wocditiert
[OReceiverhame O Maciifier2
OReceivero O Mecitiers
O TranzactionType (BHT_06) O modifier4
=[] Biting Provicier [ ProcedureDescription
OFedrax O oralCavityDesigration
Oeitravipl O cralCavityDesignation2
OsiFrovioType O craiCavityDesignation3
Osierovic O CraiCavityDesignations
OeieravLast O craiCavityDesignations
[OsierovFirst [ bisgPoirtert
O eitProvhicde [ isgPoirter2
O eierovsutfic [ DisgPointer3 -
[Oeieravspaciaky = Al |
Select Al ] Select Hone I Select Al I Select llone I

L
oy

The "Database Server Setup for OLE/ODBC Connection

On the left side of the screen, define the database connection properties.

There are two tabs:
¢ Production Connection
¢ Test Connection

Each tab has the following fields:

e Database Type - Select the type of the database from the drop-down menu: is
either ODBC or Microsoft SQL Server either with Windows Authentication or with

explicit credentials.

Note: If you need other types, please contact us for customizations.

e MS SQL Server

e MS SQL Server Integrated Security

e ODBC Connection

e ODBC Connection for Oracle
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e Database Server Name — Specify the database server name or DSN. In case of SQL
Server, it is the IP address or the name of the database server; for ODBC it is the
Data Source Name (DSN) that is defined through the ODBC setup in the Control
Panel of Windows.

e Database - Enter the database name under the above connection. Typically, this
field will be empty for ODBC setup.

e Username - Specify the user name that has privileges to the database. Typically,
this field will be empty for ODBC setup.

e Password - Specify user's password. Typically, this field will be empty for ODBC
setup.

¢ Claim Header Table Name - Enter the name that you give to your Claim header
table. The default name is suggested but can be changed.

¢ Claim Detail Table Name - Enter the name of the table that contains the line
information. A default name is suggested but can be changed.

We will configure the Test Connection and show the process on the screen-shots.
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_ﬁ Database Server Setup for OLE/DDBC Connection

— HIFAAsuite"s Claim Extract Capabilities

HIPAAsuite natively stores a Claim as a single Objact.
HIFA&suite can extract the claim data and write those into a
normalized Database such as Microsoft SQL Server or IEM
AS 400, Custornizations are possible. Ask ‘endar for details

Production Connection Test Connection |

— Connection Properties
Database Type

|0DEC Connection

Data Source Mame

g

Databasze

zemame

Password

Clairm Header Table Mame

|EDI_Claims

Claim Detail Table Mamea

|EDI_ClaimDetail

TwICu'mctionl

[ Checked

Save Connection Information

Help

The connection properties fields

84

To create tables in your database, click on the "You can create the tables through a
separate screen” link. For instructions, refer to Creating Tables.
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& patabase Server Setup for OLE/ODBC Connection

— HIPAAzuite’s Claim Extract Capabilities
HIPAAsuite natively stores a Claim as a single Objact.
HIFAAsuite can extract the claim data and write those into a
normalized Database such as Microsoft SQL Server or IEM
AS 400, Custornizations are possible. Ask ‘endar for details

Production Connection Test Connection |

— Connection Properties
Database Type
|0DEC Connection j

Data Source Mame

TwICu'mctionl

Databasze
[ Checked

Lsemame
Password
Clairm Header Table Mame
|EDI_Claims o —

[ You can create the
Claim Detail Table Name tablestwowghia
[EDI_ClaimDetail \gegerale screen

Save Connection Information |

Cancel I Help

A link to create tables

Once the connection parameters have been entered, click "Save Connection Information.”
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_ﬁ Database Server Setup for OLE/DDBC Connection

— HIPAAzuite’s Claim Extract Capabilities
HIPAAsuite natively stores a Claim as a single Objact.
HIFAAsuite can extract the claim data and write those into a
normalized Database such as Microsoft SQL Server or IEM
AS 400, Custornizations are possible. Ask ‘endar for details

Production Connection Test Connection |

— Connection Properties
Database Type
|0DEC Connection j

Data Source Mame

TwICu'mctionl

Databasze
[ Checked
Lsemame
Password
Clairm Header Table Mame
|EDI_Claims .
You can create the
Claim Detail Table Mame lables throtigh 2.
Seperate scieen

|EDI_ClaimDetail

| Save Connection Information

C
!

Cancel I Help

The "Save Connection Information” button

To verify if the entered parameters are correct, click on the "Test Connection” button.
You cannot export claims before this connection tests successfully.
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— HIFAAzuite's Claim Extract Capabilities
HIPAAsuite natively stores a Claim as a single Object.
HIPAAsuite can extract the claim data and write those into a
normalized Database such as Microsoft SAL Semver or IBM
AS 400, Customizations are possible. Ask “endor for details

Production Connection Test Connection |

— Connection Properties
Database Type
|DDEC Cannection j

Data Source Name

Database
[T Checked

Llzemame
Password
Claim Header Table Name
[EDI_Claims

Yioll can creata the
Claim Detail Table Name Lables U euiha.

seperate Screen

|EDI_ClaimDetail

Save Connection Information

Cancel I Healp

If the test has passed successfully, you will see the following notification:

The success message

Once the test has passed successfully, the "Checked" box becomes enabled.
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Production Connection Test Connection I

Connection Propeities
Database Type

|DDEFC Connection :J

Data Source Name
|m3.r5|:||-1est

The "Checked" checkbox

Database

|lzsemame

Once you have the database connection defined and tested, you can enter the table
names. See Selecting Fields to Export.

If you need to create the tables first, then see Creating Tables.

5.3 Creating Tables

Before Creating Tables...

The scripts that are supplied with the HIPAA Claim Master will generate every field that is
available for import. These are more than 260 fields in the claim header. You will not
need all these fields. You can edit the scripts to only use the fields that your adjudication
system requires. System performance will be better if you only select the needed fields.

Not all databases are supported. Most likely only Microsoft SQL server and MYSQL scripts
are supplied. And even here different versions of the database behave differently. If you
have database expertise, please modify the scripts accordingly. We invite you to submit
improvements and requests.

If you encounter persistent errors with the script, we recommend you to work with the
scripts within the database environment. SQL Server Enterprise Manager or SQLyog for
example have an SQL query analyzer that helps you tweak the scripts until they run.

Also, feel free to contact us if you have any problems.

How to Create Tables
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In order to facilitate the development, HIPAA Claim Master allows you to create the
staging tables for your database where HIPAA Claim Master will export the claim data.

Before data export, you need to create the tables through SQL table statements. You
can do it using the built-in function of the HIPAA Claim Master. Creating these tables is a
quite intimidating task. Once you have your connection defined and tested, follow the
instructions below.

Note: The tables are created via the "Drop Table" and "Create Table" commands. The scripts come
from two files: EDI _C ai ns. sql and EDI _d ai nDet ai | . sql that are distributed with the
application. Please, contact HIPAAsuite if you need help with the database setup.

1. Select the Data Base » Create SQL Table in the main menu.

".- HIPAA Claim Master - 64bit

File Forms View Search  Claim Entry/Edk | DataBase | Code Sets  Logs

; E > 5 Connection and Fields
: ~ | Clairns in Database
Dutput Mode |: Crashs SCI Tables
= Priker Code Look-up Table |

T Sereen iCreate 837 EOI Files |

The "Create SQL Table" menu

2. The following window will be displayed.

© <2003> Martin Scholl Consulting, Inc.



Using the Database

[ Create SQL Tables

— Database
& Microsoft SOL Server  Oracle
" MySQL/Generic

Claim Header Tables script:

|

90

Enwironment

% Live Database
" Test Database

1 CREATE TABLE [dba) [EDI_Claims)|
2 [ID] [bigint] IDENTITY(1.1) NOT NULL.
I"File Level Data”/
[Filename] [varchar](100) NULL.
[Version| [warchar](12) NULL,
ImageFilePath] [varchar](300) NULL,
ImageFilename] [varchar]{100) MULL.
[TradingPartnerdDType] [char](2) NULL.

Ll

5w 0 LT s

TransactionDate] [date] NULL.
TransactionDate] [time] MULL.,
[ReceneDate] [date] NULL.
SubmitterName] [varchar](60) NULL.
Submitter| D] [varchar](30) MULL.
SubmitterContact] [varchar](60) NULL.
SubmitterTel] [varchar](20) NULL,
SubmitterTelExt] [varchar]{10) NULL.

e

S B

(S -

i = T LN

Cialm Detail Table Script:

TradingParnerlD] [varchar](12) NOT MULL.

Save

1 CREATE TABLE [dba] [edi_ClaimDetail](

|1D] [bigi nia IDENTITY(1.1) NOT MULL,
ClaimlD] [bigint] NOT NULL,
[LineMumber] [decimall(18. () NULL,
[LinglD] [varchar]{S0) NULL.

[ServiceDateTa] [date] NULL.
[AssessmentDate] [date] NULL.

g [FacilityCode] [char](2) MULL.

10 [RevenueCode] [varchar](48) NULL.

11 [ProceduraCode| [varchar](48) NULL,

12 [Amiount] [money] NULL,

13 [Unit] [char](2) MULL.

14 [Quantity] [float] MULL.

15 [UnitHate] [money] MULL,

16 |NunCwmad] [mioney] NULL,

i Paid] [money] MULL,

i
6 [ServicaDateFrom| [datetime2](0) MULL.
7
9

=l

Save | Execute Sulptl

Help

Cancel |

4

|

The "Create SQL Tables" window
3. Define the following options:
Database

¢ Microsoft SQL Server
e MySQL/Genetic

¢ Oracle
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Environment
¢ Live Database
¢ Test Database

Scripts

On the following tabs there are SQL scripts used to create the appropriate tables:

e Claim Header Tables Script

e Claim Detail Table Script

Tip: You can modify the scripts so that they run on your specific database and to conform to your

database's specific SQL syntax. For each script, click "Save."
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[ Create SQL Tables HEE |
" Database Ervironment
& Microsoft SQL Server " Oracle @ Live Database
" MySQL/Generic " Test Database
Claim Header Tables script:
T CREATE TABLE [dbo) [EDI_Claims)| =]

[1D] [bagent] IDEMTITY(1.1) NOT NULL,
I"File Level Data®/

[Filename] [varchar](100) NULL.

[Version| [warchar](12) NULL,
ImageFilePath] [varchar](300) NULL,
ImageFilename] [varchar]{100) MULL.
[TradingPartnerdDType] [char](2) NULL.
TradingParnerlD] [varchar](12) NOT MULL.
10 TransactionDate] [date] NULL.

11 TransactionDate] [time] MULL.,

12 [ReceneDate] [date] NULL.

13 SubmitterName] [varchar](60) NULL.

14 Submitter| D] [varchar](30) MULL.

15 SubmitterContact] [varchar](60) NULL.

16 SubmitterTel] [varchar](20) NULL,

17 SubmitterTelExt] [varchar](10) NULL, |

Lad B3

5w 0 LT s

W

( Save T: Execute Script [

Cialm Detail Table Script:

1 CREATE TABLE [dbo] [edi_ClaimDetail]( N
|1D] [bigi nia IDENTITY{1,1) NOT MULL,
ClaimlD] [bigint] NOT NULL,

[LineMNumber] [decimal](18. 0) MULL.

[LinelD] [varchar]{50) MULL.

[ServicaDateFrom| [datetime2](0) MULL.

[ServiceDateTa] [date] NULL.

[AssessmentDate] [date] NULL.

[FacilityCode] [char](2) MULL.

10 [RevenueCode] [varchar](48) NULL.

11 [ProceduraCode| [varchar](48) NULL,

12 [Amiount] [money] NULL,

12 [Unit] [char](2) MULL.

14 [Quantity] [float] NULL,

15 [UnitHate] [money] MULL,

16 |NunCwmad] [mioney] NULL,

17 Paid] [money] MULL, j

Tl I R 0 - Y X

!

( Sawa_nl} Execute Script |

Help Cancel |

The "Save" button

4

For each script, click "Execute Script” to create the corresponding table in the database.

Warning: Executing the scripts will wipe out any previous tables that you created and you will loose all
data.
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[ Create SQL Tables

~ Databaze Envwironment
& Microsoft SOL Server  Oracle % Live Database
" MySQL/Generic " Test Database
Claim Header Tables seript:
T CREATE TABLE [dbo) [EDI_Claims)| B

[10] [bigint] IDENTITY(1.1) MOT MULL,
[*File Level Data®/

Lad B3

4 [Filename] [warchar](100) NULL.

5 [Version| [warchar](12) NULL,

b ImageFilePath] [varchar](300) NULL,

7 ImageFilename] [varchar]{100) NULL.

g [TradingPartnerdDType] [char](2) NULL.

9 TradingParnerlD] [varchar](12) NOT MULL.

10 TransactionDate] [date] NULL.

11 TransactionDate] [time] NULL.

12 [ReceneDate] [date] NULL.

13 SubmitterName] [varchar](60) NULL.

14 Submitter| D] [varchar](30) MULL.

15 SubmitterContact] [varchar](60) NULL.

16 SubmitterTel] [varchar](20) NULL,

17 SubmitterTelExt] [varchar](10) NULL, =

Save if Execute Suipt?)

Cialm Detail Table Script:

1 CREATE TABLE [dbo] [edi_ClaimDetail]( -
: |1D] ]bi%nia IDENTITY{1.1) NOT MULL.
] (bigint] NOT NULL,

Claim
4 [LineMNumber] [decimal](18. 0) MULL.
[LinglD] [varchar]{50) MULL.
& [ServicaDateFrom| [datetime2](0) MULL.
7 [ServiceDateTa] [date] NULL.
8 [AssessmentDate] [date] NULL.
) [FacilityCode] [char](2) NULL,
10 [RevenueCode] [varchar](48) NULL.
11 [ProceduraCode| [varchar](48) NULL,
12 [Amiount] [money] NULL,
13 [Unit] [char](2) MULL.
14 [Quantity] [float] NULL,
15 [UnitHate] [money] MULL,
16 NonCovered) [money] NULL,
' |Puid] [money] MULL, |

Save |:ir_Exawtn Sulpt_‘D

Help Cancel |£

The "Execute Script” button

Once the table has been created successfully, you will see the following notification:

Success S

Table successfully created

=

The success message
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5.3.1 Microsoft SQL Server Scriptto Create Tables

Header

CREATE TABLE [ dbo].[ED _d ai ns] (
[1D [bigint] IDENTITY(1,1) NOT NULL,
/*File Level Data*/
[Fil enane] [varchar] (100) NULL,
[ Version] [varchar](12) NULL,
[ mageFi | ePat h] [varchar] (300) NULL,
[ mageFi | enane] [varchar] (100) NULL,
[ Tradi ngPart ner | DType] [char](2) NULL,
[ Tradi ngPartner|I D] [varchar] (15) NOT NULL,
[ Transacti onDate] [date] NULL,
[ Recei veDate] [date] NULL,
[ Submi tterNane] [varchar](60) NULL,
[Submitterl D] [varchar](30) NULL,
[ SubmitterContact] [varchar](60) NULL,
[SubmitterTel] [varchar](20) NULL,
[ SubmitterTel Ext] [varchar] (10) NULL,
[ Submi tterFax] [varchar](20) NULL,
[SubmitterEmail] [varchar](80) NULL,
[ Recei ver Nane] [varchar] (60) NULL,
[ Receiver1 D] [varchar](30) NULL,
[ TransactionType] [char](2) NULL,
[*Billing Provider*/

[ FedTaxI D] [varchar] (15) NULL,

© <2003> Martin Scholl Consulting, Inc.



95

HIPAA Claim Master

[Bill Provl DType] [char](2) NULL,
[Bill ProviD] [varchar](80) NULL,

[Bill ProvNPI] [varchar](12) NULL,

[Bill ProvLast] [varchar](60) NULL,

[Bill ProvFirst] [varchar](35) NULL,

[Bill ProvM ddl e] [varchar](25) NULL,

[Bill ProvSuffix] [varchar](10) NULL,

[BillProvSpecialty] [varchar] (10) NULL,

[Bill ProvAddress] [varchar](55) NULL,

[Bill ProvAddress2] [varchar](55) NULL,

[Bill ProvGty] [varchar](30) NULL,

[Bill ProvState] [char](2) NULL,

[Bill ProvZi p] [varchar](15) NULL,

[Bill ProvCountry] [varchar](3) NULL,

[Bi Il ProvSubdivision] [varchar](3) NULL,

[Bill ProvContact] [varchar](60) NULL,

[Bill ProvTel] [varchar](80) NULL,

[Bill ProvTel Ext] [varchar](80) NULL,

[Bill ProvFax] [varchar](80) NULL,

[Bill ProvEmail] [varchar](80) NULL,

[Bill ProvQx herl DQual 1] [char] (2)
[Bill ProvQxherl D1] [varchar] (30)
[Bill ProvQx herl DQual 2] [char] (2)
[Bill ProvQxherl D2] [varchar] (30)
[Bill ProvQx herl DQual 3] [char] (2)

[Bill ProvQxherl D3] [varchar] (30)

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,
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[Bill ProvQx herl DQual 4] [char](2) NULL,
[Bill ProvQxherl D4] [varchar](30) NULL,
[Bill ProvQx herl DQual 5] [char](2) NULL,
[Bill ProvQxherl D5] [varchar](30) NULL,
/ *Pay-to Provider*/

[ PayToProvl DType] [char](2) NULL,

[ PayToProvl D] [varchar](30) NULL,

[ PayToProvTaxl D] [varchar](12) NULL,

[ PayToProvNPI ] [varchar](12) NULL,

[ PayToProvLast] [varchar](60) NULL,

[ PayToProvFirst] [varchar](35) NULL,

[ PayToProvM ddl e] [varchar](25) NULL,

[ PayToProvSuffix] [varchar](10) NULL,

[ PayToProvSpeci alty] [varchar] (10) NULL,

[ PayToProvAddr ess] [varchar](55) NULL,
[ PayToProvAddr ess2] [varchar] (55) NULL,
[ PayToProvCity] [varchar](30) NULL,

[ PayToProvState] [char](2) NULL,

[ PayToProvZi p] [varchar](15) NULL,

/ *Pay-to Payer*/

[ PayToPayer | DType] [char](2) NULL,

[ PayToPayer | D] [varchar] (80) NULL,

[ PayToPayer Taxl D] [varchar](12) NULL,
[ PayToPayer Last] [varchar](60) NULL,

[ PayToPayer First] [varchar](35) NULL,

[ PayToPayer M ddl e] [varchar](25) NULL,

96
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[ PayToPayer Suf fi x] [varchar] (10) NULL,

[ PayToPayer Address] [varchar] (55) NULL,
[ PayToPayer Addr ess2] [varchar] (55) NULL,
[ PayToPayer City] [varchar](30) NULL,

[ PayToPayer State] [char](2) NULL,

[ PayToPayer Zi p] [varchar] (15) NULL,

[ PayToPayer O herl DQual ] [char](2) NULL,
[ PayToPayer G her1 D] [varchar] (30) NULL,
/ *Subscri ber*/

[ Subscri berLast] [varchar](60) NULL,

[ SubscriberFirst] [varchar](35) NULL,

[ Subscri berM ddl e] [varchar](25) NULL,

[ Subscri ber Suffix] [varchar](10) NULL,

[ Subscri ber | DType] [char](2) NULL,

[ Subscriber1 D] [varchar](30) NULL,

[ Subscri ber Address] [varchar] (55) NULL,
[ Subscri ber Address2] [varchar] (55) NULL,
[ SubscriberCty] [varchar](30) NULL,

[ Subscri berState] [char](2) NULL,

[ Subscri berZip] [varchar](15) NULL,

[ Subscri ber Country] [varchar](3) NULL,

[ Subscri berLocation] [varchar] (30) NULL,
[ Subscri ber Subdi vi si on] [varchar] (3) NULL,
[ Subscri ber DOB] [varchar](10) NULL,

[ Subscri berSex] [char] (1) NULL,

[ Subscri berEthnicity] [varchar] (75) NULL,
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[ Subscri berMarital Status] [char] (1) NULL,
[ Subscri ber Col | ecti onMet hod] [varchar] (30) NULL,
[ Subscri ber SSN] [varchar] (12) NULL,

[ Subscri ber Agencyd ai mNo] [varchar] (50) NULL,
[ Subscri ber Menber 1 D] [varchar] (50) NULL,

[ Subscri ber Personal | D] [varchar] (50) NULL,
[ Subscri ber Contact] [varchar] (60) NULL,

[ Subscri berTel] [varchar](15) NULL,

[ Subscri ber Tel Ext] [varchar] (10) NULL,
/*Destination Payer*/

[ Payer Nane] [varchar] (60) NULL,

[ Payer | DType] [char](2) NULL,

[ Payer I D] [varchar](30) NULL,

[ Payer Addr ess] [varchar] (55) NULL,

[ Payer Addr ess2] [varchar](55) NULL,
[PayerGity] [varchar] (30) NULL,

[ Payer State] [char](2) NULL,

[ Payer Zi p] [varchar] (15) NULL,

[ Payer Responsi bility] [char] (1) NULL,

[ Payer & her | DQual 1] [char](2) NULL,

[ Payer & her1 D1] [varchar](30) NULL,

[ Payer & her | DQual 2] [char](2) NULL,

[ Payer & her1 D2] [varchar](30) NULL,

[ Payer & her | DQual 3] [char](2) NULL,

[ Payer @ her1 D3] [varchar](30) NULL,

[ G oupNo] [varchar](50) NULL,
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[ G oupNane] [varchar] (60) NULL,

[ nsuranceType] [char](2) NULL,

[Fili

[ OoBl

ngl ndicator] [char](2) NULL,

ndi cator] [char] (1) NULL,

/ *Responsi bl e*/

[ Responsi bl eLast] [varchar] (60) NULL,

[ Responsi bl eFirst] [varchar](35) NULL,

[ Responsi bl eM ddl e] [varchar] (25) NULL,
[ Responsi bl eSuf fix] [varchar] (10) NULL,
[ Responsi bl eAddress] [varchar] (55) NULL,

[ Responsi bl eAddress2] [varchar] (55) NULL,

[ Responsi bl eC ty] [varchar](30) NULL,

[ Responsi bl eState] [char](2) NULL,

[ Responsi bl eZi p] [varchar] (15) NULL,

[ Responsi bl el DType] [char](2) NULL,

[ Responsi bl el D] [varchar] (80) NULL,

/*Patient*/

[Pati
[Pati
[Pati
[Pati
[Pati
[Pati
[Pati
[Pati

[Pati

entLast] [varchar] (60) NULL,
entFirst] [varchar] (35) NULL,
entM ddl e] [varchar](25) NULL,
ent Suf fix] [varchar] (10) NULL,
ent Address] [varchar] (55) NULL,
ent Address2] [varchar] (55) NULL,
entdty] [varchar] (30) NULL,
entState] [char](2) NULL,

ent Zi p] [varchar](15) NULL,
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[ Pati ent Country] [varchar](3) NULL,
[Pati ent Locati on] [varchar](30) NULL,

[ Pati ent Subdi vi sion] [varchar](3) NULL,
[Patient| DType] [char](2) NULL,
[Patient1 D [varchar](30) NULL,
[Patient SSN] [varchar](12) NULL,

[ Pati ent Menber I D] [varchar] (50) NULL,

[ Pati ent Personal I D] [varchar] (50) NULL,
[ Pati ent I nsurancePol i cy] [varchar](50) NULL,
[ Pati ent DOB] [varchar](50) NULL,
[Patient Sex] [char] (1) NULL,
[PatientEthnicity] [varchar](75) NULL,
[PatientMarital Status] [char] (1) NULL,
[ Pati ent Col | ecti onMet hod] [varchar] (30) NULL,
[Pati ent Rel ati onshi p] [char](2) NULL,
[Pati ent Paid] [varchar](10) NULL,

[ Pregnancyl ndi cator] [char] (1) NULL,

/ *Rendering Provider*/

[ RendProvl DType] [char](2) NULL,

[ RendProvl D] [varchar](30) NULL,

[ RendProvNPI] [varchar](12) NULL,

[ RendProvTaxl D] [varchar](12) NULL,

[ RendProvLast] [varchar] (60) NULL,

[ RendProvFirst] [varchar](35) NULL,

[ RendProvM ddl e] [varchar](25) NULL,

[ RendProvSuffix] [varchar](10) NULL,
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[ RendProvSpeci al ty] [varchar] (10) NULL,

[ RendProvQ her I DQual 1] [char] (2) NULL,

[ RendProvQ her I D1] [varchar](30) NULL,

[ RendProvQ her I DQual 2] [char](2) NULL,

[ RendProvQ her I D2] [varchar](30) NULL,

[ RendProvQ her I DQual 3] [char](2) NULL,

[ RendProvQ her I D3] [varchar](30) NULL,
/*Attendi ng Provider*/

[ AttendProvLast] [varchar](60) NULL,
[AttendProvFirst] [varchar](35) NULL,
[AttendProvM ddl e] [varchar](25) NULL,
[AttendProvSuffix] [varchar](10) NULL,

[ Att endProvl DType] [char](2) NULL,
[AttendProvl D] [varchar](30) NULL,
[AttendProvTaxl D] [varchar](12) NULL,
[AttendProvNPl] [varchar](12) NULL,
[AttendProvQxherl DQual 1] [char] (2) NULL,
[AttendProvQ herlI D1] [varchar] (30) NULL,
[ AttendProvSpeci alty] [varchar] (10) NULL,
/*Qperating Provider*/

[ OperatingProvLast] [varchar] (60) NULL,

[ OperatingProvFirst] [varchar] (35) NULL,
[ OperatingProvM ddl e] [varchar] (25) NULL,
[ OperatingProvSuffix] [varchar] (10) NULL,
[ Operati ngProvl DType] [char](2) NULL,

[ OperatingProvl Dl [varchar](30) NULL,
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[ OperatingProvNPI] [varchar](12) NULL,

[ OperatingProvTaxl D] [varchar] (12) NULL,

[ OperatingProvQt herl DQual 1] [char] (2) NULL,
[ OperatingProvQ herl D1] [varchar] (30) NULL,
[ Operati ngProvSpeci alty] [varchar](10) NULL,
/*CQt her Provider*/

[ herProvLast] [varchar](60) NULL,
[&herProvFirst] [varchar](35) NULL,
[&herProvM ddl e] [varchar](25) NULL,

[C& herProvSuffix] [varchar](10) NULL,

[ @ her Provl DType] [char](2) NULL,
[CherProvli D] [varchar](30) NULL,

[@ herProvTaxl D] [varchar](12) NULL,

[ herProvNPlI] [varchar](12) NULL,

[@ herProvQxherl DQual 1] [char](2) NULL,

[ herProvQherl D1] [varchar] (30) NULL,

[ herProvSpecialty] [varchar] (50) NULL,
[*Facility*/

[FacilityType] [char](2) NULL,

[Facilityl DType] [char](2) NULL,

[Facilityl D] [varchar](80) NULL,
[FacilityNPI] [varchar](12) NULL,
[FacilityTaxl D] [varchar](12) NULL,
[FacilityQherl DQual 1] [char](2) NULL,
[FacilityQherI D1l] [varchar](30) NULL,

[FacilityNanme] [varchar](80) NULL,
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[FacilityAddress] [varchar](55) NULL,
[FacilityAddress2] [varchar](55) NULL,
[FacilityGty] [varchar](30) NULL,
[FacilitySpecialty] [varchar] (50) NULL,
[FacilityState] [char](2) NULL,
[FacilityZi p] [varchar](15) NULL,
/*Referring Provider*/

[ Ref ProvLast] [varchar] (60) NULL,

[ Ref ProvFirst] [varchar](35) NULL,

[ Ref ProvM ddl e] [varchar](25) NULL,

[ Ref ProvSuffix] [varchar](10) NULL,

[ Ref Provl DType] [char](2) NULL,

[ Ref Provi D] [varchar] (80) NULL,

[ Ref ProvTaxl D] [varchar](12) NULL,

[ Ref ProvNPI] [varchar](12) NULL,

[ Ref ProvQ her | DQual 1] [char] (2) NULL,
[ Ref ProvQ her I D1] [varchar](300) NULL,
[ Ref ProvSpeci al ty] [varchar](20) NULL,
/ *Super vi si ng Provi der*/

[ SupervProvLast] [varchar](60) NULL,

[ SupervProvFirst] [varchar](35) NULL,
[ SupervProvM ddl e] [varchar](25) NULL,
[ SupervProvSuffix] [varchar](10) NULL,
[ SupervProvl DType] [char](2) NULL,

[ SupervProvl D [varchar](30) NULL,

[ SupervProvTaxl D] [varchar](12) NULL,
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[ SupervProvNPl] [varchar](12) NULL,

[ SupervProvQx herl DQual 1] [char] (2) NULL,
[ SupervProvQx herI D1] [varchar] (50) NULL,
[ SupervProvSpeci alty] [varchar] (20) NULL,
/ *Assi st ant Sur geon*/

[ Assi st SurgLast] [varchar](60) NULL,
[AssistSurgFirst] [varchar](35) NULL,

[ Assi st SurgM ddl e] [varchar](25) NULL,

[ Assi st SurgSuffix] [varchar](10) NULL,

[ Assi st Sur gl DType] [char](2) NULL,

[ AssistSurgl D] [varchar](30) NULL,

[ Assi st SurgTaxl D] [varchar](12) NULL,

[ Assi st SurgNPl] [varchar](12) NULL,

[ Assi st SurgQx her I DQual 1] [varchar] (3) NULL,
[ Assi st SurgQherl D1] [varchar] (50) NULL,
[ Assi st SurgSpeci alty] [varchar] (10) NULL,
/ * Ambul ance Pi ck-up Locati on*/

[ Pi ckUpAddress] [varchar](55) NULL,

[ Pi ckUpAddr ess2] [varchar](55) NULL,

[Pi ckUpG ty] [varchar](30) NULL,

[ Pi ckUpState] [char](2) NULL,

[ Pi ckUpZi p] [varchar] (15) NULL,

/ * Anbul ance Drop-off Location*/

[ DropOf f Name] [varchar] (80) NULL,

[ DropOf f Address] [varchar] (55) NULL,

[ DropOf f Addr ess2] [varchar] (55) NULL,
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[DropOfGty] [varchar](30) NULL,
[DropOFfState] [char](2) NULL,
[DropOF fZip] [varchar] (15) NULL,

/*COB Payer 1*/

[@ herlnsuredLast] [varchar](60) NULL,

[&herlnsuredFirst] [varchar] (35) NULL,

[@ herlnsuredM ddl e] [varchar] (25) NULL,

[@ herlnsuredSuffix] [varchar] (10) NULL,

[ herlnsuredl DQual] [char](2) NULL,

[@herlnsuredl D] [varchar](30) NULL,

[ @ herl nsuredAddress] [varchar] (55) NULL,

[ @ herl nsuredAddress2] [varchar](55) NULL,

[@herlnsuredCty] [varchar](30) NULL,

[GherlnsuredState] [char](2) NULL,

[ @ herlnsuredZip] [varchar](15) NULL,

[ @ herlnsuredCountry] [varchar](3) NULL,

[ @ her | nsur edSubdi vi si on] [varchar](3) NULL,

[ @ herlnsuredPolicy] [varchar] (50) NULL,

[ @ herl nsuredDOB] [varchar](10) NULL,
[@ herlnsuredSex] [char] (1) NULL,

[ @ herl nsuredRel ati onshi p] [char](2)
[ @ herl nsuredQ herl DQual 1] [char] (3)
[ @ herlnsuredC herl D1] [varchar] (50)
[ @ herl nsuredQ herl DQual 2] [char] (3)
[ @ herl nsuredC herl D2] [varchar](50)

[ @ herl nsuredQ herl DQual 3] [char] (3)

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,
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[ herlnsuredC herl D3] [varchar] (50) NULL,

[ & her Payer Responsi bility] [char] (1) NULL,

[ @ her Payer Nane] [varchar](35) NULL,

[ @ herPayer| DQual] [char](2) NULL,

[ @ herPayerI D] [varchar](30) NULL,

[ & her Payer Address1] [varchar] (55) NULL,

[ & her Payer Addr ess2] [varchar] (55) NULL,

[ herPayerCity] [varchar](30) NULL,

[ her Payer State] [char](2) NULL,

[ & her Payer Zi p] [varchar](15) NULL,

[ @ her Payer Pai d] [varchar] (10) NULL,

[ @ her Payer G oupNane] [varchar] (60) NULL,

[ @ her Payer GroupNo] [varchar] (50) NULL,

[ @ her Payer | nsuranceType] [char](2) NULL,

[ herPayerFilinglndicator] [char](2) NULL,

[ @& her Payer Adj ust nent ReasonG oup] [varchar] (20) NULL,
[ @ her Payer Adj ust nent Reason] [varchar] (50) NULL,
[ @ her Payer Adj ust nent Arount] [varchar] (120) NULL,
[ & her Payer Pai dDat e] [date] NULL,

[ @ her Payer | nf oRel ease] [char] (1) NULL,

[ @ her Payer Benefi t Assign] [char] (1) NULL,

[ @& her Payer DocControl No] [varchar](50) NULL,

[ @ her Payer Prior Auth] [varchar] (50) NULL,

[ @ her Payer O herl DQual 1] [char] (3) NULL,

[ & her Payer &t herI D1] [varchar] (50) NULL,

[ @ her Payer O herl DQual 2] [char] (3) NULL,
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[ & her Payer &t herl D2] [varchar] (50) NULL,

[/ *C0OB Payer 2*/

[@ herlnsured2Last] [varchar] (60) NULL,

[ herlnsured2First] [varchar] (35) NULL,

[ @ herl nsured2M ddl e] [varchar] (25) NULL,

[@ herlnsured2Suffix] [varchar] (10) NULL,

[@ herlnsured2l DQual] [char](2) NULL,

[@ herlnsured2l D] [varchar](30) NULL,

[ @ her | nsured2Address] [varchar](55) NULL,

[ @ herl nsured2Address2] [varchar](55) NULL,

[@herlnsured2CG ty] [varchar] (30) NULL,

[ herlnsured2State] [char](2) NULL,

[ @ herl nsured2Zi p] [varchar](15) NULL,

[ @ herlnsured2Country] [varchar](3) NULL,

[ @ her | nsured2Subdi vi si on] [varchar](3) NULL,

[ @ herl nsured2Pol icy] [varchar] (50) NULL,

[ @ herl nsured2DOB] [varchar](10) NULL,
[ @ herlnsured2Sex] [char] (1) NULL,

[ @ herl nsured2Rel ati onshi p] [char](2)
[ @ herl nsured2C her | DQual 1] [char] (3)
[ @ herlnsured2C her |1 D1] [varchar] (50)
[ @ herl nsured2C her | DQual 2] [char] (3)
[ @ herlnsured2C her 1 D2] [varchar] (50)
[ @ herl nsured2C her | DQual 3] [char] (3)
[@ herl nsured2C her 1 D3] [varchar] (50)

[ @& her Payer 2Responsi bility] [char] (1)

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,
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[ & her Payer 2Nane] [varchar](35) NULL,

[ & her Payer 21 DQual ] [char](2) NULL,

[ & her Payer 21 D] [varchar](80) NULL,

[ @ her Payer 2Addr ess1] [varchar] (55) NULL,

[ @& her Payer 2Addr ess2] [varchar] (55) NULL,

[ @ her Payer2C ty] [varchar](30) NULL,

[ @ her Payer2State] [char](2) NULL,

[ & her Payer 2Zi p] [varchar] (15) NULL,

[ @& her Payer 2Pai d] [varchar] (10) NULL,

[ @& her Payer 2Gr oupNane] [varchar] (60) NULL,

[ & her Payer 2Gr oupNo] [varchar] (50) NULL,

[ @& her Payer 2l nsuranceType] [char](2) NULL,

[ @ her Payer 2Fi | i ngl ndi cator] [char](2) NULL,

[ @& her Payer 2Adj ust nent ReasonG oup] [char] (20) NULL,
[ @ her Payer 2Adj ust nent Reason] [varchar] (50) NULL,
[ @ her Payer 2Adj ust nent Arount] [varchar] (120) NULL,
[ @ her Payer 2Pai dDat e] [date] NULL,

[ @ her Payer 2l nf oRel ease] [char] (1) NULL,

[ @ her Payer 2Benefit Assign] [char] (1) NULL,

[ @& her Payer 2DocCont rol No] [varchar] (50) NULL,

[ @ her Payer 2Pri or Aut h] [varchar] (50) NULL,

[ @ her Payer 2C her I DQual 1] [char] (3) NULL,

[ @ her Payer 2 her 1 D1] [varchar] (50) NULL,

[ @ her Payer 2C her 1 DQual 2] [char] (3) NULL,

[ @ her Payer 2 her1 D2] [varchar] (50) NULL,

/*d ai m Dat a*/
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[ ai mMNo] [varchar] (50) NOT NULL,

[ Amount] [noney] NULL,

[ Esti mat edAnount Due] [ noney] NULL,

[ Pati ent Esti nat edAnount Due] [noney] NULL,
[Pl aceCr Service] [char](2) NULL,

[ A ai nFrequency] [char] (1) NULL,

[ Submi t Reason] [char] (1) NULL,

[ ProviderSignature] [char] (1) NULL,

[ Provi der Accept sAssi gnnent] [char] (1) NULL,
[ BenefitAssignment] [char] (1) NULL,

[ 1 nf oRel easeCode] [char] (1) NULL,

[ Pati ent Si gnat ureCode] [char] (1) NULL,
[ Rel at edCauses] [char](2) NULL,

[ Rel at edCauses2] [char](2) NULL,

[ Rel at edCausesState] [char](2) NULL,

[ Speci al ProgranCode] [char](3) NULL,

[ ProviderParticipation] [char] (1) NULL,
[ ECBI ndicator] [char] (1) NULL,

[ Del ayReasonCode] [char](2) NULL,

[ Servi ceDateFron] [date] NULL,

[ Servi ceDat eTo] [date] NULL,
[OnsetDate] [date] NULL,
[SimlarSynptonmsDate] [date] NULL,
[DisabilityBegin] [date] NULL,
[DisabilityEnd] [date] NULL,

[Hospitalizati onBegin] [date] NULL,
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[Hospitalizati onEnd] [date] NULL,

[AccidentDate] [date] NULL,

[ Last Menstrual Period] [date] NULL,

[ Repri cer Recei vedDat e] [date] NULL,

[ Adm ssionDate] [date] NULL,

[ Adm ssionHour] [tinme] (7) NULL,

[ Adm ssionType] [char] (1) NULL,

[ Adm ssionSource] [char] (1) NULL,

[Di schargeHour] [tinme] (7) NULL,

[PatientStatus] [char](2) NULL,

[ Cover edDays] [varchar](4) NULL,

[ NonCover edDays] [varchar](4) NULL,

[ COBDays] [varchar] (4) NULL,

[ Li f eTi neReserveDays] [varchar] (4) NULL,
[PriorAuthorization] [varchar](50) NULL,

[ O earingHousel D] [varchar](50) NULL,

[ Medi cal Recor dNunber] [varchar] (50) NULL,

[ Mot her sMedi cal Recor dNunber] [varchar] (50) NULL,
[ Servi ceAut hori zati onException] [varchar](50) NULL,
[ Ref erral Nunber] [varchar](50) NULL,

[ Payer d ai nCont r ol Nunber] [varchar] (50) NULL,

[ Adj ust edRepri cedd ai mNunber] [varchar] (50) NULL,
[ Aut oAcci dent State] [varchar] (50) NULL,

[OigRef No] [varchar] (50) NULL,

[ ai nMType] [char] (1) NULL,

[ TypeOFBill] [varchar](20) NULL,
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[ Remar k1] [varchar](90) NULL,

[ Remar k2] [varchar](90) NULL,

[ Remar k3] [varchar] (90) NULL,

[ Remar k4] [varchar] (90) NULL,

[ K3_1] [varchar](80) NULL,

[ K3_2] [varchar](80) NULL,

[ K3_3] [varchar](80) NULL,

[ K3_4] [varchar](80) NULL,

[ K3_5] [varchar](80) NULL,

[ K3_6] [varchar](80) NULL,

[ K3_7] [varchar](80) NULL,

[ K3_8] [varchar](80) NULL,

[ K3_9] [varchar](80) NULL,

[ K3_10] [varchar](80) NULL,

[ Qut sideLab] [char] (1) NULL,

[ LabCharge] [varchar] (10) NULL,

[ Test _Prod] [char] (1) NULL,

[ Report TypeCodel] [char](2) NULL,

[ Report Transm ssi onCodel] [varchar](2) NULL,
[ Att achnent Cont r ol Nunber 1] [varchar](80) NULL,
/*Dental O ainms*/

[Predeterm nation] [char](2) NULL,
[OrthodonticTotal] [varchar](5) NULL,

[ Orthodonti cRemai ni ng] [varchar] (5) NULL,
[OthodonticYesNo] [char] (1) NULL,

[ Toot hStatus] [varchar](100) NULL,
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[ Appl i ancePl acenent Date] [date] NULL,
/*Di agnosi s | nformation*/

[ Adm t Di agnosi s] [varchar] (10) NULL,
[ ECode] [varchar](30) NULL,

[ ECode2] [varchar](30) NULL,

[ ECode3] [varchar](30) NULL,

[ ECoded] [varchar](30) NULL,

[ ECode5] [varchar](30) NULL,

[ ECode6] [varchar](30) NULL,

[ ECode7] [varchar](30) NULL,

[ ECode8] [varchar](30) NULL,

--[ ECode9] [varchar](30) NULL,

--[ ECodel0] [varchar](30) NULL,

--[ ECodell] [varchar](30) NULL,

--[ ECodel2] [varchar](30) NULL,

[ ReasonFor Visit] [varchar](30) NULL,
[ ReasonFor Visit2] [varchar](30) NULL,
[ ReasonFor Visit3] [varchar](30) NULL,
[ Principal D agnosis] [varchar] (10) NULL,
[Diag2] [varchar](10) NULL,

[Di ag3] [varchar](10) NULL,

[ D ag4] [varchar](10) NULL,

[ D ag5] [varchar](10) NULL,

[Di ag6] [varchar](10) NULL,

[Diag7] [varchar](10) NULL,

[Diag8] [varchar](10) NULL,
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[Diag9] [varchar](10) NULL,

[ D agl0]
[ D agll]
[ D agl2]
[ D agl3]
[ D agl4]
[ D agl5]
[ D agl6]
[ D agl7]
[ D agl8]
[ D agl9]
[ D ag20]
[ D ag21]
[ D ag22]
[ D ag23]
[ D ag24]

[ D ag25]

[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)
[ varchar] (10)

[ varchar] (10)

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

[DRG [varchar](15) NULL,

/ *Procedure | nformation*/

[ Principal Procedure] [varchar] (10) NULL,

[ Principal ProcedureDate] [datetine2](0) NULL,

[Proc2] [varchar](50) NULL,

[Proc2Date] [datetinme2] (0) NULL,

[Proc3] [varchar](10) NULL,

[Proc3Date] [datetinme2] (0) NULL,

[ Proc4] [varchar](10) NULL,
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[Proc4Date] [datetinme2] (0) NULL,
[ Proc5] [varchar](10) NULL,
[Proc5Date] [datetinme2] (0) NULL,
[Proc6] [varchar](10) NULL,
[Proc6Date] [datetinme2] (0) NULL,
[Proc7] [varchar](10) NULL,
[Proc7Date] [datetinme2] (0) NULL,
[Proc8] [varchar](10) NULL,
[Proc8Date] [datetinme2] (0) NULL,
[Proc9] [varchar](10) NULL,
[Proc9Date] [datetinme2] (0) NULL,
[Procl10] [varchar](10) NULL,
[ProclODate] [datetinme2](0) NULL,
[Procll] [varchar](10) NULL,
[ProcllDate] [datetinme2](0) NULL,
[Proc12] [varchar](10) NULL,
[Procl2Date] [datetinme2](0) NULL,
[Procl3] [varchar](10) NULL,
[Procl3Date] [datetinme2](0) NULL,
[Procl14] [varchar](10) NULL,
[Procl4Date] [datetinme2](0) NULL,
[Procl5] [varchar](10) NULL,
[Procl5Date] [datetinme2](0) NULL,
[Procl6] [varchar](10) NULL,
[Procl6Date] [datetinme2](0) NULL,

[Procl7] [varchar](10) NULL,
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[Procl7Date] [datetine2](0)
[Proc18] [varchar](10) NULL,
[ Procl8Date] [datetine2](0)
[Proc19] [varchar](10) NULL,
[Procl9Dat e] [datetine2](0)
[ Proc20] [varchar](10) NULL,
[ Proc20Dat e] [datetine2](0)
[Proc21] [varchar](10) NULL,
[Proc2lDate] [datetine2](0)
[ Proc22] [varchar](10) NULL,
[ Proc22Dat e] [datetine2](0)
[ Proc23] [varchar](10) NULL,
[ Proc23Date] [datetine2](0)
[ Proc24] [varchar](10) NULL,
[ Proc24Date] [dateti ne2] (0)
[ Proc25] [varchar](10) NULL,
[ Proc25Dat e] [datetine2] (0)
[ *Val ue Codes*/

[ Val ueCodel] [char](3) NULL
[ Val ueAnount 1] [varchar] (10)
[ Val ueCode2] [char](3) NULL
[ Val ueAnount 2] [varchar] (10)
[ Val ueCode3] [char](3) NULL
[ Val ueAnount 3] [varchar] (10)
[ Val ueCode4] [char](3) NULL

[ Val ueAnount 4] [varchar] (10)

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,
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[ Val ueCode5] [char] (3) NULL,

[ Val ueAnount 5] [varchar] (10) NULL,
[ Val ueCode6] [char](3) NULL,

[ Val ueAnount 6] [varchar] (10) NULL,
[ Val ueCode7] [varchar](10) NULL,

[ Val ueAnount 7] [varchar] (10) NULL,
[ Val ueCode8] [char](3) NULL,

[ Val ueAnount 8] [varchar] (10) NULL,
[ Val ueCode9] [char](3) NULL,

[ Val ueAnmount 9] [varchar] (10) NULL,
[ Val ueCodel0] [char](3) NULL,

[ Val ueAnount 10] [varchar] (10) NULL,
[ Val ueCodell] [char](3) NULL,

[ Val ueAnount 11] [varchar] (10) NULL,
[ Val ueCodel2] [char](3) NULL,

[ Val ueAnount 12] [varchar] (10) NULL,

--[ Val ueCodel3] [char](3) NULL,

--[ Val ueAmount 13] [varchar] (10) NULL,

--[ Val ueCodel4] [char](3) NULL,

--[ Val ueAmount 14] [varchar] (10) NULL,

--[ Val ueCodel5] [char](3) NULL,

--[ Val ueAount 15] [varchar] (10) NULL,

--[ Val ueCodel6] [char](3) NULL,

--[ Val ueAmount 16] [varchar] (10) NULL,

--[ Val ueCodel7] [char](3) NULL,

--[ Val ueAmount 17] [varchar] (10) NULL,

116

© <2003> Martin Scholl Consulting, Inc.




117 HIPAA Claim Master

--[ Val ueCodel8] [char](3) NULL,

--[ Val ueAmount 18] [varchar] (10) NULL,
--[ Val ueCodel9] [char](3) NULL,

--[ Val ueAmount 19] [varchar] (10) NULL,
--[ Val ueCode20] [char](3) NULL,

--[ Val ueAmount 20] [varchar] (10) NULL,
--[ Val ueCode21] [char](3) NULL,

--[ Val ueAmount 21] [varchar] (10) NULL,
--[ Val ueCode22] [char](3) NULL,

--[ Val ueAmount 22] [varchar] (10) NULL,
--[ Val ueCode23] [char](3) NULL,

--[ Val ueAmount 23] [varchar] (10) NULL,
--[ Val ueCode24] [char](3) NULL,

--[ Val ueAmount 24] [varchar] (10) NULL,
/*Condi ti on Codes*/

[ Condi ti onCodel] [varchar](30) NULL,
[ Condi ti onCode2] [varchar](30) NULL,
[ Condi ti onCode3] [varchar](30) NULL,
[ Condi ti onCode4] [varchar](30) NULL,
[ Condi ti onCode5] [varchar](30) NULL,
[ Condi ti onCode6] [varchar](30) NULL,
[ Condi ti onCode7] [varchar](30) NULL,
[ Condi ti onCode8] [varchar](30) NULL,
[ Condi ti onCode9] [varchar](30) NULL,
[ Condi ti onCodel0] [varchar](30) NULL,

--[ Condi ti onCodell] [varchar](30) NULL,
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--[ Condi ti onCodel2] [varchar] (30)

--[ Condi ti onCodel3] [varchar] (30)

--[ Condi ti onCodel4] [varchar] (30)

--[ Condi ti onCodel5] [varchar] (30)

--[ Condi ti onCodel6] [varchar] (30)

--[ Condi ti onCodel7] [varchar] (30)

--[ Condi ti onCodel8] [varchar] (30)

--[ Condi ti onCodel9] [varchar] (30)

--[ Condi ti onCode20] [varchar] (30)

--[ Condi ti onCode21] [varchar] (30)

--[ Condi ti onCode22] [varchar] (30)

--[ Condi ti onCode23] [varchar] (30)

--[ Condi ti onCode24] [varchar] (30)

/*Cccurrence Codes*/

[ GccurranceCodel]
[ CccurranceDat el]
[ GccurranceCode2]
[ CccurranceDat e2]
[ GccurranceCode3]
[ CccurranceDat e3]
[ Cccur ranceCode4]
[ Cceur ranceDat e4]
[ GccurranceCodeb5]
[ CccurranceDat e5]
[ GccurranceCode6]

[ CccurranceDat e6]

[char] (3) NULL,
[date] NULL,
[char] (3) NULL,
[date] NULL,
[char] (3) NULL,
[date] NULL,
[char] (3) NULL,
[date] NULL,
[char] (3) NULL,
[date] NULL,
[char] (3) NULL,

[date] NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,
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[ CccurranceCode7] [char](3) NULL,

[ CccurranceDat e7] [date] NULL,

[ CccurranceCode8] [char](3) NULL,

[ CccurranceDat e8] [date] NULL,

--[ CccurranceCode9] [char](3) NULL,

--[ CccurranceDat €9] [date] NULL,

--[ Gcecur ranceCodel0]
--[ GcecurranceDat e10]
--[ GcecurranceCodell]
--[ GcecurranceDat ell]
--[ GcecurranceCodel2]
--[ GcecurranceDat e12]
--[ GceurranceCodel3]
--[ GcecurranceDat e13]
--[ GcecurranceCodel4]
--[ GcecurranceDat el14]
--[ GcecurranceCodel5]
--[ GcecurranceDat e15]
--[ GcecurranceCodel6]
--[ GcecurranceDat e16]
--[ GceurranceCodel7]
--[ GcecurranceDat el17]
--[ Gcecur ranceCodel8]
--[ GcecurranceDat 18]
--[ GceurranceCodel9]

--[ CccurranceDat e19]

[char] (3) NULL,

[date] NULL,

[char] (3) NULL,

[date] NULL,

[char] (3) NULL,

[date] NULL,

[char] (3) NULL,

[date] NULL,

[char] (3) NULL,

[date] NULL,

[char] (3) NULL,

[date] NULL,

[char] (3) NULL,

[date] NULL,

[char] (3) NULL,

[date] NULL,

[char] (3) NULL,

[date] NULL,

[char] (3) NULL,

[date] NULL,
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--[ CccurranceCode20] [char](3) NULL,
--[ CccurranceDat e20] [date] NULL,
--[ CccurranceCode21] [char](3) NULL,
--[ CccurranceDat e21] [date] NULL,
--[ CccurranceCode22] [char](3) NULL,
--[ CccurranceDat e22] [date] NULL,
--[ CccurranceCode23] [char](3) NULL,
--[ CccurranceDat e23] [date] NULL,
--[ CccurranceCode24] [char](3) NULL,
--[ CccurranceDat e24] [date] NULL,

[ GccurranceSpanCodel] [char](3) NULL,
[ GccurranceSpanFroni] [date] NULL,

[ CccurranceSpanTol] [date] NULL,

[ GccurranceSpanCode2] [char] (3) NULL,
[ GccurranceSpanFronR] [date] NULL,

[ CccurranceSpanTo2] [date] NULL,

[ GccurranceSpanCode3] [char] (3) NULL,
[ GccurranceSpanFronB8] [date] NULL,

[ CccurranceSpanTo3] [date] NULL,

[ GccurranceSpanCode4] [char](3) NULL,
[ GccurranceSpanFrond] [date] NULL,

[ CccurranceSpanTo4] [date] NULL,
/*CR1*/

[ Pati ent Wei ght] [varchar] (10) NULL,

[ Ambul anceTr ansport Code] [char] (1) NULL,

[ Ambul anceTr ansport ReasonCode] [char] (1) NULL,
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[ Transport D stance] [varchar] (15) NULL,

[ RoundTri pPur poseDescription] [varchar] (80) NULL,
[ Stretcher PurposeDescription] [varchar] (80) NULL,
/* CRC —Anbul ance Certification */

[ Ambul anceCondi tionlndi cator] [char] (1) NULL,
[ Ambul anceCondi ti onCodel] [char](3) NULL,

[ Ambul anceCondi ti onCode2] [char](3) NULL,

[ Ambul anceCondi ti onCode3] [char](3) NULL,

[ Ambul anceCondi ti onCode4] [char](3) NULL,

[ Ambul anceCondi ti onCode5] [char](3) NULL,

/ *Repri ci ng*/

[ Repri cedd ai mNunber] [varchar] (50) NULL,

[ Repri ci ngMet hodol ogy] [varchar] (3) NULL,

[ Repri cedAnmount] [noney] NULL,

[ Savi ngsAnount] [ noney] NULL,

[Repricerl D [varchar](30) NULL,

[ RepricingRate] [varchar](9) NULL,

[ APG Code] [varchar] (30) NULL,

[ APG Anount] [noney] NULL,

[ Appr ovedRevenueCode] [varchar] (48) NULL,

[ Appr ovedPr ocedur eCode] [varchar] (48) NULL,
[ Appr ovedUni t Code] [char](2) NULL,

[ ApprovedUni ts] [bigint] NULL,

[ Rej ect Reason] [varchar] (3) NULL,

[ Conpl i anceCode] [varchar](2) NULL,

[ ExceptionCode] [varchar](2) NULL
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/*SQL To EDI*/
--,[dainmAction] [char] (1) NULL,

--[Error Message] [varchar](1000) NULL

) ON [ PRI MARY]

Detail

CREATE TABLE [dbo].[edi O ai nDetail](
[1D] [bigint] IDENTITY(1, 1) NOT NULL,
[CaimM D [bigint] NOT NULL,
[ Li neNunber] [decimal] (18, 0) NULL,
[Linel D] [varchar](50) NULL,
[ Servi ceDat eFrom [datetime2] (0) NULL,
[ Servi ceDat eTo] [date] NULL,
[ Assessnent Date] [date] NULL,
[FacilityCode] [char](2) NULL,
[ RevenueCode] [varchar] (48) NULL,
[ Procedur eCode] [varchar] (48) NULL,
[ Amount] [rmoney] NULL,
[Unit] [char](2) NULL,
[Quantity] [float] NULL,
[UnitRate] [rnoney] NULL,
[ NonCover ed] [noney] NULL,
[Pai d] [noney] NULL,
[ Placett Service] [char](3) NULL,
[ Modi fierl] [char](3) NULL,

[ Modi fier2] [char](3) NULL,
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[Modifier3] [char](3) NULL,

[Modifierd] [char](3) NULL,

[ ProcedureDescription] [varchar](80) NULL,

[ Oral CavityDesi gnationl] [char](3) NULL,

[ Oral Cavi tyDesi gnati on2]

[ Oral Cavi tyDesi gnati on3]

[ Oral Cavi t yDesi gnati on4]

[ Oral Cavi t yDesi gnati on5]

[Di agPointerl] [char] (1)

[Di agPointer2] [char](1)

[ D agPointer3] [char] (1)

[ D agPoi nterd4] [char] (1)

[char](3)
[char](3)
[char](3)
[char](3)
NULL,
NULL,
NULL,

NULL,

[ Toot hNunber] [char] (2) NULL,

[ Surface] [varchar](10) NULL,

NULL,

NULL,

NULL,

NULL,

[ Emer gencyl ndi cator] [char] (1) NULL,

[ Servi ceTax] [nmoney] NULL,

[FacilityTax] [nmoney] NULL,

[ Sal esTax] [noney] NULL,

[ Appr ovedAnount] [noney] NULL,

[Li

[Li

[Li

[Li

[Li

[Li

[Li

nekK3_01]
nek3_02]
nekK3_ 03]
nekK3_04]
nekK3_05]
nekK3_06]

nekK3_07]

[ varchar] (80)
[ varchar] (80)
[ varchar] (80)
[ varchar] (80)
[ varchar] (80)
[ varchar] (80)

[ varchar] (80)

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,
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[Li neK3_08] [varchar](80) NULL,

[Li neK3_09] [varchar](80) NULL,

[Li neK3_10] [varchar](80) NULL,

[ Remar k] [varchar](100) NULL,

[ Ambul ancePati ent Count] [bigint] NULL,

[ %k xx PYKHF ** % |

[ Report Type] [char] (2) NULL,

[ Report Transm ssion] [char](2) NULL,

[ Att achnent Control Nunber] [varchar] (80) NULL,
[ *HCP* |

[ Repri ci ngMet hodol ogy] [varchar] (3) NULL,
[ Repri cedAnmount] [noney] NULL,

[ Savi ngsAnount] [ noney] NULL,

[Repricerl D] [varchar](30) NULL,

[ RepricingRate] [varchar](9) NULL,

[ APG Code] [varchar] (30) NULL,

[ APG Anount] [noney] NULL,

[ Appr ovedRevenueCode] [varchar] (48) NULL,
[ Appr ovedPr ocedur eCode] [varchar] (48) NULL,
[ Appr ovedUni t Code] [char](2) NULL,

[ ApprovedUni ts] [bigint] NULL,

[ Rej ect Reason] [varchar](3) NULL,

[ Conpl i anceCode] [varchar](2) NULL,

[ ExceptionCode] [varchar](2) NULL,

/* Drugs */

[ DrugCode] [varchar] (48) NULL,
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[DrugUnitPrice] [noney] NULL,

[ DrugUni t Code] [char](2) NULL,

[DrugUnits] [float] NULL,

[ PrescriptionNunber] [varchar] (30) NULL,

/* CR1L */

[ Pati ent Wei ght] [varchar] (10) NULL,

[ Ambul anceTr ansport Code] [char] (1) NULL,

[ Ambul anceTr ansport ReasonCode] [char] (1) NULL,

[ Transport D stance] [varchar] (15) NULL,

[ RoundTri pPur poseDescription] [varchar] (80) NULL,

[ Stretcher PurposeDescription] [varchar] (80) NULL,

/* CRC —Anbul ance Certification */

[ Ambul anceCondi tionlndi cator] [char] (1) NULL,
[ Ambul anceCondi ti onCodel] [char](3) NULL,

[ Ambul anceCondi ti onCode2] [char](3) NULL,

[ Ambul anceCondi ti onCode3] [char](3) NULL,

[ Ambul anceCondi ti onCode4] [char](3) NULL,

[ Ambul anceCondi ti onCode5] [char](3) NULL,

/* Attending Provider */

[ At t endi ngProvi derLast] [varchar] (35) NULL,

[ Att endi ngProvi derFirst] [varchar](25) NULL,
[ At t endi ngProvi derM ddl e] [varchar](25) NULL,
[ At t endi ngProvi der Suffi x] [varchar](10) NULL,
[ Att endi ngProvi derl DQual] [char](2) NULL,

[ Attendi ngProvi derl D] [varchar] (35) NULL,

[ Att endi ngProvi der @ her I DQual ] [char](2) NULL,
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[ Att endi ngProvi der Gt herI D] [varchar](30) NULL,
/* Operating Provider */

[ Operati ngProvi derLast] [varchar](35) NULL,

[ OperatingProviderFirst] [varchar](25) NULL,

[ Operati ngProvi derM ddl e] [varchar](25) NULL,
[ Operati ngProviderSuffix] [varchar](10) NULL,
[ OperatingProviderl DQual] [char](2) NULL,

[ OperatingProviderl D [varchar](35) NULL,

[ Operati ngProvi der Gt herl DQual] [char](2) NULL,
[ Operati ngProvi der G herl D] [varchar](30) NULL,
/* Oher Provider */

[ herProviderLast] [varchar] (35) NULL,

[ herProviderFirst] [varchar] (25) NULL,

[ herProviderMddle] [varchar](25) NULL,

[@ herProviderSuffix] [varchar] (10) NULL,

[ herProviderl DQual] [char](2) NULL,
[C&herProviderl D [varchar](35) NULL,

[ herProviderQherl DQual] [char](2) NULL,

[@ herProviderQherl D] [varchar](30) NULL,

/* Rendering Provider */

[ Renderi ngProvi derLast] [varchar] (35) NULL,

[ Renderi ngProvi derFirst] [varchar](25) NULL,

[ Renderi ngProvi derM ddl e] [varchar] (25) NULL,
[ Renderi ngProvi der Suffi x] [varchar](10) NULL,
[ Renderi ngProvi derl DQual] [char](2) NULL,

[ Renderi ngProviderl D] [varchar] (35) NULL,
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[ Renderi ngProvi der @ her I DQual ] [char](2) NULL,

[ Renderi ngProvi der Gt herI D] [varchar](30) NULL,

/* PurchasedService Provider */

[ Pur chasedSer vi ceProvi derLast] [varchar] (35) NULL,

[ Pur chasedServi ceProviderFirst] [varchar](25) NULL,

[ Pur chasedSer vi ceProvi der M ddl e] [varchar] (25) NULL,

[ Pur chasedSer vi ceProvi der Suf fi x] [varchar] (10) NULL,

[ Pur chasedSer vi ceProvi derl DQual] [char](2) NULL,

[ Pur chasedServi ceProvi derl D] [varchar] (35) NULL,

[ Pur chasedSer vi ceProvi der & herl DQual] [char](2) NULL,

[ Pur chasedSer vi ceProvi der & herl1 D] [varchar] (30) NULL,

/* Facility Provider */

[FacilityNanme] [varchar](35) NULL,

[Facilityl DQual] [char](2) NULL,

[Facilityl D] [varchar](35) NULL,
[FacilityAddressl] [varchar](25) NULL,
[FacilityAddress2] [varchar](25) NULL,
[FacilityGty] [varchar](30) NULL,
[FacilityState] [char](2) NULL,

[FacilityZi p] [varchar](15) NULL,
[FacilityQiherl DQual] [char](2) NULL,
[FacilityQiherl Dl [varchar](30) NULL,

/* Supervising Provider */

[ Supervi si ngProvi der Last] [varchar] (35) NULL,
[ Supervi si ngProviderFirst] [varchar](25) NULL,

[ Super vi si ngProvi der M ddl e] [varchar](25) NULL,
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[ Super vi si ngProvi der Suf fi x] [varchar](10) NULL,
[ Super vi si ngProvi der1 DQual ] [char](2) NULL,

[ Supervi si ngProviderl D] [varchar](35) NULL,

[ Super vi si ngProvi der & herl DQual] [char](2) NULL,
[ Super vi si ngProvi derQherl D] [varchar] (30) NULL,
/* Odering Provider */

[ OrderingProviderLast] [varchar](35) NULL,
[OrderingProviderFirst] [varchar](25) NULL,

[ OrderingProvi derM ddl e] [varchar](25) NULL,

[ OrderingProviderSuffix] [varchar](10) NULL,
[OrderingProviderl DQual] [char](2) NULL,
[OrderingProviderl D] [varchar] (35) NULL,

[ O deringProviderQherlDQual] [char](2) NULL,
[OrderingProviderQherl D [varchar](30) NULL,
/* Referring Provider */

[ Ref erringProviderLast] [varchar](35) NULL,

[ ReferringProviderFirst] [varchar](25) NULL,

[ Ref erringProvi derM ddl e] [varchar](25) NULL,

[ Ref erringProviderSuffix] [varchar](10) NULL,

[ ReferringProviderl DQual] [char](2) NULL,

[ ReferringProviderl D [varchar](35) NULL,

[ ReferringProvi der G herl DQual] [char](2) NULL,
[ ReferringProviderGherl D] [varchar](30) NULL,
/*COB 1 */

[ & her Payer 11 D] [varchar](30) NULL,

[ & her Payer 1Pai d] [ noney] NULL,
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[ @& her Payer 1Pai dProcedure] [varchar](30) NULL,

[ @ her Payer 1Pai dRevenueCode] [varchar] (30) NULL,

[ & her Payer 1Pai dQuantity] [bigint] NULL,

[ @ her Payer 1Bundl edLi ne] [int] NULL,

[ @& her Payer 1Adj ust nent ReasonG oupl] [char](2) NULL,

[ @ her Payer 1Adj ust nent Reasonl] [varchar] (5) NULL,

[ @ her Payer 1Adj ust nent Arount 1] [ nmoney] NULL,

[ @ her Payer 1Adj ust nent Quanti tyl] [bigint] NULL,

[ @& her Payer 1Adj ust nent ReasonG oup2] [char](2) NULL,

[ @ her Payer 1Adj ust nent Reason2] [varchar] (5) NULL,

[ @ her Payer 1Adj ust nent Arount 2] [ money] NULL,

[ @ her Payer 1Adj ust nent Quantity2] [bigint] NULL,

[ @& her Payer 1Adj ust nent ReasonG oup3] [char](2) NULL,

[ @ her Payer 1Adj ust nent Reason3] [varchar] (5) NULL,

[ @ her Payer 1Adj ust nent Amount 3] [ money] NULL,

[ @ her Payer 1Adj ust nent Quantity3] [bigint] NULL,

[ @ her Payer 1Adj ust nent ReasonG oup4] [char](2) NULL,

[ @ her Payer 1Adj ust nent Reason4] [varchar] (5) NULL,

[ @ her Payer 1Adj ust nent Amount 4] [ money] NULL,

[ @ her Payer 1Adj ust nent Quanti ty4] [bigint] NULL,

--[ & her Payer 1Adj ust ment ReasonG oup5Pl us] [varchar] (77) NULL,
--[ & her Payer 1Adj ust ment Reason5Pl us] [varchar] (155) NULL,
--[ & her Payer 1Adj ust ment Anount 5Pl us] [varchar] (493) NULL,
--[ & her Payer 1Adj ust ment Quanti t y5Pl us] [varchar] (415) NULL,
[ @ her Payer 1Pai dDat e] [date] NULL,

[*CcB 2 */
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[ @ her Payer 21 D] [varchar](30) NULL,

[ & her Payer 2Pai d] [ noney] NULL,

[ @& her Payer 2Pai dProcedure] [varchar](30) NULL,

[ @& her Payer 2Pai dRevenueCode] [varchar] (30) NULL,

[ @ her Payer 2Pai dQuantity] [bigint] NULL,

[ @ her Payer 2Bundl edLi ne] [int] NULL,

[ @& her Payer 2Adj ust nent ReasonG oupl] [char](2) NULL,

[ @ her Payer 2Adj ust nent Reasonl] [varchar] (5) NULL,

[ @ her Payer 2Adj ust nent Amount 1] [ money] NULL,

[ @& her Payer 2Adj ust nent Quanti tyl] [bigint] NULL,

[ @& her Payer 2Adj ust nent ReasonG oup2] [char](2) NULL,

[ @ her Payer 2Adj ust nent Reason2] [varchar] (5) NULL,

[ @ her Payer 2Adj ust nent Amount 2] [ money] NULL,

[ @ her Payer 2Adj ust nent Quantity2] [bigint] NULL,

[ @& her Payer 2Adj ust nent ReasonG oup3] [char](2) NULL,

[ @ her Payer 2Adj ust nent Reason3] [varchar] (5) NULL,

[ @& her Payer 2Adj ust nent Amount 3] [ nmoney] NULL,

[ @ her Payer 2Adj ust nent Quanti ty3] [bigint] NULL,

[ @ her Payer 2Adj ust nent ReasonG oup4] [char](2) NULL,

[ @ her Payer 2Adj ust nent Reason4] [varchar] (5) NULL,

[ @ her Payer 2Adj ust nent Amount 4] [ nmoney] NULL,

[ @ her Payer 2Adj ust nent Quanti ty4] [bigint] NULL,

--[ & her Payer 2Adj ust ment ReasonG oup5Pl us] [varchar] (77) NULL,
--[ & her Payer 2Adj ust ment Reason5Pl us] [varchar] (155) NULL,
--[ & her Payer 2Adj ust ment Anount 5Pl us] [varchar] (493) NULL,

--[ & her Payer 2Adj ust ment Quanti t y5Pl us] [varchar] (415) NULL,
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5.3.2

[ @ her Payer 2Pai dDat e] [date] NULL

) ON [ PRI MARY]

MySQL Script to Create Tables

Header

CREATE TABLE “EDI _O ai ns’ (

“ID int(11) NOT NULL auto_increnent,
/*File Level Data*/

“Filenane™ varchar (100) default NULL,

"I mageFi | ePath® varchar (300) default NULL,
"I mageFi | enanme”™ varchar (100) default NULL,

“Version® varchar(12) default NULL,

“Tradi ngPart ner | DType® char(2) default NULL,

“Tradi ngPartnerI D varchar (15) NOT NULL,
"Transacti onDate” varchar (15) default NULL,
"Recei veDate’ varchar(15) default NULL,
“SubmitterNane® varchar (60) default NULL,

"Submitterl D varchar(30) default NULL,

"SubmitterContact® varchar(60) default NULL,

“SubmitterTel ® varchar(20) default NULL,
“SubmitterTel Ext® varchar(10) default NULL,
“SubmitterFax® varchar(20) default NULL,
“SubmitterEmail® varchar(80) default NULL,
"Recei ver Nane™ varchar (60) default NULL,

"ReceiverI D varchar(30) default NULL,

This is a free, industrial strength Open Source database available at www.MySQL.com
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“TransactionType' char(2) default NULL,
/*Billing Provider*/

"FedTaxI D' varchar(15) default NULL,

"Bill Provl DType® char(2) default NULL,

"Bill ProviD varchar(80) default NULL,

"Bill ProvNPl © varchar (12) default NULL,

"Bill ProvLast™ varchar(60) default NULL,
"Bill ProvFirst®™ varchar(35) default NULL,
"Bill ProvM ddl e* varchar(25) default NULL,
"Bill ProvSuffix® varchar(10) default NULL,
"Bill ProvSpecialty' varchar(10) default NULL,
"Bill ProvAddress®™ varchar(55) default NULL,
"Bill ProvAddress2® varchar (55) default NULL,
"Bill ProvCity" varchar(30) default NULL,
"Bill ProvState® char(2) default NULL,

"Bill ProvZi p° varchar(15) default NULL,

"Bill ProvCountry™ varchar(3) default NULL,
"Bil | ProvSubdi vi sion® varchar(3) default NULL,
"Bill ProvContact™ varchar(60) default NULL,
"Bill ProvTel ° varchar (80) default NULL,

"Bill ProvTel Ext® varchar(80) default NULL,
"Bill ProvFax®™ varchar (80) default NULL,

"Bill ProvEmai |l ° varchar (80) default NULL,
"Bill ProvQt herl DQual 1° varchar (100) default NULL,
"Bill ProvQtherlI D1° varchar (100) default NULL,

"Bill ProvQt herl DQual 2° varchar (100) default NULL,
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"Bill ProvQtherl D2° varchar (100) default NULL,

"Bill ProvQ her |l DQual 3° varchar (100) default NULL,

"Bill ProvQther|I D3° varchar (100) default NULL,

"Bill ProvQ her |l DQual 4° varchar (100) default NULL,

"Bill ProvQtherl D4° varchar (100) default NULL,

"Bill ProvQt herl DQual 5° varchar (100) default NULL,

"Bill ProvQtherl D5° varchar (100) default NULL,
/ *Pay-to Provider*/

" PayToProvl DType” char(2) default NULL,
“PayToProvl D' varchar (80) default NULL,
“PayToProvTaxl D' varchar(12) default NULL,
“PayToProvNPl ° varchar(12) default NULL,
“PayToProvLast ™ varchar(60) default NULL,
“PayToProvFirst® varchar(35) default NULL,

" PayToProvM ddl e* varchar(25) defaul t NULL,
“PayToProvSuffi x® varchar(10) default NULL,
“PayToProvSpecialty” varchar (10) default NULL,
" PayToProvAddress™ varchar (55) default NULL,
“ PayToPr ovAddr ess2™ varchar (55) default NULL,
“PayToProvCity varchar(30) default NULL,
“PayToProvState® char(2) default NULL,
“PayToProvZi p® varchar(15) default NULL,

/ *Pay-to Payer*/

" PayToPayer | DType® char(2) default NULL,

" PayToPayer| D' varchar (80) default NULL,

" PayToPayer Taxl D' varchar(12) defaul t NULL,
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" PayToPayer Last® varchar (60) default NULL,

" PayToPayer First™ varchar(35) default NULL,

" PayToPayer M ddl e varchar (25) default NULL,

" PayToPayer Suf fi x™ varchar (10) default NULL,

" PayToPayer Address™ varchar (55) default NULL,
" PayToPayer Addr ess2” varchar (55) default NULL,
" PayToPayerCity" varchar(30) default NULL,

" PayToPayer State™ char(2) default NULL,

" PayToPayer Zi p° varchar (15) default NULL,

" PayToPayer 0t her I DQual © char (2) default NULL,
" PayToPayer G herl D varchar (30) default NULL,
/ *Subscri ber*/

“Subscri berLast” varchar(60) default NULL,
“SubscriberFirst® varchar(35) default NULL,
“Subscri berMddl e® varchar(25) default NULL,
“Subscri berSuffix® varchar(10) default NULL,
“Subscri ber| DType® char(2) default NULL,
“Subscriberl D varchar(80) default NULL,

" Subscri ber Address® varchar (55) default NULL,
“Subscri ber Address2® varchar (55) default NULL,
“SubscriberCty’ varchar(30) default NULL,
“SubscriberState’ char(2) default NULL,
“Subscri berZip® varchar(15) default NULL,
“Subscri berCountry® varchar(3) default NULL,
“Subscri berLocation® varchar(30) default NULL,

“Subscri ber Subdi vi si on® varchar(3) default NULL,
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“Subscri berDOB® varchar (10) default NULL,
“Subscri ber Sex® char (1) default NULL,
“SubscriberEthnicity’ varchar(75) default NULL,

“SubscriberMarital Status® char (1) default NULL,

" Subscri ber Col | ecti onMet hod™ varchar (30) default NULL,

“Subscri ber SSN' varchar(12) default NULL,

" Subscri ber Agencyd ai mMNo™ var char (50) defaul t NULL,
“Subscri ber Menber I D' varchar (50) default NULL,
“Subscri berPersonal | D' varchar (50) default NULL,
" Subscri ber Contact ™ varchar (60) default NULL,
“Subscri berTel ° varchar (15) default NULL,
“Subscri ber Tel Ext© varchar (10) default NULL,
/*Destination Payer*/

“Payer Nane® varchar (60) default NULL,

" Payer | DType® char(2) default NULL,

“Payer| D' varchar(30) default NULL,

" Payer Addr ess” varchar (55) default NULL,

" Payer Addr ess2” varchar (55) default NULL,
“PayerGity' varchar (30) default NULL,

“Payer State® char(2) default NULL,

“PayerZip° varchar(15) default NULL,

“Payer Responsibility' char(1l) default NULL,
“Payer @ her | DQual 1° varchar(3) default NULL,
“Payer @ her1 D1° varchar (50) default NULL,
“Payer O her | DQual 2° varchar (3) default NULL,

“Payer @ her1 D2° varchar (50) default NULL,
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“Payer O her | DQual 3° varchar (3) default NULL,
“Payer @ her1 D3° varchar (50) default NULL,

"G oupNo® varchar (50) default NULL,

"G oupNane’ varchar (60) default NULL,

"I nsuranceType” char(2) default NULL,
"Filinglndicator® char(2) default NULL,

"COBI ndicator” char(1) default NULL,

/ *Responsi bl e*/

" Responsi bl eLast ™ varchar (60) defaul t NULL,

" Responsi bl eFirst™ varchar(35) default NULL,
" Responsi bl eM ddl e* varchar (25) default NULL,
" Responsi bl eSuf fi x™ varchar (10) default NULL,
" Responsi bl eAddress™ varchar (55) default NULL,
" Responsi bl eAddress2” varchar (55) default NULL,
" Responsi bl eCty” varchar(30) default NULL,
"Responsi bl eState™ char(2) default NULL,

" Responsi bl ezZi p° varchar(15) default NULL,

" Responsi bl el DType® char(2) default NULL,
"Responsi bl el D' varchar (80) default NULL,
/*Patient*/

“PatientlLast”™ varchar(60) default NULL,
“PatientFirst® varchar(35) default NULL,
“Patient M ddl e varchar(25) default NULL,
“PatientSuffix® varchar(10) default NULL,
“Pati ent Address” varchar(55) default NULL,

“Pati ent Address2® varchar(55) default NULL,
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“PatientGty” varchar(30) default NULL,
“PatientState’ char(2) default NULL,
“PatientZi p® varchar(15) default NULL,
“PatientCountry” varchar(3) default NULL,
“PatientLocation® varchar(30) default NULL,
“Pati ent Subdi vi sion” varchar(3) default NULL,
“Patient| DType” char(2) default NULL,
“Patient| D varchar (80) default NULL,
“Patient SSN' varchar (12) default NULL,

“Pati ent Menber I D' varchar (50) defaul t NULL,

“Pati ent Personal ID varchar (50) default NULL,

“PatientlnsurancePolicy’ varchar(50) default NULL,

“Pati ent DOB" varchar (50) default NULL,
“PatientSex’ char(1l) default NULL,
“PatientEthnicity varchar(75) default NULL,

“PatientMarital Status® char(1) default NULL,

“Patient Col | ecti onMet hod™ varchar (30) defaul t NULL,

“PatientRel ati onship® char(2) default NULL,
“PatientPaid® varchar(10) default NULL,

" Pregnancyl ndi cator® char(1) default NULL,
/ *Rendering Provider*/

“RendProvl DType® char(2) default NULL,
"RendProvl D' varchar (80) default NULL,
“RendProvNPI © varchar (12) default NULL,
"RendProvTaxl D' varchar(12) default NULL,

"RendProvLast® varchar(60) default NULL,
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"RendProvFirst® varchar(35) default NULL,
"RendProvM ddl e* varchar(25) default NULL,
"RendProvSuffix® varchar(10) default NULL,
"RendProvSpecialty” varchar(10) default NULL,
"RendProvQ her I DQual 1° varchar (3) default NULL,
"RendProvQt herI D1° varchar (50) default NULL,
“RendProvQ her I DQual 2° varchar (3) default NULL,
"RendProvQ her I D2° varchar (50) default NULL,
“RendProvQ her | DQual 3° varchar (3) default NULL,
"RendProvQ her I D3° varchar (50) default NULL,
/*Attendi ng Provider*/

“AttendProvLast” varchar(60) default NULL,
“AttendProvFirst® varchar(35) default NULL,
“AttendProvM ddl e® varchar (25) default NULL,
“AttendProvSuffix® varchar(10) default NULL,
“AttendProvl DType® char(2) default NULL,
“AttendProvl D' varchar(80) default NULL,
“AttendProvTaxl D' varchar(12) default NULL,
“AttendProvNPl © varchar(12) default NULL,
“AttendProvQherl DQual 1° varchar (100) defaul t NULL,
“AttendProvQherI D1 varchar (100) default NULL,
“AttendProvSpecialty” varchar(10) default NULL,
/*Qperating Provider*/

“QperatingProvLast ™ varchar(60) default NULL,
“QperatingProvFirst® varchar(35) default NULL,

“QperatingProvM ddl e® varchar (25) default NULL,
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“QperatingProvSuffix® varchar(10) default NULL,
“QperatingProvl DType® char(2) default NULL,
“QperatingProvli D varchar(80) default NULL,
“QperatingProvNPl® varchar(12) default NULL,
“QperatingProvTaxl D varchar (12) default NULL,
“QperatingProvQ herl DQual 1° varchar (100) default NULL,
“QperatingProvQ herl D1° varchar (100) default NULL,
“QperatingProvSpecialty” varchar(10) default NULL,
/*CQt her Provider*/

"QtherProvLast®™ varchar(60) default NULL,
"QherProvFirst® varchar(35) default NULL,
"QherProvM ddl e° varchar(25) defaul t NULL,
"QherProvSuffix® varchar(10) defaul t NULL,

“Qher Provl DType® varchar (100) default NULL,
"QherProvli D varchar (100) default NULL,
"QherProvTaxl D' varchar(12) default NULL,
"QtherProvNPl © varchar(12) default NULL,
"QherProvQ her I DQual 1° varchar (100) default NULL,
"G herProvQ herI D1 varchar (100) default NULL,
"QtherProvSpecialty” varchar(100) default NULL,
[*Facility*/

“FacilityType' char(2) default NULL,

“Facilityl DType® char(2) default NULL,
“FacilitylD varchar(80) default NULL,
“FacilityNPl* varchar(12) default NULL,

“FacilityTaxl D' varchar(12) default NULL,
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“FacilityQherl DQual 1° varchar (100) default NULL,
“FacilityQherI DL varchar (100) default NULL,
“FacilityNane® varchar(80) default NULL,
“FacilityAddress® varchar(55) default NULL,
“FacilityAddress2® varchar(55) default NULL,
"FacilityGty  varchar(30) default NULL,
“FacilitySpecialty  varchar(100) default NULL,
“FacilityState® char(2) default NULL,
“FacilityZip® varchar(15) default NULL,
/*Referring Provider*/

"Ref ProvLast ™ varchar (60) default NULL,

"Ref ProvFirst® varchar(35) default NULL,

"Ref ProvM ddl e* varchar (25) default NULL,

"Ref ProvSuffix® varchar(10) default NULL,

" Ref Provl DType® char (2) default NULL,

"Ref Provli D' varchar (80) default NULL,

"Ref ProvTaxl D' varchar(12) default NULL,

"Ref ProvNPl © varchar (12) default NULL,

"Ref ProvQt her I DQual 1° varchar (100) default NULL,
"Ref ProvQt her I D1° varchar (100) default NULL,
"Ref ProvSpecialty” varchar(10) default NULL,

/ *Super vi si ng Provi der*/

" SupervProvLast® varchar(60) default NULL,
“SupervProvFirst® varchar(35) default NULL,
“SupervProvM ddl e varchar (25) default NULL,

“SupervProvSuffix® varchar (10) default NULL,
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“SupervProvl DType® char(2) default NULL,
“SupervProvl D' varchar (80) default NULL,
“SupervProvTaxl D' varchar(12) default NULL,
“SupervProvNPl © varchar(12) default NULL,
“SupervProvQherl DQual 1° varchar(3) default NULL,
“SupervProvQ herI D1 varchar (50) default NULL,
" SupervProvSpecialty” varchar (10) default NULL,
/ *Assi st ant Sur geon*/

" Assi st SurglLast” varchar(60) default NULL,
“AssistSurgFirst® varchar(35) default NULL,
“AssistSurgM ddl e® varchar(25) default NULL,
“AssistSurgSuffix® varchar(10) default NULL,

" Assi st Sur gl DType® char(2) default NULL,
“AssistSurgl D varchar(80) default NULL,

“Assi st SurgTaxl D' varchar(12) defaul t NULL,
“AssistSurgNPl© varchar(12) default NULL,

“Assi st SurgQherl DQual 1° varchar(3) default NULL,
“AssistSurgQherl D1° varchar (50) default NULL,
" Assi st SurgSpecialty” varchar (10) default NULL,
/ * Ambul ance Pi ck-up Locati on*/

" Pi ckUpAddr ess™ varchar (55) default NULL,

" Pi ckUpAddr ess2” varchar(55) default NULL,
"PickUpGity varchar (30) default NULL,
"PickUpState® char(2) default NULL,

“Pi ckUpZi p° varchar (15) default NULL,

/ * Anbul ance Drop-off Location*/
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“DropOf f Name™ varchar (80) default NULL,
"DropOf f Address™ varchar (55) default NULL,
“DropOf f Addr ess2™ varchar (55) defaul t NULL,
"DropOFfGty” varchar(30) default NULL,
"DropOffState” char(2) default NULL,
"DropOfZzip® varchar(15) default NULL,

/*COB Payer 1*/

"QherlnsuredLast ™ varchar (60) default NULL,
"QherlnsuredFirst® varchar(35) default NULL,
"QherlnsuredM ddl e® varchar (25) default NULL,
"QtherlnsuredSuffix® varchar(10) default NULL,
"Qherlnsuredl DQual © char(2) default NULL,
"Qherlnsuredl D varchar(10) default NULL,

O herl nsuredAddress™ varchar (55) default NULL,
"Q herl nsuredAddress2” varchar (55) default NULL,
"Qherlnsuredd ty” varchar(30) default NULL,
"QherlnsuredState’ char(2) default NULL,
"QtherlnsuredZip® varchar(15) default NULL,
"QherlnsuredCountry” varchar (3) default NULL,

" her |l nsuredSubdi vi si on® varchar(3) default NULL,
"QtherlnsuredPolicy’ varchar(50) default NULL,
"Q herl nsuredDOB’ varchar(10) defaul t NULL,
"QherlnsuredSex™ char(1) default NULL,

"Q herlnsuredRel ationship™ char(2) default NULL,
"G herlnsuredC herl DQual 1° char(3) default NULL,

"G herlnsured herl D1° varchar (50) default NULL,
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"Q herlnsuredQ herl DQual 2° char(3) default NULL,

"G herlnsuredQ herl D2° varchar (50) default NULL,

"Q herlnsuredQ herl DQual 3° char(3) default NULL,

"G herlnsuredQ her1 D3° varchar (50) default NULL,

" her Payer Responsi bility" varchar(100) default NULL,

" her Payer Nanme™ varchar (35) default NULL,

"Qher Payer I DQual ° char(2) default NULL,

"QtherPayerI D varchar(80) default NULL,

" her Payer Address1” varchar (55) default NULL,

" her Payer Address2” varchar (55) default NULL,
"QtherPayerCity” varchar(30) default NULL,

"Qther Payer State™ char(2) default NULL,

"QtherPayer Zi p° varchar(15) default NULL,

" her Payer Pai d° varchar (10) default NULL,

" her Payer GroupNane™ varchar (100) default NULL,

" her Payer G oupNo™ varchar (100) default NULL,

" her Payer | nsuranceType® char (2) default NULL,
"QtherPayerFilinglndicator® char(2) default NULL,

" her Payer Adj ust nent ReasonG oup™ varchar (100) defaul t NULL,
" her Payer Adj ust nent Reason™ var char (100) default NULL,
" her Payer Adj ust nent Amount © var char (100) default NULL,
" her Payer Pai dDat e” varchar (15) default NULL,

" her Payer | nf oRel ease” varchar (100) default NULL,

" her Payer Benefi t Assi gn® varchar (100) defaul t NULL,

" her Payer DocControl No© varchar (100) defaul t NULL,

"Qher Payer Prior Auth® varchar (100) default NULL,
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"G her Payer O herl DQual 1° char (3) default NULL,
"QtherPayerherl D1 varchar (50) default NULL,

" her Payer O herl DQual 2° char (3) default NULL,
"QtherPayer herl D2° varchar (50) default NULL,

[/ *COB Payer 2*/

"Qherlnsured2Last® varchar (60) default NULL,
"Qtherlnsured2First® varchar(35) default NULL,
"G herlnsured2M ddl e® varchar (25) default NULL,
"G herlnsured2Suf fi x® varchar (10) default NULL,
"Qherl nsured2l DQual © char(2) default NULL,
"Qherlnsured2l D varchar(10) defaul t NULL,

"Q herl nsured2Address” varchar (55) default NULL,
“Q herl nsured2Address2” varchar (55) default NULL,
"Qherlnsured2G ty” varchar(30) default NULL,
"Qtherlnsured2State’ char(2) default NULL,
"Qtherl nsured2Zip® varchar(15) default NULL,

"G herlnsured2Country” varchar (3) default NULL,
O her |l nsured2Subdi vi si on® varchar(3) default NULL,
"Q herlnsured2Policy” varchar(50) default NULL,
"Qherl nsured2DOB’ varchar (10) default NULL,
"Qherlnsured2Sex™ char(1) default NULL,

“Qherl nsured2Rel ationship™ char(2) default NULL,
"Qherlnsured2C her I DQual 1° char(3) default NULL,
"Qherlnsured2C her 1 D17 varchar (50) default NULL,
“Qherlnsured2C her | DQual 2° char(3) default NULL,

“Qherlnsured2C her 1 D2° varchar (50) default NULL,
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“Qherlnsured2C her | DQual 3° char(3) default NULL,
"Qherlnsured2C her 1 D3° varchar (50) default NULL,

" her Payer 2Responsi bility™ varchar(100) default NULL,

" her Payer 2Nane™ varchar (35) defaul t NULL,

O her Payer 21 DQual ° char(2) default NULL,

"QtherPayer2I D' varchar(80) default NULL,

" her Payer 2Address1’ varchar (55) default NULL,

" her Payer 2Address2” varchar (55) default NULL,
"QtherPayer2C ty” varchar(30) default NULL,

"Qther Payer2State™ char(2) default NULL,

O her Payer 2Zi p° varchar(15) default NULL,

" her Payer 2Pai d° varchar (10) defaul t NULL,

" her Payer 2Gr oupNanme™ var char (100) default NULL,

" her Payer 2GoupNo™ var char (100) default NULL,

" Q her Payer 2l nsuranceType® char(2) default NULL,

"Qther Payer 2Fi l i ngl ndi cator™ char(2) default NULL,

" her Payer 2Adj ust nent ReasonG oup™ varchar (100) defaul t NULL,
" her Payer 2Adj ust nent Reason™ var char (100) default NULL,
" her Payer 2Adj ust nent Amount © var char (100) default NULL,
" her Payer 2Pai dDat e* varchar (15) default NULL,

" her Payer 2l nf oRel ease”™ varchar (100) defaul t NULL,

" her Payer 2Benef it Assi gn® varchar (100) default NULL,

" her Payer 2DocCont rol No™ var char (100) defaul t NULL,

“Q her Payer 2Pri or Auth® varchar (100) default NULL,

" her Payer 2 her 1 DQual 1° char (3) default NULL,

" her Payer 2 her I D1 varchar (50) default NULL,
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" her Payer 2O her I DQual 2° char (3) default NULL,
" her Payer 2 her1 D2° varchar (50) default NULL,
/*d ai m Dat a*/

“ClaimMo’ varchar (50) NOT NULL,

“Anmount © decinmal (10, 2) default NULL,

" Esti mat edAnount Due® deci mal (10, 2) default NULL,
“Pati ent Esti mat edAnount Due® deci mal (10, 2) default NULL,
"Placet Service' char(2) default NULL,

“d ai nFrequency” char (1) default NULL,

“Subm t Reason™ char (1) default NULL,
“ProviderSignature’ char(1) default NULL,

“Provi der Accept sAssi gnment © char (1) default NULL,
“BenefitAssignment® char(1) default NULL,

"I nf oRel easeCode™ char (1) default NULL,

“Pati ent Si gnatureCode” char (1) default NULL,

" Rel at edCauses™ char (2) default NULL,

" Rel at edCauses2” char(2) default NULL,

"Rel at edCausesState’ char(2) default NULL,

* Speci al ProgranCode” char(3) default NULL,
“ProviderParticipation® char(1l) default NULL,
"ECBI ndicator® char(1) default NULL,

" Del ayReasonCode™ char(2) default NULL,

" Servi ceDat eFrom varchar(15) defaul t NULL,
“ServiceDateTo™ varchar(15) default NULL,
“OnsetDate’ varchar (15) default NULL,

"SimlarSynptonsDate” varchar (10) default NULL,
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“DisabilityBegin® varchar(10) default NULL,
"DisabilityEnd” varchar(10) default NULL,
“HospitalizationBegin® varchar(20) default NULL,
“Hospitalizati onEnd” varchar (10) default NULL,
“Accident Date’ varchar(20) default NULL,

“Last Menstrual Period” varchar (15) default NULL,
"RepricerRecei vedDat e” varchar (15) default NULL,

" Admi ssionDate” varchar(15) default NULL,

“Admi ssi onHour ™ varchar (10) default NULL,

“Admi ssionType® char (1) default NULL,

“Admi ssionSource’ char(1) default NULL,

"Di schargeHour™ varchar (10) default NULL,
“PatientStatus® char(2) default NULL,

“CoveredDays™ varchar (4) default NULL,

“NonCover edDays™ varchar(4) default NULL,

" COBDays™ varchar(4) default NULL,

“Li f eTi neReserveDays™ varchar (4) default NULL,
“PriorAuthorization varchar(50) default NULL,

" earingHousel D' varchar (100) default NULL,

“ Medi cal Recor dNunber ™ varchar (50) default NULL,

* Mot her sMedi cal Recor dNunber ™ var char (50) default NULL,
“Servi ceAut hori zati onException’ varchar (50) default NULL,
"Ref erral Nunber™ varchar(50) default NULL,

“Payer d ai nCont rol Nunber™ varchar (50) defaul t NULL,
" Repricedd ai mNunber ™ varchar (50) default NULL,

" Adj ust edRepri cedd ai mNunber ™ varchar (50) default NULL,
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" Aut 0Acci dent State” varchar (50) default NULL,
"OrigRefNo® varchar (50) default NULL,

“dai nMype” char(1) default NULL,
“TypeOEBill ™ varchar (20) default NULL,
"Rermar k1l® varchar (90) default NULL,

"Rermar k2° varchar (90) default NULL,

"Rermar k3™ varchar (90) default NULL,

"Rermar k4™ varchar (90) default NULL,

"K3_1" varchar(80) default NULL,

"K3_2" varchar(80) default NULL,

"K3_3" varchar(80) default NULL,

"K3_4" varchar(80) default NULL,

"K3_5" varchar(80) default NULL,

"K3_6" varchar(80) default NULL,

"K3_7" varchar(80) default NULL,

"K3_8" varchar(80) default NULL,

"K3_9" varchar(80) default NULL,

"K3_10" varchar(80) default NULL,
“QutsideLab™ char(1l) default NULL,
“LabCharge’ varchar (10) default NULL,

“Test _Prod’ char(1l) default NULL,

" Report TypeCodel® varchar (100) default NULL,
" Report Transm ssi onCodel” varchar (100) defaul t NULL,
“Attachnent Control Nunber1® varchar (100) default NULL,
/*Dental d aimnms*/

"Predetermnati on® varchar (100) default NULL,

© <2003> Martin Scholl Consulting, Inc.



149

HIPAA Claim Master

"OrthodonticTotal ° varchar (100) default NULL,
“Orthodonti cRemai ni ng™ varchar (100) default NULL,
"Orthodonti cYesNo™ varchar (100) default NULL,
“Toot hStatus™ varchar (100) default NULL,

" Appl i ancePl acenent Dat e® varchar (100) defaul t NULL,

/*Di agnosi s | nformation*/

“Admi t Di agnosi s® varchar(10) default NULL,

"ECode” varchar(100) default NULL,

* ECode2’
* ECode3’
" ECode4”
" ECode5®
* ECode6’
" ECode7"
* ECode8’
# ECode9” varchar (100) default NULL,

# ECodel0" varchar (100) default NULL,

# ECodell” varchar(100) default NULL,

# ECodel2” varchar (100) default NULL,
"ReasonFor Visit® varchar(100) default NULL,
"ReasonFor Visit2' varchar(100) default NULL,
"ReasonFor Visit3" varchar(100) default NULL,

“Principal D agnosis® varchar (10) default NULL,

var char (100)
var char (100)
var char (100)
var char (100)
var char (100)
var char (100)

var char (100)

default NULL,

default NULL,

default NULL,

default NULL,

default NULL,

default NULL,

default NULL,

“Diag2” varchar(10) default NULL,

"Diag3” varchar(10) default NULL,

“Diag4” varchar(10) default NULL,
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"D agh’
"Di ag6”
"Diag7’
"Di ag8’

"D ag9’

"Diagl0”
"Diagll”
“Diagl2”
"Diagl3”
"Diagld”
"Diagls”
"Diagl6”
“Diagl7”
"Diagl8”
"Diagl9”
"D ag20”
"Diag2l”
"Diag22”
"D ag23”
"D ag24”

"D ag25”

var char (10)
var char (10)
var char (10)
var char (10)
var char (10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)
var char ( 10)

var char ( 10)

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

defaul t NULL,

"DRG varchar(15) default NULL,

/ *Procedure | nformation*/

“Principal Procedure’ varchar (10) default NULL,

“Principal ProcedureDate” datetinme default NULL,

“Proc2” varchar(50) default NULL,
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"Proc2Date’ datetinme default NULL,
"Proc3” varchar(10) default NULL,
"Proc3Date’ datetinme default NULL,
"Proc4” varchar(10) default NULL,
"Proc4Date’ datetinme default NULL,
"Proc5’ varchar(10) default NULL,
"ProcbSDate’ datetinme default NULL,
"Proc6” varchar(10) default NULL,
"Proc6Date’ datetinme default NULL,
"Proc7 varchar(10) default NULL,
"Proc7Date’ datetinme default NULL,
"Proc8 varchar(10) default NULL,
"Proc8Date’ datetinme default NULL,
"Proc9” varchar(10) default NULL,
"Proc9Date’ datetinme default NULL,
"Procl0” varchar(10) default NULL,
"ProclODate’ datetine default NULL,
"Procll’ varchar(10) default NULL,
"ProcllDate’ datetine default NULL,
"Procl2” varchar(10) default NULL,
"Procl2Date’ datetine default NULL,
"Procl3" varchar(10) default NULL,
"Procl3Date’ datetine default NULL,
"Procl4’ varchar(10) default NULL,
"Procl4Date’ datetine default NULL,

“Procl5 varchar(10) default NULL,
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"Procl5Date’ datetine default NULL,
"Procl6” varchar(10) default NULL,
"Procl6Date’ datetine default NULL,
“Procl7" varchar(10) default NULL,
"Procl7Date’ datetine default NULL,
"Procl8 varchar(10) default NULL,
"Procl8Date’ datetine default NULL,
“Procl9" varchar(10) default NULL,
"Procl9Date’ datetine default NULL,
“Proc20° varchar(10) default NULL,
"Proc20Date’ datetine default NULL,
“Proc21" varchar(10) default NULL,
"Proc2lDate’ datetine default NULL,
“Proc22° varchar(10) default NULL,
"Proc22Date’ datetine default NULL,
"Proc23" varchar(10) default NULL,
"Proc23Date’ datetine default NULL,
"Proc24° varchar(10) default NULL,
"Proc24Date’ datetine default NULL,
“Proc25° varchar(10) default NULL,
"Proc25Date’ datetine default NULL,
/ *Val ue Codes*/

“Val ueCodel” char(3) default NULL,
“Val ueAnount 1° varchar (10) default NULL,
“Val ueCode2” char(3) default NULL,

“Val ueAnount 2° varchar (10) default NULL,
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“Val ueCode3” char(3) default NULL,

“Val ueAnount 3° varchar (10) default NULL,
“Val ueCode4™ char(3) default NULL,

“Val ueAnount 4° varchar (10) default NULL,
“Val ueCode5™ char(3) default NULL,

“Val ueAnount5° varchar (10) default NULL,
“Val ueCode6™ char(3) default NULL,

“Val ueAnount 6° varchar (10) default NULL,
“Val ueCode7" varchar (10) default NULL,
“Val ueAnount 7° varchar (10) default NULL,
“Val ueCode8" char(3) default NULL,

“Val ueAnount 8° varchar (10) default NULL,
“Val ueCode9” char(3) default NULL,

“Val ueAnount 9° varchar (10) default NULL,
“Val ueCodel0” char(3) default NULL,

“Val ueAnount 10° varchar (10) default NULL,
“Val ueCodell” char(3) default NULL,
“Val ueAnount 11° varchar (10) default NULL,
“Val ueCodel2” char(3) default NULL,

“Val ueAnount 12° varchar (10) default NULL,

“Val ueCodel3” char(3) default NULL,

“Val ueAnount 13° varchar (10) default NULL,

“Val ueCodel4” char(3) default NULL,

“Val ueAnount 14" varchar (10) default NULL,

“Val ueCodel5" char(3) default NULL,

“Val ueAnount 15° varchar (10) default NULL,
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" Condi ti onCodel” varchar(30) default NULL,
“ Condi ti onCode2™ varchar(30) default NULL,
“ Condi ti onCode3” varchar(30) default NULL,
“ Condi ti onCode4”™ varchar(30) default NULL,
“ Condi ti onCode5™ varchar(30) default NULL,
“ Condi ti onCode6” varchar(30) default NULL,

“ Condi ti onCode7" varchar(30) default NULL,

“Val ueCodel6” char(3) default NULL,

“Val ueAnount 16° varchar (10) default NULL,

“Val ueCodel7” varchar (10) default NULL,

“Val ueAnount 17° varchar (10) default NULL,

“Val ueCodel8" char(3) default NULL,

“Val ueAnount 18" varchar (10) default NULL,

“Val ueCodel9” char(3) default NULL,

“Val ueAnount 19° varchar (10) default NULL,

“Val ueCode20" char(3) default NULL,

“Val ueAnount 20" varchar (10) default NULL,

“Val ueCode21” char(3) default NULL,

“Val ueAnount 21° varchar (10) default NULL,

“Val ueCode22" char(3) default NULL,

“Val ueAnount 22° varchar (10) default NULL,

“Val ueCode23" char(3) default NULL,

“Val ueAnmount 23" varchar (10) default NULL,

Val ueCode24 char(3) default NULL,

*Condi ti on Codes*/

Val ueAnount 24° varchar (10) default NULL,
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“ Condi ti onCode8" varchar(30) default NULL,

“Condi ti onCode9” varchar(30) default NULL,

“ Condi ti onCodel0" varchar(30) default NULL,

&

&

&

&

* Condi ti onCodel3”

* Condi ti onCodel4’

* Condi ti onCodel5”

* Condi ti onCodel6”

“Condi ti onCodel7"

* Condi ti onCodel8”

* Condi ti onCodel9”

* Condi ti onCode20®

*Condi ti onCode21”

* Condi ti onCode22"

Condi ti onCodell”

Condi ti onCodel2"

Condi ti onCode23"

Condi ti onCode24"

var char ( 30)
var char ( 30)
var char ( 30)
var char ( 30)
var char ( 30)
var char ( 30)
var char ( 30)
var char ( 30)
var char ( 30)
var char ( 30)
var char ( 30)
var char ( 30)
var char ( 30)

var char ( 30)

/*CQccurrence Codes*/

" CQccurranceCodel”

“CQccurrancebDat el”

" CQccurranceCode2”

“CQccurrancebDat e2°

" CQccurranceCode3”

" CQccurranceDat e3°

" CQccurranceCode4’

" CQccurrancebDat e4”

default NULL,

def aul t

def aul t

def aul t

def aul t

def aul t

def aul t

def aul t

def aul t

def aul t

def aul t

def aul t

def aul t

def aul t

char (3) default NULL,

varchar (10) default NULL,

char (3) default NULL,

varchar (10) default NULL,

char (3) default NULL,

varchar (10) default NULL,

char (3) default NULL,

varchar (10) default NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,
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" CQccurranceCodeb”

“CQccurrancebDat e5°

" CQccurranceCode6”

“CQccurranceDat e6”

" CQccurranceCode7”

“CQccurrancebDat e7”

" CQccurranceCode8”

" CQccurranceDat e8°

# QccurranceCode9”

char (3) default NULL,
varchar (10) default NULL,
char (3) default NULL,
varchar (10) default NULL,
char (3) default NULL,
varchar (10) default NULL,
char (3) default NULL,
varchar (10) default NULL,

char (3) default NULL,

# CccurranceDat e9” varchar (10) default NULL,

# CccurranceCodel0” char(3) default NULL,

# CccurranceDat e10° varchar (10) default NULL,

# CccurranceCodell” char(3) default NULL,

# CccurranceDat ell” varchar (10) default NULL,

# CccurranceCodel2” char(3) default NULL,

# CccurranceDat el2” varchar (10) default NULL,

# CccurranceCodel3” char(3) default NULL,

# CccurranceDat e13” varchar (10) default NULL,

# CccurranceCodeld”™ char(3) default NULL,

# CccurranceDat el4™ varchar (10) default NULL,

# CccurranceCodel5” char(3) default NULL,

# CccurranceDat el5° varchar (10) default NULL,

# CccurranceCodel6” char(3) default NULL,

# CccurranceDat el6™ varchar (10) default NULL,

# CccurranceCodel7” char(3) default NULL,

# CccurranceDat el7” varchar (10) default NULL,
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“CQccurranceCodel8’

“CQccurrancebDat e18°

“CQccurranceCodel9”

“CQccurrancebDat e19°

“CQccurranceCode20°

" CQccurrancebDat €20°

" CQccurranceCode21”

“CQccurrancebDat e21°

" CQccurranceCode22”

“CQccurrancebDat e22°

" CQccurranceCode23”

" CQccurrancebDat €23°

CccurranceCode24’

CccurrancebDat e24°

char (3) default NULL,

var char (10) default NULL,

char (3) default NULL,

var char (10) default NULL,

char (3) default NULL,

var char (10) default NULL,

char (3) default NULL,

var char (10) default NULL,

char (3) default NULL,

var char (10) default NULL,

char (3) default NULL,

var char (10) default NULL,

char (3) default NULL,

var char (10) default NULL,

“QccurranceSpanCodel” char(3) defaul t NULL,

“QccurranceSpanFronl” varchar (10) default NULL,

“QccurranceSpanTol™ varchar (10) default NULL,

“QccurranceSpanCode2” char(3) defaul t NULL,

“QccurranceSpanFron2® varchar (10) default NULL,

“QccurranceSpanTo2™ varchar (10) default NULL,

“QccurranceSpanCode3” char(3) defaul t NULL,

“QccurranceSpanFron8® varchar (10) default NULL,

“QccurranceSpanTo3™ varchar (10) default NULL,

“QccurranceSpanCode4™ char(3) defaul t NULL,

“QccurranceSpanFromd™ varchar (10) default NULL,

“QccurranceSpanTo4™ varchar (10) default NULL,
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/* CR1L */

“Pati ent Wi ght ™ varchar (10) NULL,

* Anbul anceTr ansport Code™ char (1) NULL,

" Anbul anceTr ansport ReasonCode™ char (1) NULL,
“Transport D stance™ varchar (15) NULL,

" RoundTr i pPur poseDescription varchar (80) NULL,
" Stretcher PurposeDescription  varchar(80) NULL,
/* CRC —Anbul ance Certification */

“ Anbul anceCondi tionlndi cator™ char(1) NULL,
" Anbul anceCondi ti onCodel™ char (3) NULL,

" Anbul anceCondi ti onCode2™ char (3) NULL,

" Anbul anceCondi ti onCode3"™ char (3) NULL,

" Anbul anceCondi ti onCode4™ char (3) NULL,

" Anbul anceCondi ti onCode5™ char (3) NULL,

/ *Repri ci ng*/

" Repri ci ngMet hodol ogy™ varchar (3) NULL,

" Repri cedAnount © deci mal (10, 2) NULL,

* Savi ngsAnount © deci mal (10, 2) NULL,
"Repricerl D varchar(30) NULL,
"RepricingRate’ varchar(9) NULL,

" APG Code™ varchar (30) NULL,

" APG Anount® deci mal (10, 2) NULL,

" Appr ovedRevenueCode™ varchar (48) NULL,

" Appr ovedPr ocedur eCode™ varchar (48) NULL,

“ ApprovedUni t Code™ char(2) NULL,

" ApprovedUni ts® bigint NULL,
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" Rej ect Reason™ varchar (3) NULL,

“ Conpl i anceCode™ varchar(2) NULL,

" ExceptionCode” varchar(2) NULL,
/*SQL To EDI */

# dai mAction  char(1l) NULL,

# Error Message® varchar (1000) NULL,

PRIMARY KEY ('1D)

) ENG NE=I nnoDB DEFAULT CHARSET=I at i n1l;

Detail

CREATE TABLE “edi O ai nDetail " (
"ID int(11) NOT NULL auto_increnent,
*AainD int(11) NOT NULL,
*Li neNunber® deci mal (18, 0) NULL,
“Linel D varchar(50) NULL,
“Servi ceDat eFrom datetinme NULL,
“ServiceDateTo™ date NULL,
“Assessnent Date” date NULL,
“FacilityCode® char(2) NULL,
" RevenueCode™ varchar (48) NULL,
" Procedur eCode” varchar (48) NULL,
“Amount © deci mal (10, 2) NULL,
“Unit® varchar (50) NULL,
“Quantity® float NULL,
“UnitRate” decimal (10, 2) NULL,

“NonCovered” deci mal (10, 2) NULL,
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“Pai d* decinal (10, 2) NULL,

"Placet Service® char(3) NULL,
“Modifierl char(3) NULL,

“Modi fier2' char(3) NULL,

“Modi fier3 char(3) NULL,

“Modi fier4® char(3) NULL,

" ProcedureDescription” varchar(80) NULL,
“Oral CavityDesignationl® char(3) NULL,
“Oral CavityDesi gnation2® char(3) NULL,
“Oral CavityDesi gnation3™ char(3) NULL,
“Oral CavityDesi gnationd4™ char(3) NULL,
“Oral CavityDesi gnation5” char(3) NULL,
“DiagPointer1l” char (1) NULL,

“Di agPointer2” char (1) NULL,

“Di agPointer3” char (1) NULL,

“Di agPointer4” char (1) NULL,

“Toot hNunber ™ char (2) NULL,

“Surface’ varchar(10) NULL,

" Energencyl ndi cator® char(1) NULL,
“ServiceTax™ deci mal (10,2) NULL,
“FacilityTax® decimal (10,2) NULL,

" Sal esTax™ deci mal (10, 2) NULL,

* Appr ovedAnount © deci mal (10, 2) NULL,
“LineK3_01" varchar(80) NULL,
“LineK3_02" varchar (80) NULL,

“LineK3_03" varchar (80) NULL,
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“Li

nekK3 04"

“Li

nekK3_ 05"

“Li

nekK3_ 06"

“Li

nekK3 07"

“Li

nekK3 08"

“Li

nekK3_09°

“Li

nek3 10"

"Remark® var

var char (80) NULL,
var char (80) NULL,
var char (80) NULL,
var char (80) NULL,
var char (80) NULL,
var char (80) NULL,
var char (80) NULL,

char (100) NULL,

* Anbul ancePat i ent Count ™ bi gi nt  NULL,

/****WK****/

" Report Type’

char(2) NULL,

"Report Transm ssion’ char(2) NULL,

" Attachnent Cont r ol Nunber ™ varchar (80) NULL,

[ *HCP*/

" Repri ci ngMet hodol ogy™ varchar (3) NULL,

" Repri cedAnount © deci mal (10, 2) NULL,

* Savi ngsAnount © deci mal (10, 2) NULL,

"Repricerl D

var char (30) NULL,

"RepricingRate’ varchar(9) NULL,

" APG Code™ varchar (30) NULL,

" APG_Anount ®

" Appr ovedRevenueCode™ varchar (48) NULL,

" Appr ovedPr ocedur eCode™ varchar (48) NULL,

* Appr ovedUni

* Appr ovedUni

deci nal (10, 2) NULL,

t Code” char(2) NULL,

ts® bigint NULL,

" Rej ect Reason™ varchar (3) NULL,
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“ Conpl i anceCode™ varchar(2) NULL,

" ExceptionCode” varchar(2) NULL,

/* Drugs */

"DrugCode” varchar (48) NULL,

“DrugUnitPrice’ decinal (10,2) NULL,

" DrugUni t Code™ char (2) NULL,

"DrugUnits’ doubl e NULL,
“PrescriptionNunber® varchar(30) NULL,

/* CR1L */

“Pati ent Wi ght ™ varchar (10) NULL,

* Anbul anceTr ansport Code™ char (1) NULL,

* Anbul anceTr ansport ReasonCode™ char (1) NULL,
“TransportDi stance™ varchar (15) NULL,

" RoundTr i pPur poseDescription  varchar (80) NULL,
" Stretcher PurposeDescription  varchar(80) NULL,
/* CRC —Anbul ance Certification */

“ Anbul anceCondi tionlndi cator™ char(1) NULL,
" Anbul anceCondi ti onCodel™ char (3) NULL,

" Anbul anceCondi ti onCode2™ char (3) NULL,

" Anbul anceCondi ti onCode3"™ char (3) NULL,

" Anbul anceCondi ti onCode4™ char (3) NULL,

" Anbul anceCondi ti onCode5™ char (3) NULL,

/* Attending Provider */

" Attendi ngProvi derLast ™ varchar (35) NULL,
“AttendingProviderFirst® varchar(25) NULL,

" At t endi ngProvi der M ddl e* varchar (25) NULL,
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" Attendi ngProvi derSuffix® varchar(10) NULL,
" Attendi ngProviderl DQual © char(2) NULL,
“AttendingProviderl D varchar (35) NULL,

" At t endi ngProvi der @ her I DQual © char (2) NULL,
" Attendi ngProvi der G herl D' varchar(30) NULL,
/* Operating Provider */

" QperatingProviderLast™ varchar (35) NULL,
“QperatingProviderFirst® varchar(25) NULL,

" QperatingProvi derM ddl e varchar (25) NULL,
“QperatingProviderSuffix® varchar(10) NULL,
“QperatingProviderl DQual © char(2) NULL,
“QperatingProviderl D varchar (35) NULL,

" QperatingProvider G herl DQual © char(2) NULL,
“QperatingProviderQherl D varchar(30) NULL,
/* Oher Provider */

“Qther Provi derLast ™ varchar (35) NULL,
"QtherProviderFirst® varchar(25) NULL,
"QtherProviderMddl e varchar (25) NULL,
"QtherProviderSuffix® varchar(10) NULL,
“QtherProviderl DQual © char(2) NULL,
"QtherProviderl D varchar(35) NULL,

"Qher Provi der & herl DQual ° char (2) NULL,
"QherProviderQherl D varchar (30) NULL,

/* Rendering Provider */

" Renderi ngProvi derLast® varchar (35) NULL,

“Renderi ngProvi derFirst® varchar(25) NULL,
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" Renderi ngProvi der M ddl e* varchar (25) NULL,

" Renderi ngProvi der Suffi x~ varchar (10) NULL,

" Renderi ngProvi derl DQual = char (2) NULL,
“RenderingProviderl D varchar(35) NULL,

" Renderi ngProvi der @ her | DQual © char (2) NULL,
“Renderi ngProvi der G herI D' varchar (30) NULL,

/* PurchasedService Provider */

* Pur chasedSer vi ceProvi der Last © varchar (35) NULL,

“ Pur chasedSer vi ceProvi derFirst™ varchar (25) NULL,
* Pur chasedSer vi ceProvi der M ddl e* varchar (25) NULL,
* Pur chasedSer vi ceProvi der Suf fi x> varchar (10) NULL,
" Pur chasedSer vi ceProvi der I DQual © char (2) NULL,

" Pur chasedSer vi ceProvi derI D varchar (35) NULL,

* Pur chasedSer vi ceProvi der @ her I DQual = char (2) NULL,

* Pur chasedSer vi ceProvi der & herI D° varchar (30) NULL,

/* Facility Provider */
“FacilityNane® varchar(35) NULL,
“Facilityl DQual ° char(2) NULL,
“Facilityl D varchar(35) NULL,
“FacilityAddressl® varchar(25) NULL,
“FacilityAddress2® varchar(25) NULL,
“FacilityCGty  varchar(30) NULL,
“FacilityState® char(2) NULL,
“FacilityZi p® varchar (15) NULL,
“FacilityQherl DQual © char(2) NULL,

“FacilityQherl D' varchar(30) NULL,
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/* Supervising Provider */

“ Super vi si ngProvi der Last® varchar (35) NULL,

“ Super vi si ngProviderFirst® varchar(25) NULL,
* Super vi si ngProvi der M ddl e varchar (25) NULL,
* Super vi si ngProvi der Suf fi x* varchar (10) NULL,
* Super vi si ngProvi der | DQual = char (2) NULL,

“ Supervi si ngProviderI D varchar (35) NULL,

“ Super vi si ngProvi der & herl DQual © char (2) NULL,
“ Super vi si ngProviderQ herl D varchar (30) NULL,
/* Odering Provider */
“OrderingProviderLast™ varchar (35) NULL,
“OrderingProviderFirst® varchar (25) NULL,
“OrderingProviderMddl e varchar(25) NULL,
“OrderingProviderSuffix® varchar(10) NULL,
“OrderingProviderl DQual © char(2) NULL,
“OrderingProviderl D varchar(35) NULL,
“OrderingProvider & herl DQual © char(2) NULL,
“OrderingProviderherl D varchar(30) NULL,
/* Referring Provider */
"ReferringProviderLast™ varchar (35) NULL,
"ReferringProviderFirst® varchar(25) NULL,
"ReferringProviderMddl e varchar(25) NULL,
“ReferringProviderSuffix® varchar(10) NULL,
"ReferringProviderl DQual © char(2) NULL,
"ReferringProviderl D varchar(35) NULL,

“ReferringProviderQherl DQual © char(2) NULL,
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“ReferringProviderQherl D varchar(30) NULL,

/*COB 1 */

“Qher Payer 11 D' varchar (30) NULL,

O her Payer 1Pai d* deci mal (10, 2) NULL,

" her Payer 1Pai dProcedure” varchar (30) NULL,

" her Payer 1Pai dRevenueCode™ varchar (30) NULL,

" her Payer 1Pai dQuantity” bigi nt NULL,

" her Payer 1Bundl edLi ne® int NULL,

" her Payer 1Adj ust nent ReasonGr oupl™ char (2) NULL,
" her Payer 1Adj ust nent Reasonl™ varchar (5) NULL,
"t her Payer 1Adj ust nent Amount 1° deci nal (10, 2) NULL,
" her Payer 1Adj ust nent Quantityl®™ bigint NULL,

" her Payer 1Adj ust nent ReasonGr oup2”™ char (2) NULL,
" her Payer 1Adj ust nent Reason2™ var char (5) NULL,

" her Payer 1Adj ust nent Amount 2° deci nal (10, 2) NULL,
" her Payer 1Adj ust nent Quantity2® bigint NULL,

" O her Payer 1Adj ust nent ReasonGr oup3™ char (2) NULL,
" O her Payer 1Adj ust nent Reason3™ var char (5) NULL,

" her Payer 1Adj ust nent Arount 3° deci nal (10, 2) NULL,
" her Payer 1Adj ust nent Quantity3" bigint NULL,

" her Payer 1Adj ust nent ReasonGr oup4™ char (2) NULL,
" her Payer 1Adj ust nent Reason4™ var char (5) NULL,

" her Payer 1Adj ust nent Amount 4° deci nal (10, 2) NULL,
" her Payer 1Adj ust nent Quantity4" bigint NULL,

# O her Payer 1Adj ust nent ReasonG oup5Pl us™ varchar (77) NULL,

# O her Payer 1Adj ust nent Reason5Pl us™ var char (155) NULL,
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# O her Payer 1Adj ust nent Anount 5Pl us™ var char (493) NULL,
# O her Payer 1Adj ust nent Quanti t y5Pl us® varchar (415) NULL,
" her Payer 1Pai dDat e* varchar (15) default NULL,
/*COB 2 */

“Q her Payer 21 D' varchar (30) NULL,

" her Payer 2Pai d* deci mal (10, 2) NULL,

" her Payer 2Pai dProcedure” varchar (30) NULL,

" her Payer 2Pai dRevenueCode™ varchar (30) NULL,

" her Payer 2Pai dQuantity” bigint NULL,

" her Payer 2Bundl edLi ne® int NULL,

" her Payer 2Adj ust nent ReasonGr oupl”™ char (2) NULL,
" O her Payer 2Adj ust nent Reasonl™ varchar (5) NULL,

" her Payer 2Adj ust nent Amount 1° deci nal (10, 2) NULL,
" her Payer 2Adj ust nent Quantityl” bigi nt NULL,

" her Payer 2Adj ust nent ReasonGr oup2”™ char (2) NULL,
" her Payer 2Adj ust nent Reason2™ var char (5) NULL,

" her Payer 2Adj ust nent Amount 2° deci nal (10, 2) NULL,
" her Payer 2Adj ust nent Quantity2™ bigint NULL,

" her Payer 2Adj ust nent ReasonG oup3™ char (2) NULL,
" her Payer 2Adj ust nent Reason3™ var char (5) NULL,

" her Payer 2Adj ust nent Arount 3° deci nal (10, 2) NULL,
" her Payer 2Adj ust nent Quantity3" bigint NULL,

" O her Payer 2Adj ust nent ReasonGr oup4™ char (2) NULL,
" O her Payer 2Adj ust nent Reason4™ var char (5) NULL,

" her Payer 2Adj ust nent Amount 4° deci nal (10, 2) NULL,

" her Payer 2Adj ust nent Quantity4® bigint NULL,
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# O her Payer 2Adj ust nent ReasonG oup5Pl us™ varchar (77) NULL,
# O her Payer 2Adj ust nent Reason5Pl us™ var char (155) NULL,

# O her Payer 2Adj ust nent Anount 5Pl us™ var char (493) NULL,

# O her Payer 2Adj ust nent Quanti t y5Pl us® varchar (415) NULL,

" her Payer 2Pai dDat e® date NULL,

PRIMARY KEY ('1D)

) ENG NE=I nnoDB DEFAULT CHARSET=I at i nl;

5.3.3 Oracle Script to Create Tables

Header

CREATE TABLE EDI_O ai ns(
I D nunber (19) NOT NULL,
/*File Level Data*/
Fi | ename varchar2(100) NULL,
Versi on varchar2(12) NULL,
| mageFi | ePat h varchar2(300) NULL,
| mageFi | enanme var char2(100) NULL,
Tradi ngPart ner| DType char (2) NULL,
Tradi ngPartner| D varchar2(15) NOT NULL,
TransactionDate date NULL,
Recei veDat e date NULL,
Submi tter Nane varchar2(60) NULL,
Submi tterl D varchar2(30) NULL,
Submi tterCont act varchar2(60) NULL,
Submi tterTel varchar2(20) NULL,

Submi tterTel Ext varchar2(10) NULL,
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Submi tter Fax varchar2(20) NULL,
Subm tterEmai | varchar2(80) NULL,
Recei ver Nane var char 2(60) NULL,
Recei ver I D varchar2(30) NULL,
Transacti onType char(2) NULL,
/*Billing Provider*/

FedTax!| D varchar2(15) NULL,

Bi | | Provl DType char(2) NULL,

Bi I | Provl D varchar2(80) NULL,

Bi I | ProvNPl varchar2(12) NULL,

Bi | | ProvLast varchar2(60) NULL,

Bi | | ProvFirst varchar2(35) NULL,

Bi | | ProvM ddl e varchar2(25) NULL,
Bi | | ProvSuffix varchar2(10) NULL,
Bi | | ProvSpeci alty varchar2(10) NULL,
Bi | | ProvAddr ess varchar2(55) NULL,
Bi | | ProvAddress2 varchar2(55) NULL,
Bill ProvGty varchar2(30) NULL,
Bill ProvState char(2) NULL,

Bi || ProvZi p varchar2(15) NULL,

Bi | | ProvCountry varchar2(3) NULL,
Bi | | ProvSubdi vi si on varchar2(3) NULL,
Bi | | ProvCont act varchar2(60) NULL,
Bi | | ProvTel varchar2(80) NULL,

Bi | | ProvTel Ext varchar2(80) NULL,

Bi | | ProvFax varchar2(80) NULL,
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Bi | | ProvEmai | varchar2(80) NULL,

Bi |l ProvQ herl DQual 1 char(2) NULL,
Bi I | ProvQ herl D1 varchar2(30) NULL,
Bi || ProvQ herl DQual 2 char(2) NULL,
Bi || ProvQ herl D2 varchar2(30) NULL,
Bi | | ProvQ herl DQual 3 char(2) NULL,
Bi I | ProvQ herl D3 varchar2(30) NULL,
Bi || ProvQ herl DQual 4 char(2) NULL,
Bi || ProvQ herl D4 varchar2(30) NULL,
Bi || ProvQ herl DQual 5 char(2) NULL,
Bi || ProvQ herl D5 varchar2(30) NULL,
/ *Pay-to Provider*/

PayToPr ovl DType char (2) NULL,

Payt oPr ovl D var char 2(30) NULL,

Payt oPr ovTax| D varchar2(12) NULL,
Payt oPr ovNPl varchar2(12) NULL,

Payt oPr ovLast varchar2(60) NULL,
Payt oPr ovFirst varchar2(35) NULL,
PayToPr ovM ddl e varchar 2(25) NULL,
PayToPr ovSuffi x varchar2(10) NULL,
PayToPr ovSpeci al ty varchar2(10) NULL,
Payt oPr ovAddr ess var char 2(55) NULL,
PayToPr ovAddr ess2 var char 2(55) NULL,
Payt oProvGity varchar2(30) NULL,
Payt oProvState char(2) NULL,

Payt oProvZi p varchar 2(15) NULL,
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/ *Pay-to Payer*/

PayToPayer | DType char (2) NULL,

Payt oPayer | D var char 2(80) NULL,

Payt oPayer Taxl D var char2(12) NULL,
Payt oPayer NPl var char2(12) NULL,

Payt oPayer Last varchar2(60) NULL,
Payt oPayer Fi rst varchar2(35) NULL,
PayToPayer M ddl e varchar 2(25) NULL,
PayToPayer Suf fi x varchar2(10) NULL,
Payt oPayer Addr ess var char 2(55) NULL,
PayToPayer Addr ess2 var char 2(55) NULL,
Payt oPayer Gty varchar2(30) NULL,
Payt oPayer St ate char (2) NULL,

Payt oPayer Zi p varchar 2(15) NULL,

/ *Rendering Provider*/

RendPr ovl DType char (2) NULL,

RendPr ovl D var char 2(30) NULL,

RendPr ovNPI varchar2(12) NULL,
RendPr ovTaxl D varchar2(12) NULL,
RendPr ovLast varchar2(60) NULL,
RendPr ovFirst varchar2(35) NULL,
RendPr ovM ddl e varchar 2(25) NULL,
RendPr ovSuf fi x varchar2(10) NULL,
RendPr ovSpeci al ty varchar2(10) NULL,
RendPr ovQt her I DQual 1 char(2) NULL,

RendPr ovQt her I D1 var char 2(30) NULL,
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RendPr ovQt her | DQual 2 char (2) NULL,
RendPr ovQt her I D2 var char 2(30) NULL,
RendPr ovQt her | DQual 3 char (2) NULL,
RendPr ovQt her I D3 var char 2(30) NULL,
/*Attendi ng Provider*/

AttendProvLast varchar2(60) NULL,
AttendProvFirst varchar2(35) NULL,

At t endPr ovM ddl e var char 2(25) NULL,
AttendProvSuffix varchar2(10) NULL,

At t endPr ovl DType char(2) NULL,

At t endPr ovl D var char 2(30) NULL,

At t endProvTaxl D varchar2(12) NULL,
AttendPr ovNPl varchar2(12) NULL,
AttendProvQ herl DQual 1 char(2) NULL,
AttendProvQ her| D1 varchar2(30) NULL,
Att endProvSpeci alty varchar2(10) NULL,
/*Qperating Provider*/

Qper ati ngProvLast varchar2(60) NULL,
Qper ati ngProvFirst varchar2(35) NULL,
Qper ati ngProvM ddl e varchar 2(25) NULL,
Qper ati ngProvSuffix varchar2(10) NULL,
Qper ati ngProvl DType char(2) NULL,

Qper ati ngProvl D varchar 2(30) NULL,
Qper ati ngProvNPl varchar2(12) NULL,
Qper ati ngProvTaxl D varchar2(12) NULL,

Qper ati ngProvQ her I DQual 1 char (2) NULL,
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Qper ati ngProvQ her| D1 varchar2(30) NULL,
Qper ati ngProvSpeci alty varchar2(10) NULL,
/*CQt her Provider*/

Q her ProvLast varchar2(60) NULL,

CQ her ProvFirst varchar2(35) NULL,

CQ her ProvM ddl e varchar2(25) NULL,

Q her ProvSuf fi x varchar2(10) NULL,

C her Provl DType char (2) NULL,

C her Provl D varchar 2(30) NULL,

Q her ProvTaxI| D varchar2(12) NULL,

G her ProvNPl varchar2(12) NULL,

G her ProvQx herl DQual 1 char (2) NULL,
G herProvQ herI D1 varchar2(30) NULL,
C her ProvSpeci al ty varchar2(50) NULL,
[*Facility*/

FacilityType char(2) NULL,

Facilityl DType char(2) NULL,
Facilityl D varchar2(80) NULL,
FacilityNPl varchar2(12) NULL,
FacilityTaxl D varchar2(12) NULL,
FacilityQherl DQual 1 char(2) NULL,
FacilityQtherl D1 varchar2(30) NULL,
Faci |l i tyNane varchar2(80) NULL,

Faci | i t yAddr ess varchar2(55) NULL,
Faci |l i t yAddress2 varchar 2(55) NULL,

FacilityGQty varchar2(30) NULL,
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Faci litySpecialty varchar2(50) NULL,
FacilityState char(2) NULL,
FacilityZi p varchar2(15) NULL,
/*Referring Provider*/

Ref ProvLast varchar2(60) NULL,

Ref ProvFi rst varchar2(35) NULL,

Ref ProvM ddl e varchar 2(25) NULL,
Ref ProvSuf fi x varchar2(10) NULL,
Ref Provl DType char(2) NULL,

Ref Provl D var char 2(80) NULL,

Ref ProvTax| D varchar2(12) NULL,

Ref ProvNPl varchar2(12) NULL,

Ref ProvQt her | DQual 1 char (2) NULL,
Ref ProvQt her | D1 var char 2(300) NULL,
Ref ProvSpeci al ty varchar2(20) NULL,
/ *Super vi si ng Provi der*/
SupervProvLast varchar2(60) NULL,
SupervProvFi rst varchar2(35) NULL,
SupervProvM ddl e varchar2(25) NULL,
SupervProvSuffi x varchar2(10) NULL,
Super vProvl DType char (2) NULL,
Super vProvl D varchar 2(30) NULL,
Super vProvTaxl D varchar2(12) NULL,
SupervProvNPl varchar2(12) NULL,
SupervProvQ her I DQual 1 char (2) NULL,

SupervProvQ her I D1 var char 2(50) NULL,
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Super vProvSpeci al ty varchar2(20) NULL,
/ *Assi st ant Sur geon*/

Assi st SurgLast varchar2(60) NULL,

Assi st Sur gFirst varchar2(35) NULL,
Assi st Sur gM ddl e varchar 2(25) NULL,
Assi st SurgSuffi x varchar2(10) NULL,
Assi st Sur gl DType char(2) NULL,

Assi st Sur gl D var char 2(30) NULL,

Assi st SurgTax| D varchar2(12) NULL,

Assi st SurgNPl varchar2(12) NULL,

Assi st SurgQ her | DQual 1 varchar 2(3) NULL,

Assi st SurgQ her I D1 varchar 2(50) NULL,
Assi st Sur gSpeci alty varchar2(10) NULL,
/ * Ambul ance Pi ck-up Locati on*/

Pi ckUpAddr ess var char 2(55) NULL,

Pi ckUpAddr ess2 varchar 2(55) NULL,

Pi ckUpQ ty varchar2(30) NULL,

Pi ckUpState char(2) NULL,

Pi ckUpZi p varchar2(15) NULL,

/ * Anbul ance Drop-off Location*/
DropO f Nane var char 2(80) NULL,

Dr opO f Addr ess var char 2(55) NULL,

Dr opO f Addr ess2 var char 2(55) NULL,
DropOfdty varchar2(30) NULL,
DropOfState char(2) NULL,

DropOfZip varchar2(15) NULL,
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/ *Subscri ber*/

Subscri ber Last varchar2(60) NULL,
Subscri ber Fi rst varchar2(35) NULL,
Subscri ber M ddl e varchar2(25) NULL,
Subscri ber Suf fi x varchar2(10) NULL,
Subscri ber Addr ess varchar2(55) NULL,
Subscri ber Addr ess2 var char 2(55) NULL,
Subscri berGty varchar2(30) NULL,
Subscri ber State char (2) NULL,

Subscri ber Zi p varchar2(15) NULL,
Subscri ber Country varchar2(3) NULL,
Subscri ber Subdi vi si on varchar2(3) NULL,
Subscri ber | DType char (2) NULL,

Subscri ber | D varchar 2(30) NULL,
Subscri ber SSN varchar2(12) NULL,
Subscri ber DOB varchar2(10) NULL,
Subscri ber Sex char (1) NULL,

Subscri ber Et hni city varchar 2(55) NULL,
/ *Responsi bl e*/

Responsi bl eLast varchar2(60) NULL,
Responsi bl eFi rst varchar2(35) NULL,
Responsi bl eM ddl e varchar2(25) NULL,
Responsi bl eSuf fi x varchar2(10) NULL,
Responsi bl eAddr ess var char 2(55) NULL,
Responsi bl eAddr ess2 var char 2(55) NULL,

Responsi bl eC ty varchar2(30) NULL,
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Responsi bl eState char (2) NULL,
Responsi bl eZi p varchar2(15) NULL,
Responsi bl el DType char (2) NULL,
Responsi bl el D var char 2(80) NULL,
/*Destination Payer*/

Payer Responsi bility char (1) NULL,
Payer Name var char 2(60) NULL,
Payer | DType char(2) NULL,

Payer | D varchar2(30) NULL,

Payer Addr ess var char 2(55) NULL,
Payer Addr ess2 var char 2(55) NULL,
Payer Gty varchar2(30) NULL,
Payer State char (2) NULL,

Payer Zi p varchar2(15) NULL,

G oupNo var char 2(50) NULL,

G oupNane var char 2(60) NULL,

I nsuranceType char(2) NULL,

Fi l'i ngl ndi cator char(2) NULL,
COBI ndi cator char (1) NULL,
/*Patient*/

Pati ent Last varchar2(60) NULL,
PatientFirst varchar2(35) NULL,
Pati ent M ddl e varchar2(25) NULL,
Pati ent Suf fi x varchar2(10) NULL,
Pat i ent Address var char 2(55) NULL,

Pat i ent Addr ess2 varchar 2(55) NULL,
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Patient Gty varchar2(30) NULL,
PatientState char(2) NULL,

PatientZi p varchar2(15) NULL,

Pati ent Country varchar2(3) NULL,

Pat i ent Subdi vi si on varchar2(3) NULL,
Pati ent | DType char(2) NULL,

Pati ent| D varchar2(30) NULL,

Pati ent SSN varchar2(12) NULL,

Pat i ent DOB var char 2(50) NULL,

Pati ent Sex char (1) NULL,
PatientEthnicity varchar2(35) NULL,
Pati ent Rel ati onshi p char(2) NULL,
Pati ent Pai d varchar2(10) NULL,
Pregnancyl ndi cat or char (1) NULL,
/*COB Payer 1*/

C her I nsuredLast varchar2(60) NULL,
CQ herl nsuredFirst varchar2(35) NULL,
C her I nsuredM ddl e varchar 2(25) NULL,
CQ her I nsuredSuf fi x varchar2(10) NULL,
CQ her I nsur edl DQual char(2) NULL,

C her I nsuredl D varchar 2(30) NULL,

C her I nsur edAddr ess var char 2(55) NULL,
Q her I nsur edAddr ess2 var char 2(55) NULL,
G herlnsuredGty varchar2(30) NULL,
G herlnsuredState char(2) NULL,

CQ herl nsuredZi p varchar2(15) NULL,
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CQ her I nsuredCountry varchar2(3) NULL,

Q her I nsur edSubdi vi si on varchar2(3) NULL,
C herl nsuredPol i cy varchar2(50) NULL,

C her I nsuredDOB var char 2(10) NULL,

CQ herl nsuredSex char (1) NULL,

C herl nsuredRel ati onship char(2) NULL,

C her Payer Responsi bility char(1) NULL,

Q her Payer Nane var char 2(35) NULL,

C her Payer | DQual char(2) NULL,

Q her Payer | D var char 2(30) NULL,

Q her Payer Pai d var char 2(10) NULL,

C her Payer G oupNane var char 2(60) NULL,

Q her Payer GroupNo var char 2(50) NULL,

C her Payer | nsuranceType char (2) NULL,

Q her Payer Fi | i ngl ndi cator char(2) NULL,
C her Payer Adj ReasonGr oup var char2(20) NULL,
C her Payer Adj Reason var char 2(50) NULL,

Q her Payer Adj Anmount var char 2(120) NULL,
C her Payer Pai dDat e date NULL,

Q her Payer | nf oRel ease char (1) NULL,

C her Payer Benefi t Assi gn char (1) NULL,

Q her Payer DocCont rol No var char2(50) NULL,
C her Payer Pri or Aut h varchar 2(50) NULL,

[/ *COB Payer 2*/

Q herl nsured2Last varchar2(60) NULL,

C her I nsured2First varchar2(35) NULL,

© <2003> Martin Scholl Consulting, Inc.



Using the Database 180

C her I nsured2M ddl e varchar 2(25) NULL,
CQ her I nsured2Suffi x varchar2(10) NULL,
C her I nsured2l DQual char(2) NULL,

C her I nsured2l D varchar 2(30) NULL,

Q her I nsur ed2Addr ess var char 2(55) NULL,
C her I nsur ed2Addr ess2 varchar2(55) NULL,
G herlnsured2CG ty varchar2(30) NULL,

G herlnsured2State char(2) NULL,

C her I nsured2Zi p varchar2(15) NULL,

CQ herl nsured2Country varchar2(3) NULL,
Q her I nsur ed2Subdi vi si on varchar2(3) NULL,
C her I nsured2Pol i cy varchar2(50) NULL,
C her I nsured2DOB var char 2(10) NULL,

C her I nsured2Sex char (1) NULL,

Q her I nsured2Rel ati onship char(2) NULL,
Q her Payer 2Responsi bility char(1) NULL,
Q her Payer 2Nane var char 2(35) NULL,

C her Payer 21 DQual char(2) NULL,

Q her Payer 21 D var char 2(80) NULL,

Q her Payer 2Pai d var char2(10) NULL,

Q her Payer 2G oupNane var char 2(60) NULL,
C her Payer 2G oupNo var char 2(50) NULL,

C her Payer 2l nsur anceType char (2) NULL,
C her Payer 2Fi | i ngl ndi cator char(2) NULL,
Q her Payer 2Adj ReasonG oup char (20) NULL,

Q her Payer 2Adj Reason var char 2(50) NULL,
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C her Payer 2Adj Anount var char 2(120) NULL,
C her Payer 2Pai dDat e date NULL,

Q her Payer 21 nf oRel ease char (1) NULL,

C her Payer 2Benefi t Assi gn char (1) NULL,
Q her Payer 2DocCont r ol No var char 2(50) NULL,
Q her Payer 2Pri or Aut h varchar 2(50) NULL,
/*d ai m Dat a*/

C ai MNo varchar2(50) NOT NULL,

Anpunt NUMBER( 19, 4) NULL,

Esti mat edAnount Due var char 2(10) NULL,
Pl aceO Servi ce char(2) NULL,
Subm t Reason char (1) NULL,

Provi der Si gnature char (1) NULL,

Provi der Accept sAssi gnnment char (1) NULL,
Benefi t Assi gnment char (1) NULL,

I nf oRel easeCode char (1) NULL,

Pat i ent Si gnat ureCode char (1) NULL,

Rel at edCauses char(2) NULL,

Rel at edCauses2 char (2) NULL,

Rel at edCausesState char (2) NULL,

Speci al ProgranCode char(3) NULL,

Provi derParticipation char(1) NULL,

EOBI ndi cator char(1) NULL,

Del ayReasonCode char (2) NULL,

Servi ceDat eFrom dat e NULL,

Servi ceDat eTo date NULL,
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Onset Date date NULL,

Si m | ar Synpt onsDat e date NULL,

Di sabilityBegin date NULL,

Di sabilityEnd date NULL,

Hospi tal i zati onBegi n date NULL,

Hospi tal i zati onEnd date NULL,

Acci dent Dat e date NULL,

Last Menstrual Period date NULL,

Repri cer Recei vedDat e date NULL,

Adm ssi onDat e date NULL,

Adm ssi onHour VARCHAR2(10) NULL,

Adm ssi onType char (1) NULL,

Adm ssi onSource char (1) NULL,

Di schar geHour VARCHAR2(10) NULL,

Pati ent Status char(2) NULL,

Cover edDays varchar2(4) NULL,

NonCover edDays varchar2(4) NULL,
COBDays varchar2(4) NULL,

Li f eTi meReser veDays varchar2(4) NULL,
Pri or Aut hori zati on varchar2(50) NULL,
Cl eari ngHousel D var char 2(50) NULL,

Medi cal Recor dNunber var char 2(50) NULL,
Servi ceAut hori zat i onExcepti on varchar2(50) NULL,
Ref erral Nunber varchar2(50) NULL,
Payer C ai mCont r ol Nunber var char2(50) NULL,

Adj ust edRepri cedd ai nNunber varchar 2(50) NULL,
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Aut oAcci dent St at e varchar 2(50) NULL,
O i gRef No varchar 2(50) NULL,

d ai mype char (1) NULL,

TypeOBi || varchar2(20) NULL,
Remar k1 varchar2(90) NULL,

Remar k2 varchar2(90) NULL,

Remar k3 varchar2(90) NULL,

Remar k4 varchar2(90) NULL,

K3_1 varchar2(80) NULL,

K3_2 varchar2(80) NULL,

K3_3 varchar2(80) NULL,

K3_4 varchar2(80) NULL,

K3_5 varchar2(80) NULL,

K3_6 varchar2(80) NULL,

K3_7 varchar2(80) NULL,

K3_8 varchar2(80) NULL,

K3_9 varchar2(80) NULL,

K3_10 varchar2(80) NULL,

CQut si deLab char (1) NULL,

LabChar ge varchar2(10) NULL,

Test _Prod char (1) NULL,

Report TypeCodel char (2) NULL,
Report Transm ssi onCodel varchar2(2) NULL,
At t achnment Cont r ol Nunber 1 var char 2(80) NULL,
/*Dental d aimnms*/

Predeterm nati on char(2) NULL,
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O thodonti cTotal varchar2(5) NULL,
Ot hodonti cRenmi ni ng varchar 2(5) NULL,
Ot hodonti cYesNo char (1) NULL,
Toot hSt at us var char 2( 100) NULL,
Appl i ancePl acenent Dat e date NULL,
/*Di agnosi s | nformation*/

Adm t Di agnosi s varchar2(10) NULL,
ECode varchar2(30) NULL,

ECode2 varchar2(30) NULL,

ECode3 varchar2(30) NULL,

ECode4 varchar2(30) NULL,

ECode5 varchar2(30) NULL,

ECode6 varchar2(30) NULL,

ECode7 varchar2(30) NULL,

ECode8 varchar2(30) NULL,

- - ECode9 varchar2(30) NULL,

- - ECodel0 varchar2(30) NULL,
--ECodell varchar2(30) NULL,
--ECodel2 varchar2(30) NULL,
ReasonFor Vi sit varchar2(30) NULL,
ReasonFor Vi si t 2 varchar2(30) NULL,
ReasonFor Vi si t 3 varchar2(30) NULL,
Pri nci pal Di agnosi s varchar2(10) NULL,
Di ag2 varchar2(10) NULL,

Di ag3 varchar2(10) NULL,

Di ag4 varchar2(10) NULL,
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Di ag5 varchar2(10) NULL,
Di ag6 varchar2(10) NULL,
Di ag7 varchar2(10) NULL,
Di ag8 varchar2(10) NULL,
Di ag9 varchar2(10) NULL,
Di ag10 varchar2(10) NULL,
Di agll varchar2(10) NULL,
Di agl2 varchar2(10) NULL,
Di ag13 varchar2(10) NULL,
Di agl4 varchar2(10) NULL,
Di agl5 varchar2(10) NULL,
Di agl6 varchar2(10) NULL,
Di agl7 varchar2(10) NULL,
Di ag18 varchar2(10) NULL,
Di agl19 varchar2(10) NULL,
Di ag20 varchar2(10) NULL,
Di ag21 varchar2(10) NULL,
Di ag22 varchar2(10) NULL,
Di ag23 varchar2(10) NULL,
Di ag24 varchar2(10) NULL,
Di ag25 varchar2(10) NULL,
DRG var char 2(15) NULL,
/*Procedure | nformation*/
Pri nci pal Procedure varchar2(10) NULL,
Pri nci pal Procedur eDat e date NULL,

Proc2 varchar2(50) NULL,
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Proc2Dat e date NULL,
Proc3 varchar2(10) NULL,
Proc3Dat e date NULL,
Proc4 varchar2(10) NULL,
Proc4Dat e date NULL,
Proc5 varchar2(10) NULL,
Proc5Dat e date NULL,
Proc6 varchar2(10) NULL,
Proc6Dat e date NULL,
Proc7 varchar2(10) NULL,
Proc7Dat e date NULL,
Proc8 varchar2(10) NULL,
Proc8Dat e date NULL,
Proc9 varchar2(10) NULL,
Proc9Dat e date NULL,
Proc10 varchar2(10) NULL,
ProclODat e date NULL,
Procl1l varchar2(10) NULL,
ProcllDate date NULL,
Proc12 varchar2(10) NULL,
Procl2Date date NULL,
Proc13 varchar2(10) NULL,
Procl3Date date NULL,
Proc14 varchar2(10) NULL,
Procl4Date date NULL,

Proc15 varchar2(10) NULL,
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Procl5Dat e date NULL,
Proc16 varchar2(10) NULL,
Procl6Dat e date NULL,
Proc17 varchar2(10) NULL,
Procl7Date date NULL,
Proc18 varchar2(10) NULL,
Procl8Dat e date NULL,
Proc19 varchar2(10) NULL,
Procl9Dat e date NULL,
Proc20 varchar2(10) NULL,
Proc20Dat e date NULL,
Proc21 varchar2(10) NULL,
Proc21Date date NULL,
Proc22 varchar2(10) NULL,
Proc22Dat e date NULL,
Proc23 varchar2(10) NULL,
Proc23Dat e date NULL,
Proc24 varchar2(10) NULL,
Proc24Dat e date NULL,
Proc25 varchar2(10) NULL,
Proc25Dat e date NULL,

/ *Val ue Codes*/

Val ueCodel char (3) NULL,
Val ueAnount 1 var char 2( 10)
Val ueCode2 char (3) NULL,

Val ueAnount 2 var char 2( 10)

NULL,

NULL,
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Val ueCode3 char (3) NULL,

Val ueAnount 3 var char 2(10) NULL,
Val ueCode4 char (3) NULL,

Val ueAnount 4 var char 2(10) NULL,
Val ueCode5 char (3) NULL,

Val ueAnmount 5 var char 2(10) NULL,
Val ueCode6 char (3) NULL,

Val ueAnount 6 var char 2(10) NULL,
Val ueCode7 varchar2(10) NULL,
Val ueAnount 7 var char 2(10) NULL,
Val ueCode8 char (3) NULL,

Val ueAnount 8 var char 2(10) NULL,
Val ueCode9 char (3) NULL,

Val ueAmount 9 var char 2(10) NULL,
Val ueCodel0 char (3) NULL,

Val ueAnount 10 var char 2(10) NULL,
Val ueCodell char (3) NULL,

Val ueAnount 11 var char 2(10) NULL,
Val ueCodel2 char (3) NULL,

Val ueAnount 12 var char 2(10) NULL,
--Val ueCodel3 char (3) NULL,

- - Val ueAnount 13 varchar 2(10) NULL,
--Val ueCodel4 char (3) NULL,

- - Val ueAnount 14 var char 2(10) NULL,
--Val ueCodel5 char (3) NULL,

- - Val ueAnount 15 varchar 2(10) NULL,
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--Val ueCodel6 char (3) NULL,
--Val ueAnount 16 var char 2( 10)
--Val ueCodel7 char (3) NULL,
--Val ueAnount 17 var char 2( 10)
--Val ueCodel8 char (3) NULL,
- - Val ueAnount 18 var char 2( 10)
--Val ueCodel9 char (3) NULL,
- - Val ueAnount 19 var char 2( 10)
--Val ueCode20 char (3) NULL,
- - Val ueAnount 20 var char 2( 10)
--Val ueCode21 char (3) NULL,
--Val ueAnount 21 var char 2( 10)
--Val ueCode22 char (3) NULL,
- - Val ueAnount 22 var char 2( 10)
--Val ueCode23 char (3) NULL,
- - Val ueAnount 23 var char 2( 10)
--Val ueCode24 char (3) NULL,
- - Val ueAnount 24 var char 2( 10)
/*Condi ti on Codes*/

Condi ti onCodel var char 2(30)
Condi ti onCode2 var char 2(30)
Condi ti onCode3 var char 2( 30)
Condi ti onCode4 var char 2( 30)
Condi ti onCode5 var char 2( 30)
Condi ti onCode6 var char 2( 30)

Condi ti onCode7 var char 2( 30)

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,

NULL,
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Condi ti onCode8 var char 2(30) NULL,

Condi ti onCode9 varchar2(30) NULL,

Condi ti onCodel0 varchar2(30) NULL,

--Condi tionCodell

--Condi ti onCodel2

--Condi ti onCodel3

--Condi ti onCodel4d

--Condi ti onCodel5

--Condi ti onCodel6

--Condi ti onCodel?7

--Condi ti onCodel8

--Condi ti onCodel9

--Condi ti onCode20

--Condi ti onCode21

--Condi ti onCode22

--Condi ti onCode23

--Condi ti onCode24

var char 2( 30)
var char 2( 30)
var char 2( 30)
var char 2( 30)
var char 2( 30)
var char 2( 30)
var char 2( 30)
var char 2( 30)
var char 2( 30)
var char 2( 30)
var char 2( 30)
var char 2( 30)
var char 2( 30)

var char 2( 30)

/*CQccurrence Codes*/

CccurranceCodel char(3) NULL

CccurranceDat el date NULL,

CccurranceCode2 char(3) NULL

CccurranceDat e2 date NULL,

CccurranceCode3 char(3) NULL

CccurranceDat e3 date NULL,

CccurranceCode4 char(3) NULL

CccurranceDat e4 date NULL,

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL

NULL
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CccurranceCode5 char (3) NULL,

CccurranceDat e5 date NULL,

CccurranceCode6 char(3) NULL,

CccurranceDat e6 date NULL,

CccurranceCode7 char(3) NULL,

CccurranceDat e7 date NULL,

CccurranceCode8 char (3) NULL,

CccurranceDat e8 date NULL,

--QccurranceCode9 char(3) NULL,

--CccurrancebDat €9 date NULL,

--CccurranceCodel0

--CQccurrancebDat el0

--CccurranceCodell

--CQccurrancebDat ell

--CccurranceCodel?2

--CQccurrancebDat el2

--CccurranceCodel3

--CccurrancebDat el3

--CccurranceCodel4d

--CccurrancebDat el4

--CccurranceCodel5

--CQccurrancebDat el5

--CccurranceCodel6

--CccurrancebDat el6

--CccurranceCodel?

--CQccurrancebDat el7

char (3) NULL,
date NULL,
char (3) NULL,
date NULL,
char (3) NULL,
date NULL,
char (3) NULL,
date NULL,
char (3) NULL,
date NULL,
char (3) NULL,
date NULL,
char (3) NULL,
date NULL,
char (3) NULL,

date NULL,
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--QccurranceCodel8 char(3) NULL,
--CccurranceDat e18 date NULL,
--QccurranceCodel9 char(3) NULL,
--CccurranceDat e19 date NULL,
--QccurranceCode20 char(3) NULL,
--CccurranceDat e20 date NULL,
--QccurranceCode2l1 char(3) NULL,
--CccurranceDat e21 date NULL,
--QccurranceCode22 char(3) NULL,
--CccurranceDat e22 date NULL,
--QccurranceCode23 char(3) NULL,
--CccurranceDat e23 date NULL,
--QccurranceCode24 char(3) NULL,
--CccurranceDat e24 date NULL,
CccurranceSpanCodel char (3) NULL,
CccurranceSpanFronl date NULL,
CccurranceSpanTol date NULL,
CccurranceSpanCode2 char (3) NULL,
CccurranceSpanFron2 date NULL,
CccurranceSpanTo2 date NULL,
CccurranceSpanCode3 char (3) NULL,
CccurranceSpanFron8 date NULL,
CccurranceSpanTo3 date NULL,
CccurranceSpanCode4 char (3) NULL,
CccurranceSpanFromd date NULL,

CccurranceSpanTo4 date NULL,
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/*CR1*/

Pat i ent Wi ght varchar2(10) NULL,

Anbul anceTr ansport Code char (1) NULL,

Anbul anceTr anspor t ReasonCode char (1) NULL,

Transport D st ance varchar2(15) NULL,

RoundTri pPur poseDescri pti on varchar2(80) NULL,

St r et cher Pur poseDescri pti on varchar 2(80) NULL,

/* CRC —Anbul ance Certification */

Anbul anceCondi ti onl ndi cator char (1) NULL,
Anbul anceCondi ti onCodel char(3) NULL,
Anbul anceCondi ti onCode2 char (3) NULL,
Anbul anceCondi ti onCode3 char (3) NULL,
Anbul anceCondi ti onCode4 char (3) NULL,
Anbul anceCondi ti onCode5 char (3) NULL,

/ *Repri ci ng*/

Repri cedd ai mM\unber varchar2(50) NULL,
Repri ci nghet hodol ogy varchar2(3) NULL,
Repri cedAmount nunber (19, 4) NULL,

Savi ngsAnount nunber (19, 4) NULL,
Repricer| D varchar2(30) NULL,

Repri ci ngRat e varchar2(9) NULL,

APG Code varchar2(30) NULL,

APG_Anount nunber (19, 4) NULL,

Appr ovedRevenueCode varchar2 (48) NULL,
Appr ovedPr ocedur eCode varchar2 (48) NULL,

Appr ovedUni t Code char (2) NULL,
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ApprovedUni ts nunber (19) NULL,
Rej ect Reason varchar 2(3) NULL,
Conpl i anceCode varchar2(2) NULL,
Excepti onCode varchar2(2) NULL,
/*SQL To EDI */

--[dai mAction] char(1) NULL,

--[ Error Message] varchar2(1000) NULL
) NOLOGA NG
NOCOMPRESS
NOCACHE
NOPARAL LEL

MONI TORI NG

create sequence edi _clains_seq start with 1 increnment by 1;

create or replace trigger edi_clains_trigger
before insert on ED _d ains
REFERENCI NG NEW AS newr ow
for each row
begi n
sel ect edi _clains_seq.nextval into :newow. ID fromdual;

end;

Detail

CREATE TABLE EDI _C ai nDet ai | (
I D nunmber (19) NOT NULL,

d ai M D nunber (19) NOT NULL,
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Li neNunber nunber (18, 0) NULL,

Li nel D varchar 2(50) NULL,

Ser vi ceDat eFr om var char 2(50) NULL,

Servi ceDat eTo varchar2(50) NULL,
Assessnent Dat e var char 2(50) NULL,
Faci |l i tyCode varchar2(50) NULL,
RevenueCode varchar 2(50) NULL,

Procedur eCode var char 2(50) NULL,

Amount var char 2(50) NULL,
Unit varchar2(50) NULL,
Quantity varchar2(50) NULL,
Uni t Rat e varchar2(50) NULL,
NonCover ed varchar2(50) NULL,
Pai d varchar2(50) NULL,

Pl aceX Servi ce char(3) NULL,
Modi fierl char(3) NULL,

Modi fier2 char(3) NULL,

Modi fier3 char(3) NULL,

Modi fierd4 char(3) NULL,

Procedur eDescri pti on varchar2(80) NULL,

O al Cavi tyDesi gnati onl char (3)
O al Cavi tyDesi gnati on2 char (3)
O al Cavi tyDesi gnati on3 char (3)
O al Cavi tyDesi gnati ond4 char (3)
O al Cavi tyDesi gnati on5 char (3)

Di agPoi nter1l char(1) NULL,

NULL,

NULL,

NULL,

NULL,

NULL,
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Di agPoi nter2 char(1) NULL,

Di agPoi nter3 char(1) NULL,

Di agPoi nter4 char(1) NULL,

Toot hNunber char (2) NULL,
Surface varchar2(10) NULL,

Ener gencyl ndi cator char (1) NULL,
Servi ceTax nunber (19, 4) NULL,
FacilityTax nunber (19, 4) NULL,
Sal esTax nunber (19, 4) NULL,

Appr ovedAnount nunber (19, 4) NULL,
Li neK3_01 varchar2(80) NULL,

Li

nekK3_02 varchar2(80) NULL,

Li

nekK3_03 varchar2(80) NULL,

Li

nekK3 04 varchar2(80) NULL,

Li

nekK3_05 varchar2(80) NULL,

Li

nekK3_06 varchar2(80) NULL,

Li

neK3_07 varchar2(80) NULL,

Li

nekK3_08 varchar2(80) NULL,

Li

nekK3_09 varchar2(80) NULL,

Li neK3_10 varchar2(80) NULL,
Remar k var char 2(100) NULL,

Anbul ancePat i ent Count bi gi nt NULL,
[ %k ko PYKF ** % |

Report Type char (2) NULL,

Report Transm ssi on char (2) NULL,

At t achnent Cont r ol Nunber var char2(80) NULL,
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[ *HCP* |

Repri ci nghet hodol ogy varchar2(3) NULL,
Repri cedAmount nunber (19, 4) NULL,

Savi ngsAnount nunber (19, 4) NULL,
Repricer| D varchar2(30) NULL,

Repri ci ngRat e varchar2(9) NULL,

APG Code varchar2(30) NULL,

APG_Anount nunber (19, 4) NULL,

Appr ovedRevenueCode varchar2 (48) NULL,
Appr ovedPr ocedur eCode varchar2 (48) NULL,
Appr ovedUni t Code char (2) NULL,
ApprovedUni ts nunber (19) NULL,

Rej ect Reason varchar 2(3) NULL,

Conpl i anceCode varchar2(2) NULL,
Excepti onCode varchar2(2) NULL,

/* Drugs */

DrugCode varchar2(48) NULL,

DrugUni t Price nunber (19, 4) NULL,
DrugUni t Code char(2) NULL,

DrugUnits float NULL,

Prescri pti onNunber varchar2(30) NULL,
/* CR1L */

Pat i ent Wi ght varchar2(10) NULL,

Anbul anceTr ansport Code char (1) NULL,
Anbul anceTr anspor t ReasonCode char (1) NULL,

Transport D st ance varchar2(15) NULL,
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RoundTri pPur poseDescri pti on varchar2(80) NULL,
St r et cher Pur poseDescri pti on varchar2(80) NULL,
/* CRC —Anbul ance Certification */

Anbul anceCondi ti onl ndi cator char (1) NULL,
Anbul anceCondi ti onCodel char(3) NULL,

Anbul anceCondi ti onCode2 char (3) NULL,

Anbul anceCondi ti onCode3 char (3) NULL,

Anbul anceCondi ti onCode4 char (3) NULL,

Anbul anceCondi ti onCode5 char (3) NULL,

/* Attending Provider */

At t endi ngProvi der Last varchar 2(35) NULL,
At t endi ngProvi der Fi rst varchar2(25) NULL,
At t endi ngProvi der M ddl e varchar 2(25) NULL,
At t endi ngProvi der Suf fi x varchar2(10) NULL,
At t endi ngProvi der | DQual char(2) NULL,
At t endi ngProvi der | D varchar2(35) NULL,
At t endi ngProvi der & her | DQual char (2) NULL,
At t endi ngProvi der & her I D varchar2(30) NULL,
/* Operating Provider */

Qper ati ngProvi der Last varchar2(35) NULL,
Qper ati ngProvi der Fi rst varchar2(25) NULL,
Qper ati ngProvi der M ddl e varchar2(25) NULL,
Qper at i ngProvi der Suf fi x varchar2(10) NULL,
Qper ati ngProvi der | DQual char(2) NULL,

Qper ati ngProvi der | D varchar 2(35) NULL,

Qper at i ngProvi der @ her I DQual char (2) NULL,
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Qper at i ngPr ovi der @ her I D var char 2(30) NULL,
/* Oher Provider */

C her Provi der Last varchar2(35) NULL,

C her Provi der First varchar2(25) NULL,

C her Provi der M ddl e varchar 2(25) NULL,

C her Provi der Suf fi x varchar2(10) NULL,

C her Provi der | DQual char (2) NULL,

CQ her Provi der | D varchar 2(35) NULL,

C her Provi der @ her | DQual char (2) NULL,

CQ her Provi der @ her I D varchar 2(30) NULL,

/* Rendering Provider */

Render i ngProvi der Last varchar 2(35) NULL,
Renderi ngProvi der First varchar2(25) NULL,
Render i ngProvi der M ddl e varchar2(25) NULL,
Render i ngProvi der Suf fi x varchar2(10) NULL,
Render i ngProvi der | DQual char(2) NULL,
Render i ngProvi der | D varchar2(35) NULL,
Render i ngProvi der & her | DQual char (2) NULL,
Render i ngProvi der & her I D var char 2(30) NULL,
/* PurchasedService Provider */

Pur chasedSr vProvi der Last var char 2(35) NULL,

Pur chasedSr vProvi der Fi rst varchar 2(25) NULL,

Pur chasedSr vProvi der M ddl e varchar 2(25) NULL,

Pur chasedSr vProvi der Suffi x varchar2(10) NULL,

Pur chasedSr vProvi der | DQual char (2) NULL,

Pur chasedSr vProvi der I D var char 2(35) NULL,
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Pur chasedSr vProvQt her | DQual char (2) NULL,
Pur chasedSr vProvQt her I D var char 2(30) NULL,
/* Facility Provider */

Faci |l i tyNane varchar2(35) NULL,

Facilityl DQual char(2) NULL,

Facilityl D varchar2(35) NULL,

Faci |l i t yAddressl varchar2(25) NULL,

Faci | i t yAddress2 varchar 2(25) NULL,
FacilityGQty varchar2(30) NULL,
FacilityState char(2) NULL,

FacilityZi p varchar2(15) NULL,

FacilityQ herl DQual char(2) NULL,
FacilityQherl D varchar2(30) NULL,

/* Supervising Provider */

Super vi si ngPr ovi der Last varchar 2(35) NULL,
Super vi si ngProvi der Fi rst varchar 2(25) NULL,
Super vi si ngPr ovi der M ddl e varchar2(25) NULL,
Super vi si ngPr ovi der Suf fi x varchar2(10) NULL,
Super vi si ngPr ovi der | DQual char (2) NULL,
Super vi si ngPr ovi der | D var char 2(35) NULL,
Super vi si ngPr ovi der @ her | DQual char (2) NULL,
Super vi si ngPr ovi der @ her I D var char 2(30) NULL,
/* Odering Provider */

O deri ngProvi der Last varchar 2(35) NULL,

O deringProviderFi rst varchar2(25) NULL,

O deri ngProvi der M ddl e varchar2(25) NULL,
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O deringProvi der Suffi x varchar2(10) NULL,
O deri ngProvi derl DQual char (2) NULL,
O deringProviderl D varchar 2(35) NULL,

O deri ngProvi der @ her | DQual char(2) NULL,

O deri ngProvi der @ her I D var char 2(30) NULL,

/* Referring Provider */
Ref erri ngProvi der Last varchar 2(35) NULL,

Ref erringProvi der First varchar2(25) NULL,

Ref erri ngProvi der M ddl e varchar2(25) NULL,

Ref erringProvi der Suf fi x varchar2(10) NULL,

Ref erringProvi der | DQual char(2) NULL,

Ref erringProvi der| D varchar2(35) NULL,

Ref erringProvi der & her |1 DQual char (2) NULL,

Ref erri ngProvi der & her| D varchar 2(30) NULL,

/[*COB 1 */
C her Payer 11 D var char 2(30) NULL,

Q her Payer 1Pai d nunber (19, 4) NULL,

C her Payer 1Pai dProcedur e varchar2(30) NULL,

Q her Payer 1Pai dRevenueCode var char 2(30) NULL,

Q her Payer 1Pai dQuantity nunber (19) NULL,
Q her Payer 1Bundl edLi ne int NULL,

Q her Payer 1Adj ReasonG oupl char(2) NULL,
Q her Payer 1Adj Reasonl varchar2(5) NULL,
C her Payer 1Adj Anount 1 nunber (19, 4) NULL,
Q her Payer 1Adj Quantityl nunber (19) NULL,

Q her Payer 1Adj ReasonG oup2 char(2) NULL,
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Q her Payer 1Adj Reason2 varchar 2(5) NULL,

C her Payer 1Adj Anount 2 nunber (19, 4) NULL,

C her Payer 1Adj Quantity2 nunber (19) NULL,

C her Payer 1Adj ReasonG oup3 char(2) NULL,

Q her Payer 1Adj Reason3 varchar 2(5) NULL,

C her Payer 1Adj Anount 3 nunber (19, 4) NULL,

C her Payer 1Adj Quanti ty3 nunber (19) NULL,

C her Payer 1Adj ReasonG oup4 char (2) NULL,

Q her Payer 1Adj Reason4 var char 2(5) NULL,

C her Payer 1Adj Anount 4 nunber (19, 4) NULL,

C her Payer 1Adj Quanti ty4 nunber (19) NULL,

- - O her Payer 1Adj ReasonG p5Pl us varchar2(77) NULL,
- - O her Payer 1Adj Reason5Pl us var char 2(155) NULL,
- - O her Payer 1Adj Anmount 5Pl us var char 2(493) NULL,
-- O her Payer 1Adj Quanti t y5Pl us varchar2(415) NULL,
C her Payer 1Pai dDat e date NULL,

/*COB 2 */

Q her Payer 21 D var char 2(30) NULL,

Q her Payer 2Pai d nunber (19, 4) NULL,

C her Payer 2Pai dProcedur e varchar2(30) NULL,

Q her Payer 2Pai dRevenueCode var char 2(30) NULL,
Q her Payer 2Pai dQuantity nunber (19) NULL,

Q her Payer 2Bundl edLi ne int NULL,

Q her Payer 2Adj ReasonG oupl char(2) NULL,

Q her Payer 2Adj Reasonl varchar 2(5) NULL,

Q her Payer 2Adj Anount 1 nunber (19, 4) NULL,
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C her Payer 2Adj Quantityl nunber (19) NULL,

C her Payer 2Adj ReasonG oup2 char(2) NULL,

Q her Payer 2Adj Reason2 varchar 2(5) NULL,

C her Payer 2Adj Anount 2 nunber (19, 4) NULL,

C her Payer 2Adj Quantity2 nunber (19) NULL,

C her Payer 2Adj ReasonG oup3 char(2) NULL,

Q her Payer 2Adj Reason3 var char 2(5) NULL,

C her Payer 2Adj Anount 3 nunber (19, 4) NULL,

C her Payer 2Adj Quanti ty3 nunber (19) NULL,

C her Payer 2Adj ReasonG oup4 char (2) NULL,

Q her Payer 2Adj Reason4 var char 2(5) NULL,

C her Payer 2Adj Anount 4 nunber (19, 4) NULL,

C her Payer 2Adj Quanti ty4 nunber (19) NULL,

- - O her Payer 2Adj ReasonG p5Pl us varchar2(77) NULL,
- - O her Payer 2Adj Reason5Pl us var char 2(155) NULL,

- - O her Payer 2Adj Amount 5Pl us var char 2(493) NULL,
-- O her Payer 2Adj Quanti t y5Pl us varchar2(415) NULL,

C her Payer 2Pai dDat e date NULL
) NOLOGA NG
NOCOMPRESS
NOCACHE
NOPARAL LEL

MONI TORI NG

create sequence edi _claindetail _seq start with 1 increnent by 1;

create or replace trigger edi_claindetail _trigger
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before insert on EDI_C ai nDetail
REFERENCI NG NEW AS newr ow
for each row
begi n
sel ect edi _claindetail _seq.nextval into :newow |ID fromdual;

end;

5.3.4 Microsoft Access Script to Create Tables

We do not recommend Access.

It has limitations and problems that make it unacceptable for business solutions. If price
is an issue, we recommend the free MySQL software. This is a free, industrial strength
Open Source database available at www.MySOQL.com

CREATE TABLE edi _claims (
I D INT NOT NULL AUTO_| NCREMENT KEY,
C ai Mo varchar (50) NOT NULL ,
H PAAsui tel D varchar (9) NULL ,
Tradi ngPartner| DType char (2) NULL ,
Tradi ngPartner| D varchar (15) NOT NULL ,
Submi tter Nane varchar (35) NULL ,
Submitterl D varchar (30) NULL ,
Submi tterContact varchar (60) NULL ,
Submi tterTel varchar (20) NULL ,
Submi tterTel Ext varchar (10) NULL ,
Submi tterFax varchar (20) NULL ,
Submi tter Enail varchar (80) NULL ,
Recei ver Name varchar (35) NULL ,

Bi | | Provl DType char (2) NULL ,
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Bi || Provli D varchar (80) NULL ,

Bi | | ProvLast varchar (35) NULL ,

Bi || ProvFirst varchar (25) NULL ,

Bi || ProvM ddl e varchar (25) NULL ,

Bi |l ProvSuffix varchar (10) NULL ,

Bi | | ProvSpeci alty varchar (10) NULL ,
Bi | | ProvAddress varchar (55) NULL ,
Bi | | ProvAddress2 varchar (55) NULL ,
BillProvGty varchar (30) NULL ,
BillProvState char (2) NULL ,

Bill ProvZip varchar (15) NULL ,

Bi | | ProvCont act varchar (60) NULL ,
Bi |l ProvTel varchar (80) NULL ,

Bi | | ProvTel Ext varchar (80) NULL ,

Bi | | ProvFax varchar (80) NULL ,

Bi || ProvEmai |l varchar (80) NULL ,
PayToPr ovl DType char (2) NULL ,

Payt oProvl D varchar (80) NULL ,

Payt oProvLast varchar (35) NULL ,
Payt oPr ovFirst varchar (25) NULL ,
PayToPr ovM ddl e varchar (25) NULL ,
PayToProvSuffi x varchar (10) NULL ,
PayToProvSpeci alty varchar (10) NULL ,
Payt oPr ovAddr ess varchar (55) NULL ,
PayToPr ovAddr ess2 varchar (55) NULL ,

Payt oProvCity varchar (30) NULL ,
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Payt oProvState char (2) NULL ,

Payt oProvZi p varchar (15) NULL ,

RendPr ovl DType char (2) NULL ,

RendPr ovl D varchar (80) NULL ,
RendProvLast varchar (35) NULL ,

RendPr ovFirst varchar (25) NULL ,
RendPr ovM ddl e varchar (25) NULL ,
RendProvSuffix varchar (10) NULL ,
RendPr ovSpeci alty varchar (10) NULL ,
AttendProvLast varchar (35) NULL ,
AttendProvFirst varchar (25) NULL ,
AttendProvM ddl e varchar (25) NULL ,
AttendProvSuffix varchar (10) NULL ,

At tendPr ovl DType char (2) NULL ,
AttendProvl D varchar (80) NULL ,
AttendProvSpeci alty varchar (10) NULL ,
Qper ati ngProvLast varchar (35) NULL ,
Qper ati ngProvFirst varchar (25) NULL ,
Qper ati ngProvM ddl e varchar (25) NULL ,
Qper ati ngProvSuffix varchar (10) NULL ,
Qper ati ngProvl DType char (2) NULL ,
Qper ati ngProvl D varchar (80) NULL ,
Qper ati ngProvSpeci alty varchar (10) NULL ,
Q her ProvLast varchar (35) NULL ,

G herProvFirst varchar (25) NULL ,

CQ her ProvM ddl e varchar (25) NULL ,
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CQ her ProvSuf fix varchar (10) NULL ,
C her Provl DType varchar (100) NULL ,

G herProvl D varchar (100) NULL ,

CQ herProvSpeci alty varchar (100) NULL ,

FacilityType char (2) NULL ,
Facilityl DType char (2) NULL ,
Facilityl D varchar (80) NULL ,
FacilityNane varchar (80) NULL ,
Faci |l i tyAddress varchar (55) NULL ,
Faci |l i tyAddress2 varchar (55) NULL ,

FacilityGty varchar (30) NULL ,

FacilitySpecialty varchar (100) NULL ,

FacilityState char (2) NULL ,
FacilityZi p varchar (15) NULL ,
Qut si deLab char (1) NULL ,
LabCharge varchar (10) NULL ,
Subscri ber Last varchar (35) NULL ,
Subscri ber First varchar (25) NULL ,
Subscri ber M ddl e varchar (25) NULL ,
Subscri ber Suffi x varchar (10) NULL ,

Subscri ber Address varchar (55) NULL ,

Subscri ber Address2 varchar (55) NULL ,

Subscri berCity varchar (30) NULL ,
Subscri ber State char (2) NULL ,
Subscri berZi p varchar (15) NULL ,

Subscri ber | DType char (2) NULL ,
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Subscri ber1 D varchar (80) NULL ,
Subscri ber DOB varchar (10) NULL ,
Subscri ber Sex char (1) NULL ,

I nsuranceType char (2) NULL ,
GroupNo varchar (50) NULL ,

G oupName varchar (60) NULL ,
Filingl ndicator char (2) NULL ,

Pati ent Last varchar (35) NULL ,
PatientFirst varchar (25) NULL ,
Pati ent M ddl e varchar (25) NULL ,
Pati ent Suffi x varchar (10) NULL ,
Pat i ent Address varchar (55) NULL ,
Pat i ent Address2 varchar (55) NULL ,
Patientdty varchar (30) NULL ,
PatientState char (2) NULL ,
PatientZi p varchar (15) NULL ,

Pati ent| DType char (2) NULL ,
Patientl D varchar (80) NULL ,

Pati ent DOB varchar (50) NULL ,

Pati ent Sex char (1) NULL ,

Pati ent Rel ati onship char (2) NULL ,
Pati ent Pai d varchar (10) NULL ,
Pregnancyl ndi cator char (1) NULL ,
CQ herl nsuredLast varchar (35) NULL ,
G herlnsuredFirst varchar (25) NULL ,

CQ herl nsuredM ddl e varchar (25) NULL ,
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CQ herl nsuredSuf fix varchar (10) NULL ,
CQ herl nsuredPol i cy varchar (50) NULL ,
C her I nsuredDOB var char (10) NULL ,

G herlnsuredSex char (1) NULL ,

CQ herl nsuredRel ati onship char (2) NULL ,
Q her Payer Nane varchar (35) NULL ,

C her Payer | D varchar (80) NULL ,

C her Payer Pai d varchar (10) NULL ,

C her Payer G oupNane varchar (100) NULL ,
C her Payer G oupNo varchar (100) NULL ,
Payer Narme varchar (35) NULL ,

Payer | DType char (2) NULL ,

Payer | D varchar (80) NULL ,

Payer Address varchar (55) NULL ,

Payer Address2 varchar (55) NULL ,

Payer Gty varchar (30) NULL ,

Payer State char (2) NULL ,

Payer Zi p varchar (15) NULL ,

Amount varchar (50) NULL ,

Esti mat edAnount Due varchar (10) NULL ,
Pl aceO Service char (2) NULL ,
Subm t Reason char (1) NULL ,

Provi der Signature char (1) NULL ,

Provi der Accept sAssi gnment char (1) NULL ,
Benefit Assi gnment char (1) NULL ,

I nf oRel easeCode char (1) NULL ,
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Pati ent Si gnat ureCode char (1) NULL ,
Rel at edCauses char (2) NULL ,

Rel at edCausesState char (2) NULL ,
Speci al ProgranCode char (3) NULL ,
Provi derParticipation char (1) NULL ,
Servi ceDat eFrom varchar (15) NULL ,
Servi ceDat eTo varchar (15) NULL ,
(nsetDate varchar (15) NULL ,

Si m | ar Synpt onsDat e varchar (10) NULL ,
Di sabilityBegi n varchar (10) NULL ,

Di sabilityEnd varchar (10) NULL ,

Hospi tal i zati onBegi n varchar (20) NULL ,
Hospi tal i zati onEnd varchar (10) NULL ,
Acci dent Date varchar (20) NULL ,

Adm ssi onDate varchar (15) NULL ,

Adm ssi onHour varchar (10) NULL ,

Adm ssi onType char (1) NULL ,

Adm ssi onSource char (1) NULL ,

Di schargeHour varchar (10) NULL ,
Patient Status char (2) NULL ,

Medi cal Recor dNunber varchar (50) NULL ,
Cover edDays varchar (4) NULL ,

NonCover edDays varchar (4) NULL ,
COBDays varchar (4) NULL ,

Li f eTi mreReserveDays varchar (4) NULL ,

PriorAut hori zati on varchar (50) NULL ,
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Oi gRef No varchar (50) NULL ,

Ref ProvLast varchar (35) NULL ,

Ref ProvFirst varchar (25) NULL ,

Ref ProvM ddl e varchar (25) NULL ,

Ref ProvSuf fi x varchar (10) NULL ,

Ref Provl DType char (2) NULL ,

Ref Provl D varchar (80) NULL ,

Ref ProvSpeci alty varchar (10) NULL ,
Adm t D agnosi s varchar (10) NULL ,
ECode varchar (100) NULL ,

Princi pal Di agnosi s varchar (10) NULL ,
D ag2 varchar (10) NULL ,

Di ag3 varchar (10) NULL ,

D ag4 varchar (10) NULL ,

D ags varchar (10) NULL ,

Di ag6 varchar (10) NULL ,

Di ag7 varchar (10) NULL ,

Di ag8 varchar (10) NULL ,

D ag9 varchar (10) NULL ,

Princi pal Procedure varchar (10) NULL ,
Princi pal ProcedurebDat e varchar (10) NULL ,
Proc2 varchar (50) NULL ,

Proc2Dat e varchar (10) NULL ,

Proc3 varchar (10) NULL ,

Proc3Date varchar (10) NULL ,

Proc4 varchar (10) NULL ,
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Proc4Dat e varchar (10) NULL
Proc5 varchar (10) NULL
Proc5Dat e varchar (10) NULL
Proc6 varchar (10) NULL
Proc6Dat e varchar (10) NULL

DRG varchar (15) NULL

Val ueCodel char (3) NULL ,

Val ueAnmount 1 varchar (10) NULL ,
Val ueCode2 char (3) NULL ,

Val ueAnount 2 varchar (10) NULL ,
Val ueCode3 char (3) NULL ,

Val ueAnount 3 varchar (10) NULL ,
Val ueCode4 char (3) NULL ,

Val ueAnmount 4 varchar (10) NULL ,
Val ueCode5 char (3) NULL ,

Val ueAnmount 5 varchar (10) NULL ,
Val ueCode6 char (3) NULL ,

Val ueAnmount 6 varchar (10) NULL ,
Val ueCode7 varchar (10) NULL ,
Val ueAnount 7 varchar (10) NULL ,
Val ueCode8 char (3) NULL ,

Val ueAnount 8 varchar (10) NULL ,
Val ueCode9 char (3) NULL ,

Val ueAnmount 9 varchar (10) NULL ,
Val ueCodel0 char (3) NULL

Val ueAnount 10 varchar (10) NULL
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Val ueCodell char (3) NULL

Val ueAnount 11 v

archar (10) NULL ,

Val ueCodel2 char (3) NULL

Val ueAnount 12 v

Condi ti onCodel

Condi ti onCode2

Condi ti onCode3

Condi ti onCode4

Condi t i onCode5

Condi ti onCode6

Condi t i onCode7

Condi ti onCode8

archar (10) NULL ,

varchar (30) NULL ,
varchar (30) NULL ,
varchar (30) NULL ,
varchar (30) NULL ,
varchar (30) NULL ,
varchar (30) NULL ,
varchar (30) NULL ,

varchar (30) NULL ,

Fi | eName varchar (100) NULL

CccurranceCodel

CccurrancebDat el

CccurranceCode2

CccurrancebDat e2

CccurranceCode3

CccurrancebDat e3

CccurranceCode4

CccurrancebDat e4

CccurranceCodeb

CccurrancebDat eb

CccurranceCode6

CccurrancebDat e6

CccurranceCode?

char (3) NULL

varchar (10) NULL

char (3) NULL

varchar (10) NULL

char (3) NULL

varchar (10) NULL

char (3) NULL

varchar (10) NULL

char (3) NULL

varchar (10) NULL

char (3) NULL

varchar (10) NULL

char (3) NULL

© <2003> Martin Scholl Consulting, Inc.



Using the Database 214

CccurrancebDat e7 varchar (10) NULL ,
CccurranceCode8 char (3) NULL ,
CccurrancebDat e8 varchar (10) NULL ,
CccurranceSpanCodel char (3) NULL ,
CccurranceSpanFroml varchar (10) NULL ,
CccurranceSpanTol varchar (10) NULL ,
CccurranceSpanCode2 char (3) NULL ,
CccurranceSpanFron2 varchar (10) NULL |,
CccurranceSpanTo2 varchar (10) NULL
Test _Prod char (1) NULL ,

G ai mMype char (1) NULL ,

Typeof Bil | varchar (20) NULL ,

Remar k1 varchar (90) NULL ,

Remar k2 varchar (90) NULL ,

Remar k3 varchar (90) NULL ,

Remar k4 varchar (90) NULL ,
Caimstatus char (1) NULL ,

Target TP varchar (30) NULL ,

Cl eari ngHousel D varchar (100) NULL,
Repri cedd ai mNunber varchar (100) NULL,
Repri ci nghet hodol ogy varchar (3) NULL,
Repri cedAmount varchar (15) NULL,
Savi ngsAnount varchar (15) NULL,
Repricer| D varchar (30) NULL,

Rej ect Reason varchar (3) NULL
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CREATE TABLE edi _cl ai mdetail (

I D INT NOT NULL AUTO_| NCREMENT KEY,
d ai M D varchar (50) NOT NULL ,

H PAAsui tel D varchar (10) NULL ,

Li neNurber deci mal (18, 0) NOT NULL ,
Li nel D varchar (50) NULL ,

Servi ceDat eFrom var char (50) NULL ,
Servi ceDat eTo varchar (50) NULL ,
Faci |l ityCode varchar (50) NULL ,
RevenueCode varchar (50) NULL ,

Procedur eCode varchar (50) NULL ,

Description varchar (100) NULL,
Amount varchar (50) NULL ,

Unit varchar (50) NULL ,
Quantity varchar (50) NULL ,
Uni t Rate varchar (50) NULL ,
NonCover ed varchar (50) NULL ,
Pai d varchar (50) NULL ,

Pl aceO Service char (3) NULL ,

Modi fierl char

Modi fi er2 char

Modi fi er3 char

Modi fi er4 char

(3)
(3)
(3)
(3)

NULL ,

NULL ,

NULL ,

NULL ,
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Di agPoi nterl char (1) NULL ,
Di agPoi nter2 char (1) NULL ,
Di agPoi nter3 char (1) NULL ,
Di agPoi nter4 char (1) NULL ,
Toot hNunber char (2) NULL ,
Surface varchar (10) NULL ,
Ener gencyl ndi cator char (1) NULL,
Repri ci nghet hodol ogy varchar (3) NULL,
Repri cedAmount varchar (15) NULL,
Savi ngsAnount varchar (15) NULL,
Repricer|I D varchar (30) NULL,
Rej ect Reason varchar (3) NULL
)
5.3.5 Other Databases Scripts to Create Tables

If you have a database that is not mentioned here, you can do several things:
1. Have a database administrator change the scripts in order for them to function;

2. Create the fields in you database administration tool according to the specifications in
the scripts.

5.4  Selecting Fields to Export

The HIPAA Claim Master can export all the fields that exist on the HCFA-1500 or the
UB92 form. You might not want to export every field, but only those that you have in
your database. You are really only limited by your database engine. In order to
reassemble the claim from the database, it is better to have all the fields selected and
available.

Once you have created created your tables and tested connection and table names, you
can select which fields to export. Follow the instructions below.

1. Select Data Base » Connection and Fields in the main menu.
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s HIPARA Claim Master - 64bit

DataBase | Zode Sets  Logs
r_%mm |

File Forms View  Search  Claim Enbry/Edi!
s

— Dutput Mode

= Prinker

 Screen

Clainz in Database
Create SOL Tablas
Code Look-up Table

Creste 837 EDI Files

The "Connection and Fields" menu

2. You will be confronted with the following screen where you can set up the database
connection and enter the names of the database tables.

j-_."_:n.;r_atuese Server Setup for OLE/ODBEC Connection

— HIPAAsuite"s Claim Extract Capabilities
HIPAAsuite natively stores a Claim as a single Object,
HIPAAsuite can extract the claim data and write those into a
normalized Database such as Microsoft SQL Server or IBM
AS 400. Customizations are possible. Ask Vendor for details
Production C l Test Cor i I
~ Connection Properties
Database Type
[OD BC Connection 3
Data Source Name
]mysql-pmd
Test Connection
Database
™ checked
Username
Password
Claimn Header Table Name
|EDI_Claims
= You can create the
Claim Detail Table Name tables throuha.
- - sepalate scieen
EDI_ClaimDetail
|| Save Connection Information |

=l0o| =]
i Fields to be exported
Headear Detail
= [JFie Level Data ~| = Oservice nformation -
OFiename [ CisimiD> (This: is Header Table's Key
O version [ Lineiumiber
OirageFiename Otine
OimageFirath O serdcebatefrom
O TradingPartnerD Ty O serviceDateTo
O TradingPartnent [ assessmentDate
O TranzactionDate [OFacityCode
O TransactionTime O Revenuecode
OReceiveDate O Procedurecose
O subrmittertiame O amount
O submittenD OJura
O SubmitterContact O cuantity
O subemitterTel O uritrate
O submitterTeE:d [ MonCovered
DSA.hmMchnx D PlaceliSerice
O Submitt erEmeail O Modifiert
OReceiveriame O Moxifier2
OreceiverD O meditiers
O TranzactionType (BHT_D&) [ Modifier4
= [0 Biling Frovider [ ProcedureDescrigtion
OFfedraa O craicavityDesignationt
Oeieravnp O oraiCavityDesignation2
OsirrovioType O oraiCavityDesignation3
[m] O craiCavityDesignationd
O eirravLast O craiCavityDesignations
[OsierovFirst [ DisgPoirtert
O eirrovmicds [ DisgPairter2
OeierovSuttic [ CiagPointer3 |
Oeieravspeciatty ;l 4| | [E
Select All l Selectllone |  Select Al Select lone
™ Show selected Fields only
Test Configuration Save Field Configuration

pak
oy

The "Database Server Setup for OLE/ODBC Connection

3. The right side of the screen shows all the available database fields and columns. Choose
fields to be exported by selecting checkboxes in front of the fields in the following

tables:

Header
¢ File Level Data

e Billing Provider

© <2003> Martin Scholl Consulting, Inc.




Using the Database 218

e Pay-to Provider

e Pay-to Payer

e Subscriber

e Responsible

¢ Patient

e Rendering Provider

e Attending Provider

e Operating Provider

e Other Provider

e Facility

e Referring Provider

e Primary Care Provider
e Supervising Provider

e Assistant Surgeon

¢ Pick-up Location

e Drop-off Location

¢ Destination Payer

e COB Payer 1

e COB Payer 2

¢ Claim Data

e CN1 — Contact Information
¢ Dental Claims

e Diagnosis Information
¢ Procedure Information
¢ Value Code

e Condition Codes
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e Occurrence Codes

e CR1 — Ambulance Transport Information
e Ambulance Certification

e Repricing

e SQL to EDI

Detail

e Service Information

e Paperwork

¢ Repricing

¢ Drugs

e CR1

e AmbulanceCertification
e AttendingProvider

e OperatingProvider

e OtherProvider

e RenderingProvider

¢ PurchasedServiceProvider
e Facility

e SupervisingProvider

e OrderingProvider

e RefferingProvider

e COB1

e COB2

Tip: We recommend to select all fields. This makes it possible to reassemble all the information in the

EDI file and create the image.
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Tip: Sometimes it might be necessary to rename a field or fields. Some legacy database want upper
case only or lower case only field names. The HIPAA Claim Master allows you to rename any field in any
table. Click twice (not double-click) on a field and you are in "Edit" mode. Read more in the following
"Renaming Fields" sub-topic.

[receivelate

O sutsmitterhiame
[ Suitwmitteridentifier]
[0 Sutwritter Cordact
[ suitaritter Tel

The field selection list in "Edit" Mode

4. Once you have made your selection or selected all you have to test your setup, click on
the "Test Configuration” button.

© <2003> Martin Scholl Consulting, Inc.



221

HIPAA Claim Master

=10] x|
~ Fields to be exported
Header Detail
# [e)File Level Data & @ [ Service information
+1- [#] Biling Provider # [#] Paperwork
+- [#] Pay-to Provider #- [¥] Repricing
*1 [FlPay-to Payer # [#] Drags
+- ] Subscriber o 1 [
+ [F]Responzitle # - [] AmidanceCertification
+ [#] Patient - [#] attendingProsider
+ [¢] Rendering Provider - [w] CperatingProsdder
# [#] Attending Pronider - [#] CherProvider
+1- [#] Operating Prosdder - [ RenderingProvider
+ [P]other Provider & [ PurchazedServiceProvider
+- [ Faciity - [ Faciity
&1 ] Freferring Provider &[] SupervisingProvider
#- [#] Primary Care Provider - [#] CrcderimgProvider
4 [#] Supervising Provider (- [#] ReferringProvider
# ] Assistart Surgean & [#] coet
%1 [F] Pick-up Location # ooez
- EDrnp-oﬂ Location
+- [#] Destination Payer
# [ COB Payer 1
+ [ COB Payer 2
+1- B Claim Data
#| [F ci1 - Contract Information
+1- ] Dertal Claims
%] 7] Diagreosis Information
+- [F] Frocedure Information
# [#] Value Codez o
# [#] Condtion Codes
+ ] Occurrence Codes
# IR - Ambudance Transport Information |
Select All Select Hone | Select All Select None I
I Show selected Fields only
Test Configuration Save Field Configuration |
— =é

The "Test Configuration” button

The program will connect to the database and read the table definitions. Afterwards all
the fields that you selected will be tested.

Notice: Before you can save your field configuration, you have to test the setup to make sure that all
the fields that you selected exist in the tables that you specified. The table scripts that come with
the HIPAA Claim Master do not have all the fields because some of the fields are very specific and not
of use to many people.

You should receive a message like this. Click "OK."
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The success message
If there are errors, refer to the following "Troubleshooting Data Fields" sub-section.

5. Only after the configuration have been checked out, are you allowed to save it. Click
the "Save Field Configuration” button.

Important! After you have checked the setup and got the success message, you still need to save the
configuration otherwise nothing will be exported.

Select All Select Hone Select Al Select None |

™ show selected Fields only

'I'Ias-.'lltnln'lig.i:ré;iurln Save Field Configuration I

%
L

The "Save Field Configuration” button

Renaming Fields

There are a few reasons why you would want to use different field names than the ones
given by the HIPAA Claim Master:

e Your database cannot handle long column names such as "CA Clipper” or "IBM AS
400."

e You already have a staging table and want to import the data straight into your
own table which has different field names.

HIPAA Claim Master lets you change the names of the columns that you selected for
export. All you have to do is:

1. Check the box near the field for import.

2. Click the field name twice. Do not double-click, but slowly click twice. You will see that
the field name is now editable.

3. Change the name to your value and click somewhere outside the field.

4. Your field name has now been changed.
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O ReceiveDate [ receivelate

[ SubmitterMame [ sutimtterhiame
SubmitteriD FEE

LI SubmitterContact LI SubmiterConitact

[ submitterTel Changed to: [ sutmitter Tel

Editing a field name

The new value will be saved as long as this field is selected for Import. If you unselect the
field and save your selection, the field will revert to its original name.

Notice: Field names must not contain spaces.

Troubleshooting Data Fields

Before you can save your field configuration, you have to test the setup to make sure
that all the fields that you selected exist in the tables that you specified. The table
scripts that come with the HIPAA Claim Master do not have all the fields because some of
the fields are very specific and not of use to many people.

After clicking on the "Test Configuration” button, there maybe error messages. If the
program finds errors, the "ODBC Error" screen will come up and tell you exactly which
fields caused errors.

[ SOL Errors =10] x|

....... Table EDI_Claims ======= =]
ERROR [42522] [MySQLIODBC 5.2(w) Drrved[mysqld=5.6.14]Unknown column ImageFile’ in 'field list'

=l
[ Concet ] Help - What is going on Uncheck Fields in Evor |
B y

ODBC Setup Errors
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Course

The table-created scripts that come with the HIPAA Claim Master do not contain all
possible columns that the data export provides. You can add the fields manually in your
database administration software. Some of the fields are very specialized and would not
be suitable for general distribution and make the tables unnecessarily complicated. If the
fields do not exist, an error message will come up and you have the option to deselect

them.

=101 |

Imalid column name "AfendProvOther DQual 1.
Imalid column name "AlendProvOther D7
Imalid column name "OtherProvCthedDQual1”.
Imvalid column name "OtherProvOthedD 1.

Imalid column name
Imalid column name
Imalid column name
Imalid column name
Imalid column name
Imvalid column name
Imalid column name
Imvalid column name
Imalid column name
Imvalid column name
Imalid column name
Imvalid column name
Imalid column name
Imvalid column name
Imaalid column name

"RefProvCtherdDQual 1’
"RefProvOtherd DT’
"SubscriberSSN'.
‘Responziblelast’
"ResponzibleFirst’.
‘ResponzibleMiddle’
"ResponszibleSuffuc’.
‘ResponsibleAddress’.
"ResponsibleAddress?”.
"ResponzibleCity’
‘ResponzibleState’.
‘Responzibledip’.
‘ResponziblelDType’
‘ResponziblelD)’.
‘PatentSSN'.

Imvalid column name ‘CtherPayernioRelease’
Imvalid column name ‘CtherPayerBenefithssign”.
Imvalid column name "‘CtherPayerDocControlNo'.
Irvalid column name ‘CtherPayerPriorduth’.
Imvalid column name ‘CtherPayerZinfoRelease’.
Irvalid column name ‘CitherP ayer2 Benehitissign’
Irvalid column name ‘CtherPayerZ DocControlMNo’.
Irvalid column name "‘CtherP ayer2 Pricruth’.

Help - What is going on |

I]

Uncheck Fields in Eror |

4

ODBC Setup Errors

In the picture above, you can see the columns in error obviously do not exist in the table

that was specified.
Solution

The possible solutions are:
1. To unselect the fields that course errors in the HIPAA Claim Master.
Or:
2. To create missing fields in the database and then try again.

Important! After you checked the setup and got the "Setup checks Okay" message, you still need to
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5.5

save the configuration otherwise nothing will be exported.
Browsing Exported Data
The HIPAA Claim Master can access the exported data and show it to the user. This
might be helpful in tracking particular claims.

Select the Data Base » Claims in Database in the main menu.

'.- HIPAA Claim Master - Gabit

File Forms View  Search  Claim Enbry/Edi | Data Base | Code Sets  Logs
| P ]

; E - ; Conmection and Fislds |
' = [ Comsmbatebase |
Dutput Mode Creats SO Tablas
= Prirder Code Look-up Table
" Sereen Creske 837 EDI Files |

The "Claims in Database" menu

You will see the following screen where you can see all the claims and review them. In
addition, you can query the database for any of the displayed fields. For example, if you
want to check if all the claims from a specific file were imported, you could type the
filename into the appropriate field and click the "Query” button. The results will be
returned.
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omeanoms N T

~{ | Live Database  Test Database

1 SELECT * FROM EDI_Claims
2 LIMIT 20

Edit Claims l

Clear Query | Create 837 EDI File |

Claim Tables Inulld your own quoryl

P4 i efo| b bl | [ViewClaim| [Editciaim| [Check HIPAR

o: | | Query |
ClaimNo: | [ auery |
Filename: | | Guery |
BilProvD: [ [auerv |
Amount: | Guery

Claim Header:
Field

Service Line Detail:

SubscriberlD:

SubscriberLast:

SubscriberFirst:

PatientLast:

PatientFirst:

e eie)e

Help

Cancel L

Click on a payment on the left to load the claims associated with this payment on the

right side.
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JRETES
; fﬁ:ﬁ% ~FROM EDI_Claims - ,m
Execute Query Edit Claims |
<|  Clear Query | Create 837 EDI File |
Blllld your own quuyl
P 41 of20 b ¥l |View Claim | |Edit Claim | | Check HIPAA ] |
o: i Query SubscriberlD: [0219954324 Query
ClaimMo: [987654 Guery SubseriberLast: [SMITH Query
Filename: [B37IPTST edi Guery SubscriberFirst, [TESS Query
BillProviD: |057654321 Guery PatientLast: [SMITH Guery
Amount: [1675.34 Guery PatientFirst: [TESS Query
Claim Header: Service Line Detail:
Field \ Value = D \ ClaimlD | LineNumber LinelD SemviceDateFrom SenviceDateTo Date FacilityCode RevenueCod|
1 > 1 1 120
Filename B37IPTST. edi 2 1 2 320
ImageFilePath 3 1 3 360
ImageFilename 4 1 4 370
Version 004010096 5 1 5 450
TradingParinerDType ] [ 1 3 710
TradingPartnerlD SE7E54
TransactionDate 3292001
TransactionTime 13:10:00
ReceweDate 1072472013
SubmitterName HEALING HOSPITAL O
itterlD XI54278
ontact PHIL FIELD
SubrmitterTel 7365554321
itterTelExt
SubrmitterEmail
RecewveriName XYZ INTERMEDIARY S
ReceiverD THIES4
TransactionType CH
FedTaxiD 097654321
BillProviDType 24
BillProviD 097654321
BillProviNPI
BillProviast HEALING HOSPITAL O...
BillProvFirst hd
Help

Accessing the claims in the database

Editing Data

Cancel L

You can edit the data in the tables by typing in a cell. A dialog will ask you whether you
want to save the changes.

g ZZ

Cancel

10122/2012

Editing the field value

Viewing

Click on the "View Claim" button to render the claim.

Claims
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JRETES
1 SELECT " FROM EDI_Claims =
5 LIMIT 20 " Live Database % Test Database

Execute Query I Edit Claims I
Clear Query | Create 837 EDI File |

Build your own query |

AT of20 | b Pl‘dltualmHOh.dtHlm ] |

o: i [ouery | SubscriberlD: [021995432 [avery |
ClaimMo: [987654 Guery SubseriberLast: [SMITH Query
Filename: [B37IPTST edi Guery SubscriberFirst; [TESS Query
BillProviD; [057654321 Query PatientLast: [SMITH Query
Amount: [4675.34 Guery PatientFirst: [TESS Guery
Claim Header: Service Line Detail:
Field \ Value = D \ ClaimlD | LineNumber LinelD SemviceDateFrom SenviceDateTo Date FacilityCode RevenueCod|
1 o 1 1 120
Filename B37IPTST. edi 2 1 2 320
ImageFilePath 3 1 3 360
ImageFilename 4 1 4 370
Version 004010096 5 1 5 450
TradingParinerDType ] [ 1 3 710
TradingPartnerlD SE7E54
TransactionDate 3292001
TransactionTime 13:10:00
ReceweDate 1072472013
SubmitterName HEALING HOSPITAL O
itter D XI54278
ontact PHIL FIELD
SubrmitterTel 7365554321
itterTelExt
SubrmitterEmail
RecewveriName XYZ INTERMEDIARY S
ReceiverD THIES4
TransactionType CH
FedTaxID 097654321
BillProviDType 24
BillProviD 097654321
BillProviNPI
BillProviast HEALING HOSPITAL O...
BillProvFirst hd

Help Cancel L
The following preview window will open.

Note: To preview the claims, you must have a printer installed on your PC.

HIPAA Preview ﬂ

‘ Print Close Mext Claim = 1/1 = | Claim | Addl info | COB info [

Senders 621 Bunber GETHSA =
'HEALING HOSPITAL OF ANYTOWN g [ 987654 P
1 HOSPITAL ROW F% | 69875.9 11
ANYTOWN, MD 21299 [T " . il Gl
097654321 022101 022601 | &
B PATIENT LAME |I | 0219954327 PATIENT A8 R B |I| 1 HOME STREET
[ SMITH, TESS T [HOME ciTy [FImD [ 13746 dl
[RRTRRATE |'1“' ||e BQYE'°P)%¢1.JT\'P(_ [EE i G“l' 18 (] = 21 “'25"“15"‘“2‘ = E = = |§rﬁﬂn
02/02/1930 14:00 01 T T 11 |
%‘a.?"l‘":.‘u‘&“’ Haopan ?orﬁT'*’-"n'ﬁ“'?u'- e
Jf | 1 [ ] | [
SMITH, TESS T T e CUETRS
:
1 HOME STREET .01 $250.00
HOME CITY, MD 13746 .
<
EABCE OB RFTER 4 HE PEMATERIPPECO BE ! 45 BENY . BATE 6 BEAV. URITD 7 TOTAL CRARDED & BON-COVED CHARDED |9
([ 120 $250.00 5 §1,250.00
.| 320 5 $1,006.00
»[ 360 1 §722.00
.| 370 1 $310.00
«[450 1 $987.34
<710 1 $400.00 |
e e
b I e “""Wv%w-—,_.,! [ MWWW
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5.6

A claim image created from a database record

Displaying the Revenue or Procedure Code Descriptions

EDI files do not carry the description of codes since EDI is all about saving space. But
since the codes are available commercially or from CMS, you can link tables with those
codes in your database application and have the HIPAA Claim Master look up the
description. These tables needs to be in the database defined while Setting_up Database
Connection.

Descriptions in the standard Forms

The UB92 and UB04 as well as the dental forms have the "Description” field for the line
item revenue or procedure codes. For the CMS-1500 forms one can put the description in
the upper half of the field locator 24 D.

[p300 JLAB - GENERAL CLASS 83690-TC 04/07/00 |1 $108.55
|o300 [LAB - GENERAL CLASS 85025-TC 04/07/09 |1 $100.45
|gduz OTHR IMAG SERVS-ULTRASOUND 76705.TC 04/07/09 |1 $946.30
0450 |ER - GENERAL CLASS 27502 04/06/00 |1 $930.00
A part of a UB04 with revenue code descriptions
I pp—
RECORD OF SERWICES PROVIDED
pme ik oy | b | ZToh | e . sescpten
| (041972002 D020  |PERIODIC ORAL EVALUATION 29.00
- [04/1972004 D02T4  |BITEWINGS-FOUR FILMS 11.00
, 041972004 D1110  |PROPHYLAXIS-ADULT 56.00
1
Dental Procedure Code Descriptions
., DATE= OF SERWICE 8. C. D.PROCEDURESSERVWICESOR SURPLIES E. F. G. [ Jd.
PLACEJF (BpBh Ul icimesteces DRGNS DAavS0R Fam?r o REHDERING
Frem ™ FEFVICE EMG | CPTHOPCS | MODIFIER FOINTER FUHARGES UNITE | Plan[ QUAL RROYIDER ID.#
EMERGENCY DEPART VISIT FOR THE EVAL & MGTOFA | | |
1|06/07/1997  |06/08/1997 |23 |y  |99285 Lo s | $800.00/1 | [ we|1417997107

A part of the CMS-1500 with the description filled in from the database

The CMS-1500 option is separate and can be selected in the Specific Options (the "CMS-
1500: Display procedure description in 24D" check-box). Refer to Configuring_Specific
Options.

Linking the Procedure Code Table

Acceptable Codes:
e HCPCS codes
e CPT procedure codes.
¢ All dental procedure codes.
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Tip: Using the code look-up might slow down your application depending on the speed of your
database. You can undo the code lookup by deleting the table name and clicking the "Save" button.

Follow the instructions below to show code descriptions.

1. Select the Data Base » Code Look-up Table in the main menu.

s HIPAA Claim Master - 64bit

File Forms View Search  Claim Entry/Edk || DataBase | CodeSets  Logs
: e Connection snd Fields
1A (s
- — Clains in Database
-0 Mode : Create SOL Tablas
& Prikar Code Look-up Table
| Semen | Create 837 EDI Files

The "Code Look-up Table" menu

2. You wil see the following screen:

¥ Code Look-up _ (Ol x|
Procedure Code Table Mame |I:IIIDE
You can create the table and work with it through a separate screen Open Table |
Code Field |CODE =]
Description Field |OESCRIFTION =]

Save | Help Cancel |

The "Code Look-up” screen

If you don't have a table already with the procedure codes, you can create it in the

claim master application. You see the sentence in blue "You can create the table....".
Click on this and the following form will come up.

3. Type the name of the table and click the "Open Table" button.
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Code Look-up =]

Procedure Code Table Marn |I:IIIDE
You can create the table and work with it through a separate screen Open Table

Cade Field |-00F ]
Description Field JDESCRIPTION 7]
Save Help Cancel
| )

The "Open Table" button

4. If the table is found, then the drop-down boxes for "Code Field" and "Description Field"
will be populated with all the available fields in your table. You can then choose the
field that will carry the code and description.

¥ Code Look-up _ Ol x|
Procedure Code Table Marme |I:IIIDE

You can create the table and work with it through a separate screen Open Table |

Code Field| |TYPE
Description Field |DE5EH|PT|DN

=
[

Save Help Cancel
| )
The "Code Field" and "Description Field" values populated
5. Click "Save."
Code Look-up H[=] 3
Procedure Code Table Marme |I:IIIDE
You can create the table and work with it through a separate screen Open Table |
Code Field =
Description Field ||:'ES':F“F'T“:IN j
Save Help Cancel
| l

The "Save" button

From now on, the HIPAA Claim Master will fill in the code description fields.
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5.7 Creating Code Look-up Tables

EDI is all about saving space and using code sets to represent more lengthy
circumstances. But often it would be more convenient to have the descriptions of a
revenue or procedure code visible instead of looking it up or knowing it by heart.

Important codes are

¢ Procedure Codes (HCPCS,CPT, Dental and ICD procedure codes)
* Revenue Codes

¢ Diagnosis Codes (ICD-9 and ICD-10)

There are tens of thousands of codes and they are mostly available at the CMS web site
or other web searches. The HIPAA Claim Master provides a database schema to create
cross reference tables for those codes.

When we go to the menu item Database --> Code Look-up tables we see this screen

Code Look-up

Frocedure |Fievenue| Diagnusial

Procedure Code Table Mame ICDDE

You can create the table and work with it through a separate screen Open Tahle |

Code Field |“00E
Description Field [DESCRIFTION

[

[
Save | Help Cancel I/,
3

The Code Look-up form with tabs for Procedure, Revenue and Diagnhosis codes

If you have already in your database a table that contains Procedure codes and their long
and short descriptions, you can link to it in this form. Fill in your table name and open it
and select the fields that contain the information.

If you don't have already a table with the procedure codes and and want to create a new
table, you can go to Database --> Code Look-up table and then click on the the blue
sentence "You can create..."

The following form will come up
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Procedure Codes |_ (O] x|
Tahkle CODE does not exist!

| Craste tabls CODE |

The form to create and fill the look up table

Since the table does not exist we press the button :"Create table CODE" and we will see
this form
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Database: * Microsoft SOL Server © MySQLU/Generic T Oracle

CODE Table script:

1 CREATE TABLE [dba] [CODE]( =]
[CODE] [varchar](15) NOT NULL.

[DESCRIPTION] [varchar](254) NULL.

[SHORT_DESC] [varchar](50) NULL.

[TYPE] [varchar](10) NULL

CONSTRAINT [PK_CODE] PRIMARY KEY CLUSTERED

|

B L B

[CODE] ASC
) ON [PRIMARY]
10 ) ON [PRIMARY]

1

12

13

LD S8 =) an

=

Compare Script with existing Table Save | Execute Script |

Help | Close |

4

The form with the script to create the look-up table

We click on the :Execute Script” button and create the table and close the form. Now the
previous form has changed.
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[ LoadtromxLSxfile | Loadfram TxTfie | Nurber of recards
intakble
Sawve Changes | 0

CODE | DESCRIPTION | SHORT_DESC | TYPE

The form to manage procedure codes

The table is created but is empty, so now we can load the codes that we obtained
separately. Maybe your company has a subscription to the code data as Ingenix, for
example, sells, or you find them on the internet. We click on "Load from XLSX file" and

navigate to the file. The spreadsheet has been created earlier and has the following
layout:

First column the code, second the long description and third the short description.

Load tomsisxiie | | Loadfom etz | Number of records
intable
0

Load Codes from XLEX file: |D:'\Codes'\2D1 S-&nnualalpha-Mumenc-HCPCS-File\HCPC2015_COMTR_AMNWEB w2 xlzx | |

Code Type: |HCF'CS = | ™ Firstline in table containz: headers Load Codes

Cancel |

Loading a previously prepared spread sheet with the HCPCS codes.

We navigate to the file and select it. Then we select the correct code type: HCPCS in our
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case and press on the button "Load Codes" Within a few seconds the file's codes are
loaded into the database and now we can see the values.

Procedure Codes =]
Load fram XLS%fle |  Loadfom TwTfile | Number of recards
in takle
Sawve Changes | 5119

CODE | DESCRIPTION SHORT_DE -

W Arbulance service, outside state per mile, transpart [medicaid only) Outside state—

P Annan Mon-emergency tranzportation, per mile - vehicle provided by volunteer [individual or organization], with no vested... | Honinterest ¢
A00an Morn-emergency transportation, per mile - vehicle provided by individual [family member, self, neighbor] with vested... | Interest escc
A0100 Maon-emergency tranzportation; basi MHaonemerger
Ao Mon-emergency tranzportation and bus, intra or inter state carrier Honemerger
Aman Mon-emergency transportation: mini-bus, mountain area transports, or other transportation systems Honer rangg
AT30 Maon-emergency tranzportation: wheel-chair van MHaner transp
Aaman Morn-emergency transportation and air travel [private or commercial] intra or inter state Monemerger
AED Morn-emergency transportation: per mile - caze worker or zocial worker Honer rangg
ANT70 Tranzportation ancillary: parking fees, tolls, ather Tranzport pa
Aaman Moh-emergency transportation: ancillary: lodging-recipient Maorer ransp
Aan Morn-emergency transportation: ancillary: meals-recipient Honer rangg
ADz200 Maon-emergency tranzportation: ancillary: ladging escort MHaner transp
AQ210 Moh-emergency transportation: ancillary: meals-escort Marer ranzp
ANz2A Ambulance service, neonatal ransport, base rate, emergency transport, one way MHeonatal em
A03E0 Blz milzage [per mile) Bazic life sup
A0 Bl e bivs dizmms shla emnliss P i smmn

| |

The screen after the codes have been loaded

Procedure codes are now loaded and in the database. We can add other codes such as
CPT and Dental codes to it. If you have duplicate codes in other files that you load, you
will see a message that the code is already in the table and will not be loaded again.

Revenue Codes and Diagnosis Codes work very similar. Go to the menu Code Sets -->
Revenue Codes
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5.8

E w Image Setup  EDI Exchange
z AOE 3
B; FtoP 3
Qo Z » REF Codes
Relationship
Femark Codes

Revenue Codes

Signakure Source
Subluzation Codes
Tooth Mumbering
nit Codes

Yesiho Codes

The menu Revenue Codes

Now the same form that you used for the procedure codes comes up only that it now
points to a table "RevenueCodes”

The third table that gets created and filled the same way is the diagnosis code table. You
can reach it form the Code Sets menu under "Diagnosis Codes”

Troubleshooting Data Export

When you start exporting claims into the staging tables, you may encounter errors in the
beginning. This usually results from table definition issues. The HIPAA Claim Master
displays a very detailed error message that tells you what claim has failed, at what field
and, if applicable, what line. This information should help you to troubleshoot the
problems. Sometimes you must fulfill serious detective work to find and correct issues.

Below are some of the most common errors.

ltem Cannot Be Found
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Export Error EI

Error while updating Claim header table EDI_Claims”

Error 3265: Item cannot be found inthe collection corresponding bo the requested name or ondinal. in Sub “Wirite_S0L_Claim'
Claim Cownter: 1, with Provider's Claim Mumber: "13235
Fiehd: Claimbo
Valoe: 13235

This error happens when a column that was selected for export does not exist in the
Header table. In this particular case, it is the c ai mo field. If you receive this error, go
back to your table admin tool and check if the c ai m\o field is correct.

Multi-Step OleDB Operation Generated Errors

N ——— x|

Error while: updating Claim he:ader table 'ED]_Claims’

Error -2147217857: Multiple-step OLE D8 operation generated ermors, Chedk each OLE DB status value, F avalable. No work
was dome, in Sub Write_S0L_Claim’

Clairn Counter: 1, with Provider's Claim Number: "13235°
Field: BilProvSpecialty
Wahse: 00000002331

o-:|cm|

This is typically the message when the field definition in the database is different from
the data. Here we see that the error occurred with the billing provider's specialty. The

field definition in the table was set as varchar (10) and the value here "000000002331" has
12 digits causing the error.

Field Does Not Have a Default Value

T —— x|

Error while updating Claim header table 'EDI_Claims™

Error 2147217671 [My5QLTODEC 3.51 Driver Imysald-5.0. 16-ntJField 'Claimblo’ dossn't have a default value in Sub
"Whrite_SL_Claim’

Claim Cownter: 1, wath Provider's Claim MNumber: 1 3235

Fiekd: Updating Claimheader Table
ok | Cancel |

The field c ai m\o is defined as "Not Null.” But somehow this data was not present and the
HIPAA Claim Master tries to update the table with a null ¢ ai m\o.
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Type Mismatch
x|

Error while updating Claim header table 'EDT_Claims'
Error -2147352571: Type mismatch. in Sub ‘Wrike_SCL_Claim'

Claim Counter: 1, with Provider's Claim Number: "13235°

Field: BilProvlast
Value: LEE T

[k ] concel |

This error occurs when the HIPAA Claim Master tries to "write a letter” to a field that is

defined as "Integer,"” for example. The data type of the column does not match the data
type of the value.

Claim Detail Errors

Erporteror x|

Error while updating dlaim detail table 'EDI_ClaimDetail
Error 3265: Item cannot be found in the collection corresponding bo the requested name or ondinal. in Sub “Wirite_S0L_Claim'

Claim Cownter: 1, with Provider's Claim Number: "1 3235
Field: Linehumber

Vahoe: 1

Linge Nurnber: 1

.

The errors with the claim detail table are similar; the error message indicates the line
number where the error occurred.
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6.1

Displaying and Printing Additional Information

The X12 837 EDI file format allows for much more information than fits on a paper form.
The creators of the 837 standard included many health care business scenarios besides
only a professional or institutional environment. The 837 has segments for ambulance
billing, Chiropractic care, home oxygen therapy, home health care, repricing information
and a variety more. In addition the 837 has a much finer resolution to express
complicated COB situations with several payers. The information in those segments is
usually not displayed on the standard paper forms. For this reason the HIPAA Claim
Master comes with additional pages that aim to display every possible piece of
information that an 837 can contain.

The HIPAA Claim Master checks each claim for the existence of those special segments.
You will see additional buttons in the claim view window to alert you of their existence.
By clicking on "Addl" or "COB" the screens to display this information will show. Page
through buttons will also show, if this information does not fit on one page.

Understanding Types of Additional Information

The 837 P and 837 | can contain different pieces of additional information which is
expressed through the following segments. The HIPAAsuite parsing engine catches and
stores each bit of information.

837 P

The 837 P can contain...

On the claim level:
e Loop 2010AB — Pay-To Provider's Information (Pay-To Address in 5010)
e Loop Loop 2010AC — Pay-To Plan

Loop 2010BC — Responsible Party

Loop 2010BD — Credit Card Holder

Loop 2000B — Additional Subscriber Information

Loop 2000C — Additional Patient Information

Loop 2310A — Referring Provider's Information
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Loop 2310B — Rendering Provider's Information
Loop 2310C — Purchased Service Provider

Loop 2310D — Service Facility (2310C in 5010)

Loop 2310E — Supervising Physician (2310D in 5010)
Loop 2310E — Ambulance Pick-up Location (5010)
Loop 2310F — Ambulance Drop-off Location (5010)
Loop 2420 — Line Level Providers

Loop 2300 — Additional Claim Information (DTP,REF,AMT etc.)
Segment K3 File Information

Segment PWK — Paperwork

Segment NTE — Notes

Segment HI*BF — Additional Diagnosis Codes
Segment HI*BP/BO — Anesthesia Related Procedure Codes
Segment HI*BG — Condition Codes

Segment CN1 — Contract Information

Segment CR1 — Ambulance Transport Information
Segment CR2 — Spinal Manipulation

Segment CR5 — Home Oxygen Therapie Info
Segment CRC — Certificates, Conditions etc.
Segment HCP — Repricing Information

Segment CR7 — Home Healthcare Plan Information

Segment HSD — Health Service Delivery

On the line level:

e Segment K3 File Information LineLevel
e Segment CRC — Certificates, Conditions Linelevel

e Segment QTY — Ambulance Patient Count, Anesthesia Add.Units Linelevel

242
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Loop 2420 — Line Level Providers

e Segment PWK — Paperwork Linelevel

e Segment HCP — Repricing Information Linelevel

e Segment HSD — Health Service Delivery Linelevel

e Segment PS1 Purchased Services Information Linelevel

e Segment MEA — Test Results Linelevel

Loop 2440 Form Identification Code Linelevel

e Segment NTE — Notes LineLevel

e Segment CR2 — Spinal Manipulation Linelevel//[CHF 11-21-2011 *139]

e Segment CR1 — Ambulance Info Linelevel

e Segment CN1 — Contract Info Line

e Segment CR3 — DMERC — Line only

Loop 2410 Drug Information Linelevel

e Loop 2400 — Additional Claim Information Linelevel(DTP,REF,AMT etc.)

837 1

The 837 | can contain...

On the claim level:

EDI_Envelope: ISA — GS — ST — BHT

Loop 2000A — Billing Provider's Information

Loop 2010AB — Pay-To Provider's Information (Pay-To Address in 5010

Loop 2010AC — Pay-To Plan

Loop 2010BD — Credit Card Holder

Loop 2000B — Additional Subscriber Information
Loop 2000C — Additional Patient Information

Loop 2310A — Attending Physician’s Information
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e Loop 2310B — Operating Physician's Information

e Loop 2310C — Other Physician's Information

e Loop 2310D — Rendering Provider's Information (5010
e Loop 2310E — Service Facility

e Loop 2310F — Reffering Provider's Information (5010)
e Loop 2300 — Additional Claim Information (DTP,REF,AMT etc.)
e Segment K3 2300 — K3 File Information

e Segment PWK — PWK — Paperwork

e Segment NTE 2300 — NTE Notes

e Segment NTE 2400 — NTE — Notes Linelevel

e Segment HI*BF — HI*BF — Diagnosis Codes

e Segment HI*BN — HI*"BN — E — Codes

e Segment HI*DR — HI*DR — Diagnosis Related Codes

e Segment HI*Bl — HI*BlI — Occurrence Span Codes

e Segment HI*BH — HI*BH — Occurrence Codes

e Segment HI*BE — HI*BE — Value Codes

e Segment HI*BG — HI*BG — Condition Codes

e Segment HI*TC — HI*TC — Treatment Codes

e Segment HI*BQ/BO — HI*BQ/BO — Procedure Codes

e Segment QTY — QTY — Claim Quantity

e Segment CN1 — CN1 — Contract Info

e Segment CRC — CRC — Certificates, Conditions

e Segment HCP — HCP — Repricing Information

e Segment CR7 — CR7 — Home Healthcare Plan Information
e Segment HSD — HSD — Healthcare Service Delivery

e Segment CR6 — CR6 — Home HealthCare Information
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On the line level:

e Loop 2400 — Additional Claim Information Linelevel(DTP,REF,AMT etc.)

e Loop 2410 — Drug Information

e Loop 2420 — Line Level Providers

e Segment HCP — Repricing Information Linelevel

e Segment HSD — Healthcare Service Delivery Linelevel
e Segment CN1 — Contract Info Linelevel

e Segment CRC — Certificates, Conditions Linelevel

e Segment PWK 2400 — PWK — Linelevel

837D

The 837 D can contain...
On the claim level:

¢ Loop 2000A Additional Billing Provider's Information

Loop 2010AB Additional Pay-To Provider's Information

Loop 2010BC — Credit Card Holder

Loop 2000B — Additional Subscriber Information

Loop 2000C — Additional Patient Information

Loop 2310A — Referring Provider's Information

Loop 2310B — Rendering Provider's Information

Loop 2310C — Service Facility's Information

PWK Claim Supplemental Information
e NTE Claim Note
e HCP Claim Pricing/Repricing Information

On the line level:

Loop 300 — Additional Claim Information (DTP, REF, AMT etc.)
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e Loop 2400 — Additional Claim Information Line level(DTP, REF, AMT etc.)
e NTE Claim Note

e DN2 — Tooth Status

e HCP Line Pricing/Repricing Information

e Loop 2420 — Line Level Providers

837 R
The 837 R can contain...
On the claim level:

e Loop Service Provider's Information

Loop 2000B — Additional Subscriber Information
e Loop 2000C — Additional Patient Information

e Loop 2310A — Attending Provider's Information
e Loop 2310B — Operating Provider's Information
e Loop 2310C — Other Physician's Information

® Loop 2310D — Rendering Provider's Information
e Loop 2310F — Referring Provider's Information
e Loop 2300 — Additional Claim Information (DTP, REF, AMT etc.)
e K3 — File Information

e PWK Claim Supplemental Information

¢ NTE Claim Note

e HI*BF — Diagnosis Codes

e HI*BN — E Codes

¢ HI*DR — Diagnosis Related Codes

¢ HI*BQ/BO — Procedure Codes

e HI*BI — Occurrance Span Codes

e HI*BH — Occurrance Codes
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6.2

¢ HI*BE — Value Codes
¢ HI*BG — Condition Codes

On the line level:

e Loop 2400 — Additional Claim Information Linelevel(DTP, REF, AMT etc.)

e Segment NTE Claim Note

e Loop 2410 — Drug Information

e Loop 2420 — Line Level Providers
Configuring Additional Info Pages

To configure the additional information pages options, select Setup » Additional Info

Pages in the main menu.

H =10] |
Image(| Setp |JEDIExchange Help
&% Options
Spedfic Options
Claim Forms
"%, [ Configure Additional Info Pages |
Company Setup
Create Company Setup Table

The "Configuring Additional Info Pages" menu

The following screen will appear.

© <2003> Martin Scholl Consulting, Inc.



Displaying and Printing Additional Information

Additional Information Page Configuration

Professional Claim Institutional Claim | Dental Claim Repaorting Claim I
- Professional Claim - i

Select All ] Select None

[ EDI Envelope: 54 - GS - 5T - BHT
[=] Baing Providers Additional nformation
[=] Loop 201048 - Pay-To Provider's Information (Pay-To Address in 5010)
[ Lecp 2010AC - Pay-To Plan
[=] 2010BC - Responsitle Party
[ 2010BD - Credit Card Holder
[<] 20006 - Additional Subscriber information
[ 2000¢ - Additional Patient information
[#] 22104 - Referring Providers Information
[#] 23108 - Rendering Provider's Informatien
[ 2210C - Purchased Service Provider
[#] 23100 - Service Facdity (2310C in S010)
[#] 2210E - Supervising Physician (23100 in S010)
] 2310E - Ambulance Pick-up Location (S010)
] 2310F - Ambulance Drop-off Location (5010)
[2] 2420 - Line Level Providers
[ 2300 - Additional Claim information (OTP,REF.AMT ete.)
[#] 2400 - Additional Claim Information Linekevel(DTP,REF AMT etc )
[ 3 File Information
[#] 3 File Information LineLevel
[ P - Paperwork
[l WK - Paperwerk Linglevel
[#] NTE - Hotes
[F] WTE - Hotes LineLevel
[#f] HIEF - Additional Diagnosis Codes
[ HrBPBO - Anesthesia Related Procedure Codes
[ Hr8G - Conditional Codes
[# cH1 - Contract Info
[= ciit - Contract nfo Line
[ c81 - Ambulance Transport Informaticn
[Fl cR1 - Ambulance nfo Lingkevel
[ cRz - Spinal Manipulation
[#] CR2 - Spinal Manipulation Linelevel
71 CR3 - DMERC - Line onlv =l

|»

The "Additional Information Page Configuration” window

You can configure the following options:
¢ Professional Claim
e Institutional Claim
¢ Dental Claim
e Reporting Claim

Once you have finished editing the options, click "Save."

248
X
Save
Close
Help
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Below you can see screen-shots of the tabs.

Additional Information Page Configuration

Professional Claim | Instiutional Claim | Dental Claim Reporting Claim I

~ Institutional Claim

Select All | Select None

] EDI Envelope: ISA - GS - ST - BHT
[#] Bing Providers information
Eme 201048 - Pay-To Provider's information (Pay-To Address in 5010)
[ Lecp 2010AC - Pay-To Plan
[=] 200080 - Credit Card Heider
[#] 20008 - Additional Subscriber Information
[<] 2000C - Additional Patient information
EZHM - Attanding Physician's information
[#] 2310B - Operating Physician's Information
[¥] 2310C - Other Physician's information
D23| 0D - Rendering Provider's Informaticn (S010)
[F] 2310 - Service Facity
n231 OF - Refarring Provider's information (5010)
[=] 2200 - Additional Clairn knformation (DTP,REF AMT ete.)
[#] 2400 - Additional Claim information LinelevelDTP REF AMT etc.)
[ K2 File information
[#] P - Paperwork
[#] PWK - Lingtevel
[FINTE Hoies
[#] NTE - Hotes Linslavel
[F] HreF - Diagnosis Codes
[JHFEN - E - Codes
[#] H'DR - Diagnosis Related Codes
[ Hrei- Occurrence Span Codes
[JHreH - Occurrence Codes
[ HrBE - Value Codes
[ HreS - Condition Codes
[ HIFTC - Treatment Codes
[l HrewEn - Procedure Codes
[ aT - Claim Quaniity (US04 only)
[ ci1 - Contract Infa
[=] cHt - Contract info Linelevel
[#] CRC - Certificates, Conditions
¥ CAC - Certificates. Conditions Linelevel

Close

The "Institutional Claim" tab
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Additional Information Page Configuration .EI
Professional Claim | Institutional Claim fl Reporting Claim |
~ Dental Claim - e
Select All | Select None |
[JEDiEnveiope: 54 - GS - 5T - BHT Close
[#] Bing Providers information

Eme 201048 - Pay-To Provider's information (Pay-To Address in 5010)
[ Lecp 2010AC - Pay-To Plan

[=] 2010BC - Credit Card Hoider

[#] 20008 - Additional Subscriber Information

[<] 2000C - Additional Patient information

EZHM = Referring Provider's information

[Z] 22108 - Rendering Provider's Information

[<] 2310C - Service Faciity's information

[J 23100 - Asistant Surgeon's Information (5010)

[ z310E - Supervising Physician (5010)

[#] 2300 - Additional Claim information (DTP,REF AMT etc.)

[=] 2400 - Additional Clairn knformation Lin&level(DTP REF AMT &te.)
[#] WK - Paperwork

EINTE Hotes

[#] NTE - Hotes LineLevel

[ ureF - Diagnosis Codes

[#] HCR - Repricing Infarmation

[#] HCF - Repricing information Linekevel

[F] oz - Tooth Status

[#] 2420 - Line Level Providers

Help

The "Dental Claim" tab
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6.3

Additional Information Page Configuration _EI

Institutional Claim | Dental Claim Reporting Claim

Professional Claim
“Reporting Claim

Select All ]

Select None

[ EDI Envelope: 54 - GS - 5T - BHT
[#] Service Provider's information
[=] 2000B - &dditional Subscriber Information
Z‘[H!DC - Additional Patient Information
[=] 23104 - attending Physician's Information
EZEIDB - Dperating Physician's Information
[] 2310C - Other Physician's information
[#] 22100 - Rendering Provider's Information
[#] Z310F - Referring Providers information
[ 2300 - additional Claim nformation (DTP REF AMT etc.)
E24[!|] - Additional Claim Information LinekeyelDTP.REF AMT atc.)
] 3 File information
EW-I‘H = Paperwork
[FINTE Hotes
[ HreF - Diagnosis Codes
[JHFEN - E - Codes
[ HroA - Disgnosis Aetated Codes
[ Hrewso - Procedure Codes
[0 Hr8l- Oecurrence Span Codes
[JHreH - Occurrence Codes
[ Hree - vaue Codes
[ HreG - Condition Codes
[ L 2410 - Drug Information
[l 2420 - Line Level Providers

Close

Help

The "Reporting Claim” tab

Displaying Addl Info

The HIPAA Claim Master checks for additional information every time a claim is displayed
or printed. Should the claim contain one of the above mentioned segments, you will see

the button "Addl Info" enabled.
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o 1J6B —= Claim  Addlinfo || COBinfo
.

The "Addl Info" button enabled
The arrow buttons indicate that several pages of claim information are available.

Click on the "Addl Info" button to show the additional information as shown on the
following screen-shot.
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HIPAA Prview

= 1 fB == | Chiim Addlinfe | COHinlo

Additional Claim Information in the 837 Record

Pay To Provider
Hame UVAHEALTH SERVICE
Address
City ATLANTA Stale GA Zip 30384
Employers identification Numbe S41124TESPP
Referring Provider
Hame MORGAN RAYMOND
Mational Prowider Igentifser BOTS2E
Service Location
Namg UVAHEALTH SERVICE
Address: PO BOX 281183
City ATLANTA Stile GA Jip 303241183
Claim: Additional Identifiers
| Cleading House ID 1220307311P01404

Supplemental Information/Paperwork:

Report Type.  Explanation of Benefits Sent By Mad Aachment Mo, [MNOO12

Faport Type:  Radidlogy Heports Sent By E - Mail Altachment Mo: DMNDER3A312

Repor Type. Physician Order Sent By Fax Altachment Mo, FRACTUREPICTURENO012
Report Type. Discharge Summary Sent Available on Request  ARachment Mo DMNO012

Line Level - Supplemental Information/Paperwork

Ling 1 | Report Type. Explanaton of Benefits Fepon Transmission Code
Report Type: Radiology Reports Repor Transmission Code
Fepod Type.  Physician Order Fepor Trandmission Code
Feport Type: Discharge Summany Repaor Transmission Code

Ling 2 | Repo Type.  Explanation of Benefits Repan Transmission Cooe
Report Type:  Rodology Reports Repan Transmission Code
Report Type:  Physician Order Repor Transmission Code
Report Type: Discharpe Summary Repor Transmission Code

Claim Notes

Addmanal IndGrmason

This is & Dupscate Claim and we are testing the 20 byte limit, | need 10 more

Addieonal informalon

This is a Duplcate Claim and we are testing ihe 0 byle Imit, | need 10 more

Al nial Ind anmason

FHOC NONCONTRACTED PROVIDER

Addifanal infanmatan:

PA48 4 20434 1EN 756600200

Carificabon Namalne

P448 A NEGRATE  0.0D SWNGS 00D

1]

Additional Claim information

The HIPAA Claim Master displays every element of a specific segment. Sometimes only
the HIPAA codes are displayed, often they are translated into their descriptions. If you
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need to find out about these codes, please consult the 837 implementation guide.

6.4 Displaying COB

COB information can be very complex within the 837:
e Multiple payments of
e Multiple lines, which contain
e Multiple adjustments, done by
e Multiple payers

...can be tracked in the nested structure of an 837. To display such a nested structure is
a daunting task, as you can imagine. | still recommend that you fully understand the
nesting of COB data.

On the Claim level, we find additional payers in the 2320 loops. Within the 837 EDI file,
adjudication information is stored in either CAS segments or the Medicare, MIA
(inpatient) and MOA (outpatient) segments. Specific amounts are similarly stored in the
AMT segments. On the line level, each line can contain up to 25 different adjudication
actions; SVD segments, which identify the payer and their amounts. Adjudication
information is then written in multiple CAS segments and optionally, in the DTP
segment, the adjudication date.

If the HIPAA Claim Master finds that a claim lists several payers, the claim preview screen
will display the "COB" button.

1/6 — (laim Addlinfo @ (OB info
%ﬂ

The "COB Info" button

Click this button, and the following display appears:
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= Lf6 = Chim Addlinfe

COB Information: Payer 2

COB info

Fayer Sequence: Primary
Ingurance Geoug Mo
Assignment of Benelits.  Yes

Fabent's Relationship to Inswred
Groug Name Filing Code.  Commurcial nsurance Co.
Release of Information:  Yes, Provider has a Signed Statement Permitting Release

Sell

Payérs Mame: Astna ing Payor ID PR3 Claim Agudicaion Date: 09012003
Insured Last Name: Coach First Dawn Wil e Suffix
Subscnbers DOE 0441944 Subscribers Gender.  Famale
Member IO 26654327902
Frior Payment - Adual: §1,800.00 |C-!.‘.ﬁ.#dll:-wec.-‘ummt 52,075.00
TeRal submitied Charges $2,325.00
Claim Level Adjudication Infermation:
Adjustment Group Adjustment Reason Ami ity
| 1| PR - Patsent Responsibiity | 1 - Deductible amount §20.00
2| PR . Patient Respons bty 2 - Coinsurance amount §255.00
3| P - Payos Inftabed Reductions | 45 . Chanpes excied your contraclied) kegiskated fee arrangemint, §250.00

COB Information: Payer 3

Fayer Sequénce.  Secondary
Inswrance Group No:
Assignment of Benelits.  Yes

Fabents Relabionship B0 Inswred.  Self
Coup Name: Filing Code. Commercial nsurance Co.

Release of Information:  Yes, Provider has a Signed Statement Permitling Release

Assignment of Benelits.  Yes

Fayers Mame: Uniled Healthcare ins Payor ID 04523 Claim Agjudicaion Dale: 09012003
Insured Last Name: Coach Fist Dawn Micdle Suffix
Subscribers DOB 04241944 Subscribers Gender.  Female

Kember IO 26123456802

Fror Payment - Adual $10.00 |C{§ Allowed Amount $30.00

Tofal submithéd Charges 52,2500

Claim Level Adjudication Information:

[ Adusiment Group | Adjestment Reason [Amt ES
COB Information: Payer 4

Fayer Sequence. Tertiary Fabenl's Relabonship b Inswed:  Sell

Ingurance Groug No Groug Namé Filing Code.  Commuercial msurance Co.

Release of Information:  Yes, Provider has a Signed Statement Permitting Releass

Information about additional payers

Payérs Hame: Cigna ins Payor 1D NG5 Claim Adudica®on Date. 090172003
Inswred Last Mame. Coach Furst Dawn Migdle Sulfix
Subscnbers DOB 04241944 Subscribers Gender.  Famale

Mgmber 1D 26123457902

Frior Fayment - Adual 510,00 |C{:G;dlnwen.ﬁmnmt 530,00

Tedal submitted Charges 5232500

Claim Level Adjudication Infermation:

| Adjustment Group | Adjusiment Reason | Amit | ity
COB Information; Payer &

Fayer Sequence. Tartiary Fabenl's Relaionship B Inswed.  Self

Insurance Group MNo: Groug Name: Filing Code: Commercial nswrance Co.
Aepanmmned ol Qamadita Vas Balasca af lndarmatinn VWas Drruciiar has & Cinead i Ok oLl Dalk

Each payer is in one block. Any claim level adjudication will be displayed, listing
adjustment group and adjustment reason.

Line level information is displayed on the following pages.
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HIFAD, Previsw E

C Print  Close e 1§86 == | Chim | Addlinfo | COHinfo
[ Member 1D 210005000 ] =
| COB FAYER FAID S16.00 ICGBHIM&IJ.NHMM 110000 ]

Claim Level Adjudication Information:
Adpusiment Group Adjustment Reason At Oty
1| CO - Conlractual Obligations | 45 . Charpes exceed your contracied’ legislaied fee arrangement. 535000
2| PR - Pabent Responsibility 1 - Deductible amount £90.00
3| PR . Patient Responsibility | 4 . Coinsurance amount §4.00
Line Level COB Information
Ling: |Froc Code |Moofieds Charge Frarm Diale To Duate nits  [Facility [EMG |TEP5DT [Fam Fla
| A6 TC S100u00 B0 2003 00012003 1UN | 11
Fayeri)  Fayer Mame FrocGd  |[Mods Fev L-ode FayeriFaid  [Faid Gty [Bndidnb . Date
3670 Medicare 93016 | TC $0.00 1 1 %
Adjustment Group Amjusiment Reason A Qty
1| CO - Contractual Obligations | 45 - Charges exceed your contracted kgisiated fee $20.00
amangement.
"Z| PH - Patient Responsibiity 1 - Deductibie amount §20.00
Ling: |Froc Code |Modifiers Charge From Liale ToDate Units  |Facility |EMG [EPSDT JFam Fla
2 83017 TC $100,00 09012003 09012003 1UN [ 11
Payer 1D |Payer Hame Proc Cd  [Mods Rev Code  [PayerPad  [Pad Oty [EndiUnb Pvdluﬂ Date
J6TO Muedicars axmr | TC 0,00 1 2 |M-'|:I'I-'2N$
Adgustrmsnt Group Adpustmant Beasan At Oty
1| €0 - Contractsal Obdgatons A5 < Charges excesd your contracted legislated feg 545.00
arrangement.
2| PR - Patient Réed pors iblity 1 - Dercdunc il ArmOunt $55.00
Ling: [Proc Code [Moofiers Change Frarm Diate To Dt Iunits  [Facility JEMG [EFSDT [Fam Pla
3 (93018 TC $100.00 a1 2003 00012003 1UN [N
Fayer D |Fayer Hame Fru{ Cd [Mods |ﬁe-.- Code |Fa,~er Fasd F"a-d oty |Em:l| Lnt: |§ud Date
36T Medicare | 93ME TC | | S0.00 | 1 | 3 0901200
Adgustment Group Agpustmgnt Rgasan At oty
1| C0 - Contractsal Obsgations | 4% - Charges excesd your contracted! legisiated fee $25.00
amangement.
'Z| PR . Patient Responsibility 1. Deductible amount £15.00
Cing. |Proc oo [MooRiens Charge Frarm Dae To Dlale JOnis  [Facity JEhis BP0t Fam P
4 20048 $100000 R 2003 o011 2003 1UH | 11
Payer I |Payer Hama Proc Cd  [Mods Rev Code  |PayerPaed  [Pasd Oty [Enul‘l.l'hb ljud. Date
J6TO Madicare BO048 $3.00 1 |' 4 F:-UIEWI
Adjustment Group Anjusiment Feason - Oty
1| CO - Contracisal Oblgations | 45 - Charges exceed your contracied! legislated fee 3000/
anangement.

COB information on the line level

Notice the nested structure of the display. For each line, we see a recap of the line
information, followed by payer information and possibly several lines of adjudication
information.

6.5 Displaying Document Info

The EDI envelope contains information about the transaction set, the sender, the receiver,
dates and other pieces that are not printed on medical forms.

1. Select Forms » Document Info in the main menu.
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w HIPAA Clain Master - B4bit

CMS- 1500 (0E05 MNPT)
CMS-1500 {0212 NPT}
UB 92

UE 04 (NPL)

AR 2000

ADA 2004

AL 2006 (NPT)

The "Document Info" menu

2. The following screen will be displayed.

Pt Close = 1f1 -

EDI Document Info

Control Header:

Authorization: -->Qualfier; 00 --=Infi

Securty. -—->Qualifier. 00 —=Info;

Sender IO -->Qualfier: 29 —>Subrmitber 10 99Te54
Sender IO -->Qualifier. 28 -->Camer ID; 32112
Creation: —>Date: 02901 —-=Time: 1330

Standards.  —>I0¢ U —>Version: 00401

Control Number: 112233489

Acknowledge Reguest 1 TestProduction: T

Group Header:

Document identifier Code: HC

Submitter 10 987654

Camer ID: 32112

Creation: --=>Date: 0172020 --=Time: 1330
Control Number, 328 Responsible Agency. X
ANSI Version Code: 004010x098

Transaction Header:

Transacton Set identifier: 837
Transachon Set Control Mumber. 54366

Transaction Trailer:

Murnber of Segments: 1005

Displaying the EDI envelope information
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6.6 Printing Blank Forms

Follow the instructions below to print a blank form.

Select the "Forms" menu.

(5 HIPAA Claim Master - 64bit

Fils (| Forms [ Wiew  Search  Claim Entry/Edt
Document Info

HCFA-1500

CHE-1500 (0505 NPT)

CM5-1500 {0212 NPT)

LB 92

LIE 04 (NPT)

A 2000

Ou
(C)

ADA 2004
r A 2006 (NPT)

The "Form’ menu and its sub-menus
Select one of the following claim forms that the HIPAA Claim Master can display:
e HCFA-1500
e CMS-1500 (0805 NPI)
e CMS-1500 (0212 NPI)
e UB 92
e UB 04 (NPI)
e ADA 2000
e ADA 2004
 ADA 2006 (NPI)

Clicking on this menu displays a blank form depending on the choice of claim type. This form
can be sent to the Printer by clicking on the "Print" button.
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HIPA, W

* Print

| Close | —1f1 — [
Sender 10
Dental Claim Ferm 3
Orig. Ref. Na:
Dhmencan Dental Azsociabon, 1399 version 2000
D4 denisis pu-maineniesinae  Tgecaly Lty Ky
Dlieniafs s T T
Oz  mediee Clan PRI SR WO B . Caier hjdms s
O Bechonic Diang
Sy Ia.m | T.oe
p [ = Foterd same unat,fes L ibmise) T (=T [IE=rT
&
WL o] 13 Faderd 1 0 1550 5. Frore sumser 5. Dp Cogn
IE Om Or
W | 17 Relaloretiz B roites Enploger [y e —
T | CwenOwpere Dons Dorer, Name Aaddneds
T e T BEEETL] ? I B FEIER Sk ) by B Per BUER K SERACE S B B o IS TR R
EI E O e (B T Oves Doenimor Ciesa
B | I BurcaenBmpioee Nane (Lo, Fier i, ildoe) R | T Giver Bubeciers Same (W bifkend
H P
MECH . Prore Bamae f_’ 34 e o DI QKB BT - . Frogmm wane
I! 13 Ou
E . Cily o5 Rhir T, D Lodn IE T Emglouwifctonl
) ] Eamr ddmrn
‘E I balk of B QB WY 5 e 1l Dk 0 Bex I BgsSBerlinplors Dhle
" DOarers Oimirgie Dowar Ou Or DOlmmpiowd O vrtine 5oie O iuibbra Sigent Dpaiing Glom
[ 2. IFaE Beeh irRemed o he Fraimenl glanard soeodakd fer. lagee o be e poneie £ ol 0. Braloye rBchon
L ahages KX fenE IPARSES SN0 MAERS Ao ipad By Ay derabere | glan, uriess Be Fealng fenksl
| e i e ummmmmumrmmm'w"ﬂlmam " o
1'0 e BN peemd G Unees 2 | e i b e e o By Abon =
¥ mhmuluk‘.lro s dllmal'mllhlll haﬂnl!sll!bnhml.l’lflﬂl #1. | RSNy SN S AmBEN 5 e BERE BErel B oPesiee BaEnie oine Smchy i ine
E | mulhosmbon| oo remed derds end i
e o, L#
ERgres (PaberwCE LY T QRNE BT SIEreR (B RS TR b QENE T
3 [ - R Sy berdelcr bl Bl oI Prore mumaer | o bax we. Brouder 10 6 b bens | Boc Bec.or TR
I
L[S a7 Bende | Uncaren 8508 A3 N el 2T o 8, Piscr oo Treamand
' et Dona Owcep. Oecr Diorer
L]
o | m.oy 1. 0ak 2.0 Coae £ Riigrmie ormodels eradeeesT 4. B FEaRon] £ orfedonl s T Croes Cue
. Crver. bowitargT . Qs Waesber drealy a:
: S8 NEIeTEsls (0w, BALEE  BERAIEI 12 Pi3 e, A T ESIBCEREL DAk of o macment: bl mpitaes ginEd ol mos, of FEamend
T | wiinginznerd™ Oves Dee mmanrg
.I. S bt FEameniesu |ofocopalonal Siness oiniunT Ores Owe . & mameniesuiof O o scadend Cloberacdsen™ Dinel nex
T | wemibes Brie T e i foryand daies
L Diagresis Cofe Fdec
1 2 a . ¥ . T &
5. Rawrdralon ard mamerd plare - Ul e F e oster Admin, Uee Qniy
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3y El a 2
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Display of a blank ADA 2000 form
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7 Using Search

7.1  Searching through a Claim File

Follow the instructions below to search through the claim file.

1. Select Search » Define Search in the main menu.

e HIPAA Clain Master - B4bit

File Forms  View(| Search | Claim Entry/Edi

= m  [CSwses )

The "Define Search"” menu

2. The following screen will appear. It will let you define search conditions.

[ Search EDI File
Create Search Condition

P[=] E3

Provider's Claim ID (CLM_01) ||

Patient ID (NM1_09) |

Patient Last Mame: ]

Subscriber Last Name |

Subscriber ID |

Bill Provider ID |

Complete Segment

Cancel I Help |

Search I
£

The "Search EDI File" Screen

3. Specify your search criteria. You can search for:

e The Provider's Claim Number or Patient's Record number that is stored in CLM_01

segment

¢ The Patient Control Number or Patient's ID

¢ Patient Last Name

e Subscriber ID

e Subscriber Last Name
e Billing Provider's ID

e A complete EDI segment
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You can specify multiple search conditions.
4. Click "Search.”

5. The HIPAA Claim Master parse through the file and display the claim that fulfills this
criterion. If there are many claims, it will display each claim that has this condition.
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8 Editing and Entering Clams
8.1 Using the Claim Entry/Edit Function

You can enter either a Professional, Institutional or Dental claim. Claim entry requires
more transaction code sets and you can access and edit them from those menus as well

as setup the component.

The following topics describe settings for the Claim Entry/Edit function:

e Selecting a Claim Entry/Edit CodeSet

¢ Defining Claim Entry Settings

e Creating Diagnosis Table

Follow the instructions below to edit or entry claims.

1. Select Claim Entry/Edit » Professional / Institutional / Dental Claim in the main
menu.

(s HIPAA Claim Master - G4bit

File Forms View  Searchl | Claim Enbry/Edk |JpataBase  Code Sets

B> ”_]_ * Professional Claim | ¢
; 1 [restibutional Claim
0 Mode Dental Claim
% Prinser Claim Enbry/Ed# CodeSets  » | f/
o | Clairn Enkry Settings | 4

The "Claim Entry/Edit" menu

2. A screen like the one pictured below will be displayed. The following screen-shots will
use the "Professional Claim" window.
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Professional Claim - [O] x]

Providers
Patient
Claim Information

COoB

Service Lines

T

=0

Search in
DB

Show Setup

New Claim ‘ Screen

| Codesets

Help | View Claim I Save Claim

o |

The "Professional Claim" window

3. Each segment or loop has its own set of editing screens listed on the left; they can
optionally have different colors. The five (5) main data groups are:

¢ Providers

e Patient

e Claim Information
e COB

¢ Service Lines

Click one of these menu items to open to the relevant screen.
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Professional Claim

Claim Information

CoB

Service Lines

| &= =

="

Search in

9 Show Setup
New Claim | DE

Screen

Save Claim | Exit L

| Codesets Help | View Claim

The left menu in the "Professional Claim” window

4. Once you have accessed a main category screen, you will see the top menu to access
the individual screen. Use it to navigate along the claim.

Below you can see the billing provider information from a claim that was loaded from
the database. To see and edit other provider types use the tabs at the top of the
screen. The following image shows all the provider types that are part of the
Professional Claim implementation.
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Professional Claim

Billing Provider Pay-To Provider | Referring Provider |Rendering Provider

Fiald 33 in the HCFA 1500 Form holds this information
. 3

Billing Provider Details Other ID's and Charge Info

LasyOrganization Name: GRUPO EMPRESAS DE SALUD CAROLINA

First Name: Middle: Suffoc

Provider ID: 660614786 =D Type: 24 - Employer's ldentification Number ~ i

Address: PO BOX 193044

Address2:

City: SAN JUAN * State: PR v Zip: 00919
Provider Specialty: =
Contact [ [ ]
i Save | | Clear
Phone: ( )~ Extension Fax ( ) . ’

Email

Show Setup
Screen

Codesets Help View Claim | Save Claim E xit L

The "Providers" tab selected in the "Professional Claim" window

Different sections may have a different range of tabs across the top. The following
screen-shot shows top menu items for the "Service Lines" section selected in the left.
This top menu differs from the top menu displayed on the previous screen-shot with
the "Providers" section selected.
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Professional Claim

Line Secondary |Ds

Service Date From: 08/28/2007 [0~

Place: 11 - Office

Code Type:

Sel es

Procedure Code: 93000

Charges: c Days/Units: 1

EPSDT
Patientwas exempt from co-pay

Emergency

Line Adjudication Additional Information

" ServiceDate To: _/ [ rid

HC - Procedural Code

-

-« * Modifiers
Unit Qualifier
UN - Unit -"
| Family Planning

[ I [ Delete
| Help MNew Line 1 Save Line | Line
No Service From Service To Place Procedures, Service or Supplies. M... Charges Diag. Poi.. Units
1 08/28/2007 1n HC 93000 18.43 1 UN
Show Setup -
Screen | Codesets Help | View Claim | Save Claim | E xit L

The "Service Lines" tab is selected in the "Professional Claim" window

5. To preview your changes, click "View Claim." A claim form will be shown on the screen.

Sh;:ws:r:""' | Codesets Help | View Claim | Save Claim | E xit L‘
The "View Claim” button
6. To save the changes, click "Save Claim."
Sh;:res:;"p | Codesets Help | View Claim . Save Claim | Exit L‘

The "Save Claim" button

8.2 Selecting a Claim Entry/Edit CodeSet

8.3  Defining Claim Entry Settings

1. To configure the claim entry options, select Claim Entry/Edit » Claim Entry Settings in

the main menu.
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s HIPAR Clain Master - G4bit

Fle Forms View Search(| Claim Ertry/Edit [)DataBase Code

: Professional Claim
= 7

Institutional Claim
~ Dutput Mode Derkal Claim
1 Prirter i Enitry/Edit Codesets
C Screen | CsmEntrySettings |

The "Claim Entry Settings” menu

Alternatively, you can access the setup window from the Claim entry/edit window.

Click the "Show Setup Screen” button. Read more in Using the Claim Entry/Edit
Function.

Professional Claim

7 R oo o
“ Ambulance Chiropratic J DME % Home Oxygen [ CRC l Repricing J HSD [ Paperwork
Ambulance Transport
Patient Weight Pounds

Transport Reason Code: .
Transport Distance " Miles
&>

Trip Desc

Swretcher Purpose

Help Clear Save

No  Service From Service To Place Procedures, Service or Supplies, M... Charges Diag. Poi.. Units

1 08/21/2007 1 HC 99214 76.81 1. UN
Show Setup -
Scresh | Codesets Help | View Claim | Save Claim | E xit L

The "Show Setup Screen” button on the "Professional Claim” window

2. The following screen will appear.
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Claim Entry Setup

Colors for Tabs
) Do not use colors for tabs

® Use colors fortabs

Main Color

Restore default colors

Selected Color

Providers:

Patient

Cilaim Information:
CoB-

Sernvice Lines:

Font Color:

Home Tab:

Auto-Complete Mode

Turn off Auto-Complete for Provider, Payer and Subscriber names

Turn off Auto-Complete for Provider, Payer and Subscriber ID's

Close

The HIPAA "Claim Entry Setup” window

Help

— O x

MNew Claims

Version in New Claims
O Use 4010
® Use 5010

Information in New Claims
) Production
® Test

Save Claims
[] validate claims before save

Don't save claim if warnings

Save Entities
[] Save Providers

[] Save Payers
[] Save Subscribers/Patients

Save

3. The claim entry setup screen is divided into the following groups:

e Colors for Tabs

e Auto-Complete Mode
¢ New Claims

e Save Claims

e Save Entities

Read the detailed descriptions further.

4. Once you have finished editing the options, click the Save button to save any changes
or click the Close button do discard them.

Colors for Tabs

Unlike other screens in the HIPAA Claim Master, the window for claim entry has a lot of
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colors (see Using the Claim Entry/Edit Function). We decided to do this to give a clear
distinction between the different groups of information. There are so many screens in
this application that it is easily confusing to the data entry person. To develop a sense of
intuition of where one is in the process and flow of the program we decided to add
colors. You also have the choice to not use colors for the tabs:

¢ Do not use colors for tabs
e Use colors for tabs

You are free to customize the colors. Click the button with the three dots to the right of
each color to display the color selection screen where you can choose the color for a
particular segment.

Colors for Tabs
) Do not use colors fortabs

® Use colors fortabs Restore default colors

Main Color Selected Color

Providers:

Patient

Claim fnformation:

COB:

i

Senvice Lines:

Fonf Color:

Home Tab:

The color palette selection button
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EEEENET
EEEN ]
EEEETT

Custom colors:

Hue: Iﬂl Red:
LD DL S0 | Groen: 23]
Define Custom Colors == ColoriSolid Lum: Blue:

[ ok | cance | | Add to Custom Colors |

The color selection window

New Claims

HIPAA Claim Entry lets you predefine the version of the claim that you enter. This choice
will influence the screens that you are presented with. Claims you create will be written
to the database according to the implementation guide for the version that you choose.

New Claims

Version in New Claims
O Use 4010
® Use 5010

Information in New Claims
() Production
® Test

Claim version options
Version in New Claims

Set new claims to the X12 4010 or 5010 standards. A claim loaded into the claim editor
will preserve the standard it was saved in originally.

e Use 4010
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e Use 5010

Information in New Claims

Set new claims to use Production or Test data.
¢ Production

e Test

Save Claims

Before saving a claim to the database, it can be validated against the X12 standard. The
compliance engine will warn users of errors that would make the claim fail compliance,
such as missing segments, incorrect datatypes, unrecognized qualifiers or excessive
characters in a particular field.

Save Claims
[] Validate claims before save
Don't save claim if warnings
Claim compliance validation options

¢ Validate claims before save - runs the compliance engine to check for potential
errors in a claim file

¢ Don't save claim if warnings - if a claim fails the compliance check, it is not saved
to the database

Save Entities

Saving entities to the database is an option for facilitating data entry. Providers, patients
and payers are saved into a database after being entered for later retrieval. Entering a
last name or ID will automatically fill the entity's remaining fields in the claim editor.
They can be individually selected. To view currently saved entities, see entity editing.

Save Entities
[] Save Providers

[ ] Save Payers
[] Save Subscribers/Patients

Save entity to DB options
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Checking an entity will allow a user to autofill a provider, payer, patient or subscriber in
the claim editor by filling in the entity's ID.

Auto-Complete Mode

Entities saved to the database can be loaded into a provider, payer or patient form by
typing out the relevant entity's name or ID. The ID and Name textboxes will suggest an
entity to enter into the form and accepting will autocomplete the remaining details. To
disable this capability for the ID or Name, check the appropriate box. To learn more
about autocomplete for providers, payers and subscribers, see Provider, Patient and
Payer Autocomplete.

Auto-Complete Mode
Turn off Auto-Complete for Prowider, Payer and Subscriber names

Turn off Auto-Complete for Prowider, Payer and Subscriber IDVs

Autocomplete options

8.4  Provider, Patient and Payer Tables

Filling in provider, patient, and payer details multiple times is a repetitive task that can
be alleviated by storing the relevant entity in a table for later retrieval. For example,
entering a provider's ID number will suggest a stored provider to select from and
automatically fill the remaining fields in the provider form with the relevant data. To
create the provider, patient or payer tables follow these steps:

1. Click Claim Entry/Edit » Create Tables for Entities
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32bit
Search | Claim Entry/Edit | Data Base  Code Sets

= Professicnal Claim s
'ER) o .
Institutional Claim

Dental Claim
Clairmn Entry/Edit CodeSets  »
Claim Entry Settings

Stored Patients
Stored Payers

Stored Providers

Create Tables for Entities

Create tables for entities menu

2. This opens the Create SQL Tables window. Here you can create the StoredPatient,
StoredProvider, and StoredPayer tables. Check the appropriate database is selected
and click Execute Script to create a table. If the table has been changed in a new
release, clicking Compare Script with existing table will create a script to adjust the

table. Changes to database tables do not occur often.
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Create 50L Tables

Databaze

— O x

® Microsoft SQL Server O MySQL/Generic O Oracle O DB2

Patients Providers Payers

StoredPatient Table script:
1 CREATE TABLE [dbo]. [StoredPatient](
p [ID] [bigint] IDENTITY(1.7) NOT NULL.
3 [PolicyHolderlD] [varchar](30) NULL,
- N
5 [PatientlastName] [varchar](60) MOT NULL.
6 [PatientFirstName] [varchar](35) MULL,
7 [PatientMiddleMame] [varchar](25) NULL.
8 [PatientPrefid [varchar](10) NULL,
9 [PatientSuffix] [varchar](10) MULL,
10 [PatientlDQual] [char](2) NULL
1 [PatientlD] [varchar](30) NULL,
12 *REF*]
13 (MemberMo] [varchar](30) NULL.
14 [ClientNo] [varchar](30) MULL,
15 [PolicyMo] [warchar](30) NULL,
16 [SSN] [varchar](30) MULL.
17 [PropertyCasualtyMo] [varchar](30) NULL,
18 N3
19 [PatientAddress1] [varchar](55) NULL,
20 [PatientAddress2] [varchar](55) NULL,
21 g
22 [PatientCity] [varchar](25) NULL,
23 [PatientState] [char]{2) MULL,
24 [PatientZip] [varchar]| 14]} MULL.
25 [PatientCountry] [char](3) NULL
26 [PatientSubdivision] [char](3) NULL,
27 FFDMG=
28 [PatientBirthDate] [date] NULL,
Compare Script with existing Table Save
Help

Create SQL Tables window

3. Click Execute Script. A new table will be created.

Success

Pt

Table 'StoredPatient’ successfully created

Table creation success

Execute Script

Close

© <2003> Martin Scholl Consulting, Inc.



277 HIPAA Claim Master

8.5 Stored Patients

Stored patients can be viewed and edited in this screen. To open the Stored Patients
editor, click Claim Entry/Edit and then Stored Patients:

@ HIPAA Claim Master - 32bit

File  Forms  View  Search | Claim Entry/Edit | Data Base  CodeSets  Logs Imag
" Professional Claim %
[~ | —
P 537 - il
53] L Institutional Claim
Output Mod Dental Claim
() Printer Claim Entry/Edit CodeSets  »
@ Screen Claim Entry Settings
() mage Fle Stored Patients I
Stored Payers
[ Data | Stored Providers
Create Tables for Entities
Claim Type
() Professional
() Institutional

Stored patients menu option

A new window containing all patients, both subscribers and dependents, will be opened.
To create the StoredPatient table, see Provider, Patient and Payer Tables.
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Stored Patients — O ®
1 SELECT™
2 FROM StoredPatient Execute Query
Clear Query
Stored Patients Define Query
ID Last Name First Name Patient ID Paolicy Holder ID Relationship
Patient Information
Last Name| |= First:| |*Middle:| | Sufﬁx:| |
D Type:l v| ID | |
Address | | | |
Zip| | City| | State | v| Coumry| | Subdiv.| |
DOB|_/_J/___|E~| Sex ~ | Birth Order I:I Employment Status | v|
Relationship to Subscriber | v| Palicy Holder ID | |

Additional ldentifiers:

Patient Account: | Medicaid Recipient ID: |

Group or Policy Mo: | | HIC Mumber: | |
Branch ID: | | ID Card Number: | |
Group MNo: | | Policy Mumber: | |
SSN: | | Plan Network ID: | |
| |
|

Department Mo: |

Delete Patient

Stored Patient editing screen

The table contains all patients present in the StoredPatient table. Selecting a patient in
the table will fill out the Patient Information form. Editing the fields and clicking Save
Patient into Database will modify the contents of the selected patient's row to match
your changes.

To create a new patient, click the New Patient button below the Stored Patients table,
fill in the Patient Information, and click the Save Patient into Database button to save
the new patient.

To delete an existing patient, select the patient in the Stored Patients table and click
the Delete Patient button.

8.6 Stored Payers

Stored payers can be viewed and edited in this screen. To open the Stored Payers editor,
click Claim Entry/Edit and then Stored Payers:
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€ HIPAA Claim Master - 32bit

File Feorms  View  Search | Claim Entry/Edit | Data Base CodeSets Logs i
Professional Claim
| > i) one -
) Institutional Claim |
Output Mod Dental Claim
() Printer Claim Entry/Edit CodeSets »
Iy
Ok Clairn Entry Settings
() mage He Stored Patients
Stored Payers I
[] Data I Stored Providers
Create Tables for Entities
Claim Type
i) Professional
Y actih el

Stored payers menu option

A new window containing all payers stored in the StoredPayer table will be opened. To
create the StoredPayer table, see Provider, Patient and Payer Tables.

o Stored Payers — O *
1 SELECT* Execute Query
2 FROM StoredPayer
Clear Query

Stored Payers Define Query

ID Payer Name Payer ID

e eto o [Newayer] |

Payer Information

MName: |

ID Type: | v| ID:| |

Address: | | |

Zip: | | City: | |State:| ™

Additional Identifiers:
Payer ID No: | | Claim Office Ma: | |
NAIC Code: | | Federal TaxID: | |

| Delete Payer | Save Payer into Database |

Stored Payer editing screen

The table contains all payers present in the StoredPayer table. Selecting one will fill out
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the Payer Information form beneath it. Editing the payer fields and clicking Save Payer
into Database will modify the contents of the selected payer's row to match your
changes.

To create a new payer, click the New Payer button below the Stored Payers table, fill in
the Payer Information, and click the Save Payer into Database button to save the new
Payer.

To delete an existing payer, select the payer in the Stored Payers table and click the
Delete Payer button.

8.7 Stored Providers

Providers stored in the database can be viewed and edited in the Stored Providers
editing screen. To open the Providers editor, click Claim Entry/Edit and then Stored
Providers:

@ HIPAA Claim Master - 32bit

File Forms  View  Search | Claim Entry/Edit | Data Base CodeSets Logs D
= Professional Claim
[ 5
I BSE (A,
' 533 L‘_ Institutional Claim
Output Mod Dental Claim
() Prirter Clairm Entry/Edit CodeSets  »
@ Screen Claim Entry Settings
) Image Fle Stored Patients
Stored Payers
[ Data | Stored Providers
Create Tables for Entities
Claim Type
() Professional
() Institutional
() Dertal

Stored providers menu option

A new window containing all payers stored in the StoredProvider table will be opened. To
create the StoredProvider table, see Provider, Patient and Payer Tables.
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8.8

Stored Providers

- O X
1 SELECT*
2 FROM StoredProvider Execuislduen
Stored Providers Define Query Clear Query
D Hame Provider ID 1 of 1
Last/Organization Name . First Name Middle Name Suffix
[LasT [ I Il |
Entity Type: ID Type: D
|45-Drcp-uﬁ\_ucatlcn v| |XV-Cemersfched|care and Medicaid Sel vr |12312313 |’
Address
|| |
Zip City State Country Code Subdivision
| Il I -l I
Provider Code Specialty
-l |- 1 |
Contact Phaone: Extension Fax
| | [o— I | [(o— ]
Email URL:
| I |
Pay-to Address
Address ‘ || |
City ‘ ‘ State| v| Zip ‘ |
Additional Identifiers:
State License: | | Commercial No | |
License Number State Code l:l Location No: | |
Provider UPIN | | Payer D! | |
EIN: | | Claim Office No: | |
ss: | | NAIC Code: | |
Delete Provider Save Provider into Database

Stored Provider editing screen

The table contains all providers present in the StoredProvider table. Selecting one will fill
out the Provider Information form to the right of the window. Editing these fields and
later clicking Save Provider into Database will modify the contents of the selected
provider's row to match your changes.

To create a new provider, click the New Provider button below the Stored Provider table,
fill in the Provider Information, and click the Save Provider into Database button to save
the new provider.

To delete an existing provider, select the provider in the Stored Providers table and click
the Delete Provider button.

Creating CodeSet Tables

Some codesets are so numerous that it does not make sense to store them in an XML
file. There are more than 25,000 procedure and revenue codes and more than 15,000
diagnosis codes in ICD-9 alone. For that reason we decided to store Procedure Codes,
Diagnosis Codes, Revenue Codes and ZIP codes in the database. In the following example
a Diagnosis Code table will be created.

Note: You need to configure the connection to the database first. See Setting up Database
Connection.

1. Select DataBase » Code Look-up Tables in the main menu.
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t | DataBase | CodeSets Logs Im
Connection and Fields
Claims in Database
Create SCL Tables
Code Look-up Tables |
Field Mappings

Create 837 EDI Files
Deliriters Setup

2TTCA Setup

The Code Look-up Tables menu option from the main menu bar

Alternately, a specific codeset's editor can be opened by clicking the appropriate
Procedure, Diagnostic or Revenue Code option from either the Code Sets menu or the
Claim Entry/Edit » Claim Entry/Edit CodeSets menu option.

2. The Code Set edit screen will appear.

Diagnosis Codes

Table DIAGNOSIS does not exist!

Create table DIAGNOSIS

The "Diagnosis Code" window

3. Initially the table does not exist in your database. To create the table, click the
"Create table DIAGNOSIS" button.
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Diagnosis Codes

Table DIAGNOSIS does not existl

Create table DIAGNQSIS

The "Create table DIAGNOSIS" button

4. A table creation window will be displayed.

Create DIAGMNOSIS Table — O *

Database
® Microsoft SQL Server O MySQL/Generic O Oracle () DB2

DIAGNO SIS Table script:

Lo TR = R s I I P

1

1 CREATE TABLE [dbo]. [DIAGNOSIS](

[CODE] [varchar](15) NOT NULL.
[DESCRIPTION] [varchar](254) NULL.

[SHORT_DESC] [varchar](50) NULL

[TYPE] [varchar](5) NOT NULL.

CONSTRAINT [PK_DIAGNOSIS] PRIMARY KEY CLUSTERED

[CODE] ASC.
[TYPE] ASC
) ON [PRIMARY]

11 ) ON [PRIMARY]

Compare Script with existing Table Save Execute Script

Close

The "Create DIAGNOSIS Table" window

5. Select the appropriate database and click the Execute script” button and the table will
be created.
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Create DIAGMNOSIS Table — O *

Database
® Microsoft SQL Server O MySQL/Generic O Oracle () DB2

DIAGNO SIS Table script:

1 CREATE TABLE [dbo].[DIAGNOSIS](

[CODE] [varchar](15) NOT NULL,

[DESCRIPTION] [varchar](254) NULL,

[SHORT_DESC] [varchar]{50) NULL

[TYPE] [varchar](5) NOT NULL,

CONSTF{AI NT [PK_DIAGNOSIS] PRIMARY KEY CLUSTERED

[CODE] ASC.
[TYPE] ASC
1 ) ON [PRIMARY]
11 ) ON [PRIMARY?

Lo TR = R s I I P

Compare Script with existing Table Save Execute Script

Close

The "Create DIAGNOSIS Table" with the "Execute” button highlighted

6. You will receive a success message like this. Click OK.

Success >

Table 'TIAGMNOSIS' successfully created

The success popup

7.0nce the table has been created, you are redirected back to the "Diagnosis Codes”
window. It looks different now and indicates that the newly created table exists.
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8.9

Diagnosis Codes

[Loadfrem XLSXfile | | Load from TXT file Number o:) r:::ords
intal

Search Codes
[cope | [pESCRIPTION 0

CODE DESCRIPTION SHORT_DESC TYPE

The "Diagnosis Codes” window with the empty table

Filling CodeSet Tables

Loading a Codeset Table can be done using a .xlsx spreadsheet, comma separated value
(csv) textfile, or space delimited textfile. The following examples assume you have
already opened a codeset's edit screen and will use the Diagnostic Codes codeset as an

example.

Diagnosis Codes - m} X
[Loadfrom XLSXile | | Load from TXT file Number of records
intable
Search Codes
[cope | [pESCRIPTION 0

CODE DESCRIFTION SHORT_DESC TYPE
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The Diagnosis Codes codeset editing window.

Tip: The diagnosis codes according to the International classification of Diseases (ICD) in the 9th
revision are published by Ingenix or the AMA for example. You can also download them from the CDC-
National Center for Health Statistics.

Loading from XLSX

1. Click the Load from XLSX file button.

Diagnosis Codes

Load from XLSX file Load from TXT file

Search Codes
The "Load ICD-9 Codes" button

2. Select an XLSX file to use by writing its full filepath or clicking the file selection button.

Diagnosis Codes

MNumber of records

in table
Search Codes
CODE | [oEscriPTION 0
Load Codes from XLSX file: | L]
Code Type: |ICD10 - First line in table contains headers Load Codes

Cancel
File selection button

3. Select a code type if applicable.

Code Type: |85 -
ICDS
D100
DRG

Code type selection for diagnosis codes.

4. Click the Load Codes button.

Loading from Text File

There are two ways to determine column position from a text file in order to build a
table: with a delimiter such as a comma or semicolon in a character delimited file or
knowing the each column’s position in a fixed width file.

1. Click the Load from TXT file button.
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Diagnosis Codes

Load from XLSX file Load from TXT file

Search Codes
Click the "Load ICD9 Codes" button.

2. Select a filetype to load the codesets from. Select File with positions if the codeset
text file you wish to save to the database is a fixed width file or File with delimiters
if the codeset file is character-delimited.

| Loadfrom TXTfile |
File with positions l:

File with delimiters

Text file type selection.

a. File with positions / fixed width - Select fixed width file that you downloaded or
have available on CD/DVD.

Diagnesis Codes

Search Codes

eooe 1] |
Load Codes from text file: | |
Code Type: Codes: from position to postion

Long Description: from position () to position I:I (®) to end of line
Short Description: from position @ to position () to end of line

Try One Line Load Codes Cancel

L] Firstline in file contains headers

The layout of the text file is usually the code in position 1 through 12, and the
description in position 13 through 44. If the first line contains headers, you can step
over the headers by checking the box labeled First line in file contains headers.

Diagnesis Codes

Search Codes
[cooe ] |
Load Codes from text file: |
Code Type: |ICD10 . Codes: from position to position |14
[ First line in file contains headers Long Description: from position () to position I:I (®) to end of line
Short Description: from position |17 (®) to postion |77 () to end of line
Try One Line Load Codes Cancel
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Clicking Try One Line will open a message box with a single example row from the
text file.
Click Load Codes to fill the database table.

b. File with delimiters / character delimited - Select fixed width file that you
downloaded or have available on CD/DVD.

Diagnosis Codes

Search Codes

Load Codes from text file: | I

[] First line in file contains headers Delimiter: l:l Codes figld: Description  field:

Code Type: ||CD1D M | Try One Line Load Codes Cancel

The delimited text file is usually delimited by a comma. The layout usually contains
the codes in field 1 and full description in field 3. If the text file includes the column
headers, check the box labeled First line in file contains headers.

Diagnosis Codes

Search Codes

Load Codes from text file: |

[] First line in file contains headers Delimiter: |, Codes field: |1 Description field: |3

Code Type: ||CD1D M | Try One Line Load Codes Cancel

Clicking the Try One Line button will open a message box with a single row from the
text file as an example.
Click the Load Codes button to fill the database table.

8.10 Viewing and Editing CodeSets

To view/edit code sets in HIPAA Claim Master, follow the instructions below.

1. Go to Entry/Edit » Claim Entry/Edit CodeSets in the main menu.
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ch

Claim Entry/Edit | Data Base

Code Sets

£

Professional Claim
Institutional Claim

Dental Claim

—

Legs  Image  Setup

EDI Exchange

Clairn Entry/Edit CodeSets

Claim Entry Settings

Stored Patients
Stored Payers
Stored Providers

Create Tables for Entities

Adjustrnent Reason Codes
Adrnission Type Codes
Adrnission Source Codes
Amount Qualifier Code
Condition Codes
Diagnosis Codes

DTP Codes

Entity Codes

Facility Types

Filing Indicator Codes

ID Codes

Info Release Codes
Medifiers

Oeccurrence Codes

The additional code sets that are required for Claim Entry/Edit

Alternatively, you can access the codesets setup from the Claim entry/edit window.
Click the Codesets button. Read more in Using the Claim Entry/Edit Function.

© <2003> Martin Scholl Consulting, Inc.



Editing and Entering Clams 290

X

Mew Professional Claim

— [m|
e
$ Billing Provider Pay-To Provider || Referring Provider | Rendering Provider| Service Facility

Providers Field 33 in the HCFA 1500 Form holds this information

P Billing Provider Details Other ID's and Charge Info
Last/Organization Name: | |*
o FirstName: | | Middle: | | sufix: | |
Provider ID Type: | v| Provider ID I:I

Service Lines
Address: | |*
@ Q Address2: | |
Zip: | | City: | |* State: w

Country Code: l:l Country Subdivision Code: I:I
Provider Specialty: l:l

Contact ‘ ‘

Email: ‘ ‘

Help

New Claim Search in DB Sh;: r;‘;::'p Codesets Help Save Claim Exit

The "Codesets" button on the "Professional Claim" window

2. The Code Sets - From the sub-menu, select a code set name. The following menu
items are available via the "Code Sets" menu:

e Adjustment Reason Codes
e Admission Type Codes

e Admission Source Codes

e Amount Qualifier Code

¢ Condition Codes

e Diagnosis Codes — See Creating Codeset Tables

e DTP Codes

e Facility Types

e Filing Indicator Codes
¢ Info Release Codes

¢ Occurrence Codes

e Occurrence Span Codes
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e Patient Status Codes
¢ Place of Service Codes

¢ Procedure Codes - See Creating Codeset Tables

¢ Provider Taxonomy Codes
e REF Codes

* Remark Codes

e Relationship Codes

e Report Type Codes

e Revenue Codes - See Creating Codeset Tables

e Tooth Numbering Codes
e Treatment Codes

e ZIP Codes - See Creating Codeset Tables

Diagnosis, Procedure, Revenue and ZIP code sets are too large to store in
memory. They can be edited like any other codeset but the database tables to
store them are created separately.

3.To select, for example, the "Remark Codes" codeset for display, click the Claim
Entry / Edit menu item and from the Claim Entry/Edit CodeSets dropdown menu
options select Remark Codes:
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Aaster - 32bit
View  Search CIaimEntr}rfEditIDataBase Code Sets  Logs  Image  Setup  EDIExchange H

—_ Professional Claim @
ED - .
Institutional Claim

Dental Claim

Claim Entry/Edit CodeSets  » Adjustment Reason Codes
Claim Entry Settings Admission Type Codes
Stored Patients Admission Source Codes
Stored Payers Amount Cualifier Code
" Stored Providers Condition Codes

Create Tables for Entities Diagnosis Codes

DTP Codes

Entity Codes

Facility Types

Filing Indicator Codes
ID Codes

Info Release Codes
Muodifiers

Occurrence Codes
Occurrence Span Codes
Patient Status Codes

Place of Service Codes

N | L

Procedure Codes

Provider Codes

Provider Taxonomy Codes

S REF Codes

Remark Codes

Relationship Codes
Report Type Codes

Tooth Mumberinn Codes
The "Claim Entry/Edit CodeSets"

4. The Code Set configuration window for the selected codeset, in this case Remark
Codes, will displayed. You can add additional codes by typing it into the blank row at
the end of the list or edit the existing ones by double-clicking the field to edit it and
type in the new value. Click the Save button to save the changes.
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Claim Edit/Entry Codeset: Remark Codes - O X
Claim Edit/Entry Codeset Remark Codes Mumber of records
in codeset
Close 842
Code Des=cription 2
M1 X-ray not taken within the past 12 months or near enough to the start of treatment.
M2 Mot paid separately when the patient iz an inpatient.
M3 Equipment is the same or similar to equipment already being used.
M4 This is the last monthly installment payment for this durable medical equipment.
M5 Monthly rental payments can continue until the earlier of the 15th month from the first re...
ME You must furnish and service this itemn for as long as the patient continues to need it We ..
M7 Mo rental payments after the item is purchased, or after the total of issued rental paymen. .
M2 We do not accept blood gas tests results when the test was conducted by a medical sup...
Mg This i= the tenth rental month. You must offer the patient the choice of changing the rent...
M10 Equipment purchases are limited to the first or the tenth month of medical necessity.
M1 DME, orthotics and prosthetics must be billed to the DME carrier who services the patie...
M12 Diagnostic tests perdformed by a physician must indicate whether purchased services are...
M13 Mo more than one initial visit may be covered per specialty per medical group. Visit may ...
Mi4 Mo separate payment for an injection administered during an office visit, and no paymen. .
M15 Separately billed services/tests have been bundled as they are considered components ..
M16 FPlease see the letter or bulletin of (date) for further information. y

The "Remark Codes" code set configuration window

As mentioned above, the procedure, diagnosis, revenue and ZIP codes are saved to a
database. These four codesets have a slightly different codeset editing screen (shown
below) but they behave in the same way. Since these codesets can grow very large,
search boxes are provided to filter through codes or descriptions.
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Procedure Codes — [m| X
Load from TXT file Number of records
Search Codes misble
[copE | [pESCRIPTION 92389
CODE DESCRIPTION SHORT_DESC TYPE
3 m Therapetic ultrasound of vessels of head and neck Ther ult head & neck ves ICDg
o0onT ENDOVASCULAR REPAIR OF INFRARENAL ABDOMINAL ACRTIC ANEURYSM OR DISSECTION: MODULA... |ENDOVS REP INFRARNL AAA/DISCTN CPT
0002 Therapeutic uttrasound of heart Ther ultrasound of heart ICD9
ooo2T ENDOVASCULAR REPAIR OF INFRARENAL ABDCOMINAL AQRTIC ANEURYSM OR DISSECTION; AORTO-.. | ENDOVS REP INFRARNL AAA/DISCTN CPT
0003 Therapeutic ultrasound of peripheral vascular vessels Ther ult peripheral ves ICDS
0003T CERVICOGRAPHY CERVICOGRAPHY CPT
0005T TRANSCATHETER PLACEMENT OF EXTRACRANIAL CEREBROVASCULAR ARTERY STENT(S), PERCUTA... | TRANSCATHETER PLACEMENT CPT
0006T TRANSCATHETER PLACEMENT OF EXTRACRANIAL CEREBROVASCULAR ARTERY STENT(S), PERCUTA... | TRANSCATHETER PLACEMENT CPT
0oo7T TRANSCATHETER FLACEMENT OF EXTRACRANIAL CEREBROVASCULAR ARTERY STENT(S). PERCUTA... | TRANSCATHETER FLACEMENT CPT
oooeT UPPER GASTROINTESTINAL ENDOSCOPY INCLUDING ESOPHAGUS, STOMACH, AND EITHER THE DUQ... | UGl ENDOSCOPY CPT
0oos Other therapeutic ultrasound Cther therapeutic ultsnd ICDg
000sT ENDOMETRIAL CRYOABLATION WITH ULTRASONIC GUIDANCE ENDOMETRIAL CRYOABLATION CPT
001 Certral Nervous System, Bypass Central Mervous System, Bypass ICD10
ooio Implantation of chemotherapevtic agent Implant chemothera agent ICDg
00100 ANESTHESIA FOR PROCEDURES ON SALIVARY GLANDS, INCLUDING BIOPSY ANESTH, SALIVARY GLAND CPT
00102 ANESTHESIA FOR PROCEDURES ON PLASTIC REPAIR OF CLEFT LIP ANESTH, REPAIR OF CLEFT LIP CPT .
£ >

The slightly different "Procedure Codes" code set configuration window.

The codeset windows provide the following information:
e Number of records in codeset — The total number of codes stored in the database.

e Codes and their corresponding descriptions. A short description, standards version
(ICD), city and state (ZIP) may also be included, depending on the loaded code table.
The codes are indicated in the source EDI files. The descriptions are displayed instead
of codes in the result easy-to-read files. For example, for Remark Codes there are
the following codes and corresponding descriptions:

e 3D - OBGYN

e M1 - X-ray not taken within the past 12 months or near enough to the start of
treatment.

e M2 - Not paid separately when the patient is an inpatient.
e M3 - Equipment is the same or similar to equipment already being used.
* etc.

4. Click on the "Save" button to save the changes. Changes to the procedure, diagnosis,
revenue and ZIP codes are saved automatically to the database.
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9 Creating 837 EDI Files

9.1 About Creating EDI Files

With the version 4.1, the creation of EDI files from database records was introduced.
This is a powerful and important addition to the capabilities of the HIPAA Claim Master.
Now you can create EDI files from your claim records whether they were imported into
the database via EDI files or originated from your own claim system. This is an add-on
component of the HIPAA Claim Master and needs to be licensed in order to use it.

The licensing of the database integration component is required to use this feature.

Note: HIPAA compliant EDI files are not easily created from records that don't originate from EDI. It
might take a while to produce compliant records for several reasons:

¢ You might not have every field that is required by the implementation guides
e The data that you have is not formatted according to the HIPAA guides

e Data might have to be assembled from across your enterprise's applications

We recommend that you also purchase and employ the EDI Exchange module. This way
you can check each individual claim record before it is written to the EDI file and you can
even suppress records that are not created without compliance warnings.

{3/ HIPAA Claim Master - G4bit

File Forms View Search  Claim Entry/Edk (| DataBase | Code Sets  Logs

E T Connection and Fislds
= > |
- - ~ Claims in Database
0 Mode Create SOL Tables
= Priter Code Look-up Table

 Screen I:m 457 ED1 Fles _—I

The menu item to create EDI files under the "Data Base" menu

9.2 Setting up Company

Creating EDI files will include a lot of information on you and your trading partners. The
company setup screen is designed to enter all the necessary information for the EDI
creation.When you create EDI files there are a few elements needed to identify your
company as the sender, the producer of this EDI file. For this matter, use the company
setup screen. You can specify your company information and other setting related to
your company there.

If you have the EDI Exchange component licensed then all this information is stored in the
data file "COMPANY_SETUP". If you don't have this component then this information is
stored in the Windows registry.
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Note: You need to configure the database first. See Setting up Database Connection.

1. To configure the company, select Setup » Company Setup in the main menu.

& HIPAA Claim Master - Babit

File Forms View Search  Claim Entry/Edt DataBase CodeSets Logs Image | Setup || EDIExchange  Help
1 £

& Options
Specific Options

> (i) &‘() ®

~ Dutput Mode 1 -

™ Screen - P i

Rl b MR e a
The "Company Setup” menu

2. The following screen will appear.

Claimn Forms
Configure Additional Info Pages

[ Company Setup |
Create Company Setup Table |

Company Setup

Company Information

Mame | - |54 Segment Sender ldentifier
Addrezsl | Cualifier
Address2 | Application Sender's Code GS_2
City | * Tax ID
State | =" @ PlaniD  © PayoriD
Three letter identifier to prepend l—
. | Plus 4 | to all outgoing EDI files
EDI Vession
C anks4010 ¢ 4010 if in original, otherwise 5010~ anly 5010
Contact Information 154 14 and 15
Contact Person | EDI Files will be
Telephone Ilj_] - = Exi | Fax |y -  Test
E-Mail | * |7 Acknowledc

The "Company Setup” window
3. You can configure the following options:
e Company Information
e EDI Version
e Contact Information

¢ ISA 14 and 15
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Read the detailed descriptions further.

4. Once you have finished editing the options, click "Save."

Company Information
e Name — Company name. Obligatory option.
e Address 1
e Address 2
e City — Obligatory option.
e State — Obligatory option.
e ZIP
e Plus 4

¢ ISA Segment Sender Identification — It is the most important option to choose. It
identifies your organization for all EDI transactions. Most commonly the Qualifier
"ZZ" and a free form ID up to 15 character in length is chosen. Other options include
your tax ID and the Dun & Bradstreet ID.

e Qualifier — The ISA Identifier and qualifier are the unique key to the trading
partner database file. The ISA identifier can be up to 15 bytes long, the qualifier
has to be 2 bytes. Approved qualifiers are:

e 01 — Duns (Dun & Bradstreet)

¢ 14 — Duns Plus Suffix

e 20 — Health Industry Number (HIN)

e 27 — Carrier ID Number (Identification Number as assigned by HCFA)

e 28 — Fiscal Intermediary ID Number (ldentification Number as assigned by
HCFA)

® 29 — Medicare Provider and Supplier ID Number (ldentification Number as
assigned by HCFA)

e 30 — U.S. Federal Tax ID Number (ldentification Number)

¢ 33 — NAIC Company Code (National Association of Insurance Commissioners
Company Code)
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e 77 — Mutually Defined

e Application Sender's Code GS_2 — The option represents the program or machine
that created the file. Usually the same as the ISA Segment Sender Identification.
You can select other ID if you need. Obligatory option. The GS_02 identifier is
usually the same as the ISA identifier but you can also choose some other ID. It
represents the program or machine that created the file, but the most common is
a repetition of the ISA identifier.

e Tax ID — Obligatory option. Also called an Employer Identification Number (EIN).

e Plan ID / Payor ID — Fill in your Payer ID and Plan ID if you have one; this is only
important for the 271 and 277 transactions. Optional setting.

e Three letter identifier to prepend to all outgoing EDI files — Optional setting.
Makes your files easily identifiable.

EDI version

Specify EDI version:
e only 4010
¢ 4010 if in original otherwise 5010
e only 5010

Contact Information
The contact information goes into the PER segment of outgoing transactions:

e Contact Person

Telephone
e Ext
e Fax

E-mail

ISA 14 and 15

¢ EDI files will be — ISA element 14 determines if the resultant file contains test or
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production data:
e Test
¢ Production

e Acknowledgement (TA1) req. — ISA element 15 indicates whether you want a TA1
acknowledgement for files that you send out.

9.3 Creating Company Setup Table

You can create the Company Setup Table by following the steps below in the HIPAA Claim
Master.

1. To configure the program options, select Setup » Create Company Setup Table in the
main menu.

(3 HIPAA Claim Master - B4bit .
File Forms View Search  Claim Entry/Edt DataBase CodeSets Logs Image | Setup r ECI Exchange  Help

—, . - I“ Oplions
;@ F LEDS “ u @ Specific Cptions

Claim Forms
Configure Additional Info Pages

~ Dutput Mode
*  Printer

£ei iy = me 2
T Screen e e ) Company Setup
P e _| Create Company Setup Table |

The "Create Company Setup Table" menu

2. The following screen will appear.

© <2003> Martin Scholl Consulting, Inc.



301 HIPAA Claim Master

Create Table H=E
r Mih'“ _
¥ Microsoft SOL Server C MySQL/Generic

Company Setup Table script:
| CREATE TABLE [dbo] [COMPANY_SETUP]| a
2 [I0] [bigint] IDENTITY(1.1) NOT NULL.
[Marme] [varchar](60) NULL.
[Address1] [warchar](55) NULL,
f [Address2) [varchar](55) NULL.
B [City] [warchar]{30) NULL.
' [State] [char](2) NULL.
[£ip] [char](5) NULL
[Zip_4] [char](4) NULL,
10 [SenderlD) [varchar](15) NULL.
11 [Senderl DCualifier] [char](2) NULL.
12 |EdiNo] [varchar]{15) NULL
1 [EIM] [warchar](60) MULL,
[FilelD] [char]i3) NULL,
15 [Contact] [varchar](80) NULL.
16 [Tel] [varchar](20) NULL,
17 |Ext] [varchar]{10) NULL
£ |[Fax] [varchar](20) MULL, —
19 [Email] [varchar](80) NULL.
20 [Mck] [char](1) NULL.

51 [TP)[char](1) NULL.
2 [PayorlD] [varchar]{30) NULL
23 [PlaniD)] [varchar](30) NULL. |

Help I Save Execute Script |

v

"Create Table" window
3. This window allows you to edit, save and run the table scripts.
4. Define the following options:
¢ Database
* Microsoft SQL Server
e MySQL/Genetic

e Company Setup Table Script — SQL statements to create the Company table in
your database.

Tip: You can modify the scripts so that they run on your specific database.

5. Once you have you modified the script, click "Save."
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Create Table

=] 3

[ Databaze
% Microsoft SQL Sever

Company Setup Table script:

T MySQL/Genenc

1 CR

P

Help | (" save

EATE TAELE [dbo] [COMPANY_SETUP](
[1D] [bigint] IDENTITY(1.1) NOT NULL.
[Mame] [warchar](&0) NULL.
|Address1] [varchar](55) NULL,
[Address?] [varchar](55) NULL,

[City] [warchar](30) NULL.
|State] [char](2) NULL.

|Zip] [char](5) NULL

[Zip_4] [char](4) MULL,
[SenderlD] [varchar](15) NULL.
[SenderiDCualifier] [char](2) NULL,
|EdiMo] [varchar]{15) NULL,
[EIM] [warchar](60) NULL,
[FilelD] [char](3) NULL.
[Contact] [varchar](80) MULL.
[Tel] [varchar](20) NULL,

|Ext] [varchar]{10) NULL

18 [Fax] [warchar](20) NULL,

19 [Email] [varchar](80) NULL.

20 [Ack] [char](1) NULL.

21 [TP] [char](1) NULL.
[PayorD] [varchar]{30) NULL.

[PieniD) [verchor)(30) NULL.

]

I Execute Script |

/3’

The "Save" button

6. Click "Execute Script” to create the table in the database.
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Create Table M=

[ Database
' Microsoft SOL Server C MySQL/Generic

Company Setup Table script:
| CREATE TABLE [dbo] [COMPANY_SETUP]| a
: [10] [bigint] IDENTITY(1.1) NOT NULL.
[Marme] [varchar](60) NULL.
[Address1] [warchar](55) NULL,
[Address2) [varchar](55) NULL.
[City] [warchar]{30) NULL.
|State] [char](2) NULL.
[£ip] [char](5) NULL
[Zip_4] [char](4) NULL,
[SenderlD) [varchar](15) NULL.
11 [Senderl DCualifier] [char](2) NULL.
12 |EdiNo] [varchar]{15) NULL
1 [EIM] [warchar](60) MULL,
[FilelD] [char]i3) NULL,
[Contact] [varchar](80) MULL.
[Tel] [varchar](20) NULL,
|Ext] [varchar]{10) NULL
|[Fax] [varchar](20) MULL, —
IE [Email] [varchar](80) NULL.
20 [Mck] [char](1) NULL.
21 [TP] [char](1) NULL.
2 [PayorlD] [varchar]{30) NULL
23 [PlaniD] {verchar|(30) NULL. -l

Help Save : Execute Sc:|'i||t'|I

v

The "Execute Script” button

7.0nce the table has been created successfully, you will see the following notification:

success ]

Table successfully created

The success message

Warning: Executing the script will wipe out any previous table you have created. Remove the script
files once you are satisfied so nobody can occasionally destroy the database table.

Make sure there are no any error messages for successful table creation.

9.4 Creating 834 EDI Files from the Attached Database

Once the EDI creation is enabled, you can create the EDI files. Follow the instructions
below.

1. To configure the company, select Data Base » Create 837 EDI Files in the main menu.
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e HIPAA Claim Master - Babat

File Forms View Search  Claim Entrr.fEnci( Data Base | | Sets  Logs
i e Connection snd Fields
= > fmnr | |
R Clains in Database
o e Creste SOL Tables
% Prinker
" Screen

The menu item to creaté EDI files under the "Data Base" menu

Alternatively, you can click the "Create 837 EDI File" button in the query builder
("Exported Claims" window). Refer to Exporting the Data.

T - 1

1 SELECT * FROM EDI_Claims : E—— - I
2 LIMIT 20 £ILN £ ATeRD

cute Query | Edit Claims

Clear Ouery | Create 837 EDI File |

Claim Tables IEuIId your own quer_\rl

S0t ot erwse | b 1| [view claim | [Edit claim | [check HIPAA Compliance |
I |t Guery | SubscriberiD: | 109532
ClaimNo: | 05323386-0001 Query PalientLast: | ABREU
Filename: | C327290N.H827PRD.CO820351.CLAIN] Guery PatientFirst: | EMETRIO
BilProviD: | LAWRENCE GENERAL HOSP ] PalientD0OB: | 12/23/1928
SubscriberLast: | ABREU Guery PatientSex: [M
SubseriberFirst: | DEMETRIO Query Amount; | 1376.9200

§

HHHH

ClaimiD LineMNumber LinelD SeniceDateFror SenviceDateTo  AssessmentDal FacilityCode
' ' [10r712011 [ [
10772011

10772011

0772011

10/7/2011

10/7/2011

10/7/2011

for772011

10772011

. 107772011

(1 ' 10/7/2011

[12 ' 107772011

(o @@~ | o P

=

1
1
1
1
1
1
1
1
1
1
1
1

Help Cancel |E

The "Create 837 EDI File" button located on the "Exported Claims” screen

2. Clicking the button will bring up the "Create 837 Transaction Sets"” window with the
query that you designed.

The fields are described in Understanding the "Create 837 Transaction Sets" Window.

3. After you have filled all necessary values, click "Go!"
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HIPAA Claim Master

ol
1 SELECT " e N Effective Date
2 FROM EDI_Claims E = h-” 812013 j
' Test Database

-

— Version

o 4010 if in original. 5
4010 © therwise 5010 5010

ea | Gol I Write to File | View EDI File | Help |
B - Fields with  wil be populated by the process.
I1SA segr Password 1D Type Sender ID 1D Type Receiver ID Date Time terchange 10 Ack /P
[1sA oo | oo | |zz =||HIPAASUITE |zz ~|[TEsTEDIBOI0  [131108  [1145 [ Jooso1 [312114549 fo =|P ||
~ GS segment ST segment
Sender Code Receiver Code Group Conirol No +_ Viersion + Transaction D'+ 501010 +
[Gs [H [HIPAASUITE [fEsTEDISO10  [20131108 [1207 [ss1z00002 [ Juusuiuszzza | [ST [837] [
~ BHT segment ~ Receiver Name (NM103 1000B)
Pupose Transaction IDt  Date Time Transaction Type Recaiver Name
[BHT [0019 00 - Original =|[331200002- [20131108 [1201  [CH - Chargeable || [TESTEDISO10

1 -

The "Create 837 Transaction Sets" window with the highlighted "Go!" button

. You will see a confirmation dialog like this. Click "Yes."

Confirm EDI Creation __!ﬂ

You are about to create an 837 EDI file with 98 records. Are you sure?
=) w |

The verification message before the EDI records are created

. After you click "Yes," the process of assembling the claims to the 837 files starts. You

can see the progress bar on the bottom pane.

IS 090 65%

Creating EDI transaction with 98 daims

Progress bar at the bottom of the screen keeps you informed about the process

. The bottom pane informs you about the number of transactions created.

| 2 EDI fransactions are created. 1

The bottom pane displaying the number of created EDI transactions

. The EDI text is now displayed in the bottom part of the window.
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~BHT segment Receiver Name (NM103 1000B) —
Pupose Transaction ID+  Date Time Tr jon Type Recsiver Name
BHT [0019 |00 - Original ~|[331200002- [20131108 [1201 |CH - Chargeable || [TEsTEDISO10
TISA0"  "00 _ “ZZ'HIPAASUITE “ZZ'TESTEDIS010 *1311081201% 0050131212011 T 0P~ -
2 GS™HCHIPAASUITE*TESTEDIS010°20131108"1201*331200001"X"005010X223A2™ S

3 S5T*837°000011*005010X223A2

4 BHT*0019*00~331200001-1*20131108*1201*CH™
5 NMT*41"2"HEALING HOSPITAL OF ANYTOWN™ 46 XZ54278™
& PER®IC*PHIL FIELD*TE*7365554321™

7 NM |'4gt'}2 *TESTEDIS010™"46*TESTEDIS00™
8 HL*1™20"1™

9 PRVBI"PXC*282N00000N™

10 NM1*B5"2"HEALING HOSPITAL OF ANYTOWN™
11 N3"1 HOSPITAL ROW™

12 NA"ANYTOWN*MD*21299™

13 REFEIM097654321™

14 HL"2=1~22*0~

15 SBREP*18*MA™

16 NMTUIL*1"AGAINONE " BAK™  MI"001121224A™
17 N3*75 75 ST NW™

18 NA*NOTOWN*MD*12345~

19 DMG*DE™19290604™M™

aan

2EDI transactions are created. . ______ |

The EDI file content displayed

8. Now you can write down the EDI text that is still in memory and visible in the text box
to a file. Click on the "Write to File" button and you will have the choice to write in the
default location which is the trading partner's outbox, or specify any other location:

e Use default path and names

e Select path and names

Create B37 Transaction Sets _a.lglil
1 SELECT * = ) N Effective Date
2 FROM EDI_Claims ' Live D | |
| Tost 117 8/2013
I Database ||| " "°T 7 —
4010 f in original. &
_ !f‘-lmnf' Fermian B0 f‘&mul
Exit | Gol il Write o File || View EDI File | Help |
© Use default path and names Fisids with +wil be populatad by the process.
ISA segment
[F Password ID Type Sender|  Select path and names D Date Time Interchange I Ack  T/P

The "Write to File" button

9. After successful writing, you get a message where the file was written to.

I x|

2 files are saved to C:\Documents and SettingsAll Users\Applcation Data\HIPAAsuite \HIPAA Claim Master\Samples
Files have next names:

test_1.837

test_2.337

T

The confirmation message that the file was successfully written

Viewing the Saved Files

The button "View EDI File" is now enabled and you can bring up the EDI Editor to view it.
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HIPAA Claim Master

Create B37 Transaction Sets I [=] 5
1 SELECT " - . . Effective Date
2 FROM EDI_Claims £/ LimD | |
' Tost Dotk 11/ 82013
7 Version
4010 in oniginal,
S Camn e k010 | 5010
Exit | Gol | Write to File 1 View EDI File ) __Hep |
sA test 11837 | Fields with 1wl be popuisted by the process.
- Passwond ID Type Sender ID 1D Type Receiver|__test 21837 Tme hlerchange ID Ak T/#
[isafoo [ ""foo [ [zz z]HiPAASUITE zz ~|[TESTEDIS010 |I3I108 [1206 |~ [oos01 [312120647 Jo =|[p =]
~GS segment ST segment
Sender Code Receiver Code Group Control No t_ Version Transaction ID + 501010 +
[Gs [ [HIPAASUITE [TEsTEDIBOI0  [20131108 [1206 [331200002 [x [005010%222A1 |[ST [837[oo0021  [o05010%222A
~BHT segment Receiver Name (NM103 1000B)
Purpose Trensaction ID+ Date Time Transaction Type Receiver Name:
|BHT [0019 |00 - Originat =|[331200002- [20131108 [1206 |CH - Chargeable || [TesTEDISO10
1 ISAM0" 00 *ZZ'HIPAASUITE  *ZZ*TESTEDIS010 *1311081206* *00501*312120647°0"P*:™ =
2 GS"HC"HIPAASUITE*TESTEDIS010%20131108712067331200001"X"005010X223A2™ =
3 5T"837"000011"005010X22342™
4 BHT*0019*00"331200001-1"201311081206"CH™
5 NMT*41"2*"HEALING HOSPITAL OF ANYTOWN™ 46 XZ54278™
6 PER*IC*PHIL FIELD*TE*7365554321™
7 NM1*40"2*TESTEDIS010**"46*TESTEDIS010™
8 HL™1™20°1"
9 PRVBI*PXC*282N00000N™
10 NMT*B5*2*HEALING HOSPITAL OF ANYTOWN™
11 N3*1 HOSPITAL ROW™
12 N4*ANYTOWN"MD*21299~
13 REFEI"097654321™
14 HL"2=1=22*0~
15 SBRTP18™"MA™
16 NMT*IL*T"AGAINONE"BAK™*MI"001121234A™
17 N3"75 75 ST NW™
18 NA*NOTOWN*MD*12345~
19 DMG"D8"19290604"M™ =
2EDI transactions are areated, . |

The "View EDI File" button highlighted

The following preview window will open.

© <2003> Martin Scholl Consulting, Inc.



Creating 837 EDI Files| 308

i File: test_1_1.837 =10] x|

1 ISA*00" 00" “ZZHIPAASUITE  *ZZ*TESTEDIS010 *131108*1206*00501*3121206847°0°P~ -
2 GS*HC*HIPAASUITE*TESTEDIS010*20131108"1206%331200001*X"005010X223A2™~
3 ST"B37~000011*005010X22382™

4 BHT*D019*00*331200001-1*20131108*1206*CH™ T
5 NM1*41"2°HEALING HOSPITAL OF ANYTOWN™ 46 XZ54278™
& PER*IC*PHIL FIELD*TE*7365554321™
7 NM1*40*2*TESTEDIS010™*4E*TESTEDIS010™
& HL*1™20"1~
9 PRVCBI*PXC*282N00000N™

10 NMT*B5*2*"HEALING HOSPITAL OF ANYTOWN™

11 N3*1 HOSPITAL ROW™

12 NAANYTOWN"MD*21299™

13 REF*EI"097654321™

14 HL™2=1722"0™

16 NMT*IL*T*"AGAINONE*BAK™MI"0011271234A™

17 N3"75 75 5T NW™

18 NA*NOTOWN*MD*12345™

19 DMG*DE*19290604*M™

20 NM1*PR*2*XYZ INTERMEDIARY SERVICES INC™**P|*595674™

21 CLM*112234"1247 0811 A 1A ™™

22 DTP*096*TM=1400™

23 DTP*434*RD8*20010201-20010204™

24 DTP*435*DT=200102010800™

25 CL1*3*1*01™

26 AMT*F3"607.06™

27 REF*EA™654123-6™

28 REFD8™12™

29 HIFBK:-03840™

30 HI*BJ:7806™

31 HI"BE:01:::250™

32 NMT*T1*1"KILDARE*JAMES™34*321121234™

33 PRVCATPXC=2038F0100Y™

3 REFT1GTA1234™

35 LX*1™

36 SV2*120™750"DA~3™

37 L2~

38 SVZ2*300™132.08*UN*8™

39 13~

40 SV2°320"365"UN"4™

41 HL*3" 1220~

42 SBRP™18™]{A"~

43 NMTHIL*1"AGAINONE " BAK™MI*001121234A™

44 N3*75 75 STNW™

45 N4*"NOTOWN*MD*12345~

46 DMGTDE*19290604™"M™

47 NMT*PR*2%XYZ INTERMEDIARY SERVICES INC™P[*835674™

48 CLM*112235%1007. 7811 A TASY™Y™

49 DTP*096*TM"1400™

50 DTP*434*RDE&20010208-20010211

51 DTP*435*DT=200102080800™

52 CL1=3*1*01™

53 REF"EA"654123-6™

54 REFD9"13™

55 HI"BK-496™

56 HI"BJ:78608™

57 HI"BI:71:RD8:20010201-20010204™ =

Cosarsme ma  ncnne

EDI preview window

9.5 Understanding the "Create 837 Transaction Sets" Window

Here you can find the descriptions of the "Create 837 Transaction Sets" window fields.
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HIPAA Claim Master

e Query field — This field is located in the top left corner. It is used to narrow the
records to be written to the EDI files. You can create your own query or you can
use the query builder in the exported claims screen.

e Live/Test Database radio buttons — They are located to the right of the query
text box. They allow to choose between the Live database and the Test database as
outlined in the data connection setup.

e Effective date — It is the effective date of the file. By default, the current date is
selected.

e Version — Here you can select the version of the resulting EDI file. You have the
choice of 4010 or 5010. It is generally possible to generate 4010 files from claims
that came in 5010 files and vice versa, a third option is for claims that came from
EDI files and that have been imported into the database. Here you have the option
to preserve the original version so that a claim that came in an EDI file in 4010
format will also be output as 4010 files while a 5010 file will be output as 5010.

EDI Envelopes
The next part of the screen contains the EDI envelopes:

¢ |SA Segment — The ISA segment contains the outermost envelope of the EDI file
and it represents data that is required to read an EDI file. Listed here are the
sender and receiver, the data and time, whether a response is expected and which
characters to use as segment, element and sub-element separator. The picture
above shows this screen and you can see the individual data elements. The data in
black you can change, other elements are determined by the Company Setup
screen.

e GS Segment — The GS or Group Start segment contains transaction specific
information, which transaction sets are in this file and also has information on the
creation (Sender code) and consumption (Receiver Code) of the EDI files. Group
control number and version will be filled in by the process since this is dependent on
the claim type.

e ST Segment — The ST or Start of Transaction Set segment again lists the
transaction set code and a unique identifier for the transaction.

e BHT Segment — The BHT segment further qualifies the claim in the 837 transaction
set by specifying whether this is an original submission and whether the claims are
chargeable or just encounter records.

If you have the EDI Exchange component licensed, you can select the trading partner and

© <2003> Martin Scholl Consulting, Inc.



Creating 837 EDI Files

310

fill the form with a specific trading partner's information.

e Select Trading Partner — Once this button has been clicked, a popup window
appears where you can select your defined trading partner.
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10 Creating 277CA EDI Files

10.1 What are 277CA files

The CA stands for Claim Acknowledgment. The 277CA was formerly known as the
unsolicited claim status response. This transaction is used to tell the sender of a claim in
detail whether the claim was rejected, if there is additional information necessary and
maybe even if the claim is already adjudicated. This transaction is unsolicited, meaning
that the trading partner did not send a 276 status request to receive this 277CA. This
transaction is usually sent by the receiver after a 837 claim file came in and has been
pre-processed.

10.2 277CA in the HIPAA Claim Master

The creation of the 277CA is a feature in the HIPAA Claim Master that has to be licensed and enabled. If you
see the menu items for the 277CA disabled, please contact HIPAAsuite's sales department for a quote.

The HIPAA Claim Master allows two mechanism to create the 277CA.

1. When a file is processed and the trading partner is set up to receive the 277CA, then
after each claim is parsed from the 837, a 277CA record is created and filled with a
standard claim status and status category that is determined in the 277CA setup
screen

2. The claims are exported to the database and a separate process enters values in so-
called feed back fields with the results of processing or even adjudication. Then
triggered by a query a 277CA record can be created for each claim and packaged into
a file to be send back to the claim originator.

The second method is much more precise since it returns actual process data while the
first process has only a canned message to convey.

These feed-back fields can also be used by the HIPAA Claim Status Responder to return
the status of a claim by finding it in the claim tables and then reading the status from
the feed-back fields.

The feedback fields are included in the scripts to create the EDI_Claims and
EDI_ClaimDetail tables but they are commented out. If you open the screen to create the
tables and scroll both scripts down to the bottom you will see the commented out area of
claim acknowledgment fields.
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HIPAA Claim Master

Create SOL Tables _ O] x|
— Database Environment

& Microsoft SOL Server T Oracle & | ive Database

My SOLAGeneric " Tast Database

Claim Header Tables script:

B2 [Complanceode] [varchar]|2) MULL. =]

023 [ExceptionCode] [varchar](2) NULL,

324 [*Claim Acknowledgement®/

525 —-[RecenerStatusCategory] [varchar](2) NULL.

526 —-[ReceverStatus] [varchar](3) MULL.

527 —-[RecenerActionCode] [varchar](2) NULL,

528 - [BillProvStatusCategory] [varchar](2) NULL.

529 —[BillProvStatus] [varchar](3) NULL.

830 --[BillProvActionCode] [varchar](2) NULL,

831 --[ClaimStatusCategory] [varchar](2) NULL,

832 —-[ClaimStatus] [varchar](3) MULL,

833 —-[ClaimActionCode] [varchar](2) NULL,

534 [*S0L To EDIY

835 —[ClaimAction] [char](1) NULL,

836 —[ErrorMessage] [varchar](1000) MULL,

537 CONSTRAINT [PK_edi_Claims] PRIMARY KEY CLUSTERED =

533 ( =
Compare Script with existing Tahle Save Execute Script |

Claim Detail Table Script:

OO T T O O T T T T T T TS e T Ty T [ s ST T T o T

236 [OtherPayer2AdjustrmentReasonGroupd] [char](2) MULL., —

237 [OtherPayer2AdjustmentReason4] [varchar](5) MULL.

238 [OtherPayer2Adjustrmentamount4] [maney] NULL.

239 [OtherPayer2AdjustmentQuantityd] [decimal](12, 3) NULL.

240 ~[CtherPayer2AdjustmentReasonGroup5Plus] [varchar](77) NULL,

241 ~[CtherPayer2 AdjustmentReason5Plus] [varchar](155) NULL,

242 --|OtherPayer2 AdjustmentAmountsPlus] [varchar](493) NULL,

243 - [OtherPayer2 AdjustmentQuantity5Plus] [varchar]{415) NULL,

244 [OtherPayer2PaidDate] [date] NULL,

245 [CtherPayer2AmountOwed] [money] NULL,

2465 ["Claim Acknowledgement™/

247 —[ClaimStatusCategory] [varchar](2) NULL.

248 —[ClaimStatus] [varchar](3) NULL.

249 CONSTRAINT [PK_edi_ClaimDetail] PRIMARY KEY CLUSTERED

250 N

251 [ID] ASC

252 Wik TPRIM AR =
Compare Script with existing Tahle Save | Execute Script |

Help | Cancel |

The feedback fields in the SQL scripts

To create the fields you have to uncomment those rows and then save the script. Then
you can click on the button "Compare Scripts with existing Table' and the fields will be
added to your data tables.

Now you still have to select those fields. For that you go into the screen to set up the
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database connection and fields and again scroll to the bottom of the field lists and check
all the fields in the Claim Acknowledgment section.

—Fields to be exported
Header
- W] EPSDTReferralCondCoded
- W] EPSDTReferralZondCodel
B- E| Fepricing
- |w] Repricingtethodology
- [¥] RepricedAmaourt
- [#] SavingsLmaurit
- [#] RepriceriD
- [¥#] RepricingRate
- ] PG _Code
- [W] APG_Amaunt
=[] ApprovedRevenueCode
- [w'] ApprovedProcedureCode
- [#] ApprovedUnitCode
- [w] ApprovedUnits
- [¥] RejectReazon
. ComplianceCade
- [¥] ExceptionCode
=- E| Claim Acknawledgement
- |w] ReceiverstatusCategary
- [W] Receiverstatus
- [W] Receiver actionCode
- [W] BillPr 0w StatusCategary
- [W] BillPr 0w Status
- [#] BilProv ActionCode
- W] ClaimStatusCategary
- [ ClaimStatus
- [ Claim&ctionCode
B[] a0 Ta e
- [ Claimction

- ] ErrarMeszans

Select All |

Detail

4

- W] CtherPayer2PaidProcedure ;I
- W] CtherPayer 2PaidRevenueCode

- [¥] CtherPayer2PaidCuartity

- [#] CtherPayer2BundledLine

- W] CtherPayer 2 AdjustmentRe asonGraupl
- W] OtherPayer2 AdjustmentReason

- ] CtherPayer2 Adjustment Amount]

- |w] CtherPayer2 Adjustment Quantity

- |w] CtherPayer2 AdjustmentReasonGroup2
- W] OtherPayer2 AdjustmentReason2

- ] CtherPayer2 Adjustment Amount 2

- |w'] CtherPayer2 Adiustment Quantity 2

- |w] CtherPayer2 AdjustmentReasonGroup3
- |w'] CtherPayer2 AdjustmentReasons

- [#] CtherPayer2 Adiustment Amount3

- ] CtherPayer 28djustment Suantity 3

- ] CtherPayer 28dustmentReazonGroupd
- W] CtherPayer 2 AdjustmentReasond

- ] CtherPayer2 Adjustment Amountd

- W] OtherPayer 2 Adjustmentuantity4

D CtherPayer2 AdustmertReazonGroupsPius
D CtherPayer2 &dustmentReazonsPlus
D CtherPayer2 Adustment2mountSPlus
D CtherPayer 2 AdustmentCuantitySPlus
- [#] CtherPayer 2PaidDate

= [#] CtherPayer2amourt Ovved

=8 El Claim Acknoveledgement

- ] ClaimStatus -

- [ ClaimStatusCategory

| o

Select Hunel Select All |

Select Hone

Test Configuration

[ Show =elected Field=s onhy

Save Field Configuration

The feed back fields checked so they are included in the processing.

10.3 Setting up the Auto generated 277CA

The Database menu item has now a sub menu item "277CA Setup”.
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IntryfEdit | DataBase | CodeSets Logs  Image

Conneckion and Figlds

e
L8 ';'f Claims in Database
Create 0L Tables
Zode Look-up Table
Field Mappings

Create 337 EDI Files

Delimiters Setup

27 FCh Setup

The menu for the 277CA Setup screen
When we click on it the following screen comes up:

277CA Setup _ O]

Defaults
Claim Status Categorny
I.ﬂ‘-.2 - Aicknowledgement/Acceptance into adjudication system-The claim/encounter haz been accepted into the adjudication system. j

Clairm Status
|2D - ficcepted for processing. j

The 277CA Setup screen

%

Here we set which are the standard messages for claim status after the 837 file has been
received.

The default values are:

for the Claim Status Category: A2- Acknowledgment/Acceptance into adjudication
system. - The claim/encounter has been accepted into the adjudication system

for the Claim Status: 20-Accepted for processing.

10.4 Setting up trading partner for 277

The creation of the 277CA is usually instigated by the trading partner who sends the 837
claim file. Though the 277CA is not part of the original HIPAA transactions it is eyed very
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positively as an important part of lowering the costs of healthcare.

316

In order to set up a trading partner to receive the 277CA we open the trading partner
screen and select the tab with 'Options’

Trading Partners

 Mame and Type
Mame

#

=1k

— List of Trading Partner

ITEST {Required)
Address Address 2

[24 MAIN STREET |SUITE 200
City State Zip
[arrTomm JmD 20865

EDI File Exchange Method

Status

TEST

I"_V—P j * IApproved vl
Email Addresses to send process results Type
testeri@test.com ;I IPayer j
=
'EDI Identifiers Options | Remote FTP | Contact | Encryption | Folders
¥ Send EDI Acknowledgement (997 or 999
¥ Send Email with Frocess Results
™ Muotify when recebving Files
™ Matify when sending Files
¥ Create a 277CA for 837 Claims -l
™ RejectFiles with Compliance Errars (EDI Exchange)
" One ST-5E loop per claim
Delete | Refresh |
Save New Close I:
%

The trading partner setup with the option to generate 277CA's

Here we see the option to ‘Create a 277CA for 837 claims'. Once the option is checked
the 277CA will be generated every time a 837 EDI file from this trading partner is
processed and send back according to the settings in the EDI file Exchange Method.

Creating a 277CA file manually

The HIPAA Claim Master can create 277CA's manually.

For this we go to the File menu and select "Create 277CA"
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:,; HIPAA Claim Master - b4hit

File | Forms  Miew  Search  Cl:
Cpen Sample File E

E Open LR
Open Direckary

| createz7ica |

Select Printer

Exxit:

The menu to create 277CA’'s manually
We will see the following screen come up

Create 277CA

STEP 1: Choose the source of information

" 837 EDI File " Database

Create 277CA File

Yiew Heport Yiew in ERI Editor Send to TR

Cloze

Step 1in the screen to create 277CA’s manually

Step 1 on this form is to choose the source for the 277CA creation.

1. you select an 837 claim file and create a 277CA file from the claims it contains. The
status that is assigned comes from default status values that are set in the Setup
screen.

2. Database records in the claim tables. The status information comes from the feed-
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back fields in the database

10.5.1 From file

We now select the 837 EDI file option

Create 277CA

STEP 1: Choose the source of information

&+ 337 EDI File " Database

STEP 2: Chooze 837 EDI File

STEP 3: Choose the Receiver
' Return to the Sender of 837

T Other Receiver:

Create 277CA File

Yiew Heport Yiew in ERI Editor Send to TR

Cloze

Step 2 in the process to generate a 277CA from an 837 EDI file

and now the Step 2 is revealed, we have to select the file with the Windows file chooser
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Open
@(_)v | . = Computer = Data (Dt} + HIPAAsuiteCommDir + Inbox - 837 - [‘g]l Search 837 (.‘]
Organize *  Mew Folder === S| l@l

! HIPAAsuiteComnﬂ Mame ~ Date modified Type | Size: | |
Crypk
Encryptedies 10/28/2002 10:24 AM  EDI File ZKEB
Inbos o 20 P EDI File
27 | B3TOPTST edi 4202002 5:56 PM EDI File 12 KB
e | 83TPCLM.edi 5/28/2002 9:32 AM EDI File 22 KB
J 276 | DentallG.edi 12142002 847 &M EDI File 4 KB
Sy
. 278
. 820
. 834
. B35 J
. 837
. Other
Log
Cuthioz

ProcessedFiles
. 278
. 837

A

File narme: IEBFIPTST.edl j I"Allfiles o) |

Open Cancel |

Selecting an 837 EDI file for processing

And now Step 3 comes forward and we have to choose the receiver of the 277CA file. We
have two options

1. to send the 277CA file back to where the 837 came from, this means the ISA and GS
STEP 3: Choosze the Receiver
% Return to the Sender of 837

" Other Receiver:
headers are reversed or

2. to choose a trading partner from the list of trading partners in the database.
STEFP 3: Chooze the Receiver
" Return to the Sender of 837

% Cther Receiver: I:I

If we click on the button next to the 'Other Receiver' option a list comes up on the right
side of the screen and and we can choose the trading partner.

© <2003> Martin Scholl Consulting, Inc.



Creating 277CA EDI Files 320

101

— List of Trading Partner

TEST

STEP 1: Choose the source of information

% 837 EDI File " Database

STEF 2: Choosze 837 EDI File
DiHIPAAzwite CommDininbo:A83 7837 IFTST edi | |

STEF 3: Choose the Receiver
' Return to the Sender of 837

* Other Receiver: |:|

Create 277CA File |

Yiew Report | View in EDI Editor Send to TP |

Cloze |

Selecting the trading partner who will receive the 277CA

Once we choose the desired trading partner, the button ‘Create 277CA File' is enabled.

We press it and the following process result window will show us where the system
created the file.
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Processing Results _ O] x|
Create 277CA for file DACustomersi\tMedFlus\EDI Files'x201579fc_130323_i5.837

277CA file is created: DAHIPAAsuite CommDifOutbhoxd Testh 27 7CAV 7Y CA-FOR-201E

1| | i

Process Results after creating the file

We close this window and have now several options enabled

Create 277CA File

Yiew Report Yiew in EDI Editor Send to TP

Cloze

Further processing options are now enabled
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View Report We can view the 277 as printable report
View in EDI Editor: We see the file displayed in the EDI Editor

Send to TP: Send the file and if the trading partner has FTP or other transports selected

and configured the file will be sent to the trading partner and a success message is
visible.

10.5.2 From Database

If we choose the Database options we will see the form change to this

Create 277CA

STEP 1: Choose the source of information

" 837 EDI File &~ Database

STEP 2: Define a query
1 SELECT TOF 20 * FROM EDI_Claims -

STEP 3: Choose the Receiver
€ Beturn to the Sender of 837

* Other Receiver: III

Create 277CA File

Yiew Heport | Yiew in ERI Editor Send to TR

Cloze

Step 2 is revealed, entering the SQL query to select the claims.

Now we see a text box where we can enter a SQL query that will be passed on to the
database. Through your query will you have full control over the records that you select.
The option to send the records back to the sender is in this case disabled. There is no
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guarantee that database claims are from the same trading partner so we disabled this
option. You will have to choose the trading partner by clicking on the button with the
three dots and the screen to choose a trading partner attaches next to this form.

Create 277CA

STEF 1: Choose the source of information

" 8§37 EDI File # Database

STEP 2: Define a query
1 SELECT TOPR 20 * FROM EDI_Claims -

STEF 3: Choose the Receiver
€ Beturn to the Sender of 837

* Other Receiver: El

Create 277CA File |

Send to TE |

Close |

View Report | Yiew in EDI Editor |

Trading Partner 1 ]
— List of Trading Partner
TEST

Selecting the trading partner to receive the 277CA

Once we choose the desired trading partner, the button ‘Create 277CA File' is enabled.
We press it and the following process result window will show us where the system

created the file.

© <2003> Martin Scholl Consulting, Inc.



Creating 277CA EDI Files 324

Processing Results _ O] x|
Create 277CA for file DACustomersi\tMedFlus\EDI Files'x201579fc_130323_i5.837

277CA file is created: DAHIPAAsuite CommDifOutbhoxd Testh 27 7CAV 7Y CA-FOR-201E

1| | i

The process results after generating the 277CA

We close this window and have now several options enabled

Create 277CA File

Yiew Report Yiew in EDI Editor Send to TP

Cloze

Options after the file is created
View Report We can view the 277 as printable report

View in EDI Editor: We see the file displayed in the EDI Editor
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Send to TP: Send the file and if the trading partner has FTP or other transports selected
and configured the file will be sent to the trading partner and a success message is

visible.

10.5.3 From the 'Claim in Database' screen

The previous chapter explained how to create a 277CA from the database via the special
screen to create a 277CA manually. We can arrive at this screen in a second way.

If we open the menu Database --> Claims in Database we see a button ‘Create 277CA'.

Exported Claims

1 SELECT TOP 20 * FROM EDI_Claims

4

Execute Query |

Edit Claims |

Clear Query | Create 837 EDI File

Claim Tables | Build your own queryl

—>| Create 277CA File

1 of 20 | b | | [View Claim | [Edit Claim | |Check HIPAA Compliance |
ID: |1 Query SubscriberlD: [554621234A

Gluery

ClaimMo: [765592

Guery SubscriberLast: |Nosmith

Gluery

Filename: [B37PCLM. edi

BillProviD: |09?654322

Arnount: [55.0000

Claim Header:

Query SubscriberFirst: |Herman Guery
Query PatientLast: |Nosmith Guery
ety PatientFirst: |Herman Query

Service Line Detail:

D | ClaimiD Linehurber

LinelD

ServiceDateFrom

ServiceDateTo

Field | “alue
1
Filenarme 837PCLM. edi

The 'Claims in Database' screen

g

» 1 1

We click this button and also arrive at the screen

C1

3/15/2001
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Create 277CA

STEP 1: Choose the source of information

" 837 EDI File &~ Database

STEP 2: Define a query
1 SELECT TOF 20 * FROM EDI_Claims -

STEP 3: Choose the Receiver
€ Beturn to the Sender of 837

* Other Receiver: III

Create 277CA File

Yiew Heport | Yiew in ERI Editor Send to TR

Cloze

The same screen shows that is accessed from the File menu
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11  Automating
11.1 Running the Application from the Command Line

The HIPAA Claim Master can be used through other applications. A single 837-claim file
can be read and displayed on the screen by using the HIPAA Claim Master executable with
the EDI filename as an argument. This can be an important feature for a work flow
application where a claim can be called up to the screen.

MHicrozoft Windows 2088 [Uerszion 5.08.21951
CC>» Copyright 1985-2888 Microsoft Corp.

C:~AE=~HIPAAzuite~HIPAAClaimPrinter.exe F:“Claims“Inbox~837PCLH.edi_

Calling the HIPAA Claim Master from the DOS prompt with the Claim EDI file as argument

The result is that the claim will be displayed on the screen without the usual frame of the
HIPAA Claim Master application.

| previewdlatn A=TET
Pint | Ea | Mext |
I 987654
—
—— et TESGI2
I
HEALTH INSURANCE CLAIM FORM
TR e AN TIET LA - T=EF | I3 Foaes T
[ - m ] i k] | es4E212344
| Mosmith, Herman | A2F251620 X ] Hozmith, Herman
| 10 8th Avenue - ) ! 3"_ ._' _ _ ] 10 Bth ﬂlk’lﬂl.l.l -
[ Nanachut ) MD ol _ i [] orar [ | Mamzehart ) M
| 13747 _ ' | “1arar o
w 1202501920 gt
X w | XYZ Carrier Services Inc
| | [ 3] »
T Pt © of BaFerced o X T e ARFerd PHTCA | g e
1 [ 1
on File ¥ ¥
brridy Lak? 5
] kAR
48 —r

The claim displayed on the screen without the HIPAA Claim Master program frame.

If a "P" is used as a second argument, the claim will be printed without ever being
displayed.
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Claim Master returns -1 if any errors occurred in the process, and 0 if there was no error
messages. It is really triggered by the error logging. So, any error that would make it to
the log will cause the program to return -1.

11.2 Using Command Line Arguments (CLI)

The HIPAA Claim Master can also accept command line arguments. This is a very
important feature if you want to put the HIPAA Claim Master on a scheduler and
automate the processing of files or directories. Refer to Running the Application via
Scheduler.

The following is the list of the command line arguments, they must be separated by
commas.

1.The first command line argument is the filename or the directory path. If not
applicable, leave blank.

2. The second argument or a combination of arguments contains the processing options.

e P — Print.

C:xFProgram Files“HIPAAsuite~HIPAA Claim HMaster~HIPAAClaimMaster_exe C:~Test.edi.P

Using the "P" option as a Command Line Argument

e T — TIFF File. If "T" is used as an argument, the claim will be saved as a TIFF image
file.

See Creating_Image Files from EDI for details on how to set up the Image printing
capabilities.

Be sure that you have tested the Image printing, before trying the command line
mode.

Using the "T" option as a Command Line Argument

e F — PDF File. If "F" is used as an argument, the claim will be saved as a PDF image.
("P" could not be used again as it is already taken by print option).

Again, be sure that you have tested the Image printing, before trying the command
line mode.
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e X — Export to database
e S — Search. See examples further.
e Q — Query against database. See examples further.

e E — Create EDI in conjunction with Q you can create an EDI file, either using the
default settings from the last screen or the database depending whether the
module EDI Exchange is licensed.

e P — If a"P"is used as a second argument, the claim will be printed without ever being
displayed.

3. The third command line argument is the image output filename or the EDI output
filename when you create an 837 EDI file.

If your options specify single file name, then we will have a multi-page image file.

If your options specify one file per image, then passing the image filename in the
command line really only makes sense in conjunction with a query.

Search condition when you try to find one specific claim within an EDI file and create
the image for it. If there are multiple matches the program creates an enumeration in
the filename such as "Filename," Filename_1, Filename_2 and so on.

A SQL query against the database where you expect a limited number of results (a
single record preferably).

4. The fourth argument is your Query; you should have "Q" as second argument.

5. The fifth argument is the destination trading partner that you send an EDI file to. This
works only with the EDI Exchange module enabled.

6. In the sixth argument you specify whether to use "T" Test or "P" Production database
connection if you have "Q" for query as the second argument.

Using Several Arguments

You can have a combination of the above arguments. For example, "XF" will export the
data and create a pdf file.

Example

If you want to export and image an EDI file, you can use "XF" as the second option.
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C:nJC-sProgram Files“HIPAAsuite~HIPAA Claim Master~HIPAAClainMaster.exe C:“Test_edi,®F

Using the "XF" option for export and output as PDF file

The "X" option will turn on the translator functionality and claims will be exported to the
defined data source. You can only do one imaging option such as printing or image file at
a time.

"PF" is not valid.

Searching an EDI File
Here is the syntax for the command line arguments:
1. First: Filename to be processed.

2. Second: Command options:
S for search

F for PDF
3. Third: Image file full path and filename.

4. Fourth: Search conditions in the form of Pipe (|) separated key-value pairs. (This is
the back slash key in Shift mode).

Keys that can be searched at this time are:

e ClaimNO — CLM_01 (you can look for several claim ID's at once separating the ID's
with '&" symbols)

¢ PatientID — NM1*QC_09

¢ PatientLast — NM1*QC_3

e SubcriberIlD — NM1*IL_09

e SubscriberLast — NM1*IL _03
e BillProvID — NM1*85_09

e Segment — A complete segment such as "HI*BF*3544"

Example:
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H PAAQ ai nPrinter. exe |:\H PAAsui t eComrmii r\ | nbox\ 837\ HOFA 1, SF, C \ Tenp
\ Test . pdf , d ai mM\o= 6073123GA0 Bi | | Provl D=123414| Subscri ber Last =SM TH

Working with the Database

Example 1

Here is an example of using a database search to create an 837 EDI file.

An example of using a SQL query to create an EDI file.
The above example has:
e A blank first argument since no file or directory are to be processed.

e The second argument is '‘QE' meaning that an EDI file is to be created using the
results from a SQL query.

e Argument 3 is blank, meaning we use the default file naming convention
e The fourth argument lists the query.

e The fifth argument specifies the ISA identifier of the destination trading partner.
This works only with the EDI Exchange module enabled. If the fifth argument is
blank and EDI Exchange disabled then the last setting from the Create 837 screen is
used as trading partner identifier.

e The sixth argument determines whether the production or test database connection
is to be used.

Example 2

Another example creating an image file from a query

Creating a PDF image file from the results of a query

The file C \ Tenp\ | nageFi | el will contain all the images from claims that fulfil the
query.

Example 3
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11.3

Here is an example of using a database search to create an 277CA EDI file. This works
only with the EDI Exchange module enabled.

=t s Prapapsam FileosSHIPAAzudites~HIPAA Tladinm Mazter~HIPAAClaimMaster.exe" 27'?_"3

ELECT TOP 28 = FROM EDI_Claims".123852274.T

Creating a 277CA EDI file from the results of a query
The above example has:

e A first argument is 277 meaning that an 277 EDI file is to be created using the
results from a SQL query.

e The second argument lists the query.
e The third argument specifies the ISA identifier of the destination trading partner.

e The fourth argument is optional and determines whether the production or test
database connection is to be used. By default production connection is used.

Processing EDI Files with the EDI Exchange Module Enabled

The only argument you need in this case is "Auto”. The directory to look for new files and
the processing options are defined in the setup screens for EDI Exchange. No further
arguments are needed.

Printing and imaging from the database
In January 2015 we added the capability to print or create image files from database
records.
The command line arguments for this are as follows:
1st argument: Should be empty
2nd argument can be now:
QP - print records
QT - tiff files
QF - pdf files

3rd argument - Image File name- used only if program is set to create one result file (the
same argument we use when create image files from file)
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4th argument - Your query
5th argument - Custom printer name, can be omitted if the default printer is used

6th argument - Database, Test or Production, with the default of Production.
Example:

"C:\Program Files\HIPAAsuite\HIPAA Claim Master\HIPAAClaimMaster.exe" ,QF,,Select *
from EDI_Claims where ClaimID = 1357

This example will create an image file with the default naming convention from the claim
with the ID of 1357

"C:\Program Files\HIPAAsuite\HIPAA Claim Master\HIPAAClaimMaster.exe" ,QP,,Select *
from EDI_Claims where SubscriberLast = 'SMITH',Lexmark X 500 Series, T

This example will print all claims in the Test database where the subscriber’s last name is
'SMITH' to the Lexmark X500 Printer

11.4 Changing the Default Company
The default company is the identity you assume as the sender when creating EDI files.
This affects the ISA, GS, and NM1 sender segments. A single entity may have a need to

act as multiple sender identities and so has a need to change the information in the EDI
envelopes.

The default company can be changed using command line arguments, affecting the ISA
and GS sender ID segments.

ISA Segment Sender ldentifier HIFAASUITEN

Qualifier Z7 - Mutually Defined -
Application Sender's Code G5 _2 HIPAASUITEN *
Tax ID 9876543210 *

Sender ID segments in Company Setup

To change the default company, a single argument is needed. "Setcompany” followed by
the company ID of the company you wish to set.

"set conpany <I D>"

The Company's ID in this case is not its EDI identifier, but the value of the ID row in the
COMPANY_SETUP table. It can also be found in the Company Setup window's Current
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11.5

Company selector:

Current Company: S0 slEa 2= ~| 4y Default company
1 - TESTRESPOMNDER

2 - HIPAASUITE1

3 - HIPAASUITEZ
- Add company -

Company selection in Company Setup

Example

The command argument set conpany 3

C:“Program Files*HIPAAsuite~HIPAA Claim Hazter>*HIPAAClaimMaster.exe setcompany 3

will set the default company to ID = 3, which is HIPAASUITE2 in the example picture
above. The log entry for this command will be

ISet default company with ID 3
Company # 3 iz set as a default company

Excerpt from log. Default company changed.

Running the Application via Scheduler

The HIPAA Claim Master can be automated through a scheduler. A scheduler is software
that can be programmed to execute a certain task at a certain time repeatedly.
Windows has such a scheduler built in.

The Windows scheduler can be used to let the HIPAA Claim Master execute in regular
intervals without user intervention. Usually one would let the HIPAA Claim Master scan a
directory and then print, create image files or export the data and remove the files to
prevent duplicate processing.

Use the command line with the appropriate options as described in Using_Command Line
Arguments (CLI).

Note: Please consult Windows help files for further information on setting up the scheduler.

1. If the task scheduler is installed on your system, you will find it in the "Control Panel’.
To open Scheduled Tasks, click Start » Control Panel » Scheduled Tasks.
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Note: In different Windows versions, the way to access the Task Scheduler can differ. Consult your
Windows version documentation.

8 Scheduled Tasks =101 =]
File Edit WYiew Favoites Tools Advanced Help | i
Peeck - ) - ._‘ﬁ‘|jf3mm | Folders ‘-
Address [ 4) scheduled Tasks B>
Name = | schedule | Mot Run Time | Last Run Time | Status
|.2] ad Seheduled Task
Other Places & @phGooglelpdateTaslserS-1-5-... At 12:07 PMevery ... 12:07:00FM ... Never Coubd ok skart
@ Control Panel

) My Documents
) Shared Documents
W My Network Places

Details ¥

4| |

a =

[z objects

The Windows Task Scheduler

2. Click on "Add Scheduled Task" and the "Scheduled Task Wizard" will guide you through
the setup process.

3. In the first window, read the welcome message and click "Next."

Scheduled Task Wizard x|

This wizand helps you schedule a task for Windows
to perfom,

You select the program you want Windows to run,
and then schadule & for a convenient tima,

Click Neot to continue.

The "Scheduled Task Wizard" window

4. Browse to the Hi PAAC ai mvast er. exe executable file.
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Scheduled Task Wizard

Click, the progeam wou want Windows bo mun.
To see more programs, chck Browse.

| Wersion =]
2] 7 Zip Fil Manager 457 wed
& sccessibilly Wizard 5.1.2600.551..
@) ACDSes Pro 25
d bddiess Book 6.00.2300.55.,
& 2.dobe Bridge C53 20
) &dobe Device Cenial C52 100
L R R, g - | =N ED ,ll

(sowe.|)

| < Back I Wext » I

The "Scheduled Task Wizard" window

By default, the application is located in c:\ Program Fi | es\ HI PAAsui t e\ Hl PAA Cl ai m Mast er
\ HI PAACI ai mVast er . exe

é{:_}c I = Local Disk (C:) = Program Fles = HIPAAsuRe + HIPAA Claim Master - - E [ Sezrch HIPAA Claim Mastar @
Organize ~  News folder =+ [ @
I Favorites d Nams = Date modified I Type I Seo I Iil
B Deskiop % erypto.di 262013 10:29 AM Application extension 5,540 KB
& Dowrloads % DocumnenkFormat. Opendml.dil Af2E02013 10:29 AM Application extension 5,111 KB
=4 Recenk Places %, DynamicArray.dl 9f26f2013 10:29 AM  Application extension 14 KB
_ ) EDI_Exchange.dl 9[26{2013 10:29 AM  Application extension 407 KE
- Lb[:'c'::m % EDIGEv. FrameworkEDTNET x64.dl 9[26/2013 10:29 &AM Application extension 5,710K8
J Music B £ idew_FREDI_Runtime. sxe af26{2013 10:29 AM  Application 22,263KB
= Pictures & Ediware.dl 9262013 10:29 AM  Application extertsion 27KB
= My Pictures % FindReplace,di 262013 10:29 AM  Application exterdsion 24 KB
L. Public Pictures % HIPAACIaimEntry. dl 91262013 10:29 &M Application extension 1,650 KB
B videos Sl (5 HIPAAC|aimi e 13 10:29 AM  Application 3 ]
.'H Computer _; HIPAAClsimMaster. exe, config 9f26/2013 10:29 AM ¥ML Configuration File 2KB
f_’.l.ocalDiskl[C:} % HipaaCustomControls, dil f26f2013 10:29 AM  Application extendion 24 KB
. DATAPARTI (0 =] (% HIPAALKties.dl 9/26{2013 10:29 AM  Application extension 340 KB
File narme; IHIPME laimbdaster.exe 3 INI files (%)
Open I Cancel

Selecting a program to schedule

Click "Next."

5. Type a name for this task. Choose a time interval:

e Daily
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e Weekly
e Monthly
¢ One time only
e When my computer starts
e When | log on
Click "Next."

scheduled Task Wizard x|

Type 2 name forthis task, The task name can be
the same name as the program name.

( IH PAACIam Master )

Pesfom this task:

-

~ isekiy

-

t" time only

" [When my computer sads
* [When llog on

= @Y e

The "Scheduled Task Wizard" window

6. Enter the name and password of a user. The task will run as if it were started by that
user. Click "Next."”

© <2003> Martin Scholl Consulting, Inc.



339

HIPAA Claim Master

Scheduled Task Wizard

Enter the name and password of 3 user. The task wil
run as f it wars staded by that usar.

—

-
Enter the user name: ILEEI‘
Enter the password: Inuouv

Confirm password: [sesnssne

If a password is not anterad, scheduled tasks mght
not run.

x|

The "Scheduled Task Wizard" window

You have successfully scheduled the following task:
2 HIPAACIaimMaster

Windows will perform this task:
Flun at user logon

r Eﬂip:ﬁhgdvmcedpmpmﬁfnrﬂistad{vhmlchdc

Click Finish to add this task to your Windows scheduls.

7. In the last screen, make sure you have specified all data correctly. Click "Finish" to
save your task.

Scheduled Task Wizard

x|

The "Scheduled Task Wizard" window

8. The scheduled task has been added to the system. Now lets edit the new task and add
the desired command line arguments with the appropriate options. Double-click the newly
created task in the "Scheduled Tasks" window.
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8 Scheduled Tasks ..:J.EI.EI

Fie Edt View Favortes Tools Advanced Help | o
\_J Back - J r ? | ) Search |i " Folders v
Address [ ] Scheduled Tasks =
& | Name = | Schedule | Mecet Run Time | Last fun Time | Status
Folder Tasks & (2] add scheduled Task

poateTaskllsers-1-5-,,. At 12:07 PMevery ..,  12:07:00PM... Never Coudd nok skark
Fun at wser logon A user logon Mewer

-.'j Renane this item
[ Muve this Rem
[ Copy this item
X Delate this item

HIPALClaimiMasher

The Windows Task Scheduler

9. Enter parameters to the "Run” field after the application path and click "OK." Refer to
Using Command Line Arguments (CLI) for more information.

Tip: Logs may be helpful when running the program automatically through the scheduler. See
Accessing Daily File Log.
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12 Using EDI Exchange Features

12.1 Getting Started
12.1.1 About EDI Exchange

EDI Exchange is a module available in most HIPAAsuite EDI applications. It is an option
that you can purchase for an additional cost. Some of our products, such as HIPAA Claim
Master, process EDI files but do not receive or send EDI files to and from your trading
partners. EDI Exchange is created to do that. EDI Exchange is designed for those
organizations that have a large volume of EDI files, need more order and automation and
adhere to tougher compliance rules. The EDI Exchange is an EDI pre-processor that
handles FTP transport, encryption, HIPAA compliance check, trading partner
management, etc. Outgoing EDI files can be checked for compliance; individual records
that do not pass the check can be withheld.

HIPAAsuite products with EDI Exchange module have a main menu item called "EDI
Exchange" with sub-menus to call the module’s functions.

.E"'?.!HIPAA Enroliment Master - 32bit

Fle View Datsbase CodeSets Image Setp Log | EDIExchange | Heb

Eﬁ k Check EDI File
: | )
Trading Partners
?‘ﬂ Inbox Manager
- SM
FTP Cliant
€ Printer SEF Files
" Spreadshest Fie
EDI Exchange Setup
" ASClI Fle Encryption Setup
" Image File Creats EDT Exchange Tables
Autoprocess Setup
[ Data Export Automatic Scheduler
Counter - ] EDI Receive Log
fes [ ] €I Send Log
Records :l Request EDI Exchange License
] EDI Exchange License Information

The "EDI Exchange" menu in HIPAA Enrollment Master
EDI Exchange performs the following functions:

e Trading Partners Management — The following Trading Partner's parameters can
be stored and transparently managed with the help of EDI Exchange: name,
address, EDI identifiers, delivery methods, encryption parameters, FTP servers,
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CORE-Compliant server addresses and credentials, communication numbers and
folders to keep files separated, special requirements specific to this trading
partner. Read more in Setting up Trading Partners.

File Transport — EDI Exchange has a built-in FTP client that can securely connect to
your trading partner's FTP servers. If you employ your own FTP server, you can
utilize the folder structure that EDI Exchange uses to manage incoming files, users,
home directories and permissions so that your Trading Partners can drop off and
pick up EDI files. Supported are:

e Simple FTP
e FTP Secure
e Implicit FTPS
e Explicit FTPS
¢ Secure Shell FTP or sFTP

Read more in Using FTP Client.

Encryption — Many healthcare-related companies use encryption to cloak the
content of their EDI files. The prevalent method of encryption is PKI (Private Key
Infrastructure) that uses the product of two incredibly large prime numbers as
cipher. EDI Exchange supports PGP (Pretty Good Privacy), the leader in PKI products
as well as the open source GPG project with its Windows sub project PGP4Win. Both
are implementations of the same encryption mechanism. Read more in Using

Encryption.

File Management — EDI Exchange uses a clear directory structure to store EDI files.
The structure is based on root directories for incoming files, outgoing files,
processed files and suspended files. Below these root directories, there are
subdirectories for each trading partner and then each transaction set. Read more
in Defining Root Directory and Initializing EDI Exchange.

EDI Compliance Check — EDI standards are strict and precise; adherence to the
standards is very important so that any organization can work with them regardless
of their backend system software. EDI Exchange has a built-in compliance engine
that checks incoming files for compliance. The engine also generates a report listing
each problem with the exact location. Outgoing EDI files can also be checked and
you have an option to withhold individual records that violate the rules. Read more
in Checking EDI Files.

EDI Control for Transactions — The EDI protocols have a few supporting transaction
sets that are useful to the smooth functioning of EDI exchanges. They provide the
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sender with an instant feedback on receipt. The following transaction sets are
available:

e TA1 Acknowledgment
® 997/999 Functional Acknowledgment
e 277U/277CA Unsolicited Claim Status Response (in case of Claims)

e Logging — EDI Exchange has several logs that are instrumental to keep processing in
order and allows to forensically investigate mishaps. There are three logs in EDI
Exchange:

¢ Incoming file log — See Accessing EDI Receive Log.

e Outgoing file log — See Accessing EDI Send Log.

e Daily transaction log

12.1.2 Requesting EDI Exchange License

If your trial has expired, you can request an extension to the trial.

If you purchased the product and need a final license key, you should request an EDI
Exchange license.

Follow the instructions below to request a trial or final license key.

1. Select "Request EDI Exchange license” under the "EDI Exchange” menu item.
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HIPAA Claim Master

FEHIPAA Enrollment Master - 64bit

File Wiew Datsbase CodeSets Image Setup Log

Ei > — “ \
~ Output Mode
* Screen
" Printer
" Spreadsheet File
" ASCI Fie
" Image Fie

EDI Exchange | Help

Inbax Manager

———

Request EDI Exchange License |

r Run witl

compliance check

A menu item to request a license key

EDI Exchange License Information

2. Once you have clicked this menu item, your default email application appears. In our
case, it is Microsoft Outlook. All information necessary to produce the key is

automatically filled out.

From = | Martin.Scholl@HIPAAsuite.com
Ta... nifp @HIPAAsite. com
Send
Ce..
BeL...
Subject: [EDI Exthange)[F8DCFEEF): Request for License

Request for License

Product: EDI Exchange
Volume ID: 7EDCFBBF

Current Key:
Key: - . oy v

Email message created by EDI Exchange

3. You can add a trial extension or a final key after purchasing or relocating the

software.
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Once you receive the response with the key for EDI Exchange, you can bring the
"Registration Form" screen up again and click on "Register”. Enter the key to unlock EDI
Exchange. In the Result area, you will see that EDI Exchange has been registered.

Q9 Registration Form

License Registration Form
EDI Exchange

License Kay |

— Resutt

Thank you for evaluating EDI Exchange!
ED| Excharuge ia fully functional with certain trial imiations.
This evaluation wersion expires in 15 days

Entering the license key

12.1.3 Registering EDI Exchange

EDI Exchange is licensed separately from the host application, HIPAA Claim Master, for
example. The reason is that EDI Exchange will work on all HIPAAsuite Products that are
installed on your particular computer. For example, if you have HIPAA Claim Master and
HIPAA Enrollment Master licensed, only one license of EDI Exchange is needed and the
module will work across two products.

When you first install a HIPAAsuite product of your choice, a 15-day EDI Exchange trial is
included. Once the trial expires, EDI Exchange loses its functionality. The menu items
under "EDI Exchange” become disabled except the last ones that allow you to license and
enable the product.
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HIPAA Claim Master

EE Hipaa Enroliment Master - 64bit

— AN 2R

Run with
compliance check

The "EDI Exchange” menu with menu items disabled

Request EDI Exchange License

EDI Exchange License Information

You can register the product by clicking on the "EDI Exchange License Information” option

under the "EDI Exchange” menu.

Setup log | EDIExchange | Help

SEF Filex

Encryption Setup

Autoprocess Setup

EDI Receive Log
EDI Send Log

EDI Exchange Satup

Create EDI Exchange Tables

Automatic Scheduler

Request EDI Exchange Licenss

—

EDI Exchange Livense Information

_—

"EDI Exchange License Information” option under the "EDI Exchange”
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Then the license screen appears. In the lower left corner you can find the unique
registration number needed to create either trial extensions or final licensing.

Q License
EDI Exchange
1.0
_Da]'[u] remaining for trial a
This software is for evaluation purposes only and has limited
functionality

You will have to purchase this software if you want to continue using it
after a free evaluation has expired.

2E2F5160 I Try I Order I Register I

The license information screen

Once you click on "Register,” you can enter the license key that you have previously
received via email from us (see Requesting EDI Exchange License.) Click on "Register” and
you will see the registration message in the "Result” area.

License Registration Form
EDI Exchange
License Kay |
[(Fome | oo |
— Result

Thank you for evaluating ED| Exchange!
ED| Exchange ia fully functional with certain trial imiations.
Thia evaluation version expires in 15 days

Extending the trial by entering a license key
Close the "Registration Form" and continue using the EDI Exchange.

12.2 Configuring EDI Exchange (Obligatory Settings)
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12.2.1 1 Setting up Database Connection

EDI Exchange work is based on the database connection that you define under Database »
Connection and Data Fields in the main menu of the HIPAA host application. Make sure
the connection has already been set up and tested before proceeding with EDI Exchange.

Then proceed to the next step: Creating Database Tables.

12.2.2 2 Creating Database Tables

Once you have configured the database connection (Setting up Database Connection),
follow the instructions below.

1. Select EDI Exchange » Create EDI Exchange Tables in the main menu.

SELECTtop 30 I T e e L
FROM EDI_Claims Test Database 12nmzo2 [~
Version
- 4010 if in original,
. aot0 & Qtanal. o 5010
[ Exit ] | Go! ] | Write to File | Viaw E P
ISA segment )
Password (D Type Sender ID 1D Type Receiver ID Date Time Interchange ID  Ack  T/P
ISA 00 ... 00 .. ZZ = HIPAASUITE Zz - TESTEDISO10 121210 1215 = 00501 345121558 0 =~ P = .
GS segment ST segment
Sender Code Racsivar Code Group Control Ho t Version + Transaction 1D+ 501010+
G5 HC HIPAASUITE TESTEDIS010 20021210 1215 | 234500001 | X 005010X222A1 | ST &37 0DDON2 0050102224
BHT segment B
Pumpose Transaction IDt  Date Tima Transaction Type [ Felaculisiing Eatines
BHT 0019 00 - Original = 234500001-2 20121210 1215 CH - Chargeable -

Fiedds with t will be populated by the process.

ISA*00* “00* *ZZ'HIPAASUITE  *ZZ*TESTEDISO10  *121210*1215*00501*345121558*0*P*:™ -
GS*HC*HIPAASUITE*TESTEDIS010%20121210%1215*234500002* X*005010X223A2™

ST*837°000021*005010X223A2™

BHT*0019*00*234500002-1*20121210"1215*CH™

NM1*41*2*MCHS INC DBA MINERAL COMM HOSPITAL*****46*1902990005™

PER*IC*Jane Doe*TE*9005555555™

NM1*40*2*TEST*****46*TESTEDIS010™

HL*1**20*1™

PRV*BI*PXC*282MC0060XX™

NM1*85*2*MCHS INC DBA MINERAL COMM HOSPITAL*****3X*1902990005™

N3*225 Main Street™

N4*Centerville*PA*17111™

REF*EI"8104271823™

HL*2*1*22*1™

SBR*P**Group Name*****98™

ANMT*IL*1*Doe*John****MI*123456™ =
2 EDI transactions are created. -_—

The menu item to create the necessary tables.

2. The "Create Tables for EDI_Exchange” screen will appear. Table creation and/or
modification for your database is handled here.
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Creabe Tables for EDI_Exchange

Database: * Microsoft SOL Server © MySQOL/Generic
Trading Partner | TRANS_LOG | TRANS_LOG_ERRORS | SEND_LOG | COMPANY_SETUP |

C:ProgramDatalHIPAA Suite\HIPAA Enrollment Master\Scripts\TradingPartner_5QL Server.sql

1 CREATE TABLE [dbo] [TradingPartner]|
. [TradingPartneslD] [varchar](15) NOT NULL,
3 [TradingPartnerD_QUAL] [varchar](5) MULL,
- [ETINMo] [varchar](15) NULL.
[MAME] [varchar](40) NULL
[Contact] [varchar](100) MULL
/ [Phane] [varchar](15) NULL.
8 [Extension] [varchar](10) NULL.
9 [Email] [varchar](75) NULL.
10 [Fax] [varchar]{15) MULL
1 [LocalFtpUser) [varchar](20) NULL, =
[LocalFtpPassword] [varchar](20) NLILL,
13 [Address1] [varchar](100) MULL,
14 [Address2] [varchar](100) NULL.
15 :Clty] :vﬂrchar]-ﬁﬂ:: MULL
16 [State] [varchar](2) MULL.
[Zip] [varchar]{ 10) MULL.
[FtpAddress] [warchar](50) MULL.
19 [PutDirectory] [varchar](50) NULL,
20 [GetDirectory| [varchar]{50) NULL
21 [DialupNumber] [varchar)(20) NULL,
22 [FtpUserName] [varchar](20) NULL.
23 IFtoPassword] lvarcharli 201 MULL =

save | Execute Script |

Help Cancel | 4

The screen to create the tables

|

3. Select the database type you use for your host HIPAA application.
¢ Database
e Microsoft SQL Server (SQL Server 2008 and above)
e MySQL

Note: In case your database is not listed, modify the scripts or ask your database administrator to
make the necessary modifications.

4. The following tables are part of EDI Exchange:

e TradingPartner — SQL statements to create the "TradingPartner” table in your
database. This table contains information about trading partners.

e Trans_Log — SQL statements to create the "TRANS_LOG" table in your database.
This table contains incoming file information, keeps track of all EDI files that you
receive and the compliance check report.
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e Trans_Log_Errors — SQL statements to create the "TRANS_LOG_ERRORS" table in

your database. This table collects the results of the compliance check and keeps
track of all sent files.

e Send_Log — SQL statements to create the "SEND_LOG" table in your database.
The table contains information about EDI files created and sent to trading
partners.

e Company_Setup — SQL statements to create the "COMPANY_SETUP" table in your
database. This table collects information about you, the sender of EDI
information.

5. You can modify the scripts so that they run on your specific database. Once you have
you modified the script, click "Save."

Tip: Every database system has their own little syntax idiosyncrasies and the scripts might require
tweaking. You can edit the table scripts in this screen and save your modified scripts. One example
are 'date’ and 'time’ or ‘'money’ data types that do not exist in SQL Server 2005. You can just rename
those types to 'datetime’ and save you script and it will run fine.

il
Database: ¢ Microsoft SQL Server * MySQL/Generic
Trading Pariner | TRANS_LOG TRANS_LOG_ERRORS | SEND_LOG | COMPANY_SETUP |

C:AProgramData'HIPAA Suite HIPAA Enroliment Master\ScriptsiTransLogErrors_MySaL.sql

| CREATE TABLE TRHANS_LOG_ERRORS | =]
“ID7 int(11) NOT NULL auto_increment
"TRANS_LOG_ID™ varchar(200) NOT NULL,
"ERROR_MESSAGE" varchar(300) DEFAULT MULL.
PRIMARY KEY ("1D)

=
Save Execute Script |

Help Cancel . L;;

The "Save" button

6. For each script on every tab, click "Execute Script” to create the corresponding table
in the database.
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Create Tables for EDI_Exchange gl.gl_il

Database:  Microsoft SOL Server & MySQL/Generic

Trading Partner | TRANS_LOG | TRANS_LOG_ERRORS | SEND_LOG | COMPANY_SETUP |

C:ProgramDatalHIPAA Suite\HIPAA Enroliment MasteriScriptsiTradingPartner_MySQL.sql

1 CREATE TABLE "TradingPartner |

2 “TradingPartnerlD” varchar(15) NOT NULL.
3 “TradingPartnerlD_QUAL" varchars) MULL,
"ETINMo" varchan15) MOT MULL.,

“NAME™ varchar(40) NULL,

“Contact” varchar(100) NULL.

"Phane” varchar15) NULL.

“Extension” varchar( 10) MULL,

"Email’ varchar(75) NULL.

10 “Fax” varchar(15) MULL.

11 “LocalFtpUser” varchar(20) NULL.

12 “LocalFtpPassword” varchan20) MULL. =
13 “Address1” varchar{ 1007 NULL,

14 “Address2” varchar( 100) NULL,

15 "City” varchar30) NULL.

16 “State” varchar(2) NULL.

17 *Zip® varchar(10) NULL.

18 “FtpAddress” varchar(50) MULL,

19 "PutDirectory” varchar(50) NULL.

|

=T el R (e I -

20 “GetDirectory” varchan50) NULL,

21 "DialupMumber” varchar(20) NULL.

2 “FipliserMame” varchar(20) MULL,

23 "FloPasswaord” varchar(200 MULL. =l

Save |.k Execute Script

— —

Help I Cancel I Lz

The "Execute Script” button

Notice: Creating tables means clicking the "Execute Script” button in all five tabs of the "Create Tables
for EDI_Exchange” window. Then close this window.

7. 0nce the table has been created successfully, you will see the following notification:

Soccess

Table successfully created

The Create Table script success message

Warning: Double-execution of a script wipes out the previous table you have created. A prompt will
warn you before deleting an existing table. To Add/Remove fields use the "Compare Script..."
button. Remove the script files once you have created the tables so nobody can destroy the tables
by accident.
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I -

:] This action will wipe cut all your data in TradingPartner table. Proceed?

(= [ % ]

. B 1
The double-execution warning message.

Make sure there are no error messages and the table creation has been completed
successfully.

Compare Script with existing Table

HIPAAsuite products go through continual development and improvements. Often these
changes lead to new fields in the database. While it is easy to drop a table and
regenerate it with the new fields, you will loose all the data in the table. To avoid this
trouble there is the button "Compare Script with existing Table". | you click this, the
table structure in your database will be compared with the script. There are two possible
outcomes. Your table is up to date

. )

You have all the fields in your table,
There is nothing to do

1 |

Table is up to date

or if your table is missing recently added fields, you will see a window pop up that shows
an ‘Alter Table' script with which you can add those fields to the table without interfering
with existing data.
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n'J Changes to your tab_ll LI_IQ

1 Alter Table TradingPartner

Add
[SourceEntitylD] [char](2) MULL,
[SourcelDQualifier] [char](2) NULL,
[SourceMame] [varchar]{50) NULL.
[SourcelD] [varchar](50) MULL

N LT ek L P

-

Execute Script ]

The 'Alter Table' script that shows as a result of missing fields

You can now click the "Execute Script” button and the field will be added and a message
will confirm your changes

. =)

Table successfully altered

| |

Alter Table statement successfully executed.

Once you have created the tables, you can start setting up the other application options.
See the next step: Defining Auto-Processing Options.

12.2.3 2b Creating 999 File Tables

Once you have configured the database connection (Setting up Database Connection),
follow the instructions below.

1. Select EDI Exchange » Create 999 Files Tables in the main menu.
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EDI Exchange | Help

Check EDI File

— Trading Partners -
é Inbox Manager
FTP Client
SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Create 999 Files Tables

Autoprocess Setup

Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License

EDI Exchange License Information
g [ - — L | Smm—————

The menu item to create the necessary tables

2. The "Create Tables for 999 Files" screen will appear. Table creation and/or
modification for your database is handled here.
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F ™

Database
@ Microsoft SQL Server ) Oracle O MySQL/Generic

ImplementationAck |Transac1.ionF{espcmse | SegmentErrors | Elemenﬂ'\lutes|

ImplementationAck Table script:

1 CREATE TABLE ImplementationAck( -
[ID]int IDENTITY NOT NULL.
[FileName] varchar{100) NULL.
[SenderlD] varchar(15) MULL,
[SendTime] datetime NULL.
[GroupControlNo] varchar(9) NULL,
[TransactionControlNo] varchar(9) NULL,
[FuncitionallD] char(2) NULL,
[OnginalGroupControlMa] varchar(9) NULL,
10 [Version] varchar{12) NULL.
1 [AckCode] char(1) NULL,

[IncludedTS] int NULL.
13 [ReceivedTS] int NULL,

[AcceptedTS] int MULL.

LD 00 s O 0N fe LIPS

[ErrorCode1] char{3) MULL.

[ErrorCode?] char({3) NULL,
7 [ErrorCode3] char{3) MULL.

[ErrorCode4] char{3) NULL.
19 [ErrorCode5] char{3) NULL,
20 PRIMARY KEY ([1D])

’ Compare Script with existing Table Save l [ Execute Script l

The screen to create the tables
3.Select the database type you use for your host HIPAA application.
e Database
e Microsoft SQL Server (SQL Server 2008 and above)
e Oracle
e MySQL

Note: In case your database is not listed, modify the scripts or ask your database administrator to
make the necessary modifications.

1. The following tables are part of EDI Exchange:

¢ ImplementationAck — SQL statements to create the "ImplementationAck” table in
your database. This table contains information about Acknowledgments.

¢ TransactionResponse — SQL statements to create the "TransactionResponse” table
in your database. This table contains individual transactions contained in 999 files.
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e SegmentErrors — SQL statements to create the "SegmentErrors” table in your
database. This table contains individual segments in error contained in 999
transactions.

e ElementNotes — SQL statements to create the "ElementNotes" table in your
database. The table contains the elements in error in a specific segment.

5. You can modify the scripts so that they run on your specific database. Once you have
you modified the script, click "Save."

Tip: Every database system has their own little syntax idiosyncrasies and the scripts might require
tweaking. You can edit the table scripts in this screen and save your modified scripts. One example
are 'date’ and 'time’ or ‘'money' data types that do not exist in SQL Server 2005. You can just rename
those types to 'datetime’ and save you script and it will run fine.

r ki
Database
@ Microsoft SQL Server ) Oracle @ MySQL/Generic
ImplementationAck |Transac1ionF{esponse | SegmentErrors | EIementhrtes|
ImplementationAck Table script:
1 CREATE TABLE ImplementationAck( »
2 [1D] int IDENTITY NOT NULL.
3 [FileName] varchar(100) NULL
- [SenderlD] varchar(15) MULL.
5 [SendTime] 5 NULL.
6 [GroupContralMNo] varchar(9) NULL,
7 | TransactionCaontrolMo] varchar(9) NULL,
8 [FuncitionallD] char(2) NULL,
9 [CnginalGroupControlMNa] varchar(9) NULL,
10 [Version] varchar(12) NULL.
1 [AckCode] char{1) NULL,
12 [IncludedTS] int NULL.
13 [ReceivedTS] int MULL,
B lAcceptedTS] int MULL.
15 [ErrorCode1] char{3) NULL,
16 [ErrarCade2] char{3) NULL,
7 [ErrorCode3] char{3) NULL,
18 [ErrarCade4] char{3) NULL,
19 [ErrorCodeb] char{3) NULL.
20 PRIMARY KEY ([ID])
21 :]j
[ Compare Script with existing Table Save ] [ Execute Script ]

The "Save" button

6. For each script on every tab, click "Execute Script” to create the corresponding table

in the database.
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F ™

Database
@ Microsoft SQL Server ) Oracle O MySQL/Generic

| ImplementationAck | TransactionResponse |SegmentError3| Elemenﬂ\lntes|

SegmentErrors Table script:

1 CREATE TAELE SegmentErmors( -
[ID] int IDENTITY NOT MULL,

[TS_ID] int NOT NULL,

[Ack_ID] int NOT NULL,

[SegmentlDCode] char(3) NULL.

[SegmentPosition] int NULL.

[LooplD] varchar{4) NULL.

[ErrorCode] varchar(9) NULL.

LD 0O ] O LT e La B

10 fFCTX

11 [CTX1_ContextName] varchar{35) NULL.

12 [CTX1_ContextReference] varchar(35) NULL,
13 [CTX1_SegmentlD] char(3) NULL,

14 [CTX1_LooplD] varchar(4) NULL,

15 [CTX1_SegmentPosition] int MULL,

16 [CTX1_ElementPosition] int NULL.

17 |[CTX1_ComponentDataElementPos] int NULL.
18 [CTX1_RepeatingDataElementPos] int MULL.
19 [CTX1_ElementReferencel] varchar(4) NULL,
20 [CTX1_ElementReference?2] varchar(4) NULL,

22 [CTX2_ContextName] varchar(35) NULL,

23 |[CTX2_ContextReference] varchar(35) NULL,

24 [CTX2_SegmentlD] char(3) NULL,

25 [CT*2_LooplD] varchar(4) NULL, -

[Compare Script with existing Table ] Save ] [ Execute Script ]

The "Execute Script” button

Notice: Creating tables means clicking the "Execute Script” button in all four tabs of the "Create
Tables for 999 Files" window. Then close this window.

7.0nce the table has been created successfully, you will see the following notification:

)

Table 'ElernentMotes’ successfully created

Ok

The Create Table script success message

Warning: Double-execution of a script wipes out the previous table you have created. A prompt will
warn you before deleting an existing table. To Add/Remove fields use the "Compare Script..."
button. Remove the script files once you have created the tables so nobody can destroy the tables
by accident.
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# ™
I -

:] This action will wipe out all your data in ElementMotes table, Proceed?

The double-execution warning message.

Make sure there are no error messages and the table creation has been completed
successfully.

Compare Script with existing Table

HIPAAsuite products go through continual development and improvements. Often these
changes lead to new fields in the database. While it is easy to drop a table and
regenerate it with the new fields, you will loose all the data in the table. To avoid this
trouble there is the button "Compare Script with existing Table". | you click this, the
table structure in your database will be compared with the script. There are two possible
outcomes. Your table is up to date

. )

You have all the fields in your table,
There is nothing to do

1 |

Table is up to date

or if your table is missing recently added fields, you will see a window pop up that shows
an ‘Alter Table' script with which you can add those fields to the table without interfering
with existing data. In the latter case, you can click the "Execute Script” button and the
field will be added and a message will confirm your changes
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Table successfully altered

Alter Table statement successfully executed.

12.2.4 2c Updating Database Tables

To update an existing table (in the event of an update, for example), follow the
instructions below.

1. Start with the table creation script window of the table you want to update. In this
example, we will use the Trading Partner table.
Create Tables for EDI_Exchange E[=E |

Database: * Microsoft SQL Server © MySQL/Generic

Trading Partner | TRANS_LOG | TRANS_LOG_ERRORS | SEND_LOG | COMPANY_SETUP |

C:\ProgramDatalHIPAA Suite\HIPAA Enroliment MasterScripts\TradingPariner_5QL Server.sql

1 CREATE TABELE [dba] [TradingPartner](
[TradingPartnerD] [varchar]{15) NOT NULL.
[TradingPartner D_QUAL] [varchar](s) MULL.
[ETINMag] [varchar]{15) NULL.
[MAME] [varchar](40) NULL,
[Contact] [varchar]{100) MULL.
[Phone] [varchar](15) NULL.
[Extension] [wvarchar]( 10) NULL.
9 Emsail] [varchar](75) MULL.
10 Fax] [varchar](15) NULL
1 [LocalFtpUser) [varchar](20) NULL, =
12 [LocalFtpPassword] [varchar](20) NLILL,
13 [Address1] [varchar](100) MULL,
14 [Address2] [varchar](100) NULL,
15 [City] [varchar]{30) MULL,
16 [State] [varchar](2) MULL.
17 [Zip] [warchar](10) MULL.
18 [FtpAddress] [varchar](50) MULL.
19 [PutDirectory] [varchar](50) NULL,
20 [GetDirectory| [varchar]{50) MULL,
21 [DialupMumber] [varchar](20) NULL,
22 [FtpUserName] [varchar](20) NULL.
73 IFtoPassword] [varcharl 200 NULL |

save | Execute Script |

Help | Cancel |3

The table creation script for the Trading Partner table.

|

LIPL ] e ]

00 =J TN LY b
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2. In the case of modifying a table to include/exclude/change a field or fields required by
a program update, the script will have been updated for you and clicking the Compare
Script with existing Table button will bring you to the next step. To modify the table
yourself in order to conform to your particular database, first edit the script text to
suit your database system, click the Save button, then the Compare Script with
existing Table button, and proceed to the next step.

Tip: Every database system has their own little syntax idiosyncrasies and the scripts might require
tweaking. You can edit the table scripts in this screen and save your modified scripts. One example
are 'date’ and 'time’ or ‘'money’ data types that do not exist in SQL Server 2005. You can just rename
those types to 'datetime’ and save you script and it will run fine.

3. Having clicked Compare Script with existing Table, the script will be compared to the
existing table and any additional fields will be presented. In this example, the Trading
Partner table's Address fields will be added.

a5 Changes to your table — N Y

1 Alter Table TradingPartner

J Add
[Address1] [varchar]{100) NULL,
[Address?Z] [varchar](100) MULL,
[City] [warchar](30) NULL.
[State2] [char](2) MULL,
[Zip] [varchar] (107 NULL

o LT e L

Execute Script Cancel

Changes to be made to Trading Partner table.

4. Click Execute Scipt. This will perform the additions/changes stated in the alter table
script and a prompt will appear informing you of the change. The table has now been
modified.

Table successfully altered

oK

Table has been altered.
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12.2.5 3 Defining Auto-Processing Options

In the "Auto-Process Setup” you can instruct the program on what to do after analyzing
and decrypting the received files in the Inbox Manager. The auto processing enables you
to combine and run multiple fulfilment steps together (for example, export, saving,
printing.) These options are important for the hand-over from EDI Exchange to the other
HIPAAsuite program that hosts EDI Exchange.

Follow the instructions below to specify the Auto Process Options.

1. Select EDI Exchange » Autoprocess Setup in the main menu.

Setp Log | EDIExchange | Help
? Check EDI File

Tradrug Partriers

Inboo Manager

FTP Client

SEF Fles

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
EDI Exchange License Informatbion

The "Autoprocess Setup” menu item

2. The following screen will appear if the host HIPAA application is Enrollment Master.

Automatic PI‘CH.'!P‘.‘I’H] ﬂphﬁﬂﬂ- !EE
— Check path options
[T Check FTP servers for new files
I Export in Database I"| Create Autoresponse
™ Print

Saveto: [ Image [ Excel ™ AsCl

__save | __Cancel |,

Defining the Auto Processing Options
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3. The following options can be specified:
Check Path Options
e Check FTP servers for new files — If checked, EDI Exchange automatically looks for

new files for all trading partners that have FTP connection set up. Then the program

gets all the waiting files and puts them into the Inbox. In the second step, it goes
through every file.

Default Automatic Processing Options

e Export in Database — If selected, the module exports new files to the database.
e Print — If selected, the module prints files using the selected printer.

e Create Auto-Response — If selected, the module creates an auto-response to the
received files.

e Save to — If selected, the system automatically saves files as:
¢ Image
e Excel
e ASCII
4. Click "Save."

Check path options

¥ Check FTP servers for new files

=10l x|

I Export in Database r

W Print Use printer: IFax j
Saveto: ¥ Image ¥ Excel ' ASCIH

“swve_|

The "Save" button

Once you have saved the auto-processing options, the files will not only be analyzed but

also processed according to the defined settings. Proceed to the next step: Defining
Communications Directory.
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12.2.6 4 Defining Communications Directory

EDI file directory is an obligatory setting you need to set up before starting using the EDI
Exchange. In order to keep track of the thousands of EDI files that accumulate over
time, EDI Exchange uses a folder structure which we call the "HIPAAsuite Communications
Directory” or "HIPAAsuiteCommDir" in short. In it, you will find all your EDI files sorted
into several categories:

¢ Inbox

e Outbox

® ProcessedFiles
e EncryptedFiles
e SuspendedFiles

Within these directories, there will be folders for each Trading Partner and type of
transaction. The location and names of the sub-folders are handled in the "Trading
Partner Setup.” See Setting up Trading Partners.

Follow the instructions below to specify EDI communications root directory.

1. Select "EDI Exchange Setup” under the "EDI Exchange” menu item.

Setup log | EDIExchange | Help
4 Check EDI File

Tradrug Partriers
Inbox Manager

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log

EDI Send Log

Request EDI Exchange License
EDI Exchange License Informatbion

The "EDI Exchange Setup” menu item

2. The following window will appear.
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EDI Exchange Setup

 EDI Exchange Directory Setup

Root Directory Path |23 Browse
SMTP Server Sender’s email address I™ Send email nofice of newly arrived Files? __Test |
[ I | Add
User Name Password -y
Recipients
™ SMTP server requires Logon | | d
™ Connectio the SMTP server via the SSL protocol Use Port
I Validate outgoing files " Rejectincoming Files with more ermors than
e = . (set Count below)
I Halt records if EDI compliance 1
wamings are found I' e e

® EDI Exchange is NOT yet initialized! initialize EDI Exchange | Save Help Closo |
&

The "EDI Exchange Setup” window

Note: The icon in the lower left corner indicates that EDI Exchange has not been initialized yet.

3. Under "EDI Exchange Directory Setup” specify the following setting:

¢ Root Directory Path — Define the root path in the "Root Directory Path" text field.
The root path is the folder where all your EDI files reside. EDI Exchange will later
create sub-directories required to operate.

EDI Exchange Setup M=

|~ EDI Exchange Directory Setup
Root Directory Path =13 Browse I

The root communications directory setup

4. Click "Save."”

_laix

 EDI Exchange Direclory Setup
Root Directory Path  [0EDN, MI

SMTP Server Sender’s email address I™ Send email nofice of newly arrived Files? __Test |

[ I I Add |
User Name Password =
R ts
" SMTP server requires Logon | S
™ Connectto the SMTP server via the S5L protocol Use Port
I™ Validate outgoing files " Rejectincoming Files with more ermors than
(set Count below)
I Halt records ifEDI compliance 1
wamings are found I' e

@ EDI Exchange is NOT yet initialized! initialize EDI Exchange | Save Help Clos= l
%

The "Save" button
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After setting the root directory, you can click the "Initialize EDI Exchange" button. Read
more in Initializing EDI Exchange.

12.2.7 5 Initializing EDI Exchange

Before you can use EDI Exchange, and after you have configured the obligatory settings,
you have to perform the initialization. Follow the instructions below.

1. Select "EDI Exchange Setup” under the "EDI Exchange” menu item.

Setup Log | EDIEwchange | Help
2 Check EDI File

Trading Partriers
Inbox Manager
FTFP Chent

SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log

EDI Send Log

Request EDI Exchange License

e EDI Exchange License Information
The "EDI Exchange Setup” menu item

2. The following window will appear.
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EDI Exchange Setup M= E
— EDI Exchange Directory Setup - 1
Root Directory Path |23 Browse
— Email Server Information Email Notification
SMTP Server Sender's email address ™ Send email notice of newly arrived Files? __Test |
[ I | Add
User Name Password -
Recipients
™ SMTP server requires Logon | | d
™ Connectio the SMTP server via the SSL protocol Use Port
™ Validate outgoing files I RejectIncoming Files with more emors than
e = . (set Count below)
I Halt records if EDI compliance 1
wamings are found I' .
® EDI Exchange is NOT yet initialized! initialize EDI Exchange |  Save Help Closo |
&

The "EDI Exchange Setup” window

Note: The icon in the lower left corner, indicating that EDI Exchange has not been initialized yet.

3. After setting the root directory (see the previous step Defining Communications
Directory), you can initialize EDI Exchange module. Click the "Initialize EDI Exchange”

button to accomplish the process.

— EDI Exchange Direclory Setup -

Root Directory Path [D \EDI,

 Email Server Information
SMTP Server

[ I

" SMTP server requires Logon |

™ Connectto the SMTP server via the S5L protocol
: Outgoing Files

I™ Validate outgoing files

I Halt records ifEDI compliance 1

wamings are found

-0l
Browse
Email Notification
Sender's email address ™ Send email notice of newly arrved Files? __ Test |
| Add |
User Name Password Recipients
Use Port
< Other oplions
" Rejectincoming Files with more ermors than
(set Count below)
I
i i [ W " W i 3 ) i
I Initialize EDI Exchange I Save Help Cose I
&

@ EDI Exchange is NOT yet initialized!

The "Initialize EDI Exchange" button

Once the "Initialize EDI Exchange” button is clicked, the system checks if all settings have

been configured correctly.

1. The first thing the initialization process checks is the connection to the database and
the presence of the necessary tables. EDI Exchange relies on the database connection
that is part of the HIPAAsuite application that you are using. EDI Exchange needs
Database Connectivity licensed and enabled. If this part is not yet set up, then you will

get an error like this:
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Processing Results
EDI Exchange inihalization started

Checking SOL setings and tables:
Could not establish connection

EDI Exchange encountared the above errors
EDI Exchange is not operational until everything checks out

Initialization failed because of SQL connection problems

Read more in Setting up Database Connection.

M[=] E3

2. Once the connection is established, the program checks if the correct tables exist in
the database. See Creating Database Tables. Once the SQL part checks out, you will

see the following message.

Checki ng SQL settings and tables:

Connection settings are checked. Trading Partners table is checked.

TRANS_LOG table is checked.
TRANS_LOG ERRORS table is checked.
SEND_LOG table is checked.

3. The next step of the initialization processes — the program checks and, if necessary,
creates the root directory and five sub-directories. Within these root directories, there
will be folders for each Trading Partner and type of transactions. The location and
names of the sub-folders are handled in the "Trading Partner” setup. The root folder is
specified via the "EDI Exchange Setup” screen. Read more in Defining Root Directory.

The sub-directories that EDI Exchange creates are as follows:

P\ o[ - computer - ws208 (c) -+ 3 -

Organize * Indudeinlirary = Sharewith »  New folder

- Eavorites Al MName - Date modified Type
EncryptedFiles 1/31/2013 5:56 PM File folder
w4 Libraries Inbox 1/31/2013 5:56 PM  File folder
Duthox 1/31/2013 5:56PM  File folder
"-;f“‘;:;;; © ProcessedSies 1312013 5:56PM  File folder
_— . SuspendedFiles 1/31/2013 5:56PM  File folder
g Data (D:)

The directory structure of EDI Exchange

4. The next step of the initialization — the program checks if the HIPAA EDI compliance
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engine is properly installed.

5. The last thing checked by the system is if the Automatic File Processing options have
been set up. Read more in Defining Auto-Processing Options. The options are

important for the hand over from EDI Exchange to the other HIPAAsuite program that

hosts EDI Exchange.

Once all verifications have been completed successfully, you will see the following

message:

Processing Results

EDI Exchange inibalization started

Checking S0L settings and tables:
Conneclion sellings are checked
Trading Parners table is checked.
TRAMNS_LOG table is checked.
TRANS_LOG_ERRORS table is checked
SEND_LOG table is checked.
COMPANY_SETUP table is checked
COMPANY _SETUFP data is validated.

Checking for Required Directories:
Inbox Directary is checked
Qutbox Directory is checked.
Processed Directory 1s checked.
Crypt Directory is checked
Suspense Directory is checked.

Checking for EDIDev:
EdiDev is found.

EDI Exchange has been successfully iniialized and is ready for use.

(=] E3

Successful initialization of EDI Exchange

After that your EDI Exchange is initialized.
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EDI Exchange Setup

— EDI Exchange Directory Setup

Root Directory Path [c;\a.

~ Email Server Information iz
ST Sender's smal address I Send email notice of newly arived Files? __ Test |
[ User Nanlna Password I LI
™ SMTP server requires Logon | | Recipients
™ Connectto the SMTP server via the SSL protocol Use Port I

O Files Other

I™ Validate cutgoing files

"' Halt records if EDI compliance
wamings are found

™ Rejectincoming Files with more emors than
(set Count below)

J EDI Exchange is successfully initialized.

_Hep [ Gee |

|
[ mtialize EDI Exchange | sove |
1

v

The "EDI Exchange is successfully initialized” message on the bottom of the "EDI Exchange Setup” window

Troubleshooting Initialization

When you are going through the Initialization process of the EDI Exchange, you can
encounter the following message in the "Processing Results” window:

Checking for EDI De

EDI Dev is not inst

Vi

al | ed!
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Processing Results HFIE |

EDI Exchange iniialization started

Checking SOL seftings and tables:
Conneclion setings are checked
Trading Partners table is checked.
TRAMS_LOG table is checked.
TRAMS_LOG_ERRORS table is checked
SEMD_LOG table 15 checked.
COMPANY_SETUF table is checkad
COMFANY _SETUF data is validated.

Checking for Beguired Directones:
Inkox Directory is checked.
Dutbo: Directory is checked
Processed Directory is checked.

Crypt Directony is checked,
suspense Lirectory 15 checked.

Checking for EDIDew,
| EdiDevis not installed! |

EDI Exchange encountarad the abowve errors
EDI Exchange is not operational until everything checks out.

The EdiDev component is not installed
To resolve this issue, do the following.

1. Go to the http://www.edidev.com/ediregis.htm site.

2. Some systems may require Microsoft Redistributable Package to be installed first. In
this case, download one of the following components according to your OS' bit depth.

The recommended minimum system requirement for Framework EDL

+ 256 MB RAM

s 1GB available disk space

o Windows 2000/2003/2008XP/Vista'7

L] Prﬂ’equisiles: Some wywiems may mquise hicoecd Radisribotabls Pacoegs to be installed e 1o mupport:

Frnework EDEMET (32-0d0) - dewalead Microsod Vieoal €+ 200 Redistritucsble Paclape (1886

Frasnewerk EDI NETS (32-bit) - dewnlosd Mlicmsol Visual O+ 2010 Eadiseribuaabls Packaps (xBS)

Fronswork DI NET {§4-hif) - donnload hicronsf Vissal Ce== 2005 Radistritutibls Pldu:\e{x-ﬁﬁ
Froenework EDI NETH (64=bi) - dewnload hlicosod Vismal C+= 2010 Redssributable Package (x64)

o Qo 0

3. Download one of the following components you need according to your OS' bit depth:

e Framework EDI Enterprise evaluation 32-bit
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¢ Framework EDI Professional evaluation 64-bit

4. Install downloaded components and start again the EDI Exchange initialization
procedure.

12.3 Configuring EDI Exchange (Optional Settings)

12.3.1 Setting up Email Notifications

EDI Exchange can send emails to operators and trading partners to notify them about files
and processing results. This functionality of EDI Exchange lies beyond the most basic
setup that the initialization checks for. For this feature to work properly, you need to set up

an email server which EDI Exchange communicates with. You can do this in the "Email
Server Information” frame of the setup screen. Follow the instructions below.

1. Select "EDI Exchange Setup” under the "EDI Exchange" menu item.

Selup Log | EDIExchange | Help
4 Check EDI File

Trading Partners
Inbox Manager
FTF Chent

SEF Fles

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
E EDI Exchange License Information
The "EDI Exchange Setup” menu item

2. The following window will appear.
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EDI Exchange Setup

i EDI Exchange Directory Setup

Root Directory Path [c13

— Email Server nf

SMTP Server Sender's email address

Email Notification

[ I

User Name Password

™ Send email notice of newly arrived Files? __Test |

| Addl

™ SMTP server requires Logon | |
™ Connectio the SMTP server via the SSL protocol

i Outgoing Files Other options
™ Validate outgoing files " RejectIncoming Files with more emors than

(set Count below)
I Halt records if EDI compliance 1

warnings are found 4
| f ' A f . ' ' . ' 0

Use Pont |

Recipients

® EDI Exchange is NOT yet initialized! Initialize EDI Exchange

|I T Help |

1 “

The "EDI Exchange Setup” window

3. Specify the following email options:

Email Server Information

e SMTP server

Sender’'s email address

SMTP server requires logon

Username
Password

Connect to the SMTP server via the SSL protocol

e Use port

EDI Exchange Setup

[~ EDI Exchange Di y Setup

=10l

Root Directory Path [DﬂLEDﬁ

Browse |

Email Server Infe - Email Notification
SMTP Server Sender's email address I” Send email nofice of newly anived Files? __Test
lsm!p.gmail.com |exarnple @gmail.com I Add |
User Name Password Recipients
¥ SMTP serverrequires Logon [example  ——
" Connectto the SMTP server via the S5L protocol Use Port I
I Validate outgoing files " RejectIncoming Files with more emors than
(set Count below)

™| Halt records if EDI compliance 1

wamings are found I' o e
@ EDI Exchange is NOT yet initialized! Initialize EDI Exchange i Save Help | Close |

Setting up the email server
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Note: If you do not have this information, please ask your administrator to set this portion up for you.

4. To configure email notifications, specify the following options:

Email Notification

e Send email notice of newly arrived files? — Use this checkbox to define if you want
to send email notice once new files have arrived.

e Recipients — You can add your staff's email(s) and the processing messages will be
sent to these emails.

Enter an email address and click "Add."

| . =10 x|

1
1]

[

Browse

- Email Notification
¥ Send email notice of newly amived Files? __Test

E

Iexa mple@gmail com|
Recipients

_Sawe | Hep | Cose |

V.

Setting up the email recipients

The email address will appear in the list.
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[ =10]x|

Browse

- Email Motification

¥ Send email notice of newly arived Files? __Test

| L_Add_|

Recipients

example@gmail.com

_sawe | Wb | Cowe |

#|

Added email recipient

5. Click on the "Test" button to verify your settings.

6. Click on the "Save" button.

EDI Exchange Setup

=0l x|
— EDI Exchange Directory Setup
Root Directory Path [D:‘LEDI\

Browse

 Email Server Information - Email Notification
SMTP Server

Sender's email address ¥ Send email notice of newly arived Files? __Test
Iax:ampla@gmall.com

[smlp.gman.ccm

| Add I
User Name Password IRecipienls

¥ SMTP serverrequires Logon [example |

™ Connectto the SMTP servervia the S5L protocal Use Port I example@gmail com
~OutgoingFles || Other

I™ Validate outgoing files ™ Rejectincoming Files with more emors than

set Count be
"' Halt records if EDI compliance : =

1
wamings are found -

® EDI Exchange is NOT yet initialized! Initialize EDI Exchange ilc/— Save \D

v
The "Save" button

Troubleshooting Email Settings

If you have problems with setting up the email server, please contact your administrator. He/
She should know values to specify and how to test the settings.

Below is an example of what happens when the email server does not respond.
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After a time out, you get a failure notice

After acknowledging the failure, you get a more detailed error message in the process
result screen.

_ioix)
Percert Done: |
Sending emai to ‘I

Thiere was a problem with the amail. Sea the log below

220 mex google .com ESMTP a1am91172eap.2 - gsmip
EHLO CVK
250w googhe .com at your service, [37,17,113.234]
250-SIZE 35882577
250-BBITMIME
250-5TARTTLS
250 ENHANCEDSTATUSCODES
AUTH LOGIMN
330 5.7.0 Must issise 3 STARTTLS command first. 31sm31172eep .2 - gsmip

The process result screen with a detailed error message

12.3.2 Setting up Incoming and Outgoing Files Options

To check if your files are HIPAA-compliant, EDI Exchange can run a compliance check on
outgoing EDI files. For incoming files, you can specify an acceptable error level. These
settings are especially important with new trading partner relationships or with new
processes since it always takes a while until an EDI process runs without issues and
problems.

Follow the instructions below.

1. Select "EDI Exchange Setup” under the "EDI Exchange” menu item.
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Setup Log | EDIExchange | Help
? Check EDI File

Trading Partners

Inbox Manager

FTP Clienit

SEF Fles

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log

EDI Send Log

Request EDI Exchange License

E EDI Exchange License Informabion
The "EDI Exchange Setup” menu item

2. The following window will appear.

EDI Exchange Setup

[~ ED| Exchange Directory Setup

Root Directory Path [p«le, Browse
[~ Email Server information Email Notification _

SMTP Server Sender's email address ™ Send email notice of newly arrived Files? __Test |

[ I I Add |

User Name Password .y
Ri Is

™ SMTP server requires Logon | | S

™ Connectio the SMTP server via the SSL protocol Use Port
i Ouitgoing Files < Other oplions

™ Validate outgoing files I RejectIncoming Files with more emors than

o = . (set Count below)
" | Halt records if EDI compliance 1
warnings are found I' :
|
@ EDI Exchange is NOT yet initialized! Initialize EDI Exchange | Save Help [ Clogs

The "EDI Exchange Setup"” window

3. Specify the following outgoing files options:

Outgoing Files

¢ Validate outgoing files — Select this checkbox to validate if the outgoing files are

HIPAA-compliant.

e Halt records if EDI compliance warnings are found — Select this checkbox to
suppress the sending of files with warnings or errors.

© <2003> Martin Scholl Consulting, Inc.



Using EDI Exchange Features 378

EDI Exchange Setup

=10] x|

— EDI Exchange Di ¥ Setup

Root Directory Path [[);u;ml Browse
~— Email Server Inf - [Email Notification

SMTP Server Sender's email address ¥ Send email nofice of newly arived Files? __Test
lsmlp.gmail.com |example @gmail.com I Add |

User Name Password Recipients
¥ SMTP server requires Logon [example  —

" Connectto the SMTP server via the SSL protocol
- On Files

Use Port I example@gmail.com

Other

¥ Validate outgoing files ™ RejectIncoming Files with more ermors than

et Count b
™ Haltrecords if EDI compliance . B —_—
warmings are found 5 \
@ EDI Exchange is NOT yet initialized! Initialize EDI Exchange Save Help I Close /I
i
Validating outgoing files

4. Specify the following incoming files options:

Other Options

¢ Reject incoming files with more errors than (set count below) — If checked, the

incoming files with more errors than defined will not be placed into the "Inbox"
folder.

EDI Exchange Setup

=] S|

— EDI Exchange Directory Setup

Raoot Directory Path [D:‘LEDI\ Browse
~ Email Server information - Email MNotification

SMTP Server Sender's email address F¥ Send email notice of newly amived Files? __Test
[smlp.gmaiu:om Immpla@gmall.com I Add |

UserName Password Recipients
¥ SMTP serverrequires Logon |example  —

™ Connectto the SMTP server via the SSL protocol
~Ox Files

Use Port I example@gmail com

-~ Other

W Validate cutgoing files

I™ Halt records if EDI compliance

¥ Rejectincoming Files with mc%re emors than
I
wamings are found ¥

sel Count below)

® EDI Exchange is NOT yet initialized!

i
The "Reject incoming files with more errors than" option

5. Click on "Save."
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EDI Exchange Setup _.=.l.g.|_£|
i~ EDI BExchange Directory Setup
Root Directory Path [D:‘LEDH Browse I
[~ Email Server information Email Notification
[SMTP Server ISendefs email address F Send email nofice of newly arrived Files? __Test
smtp.gmail.com example@gmail.com
Add |
User Name Password IR o
: ecipients
¥ SMTP serverrequires Logon [example | -
™ Connectto the SMTP server via the SSL protocol Use Port example@gmail com
i Outgoing Files 1 Other oplions
M Validate outgoing files ¥ Rejectincoming Files with more errors than
) : (set Count below)
™ Halt records if EDI compliance -
wamings are found .
® EDI Exchange iz NOT yet initialized| Initialize ED] Exchange |I Save L[ LL
1 7]

12.3.3 Running the Application via Scheduler

EDI Exchange integrates with the Windows Scheduler to allow the automation of the EDI
file exchange process. You can set up EDI Exchange to go out to the trading partner's
FTP server, download files, decrypt and compliance check them and further process them
with the appropriate HIPAAsuite application, for example load claims into a SQL

database.

Follow the instructions below to schedule the EDI files exchange process.

1. Select "Automatic Scheduler” under the "EDI Exchange” menu.

ER HIPAA Envollment Master - 32hit

File Wiew Database CodeSets Imege Setup Log iEDIExchangE | Help

E _— LI

Dutput Mode
# Screen

" Prinker

™ Spisacishas Fila
" ASCI File

T Image File

[T Data Export

Countes

o —

S
|

The "Automatic Scheduler" menu item

i J‘ Check EDI File
1

Trading Partrers
Inbox Manager
FTP Client

SEF Files

EDI Exchange Setup
Emcryphion Setup

Creabe EDI Exchange Tables
Autoprocess Sebup

EDI Recebse Log
EDI Send Log

Request EDI Exchange License
EDT Exchange License Informakion
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2. In the opened window, right click and choose the "Scheduled Task” menu item.

2 M

File Action View Help

«=|E EE

@ Task Scheduler (Local)

o Name Status Triggers MNextRun Time LastRun Time Last Run Result Author Created ictions
4 [ Task Scheduler Library LIPAASuite R
» ] Microsoft
» 1 MysQL E Create Basic Task...
[ HIPAASuite ©  Create Task..
Import Task...
Create Basic Task... [5 Display All Running Tasks

Create New Task... 5] Enable All Tasks Histary

[ngcrtiecEs ] MNew Folder...
Refresh X Delete Folder
View »
1 11 3 |G Refresh
Help
Task Scheduler in Windows Vista onwards.
In Windows XP, the Scheduled tasks directory looks like this:
ﬂ Scheduled Tasks M= E I
File Edit Yiew Favorites Tooks Advanced  Help o
\_) Back = J - " ,__\: Search Y- Folders - @ CHHEPOHMBALHA NanKH
Address |4 Scheduled Tasks i
Name = | Schedule | Next Run Time | Last Run Time | Status | LastResult| cre
|| Add scheduled Task
Other Places £ Elms Every 2 hour(s) from 12:00 AM for ... 8:00:00PM ...  2:00:00 &M 1)... Could nok start 0000142 Ad
B Control Panel View P
L} My Documents _
[y Shared Documents Arrange lcons By »
& My Netwark Flaces e
Faste
Baste Shortot
. Y T
| | i

The "Scheduled Task” menu item in Windows XP.

See "Running the Application via Scheduler” in the help of the host HIPAA application for
detailed instructions on how to schedule a task.

12.3.4 Using the Command Line Arguments (CLI)

The only EDI Exchange specific command line argument is "Auto”

The Auto processing options are defined in another screen and, with the command line
argument "Auto,” they will be exercised. Make sure that you have configured them
according to your needs.
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12.4

1241

Working with Trading Partners

Setting up Trading Partners

With EDI Exchange you can keep track of your trading partners. You can set up their
identifiers to send them EDI files or 999 acknowledgment, send email notifications and
compliance check results, encryption keys and file transport mechanisms.

Once you have created the trading partner table (see Creating Database Tables) and
initialized EDI Exchange (see Initializing EDI Exchange), you can set up the relationships
with your trading partner. Follow the instructions below.

1. Select "Trading Partners" under the "EDI Exchange" menu.

Selup Llog | EDIExchange | Help
3 Chedk EDI File

— —

Trading Partners

Inbaoo Manager
FTP Chent
SEF Fles

EDI Exchange Satup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log

EDI Send Log

Request EDI Exchange License
e EDI Exchange License Information
The "Trading Partners” menu item

2. The following screen will appear.
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EMDEON

LSH-PAL

HEALING HOSPITAL OF ANYTOWN
PREMIER BILLING SERVICE
TEXAS MEDICAID

The "Trading Partners" window

3. Click the "New" button to start entering the trading partner information.

4. Define the necessary options. They are described further.

© <2003> Martin Scholl Consulting, Inc.




383 HIPAA Claim Master

[raangramners [0l
~ Name and Type + List of Trading Partner
Name sats [ 3
| * (Required) Type I—H
Address
I I
City State Zip
I I |
EDI File Exchange Method
| * [~ Send EDI Acknowledgement (997 or 599)
Email Addresses ™ send Email with Process Results
™ notify when receiving Files
™ Motify when sending Files
[ create a 277U for 837 Claims
ED Identfiers | Remote FTP | Contact | Encryption | Folders |
EDI Version
Irﬁ‘ 4010 5010
EDI ldentifiers and Qualifier
ISA Identifier and Qualifier (Record Key)
| | *
ETIN Number and Qualifier Application Sender Code (GS02)
I 46 | &
Application Receiver Code (G503)
I
_Delete | _Refresh|
__swve_| [ tew ] _Gowe |

5. Click on "Save."

The "Save" button

6. The newly added Trading Partner's name will appear in the right pane.

Trading Partner Options

The company information of a trading partner can be specified on the top of the form.
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Trading Partners

~ Name and Type

Name Status | =
[ * (Required) Type I 3
Address

l |

City State Zip

| |

EDI File Exchange Method
[ ] * [T Send EDI Acknowledgement (997 or 999)

Email Addresses ™ sSend Email with Process Results

[ Motify when receiving Files
™ Motify when sending Files
" Create a 277U for 837 Claims

Top area of the "Trading Partners" window
Name and Type
e Name — Trading partner's company name. Required field.
e Address — Trading partner's company address.
e City
e State
e Zip

e Status — Trading partner's status. Choose one of the available options:

¢ |Inactive — No upload into a database system through ODBC will be done.

e Test Only — All outgoing EDI messages will be stamped with "Test” (ISA_15).

Records will only be exported to the test environment.

e Approved — All outgoing EDI messages will be stamped with

"Production” (ISA_15). Records will be exported to the Live system with ODBC.

e Type — There are five types of trading partners, select the necessary one:
¢ Providers — Hospitals, doctors or other health care providers.
¢ VANs — Value Added Networks like clearing houses or EDI Networks.

e Service bureaus — Third party entities such as repricing organizations.

e Sponsors — Entities that sponsor the benefits of subscribers such as MedicAid,

government agencies or large employers.
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e Payers — Entities that pay for health care benefits such as health insurers.
The next block on the form lists the communication methods and preferences.

e EDI File Exchange Method — Obligatory setting. HIPAAsuite supports three
communication methods. Choose a preferred mode of sending EDI communications
to the trading partner:

e FTP — Allows you to transmit files actively to the Trading Partner or his
Clearinghouse.

e Outbox — All files for Trading Partner are stored locally. The Trading Partner is
responsible for picking up files in his special directory of the local FTP or HTTP
server.

e SOAP - Allows you to transmit files to the Trading Partner or his Clearinghouse
using SOAP 1.2 (CORE) by default.

0 SOAP Version - Defaults to CAQH CORE "SOAP 1.2". "SOAP 1.1" is also provided
as a compatibility option for Trading Partners that are not yet CORE-Certified
but use SOAP services.

e MIME - Allows you to transmit files to the Trading Partner or his Clearinghouse
using MIME (CORE). This is one of two CORE options.

e Email Addresses — Enter the email address(es) into the text field.

EDI Identifiers Tab

This tab relates to the EDI identifiers and EDI Version.
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B0 Tdentnisre~\ Remote FTF'l Eu:untau:tl Enu:r_l,lptiu:unl Fu:uldersl

— EDI Yersion
= 4010 = B010

— EDI Identifiers and Quahfier

IS4 Identifier and Qualifier (Record Key)

[T=EBS [zz *

ETIN Mumber and Qualifier Application Sender Code (G502}

| {46 [TXEBS *
Application Receiver Code (GS03) Trading Partner Assigned 1D

The "EDI Identifiers" tab
e EDI Version — There are two standards for HIPAA:

¢ 4010 — This standard was introduced in the original transaction from 2003 to
2011.

¢ 5010 — From 2012 on all HIPAA transactions must be conducted in the 5010
version.

¢ EDI Identifiers and Qualifier

¢ ISA Identifier and Qualifier (Record Key) — The ISA Identifier and Qualifier are
the unique key to the trading partner database file. The ISA identifier can be up
to 15 bytes long, the qualifier has to be 2 bytes. Approved qualifiers are:

e 01 — Duns (Dun and Bradstreet)

® 14 — Duns Plus Suffix

e 20 — Health Industry Number (HIN)

e 27 — Carrier Identification Number as assigned by HCFA

e 28 — Fiscal Intermediary Identification Number as assigned by HCFA

® 29 — Medicare Provider and Supplier Identification Number as assigned by
HCFA

e 30 — U.S. Federal Tax Identification Number
e 33 — National Association of Insurance Commissioners Company Code (NAIC)

e 7Z — Mutually Defined. Many organizations use the ZZ qualifier with their
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name as the ID, for example ZZ and HIPAASUITE.

e ETIN number — The Electronic Transmitter Identification Number established by
a Trading Partner Agreement. This number occurs only in the 837 transactions.
Often, the ETIN is same as the ISA ID.

e Application Receiver Code (GS_02) — A code identifying a part that sends a
transmission or the specific application within the sender's organization. Codes
are agreed by Trading Partners. Again, usually this code is same as the ISA ID.
This code is placed in the GS_02 element in the Functional Group Header (GS).
Some Trading Partners want to send a specific code in GS_03, the application
receiver code. You can enter it into the corresponding field. Most of the time it
is not necessary.

e Assigned ID - Some trading partners, like health insurance exchanges will give a
plan an ID that is different from the ISA identifier defined in the Company Setup
screen of the application. Especially in the creation of filenames is this Assigned
ID important.

Options Tab

EDI Identifiers, Options |Remote FTP | Contact | Encryption| Folders CORE

¥| Send EDI Acknowledgement (397 or 999)
Send e-mail with compliance check and process results
Send e-mail notification when receiving Files
Send e-mail notification when sending Files
Reject Files with Compliance Errors (EDI Exchange)
Create a 277CA for 337 Claims
One ST-SE loop per claim

The "Options” Tab
You can choose one of the following options:

e Send EDI Acknowledgment (997 or 999) — This check-box allows sending
Functional Acknowledgment transactions to the Trading Partner.

¢ Send e-mail with compliance check and process results — This option allows
sending the compliance check results back to your contact at the Trading Partner
via email. No PMI will be transmitted. Adding an email address is important, even
when the Communication method is not "Email.”

¢ Send e-mail notification when receiving files — This option allows sending an

© <2003> Martin Scholl Consulting, Inc.



Using EDI Exchange Features 388

acknowledgment email of EDI files. This option is not necessary when you choose
997 or 999 acknowledgments.

e Send e-mail notification when sending files — This option allows sending a file to
the Trading Partner notifying them that a file has been created for them.

e Reject Files with Compliance Errors - This option will reject files that have
compliance warnings and move them into the suspended files directory. It also
determines whether the TA1 and 999 indicate acceptance or the 999 lists all the
errors and warning.

e Create a 277CA for 837 claims — This option only applies to 837 Claims. Checking
this option will produce a 277CA Claims Acknowledgment report for received 837
Claim files.

e One ST-SE loop per claim - This option separates all claims into individual
transactions enclosed by their own ST and SE segments.

Remote FTP Tab

If your trading partner has an FTP Server, then you can set up here the connection
information. Read more in Using Built-in FTP Client.

EDI Idertfiers ( Remote FTP | Contact | Encryption | Foldess |

& FTP Remote Connection and Directories
FTP Address
T SFTP
[ftp healinghospital com ™ Secure FTP
User Name Passward
Put Directory Get Directory
| DropOff | Pick Up
Test Upload Connection | Test Download Connection

The "Remote FTP" tab

The file transfer protocol (FTP) is one of the first internet protocols and goes back to
the 1960's. Transporting electronic files was one of the great achievements of the
internet. During the last 50 years a lot of improvements to this protocol have been
made, mainly to increase the security of the transfer.

e FTP — For security reasons, EDI Exchange supports secure FTP or FTPs.

e Explicit FTPS Connection — The explicit method is a legacy compatible
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implementation where FTPS aware clients can invoke security with an FTPS
aware server without breaking overall FTP functionality with non-FTPS aware
clients. In explicit mode (also known as FTPS), an FTPS client must "explicitly
request” security from an FTPS server and then step-up to a mutually agreed
encryption method. If a client does not request security, the FTPS server can
either allow the client to continue insecure or refuse/limit the connection.

¢ Implicit FTPS Connection — The implicit method requires that all clients of
the FTPS server be aware that SSL is to be used on the session, and thus is
incompatible with non-FTPS-aware clients. Negotiation is not allowed with
implicit FTPS configurations. A client is immediately expected to challenge the
FTPS server with a TLS/SSL ClientHello message. If such a message is not
received by the FTPS server, the server should drop the connection. In order
to maintain compatibility with existing non-TLS/SSL aware FTP clients,
implicit FTPS was expected to listen on the IANA Well Known Port 990/TCP for
the FTPS control channel and 989/TCP for the FTPS data channel. This allowed
administrators to retain legacy compatible services on the original 21/TCP FTP
control channel.

e SFTP — also known as FTP over SSH is deemed the most secure form of FTP and
uses encryption certificates. There are 3 different ways to authenticate a SFTP
connection,

= With user name and password, just like a regular FTP connection,
= User name and a certificate
= User name, certificate and password

Remote Connection and Directories

You need the FTP address, the user name and password to establish the connection
and the directory information where files are picked up and where dropped off. Fill in
the following fields:

e FTP Address - This is usually the IP address of the server

¢ User Name

e Password

e Put Directory - This is the directory where you drop off files

e Get Directory - This is the directory where you download files from

It is possible that a trading partner has two FTP servers, one for ‘put’ and another
one for ‘'get’. If so, check "Different Download Server" and additional fields will
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become visible so you can specify the those connection parameters.

After Download: You have two choices. Files on the server will be either deleted or
moved to another folder of your choice

Contact Tab

The Contact Tab stores contact information for your selected Trading Partner.

EDI idertiers | Remote FTP | Contact | Encyption | Folders |

- Contact Information
Name Communication Numbers

Communication Type Number

I =

1234567
Extension 1111

[ A | Fax 9876543
~ Local Access for FTP and HIPAAzuite Web
User Name Registered Users

Password

_ A |

The "Contact" tab
Contact Information

Enter the name and the number into the corresponding fields and select the
communication type from the drop-down list.

e Contact Name
e Communication Numbers — Valid Communication number qualifiers are:
e TE — Stands for Telephone.
e FX — Stands for Fax.
e EX — Stands for Extension.
e EM — Stands for email.

Click the "Add" button and the contact will appear in the "Communication
Numbers” table.

Note: The information that you fill in goes also into EDI files in the "PER" segment.

Local Access for FTP and HIPAAsuite Web
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To register a user, enter the user name and the password into the corresponding fields
and click the "Add" button. The user will appear in the "Registered Users” table.

e User Name
¢ Password

e Registered Users

Encryption Tab

EDI Exchange supports PKI encryption. Encryption keys are defined by the email address
of the owner. Both supported products, PGP and GnuGP use this logic. Read more in
Using Encryption.

You can set up the encryption parameters for a Trading Partner on the "Encryption” tab.

EDI Idertfiers | Remote FTP | Contact  Encryption | Fokders |

Encryplion Setup

Asymetrical Encryption
Key (email address of key owner)

" Private Key Infrastructure (PGF) |

™ Mo Encryption

The "Encryption” tab

Encryption Setup
e Asymmetrical Encryption
¢ Private Key Infrastructure (PGP)
Key (email address of key owner)

e No Encryption
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Folders Tab

Within the HIPAAsuite Communications Directory, each Trading Partner has his own
folder. This keeps files finely separated and in order. Here is where you can set this up.
Read more in Defining Communications Directory.

EDI Identifiersl Remote FTF'| Eu:untau:tl Encryphion !

— Local Directory Settings

Qutgoing Files Root Trading Partner's Quthox

{D:AHIPAAsuiteCommDir\Outbox \ |TXEBS |*

Processed Files Root Trading Partner's Respositary

{D:\HIPAAsuiteCommDir\ProcessedFiles \ |TXEBS |*
File Naming Convention Create Folders Using Trading Partner 1D |
|CMs =l

The "Folders" tab

e Outgoing Files Root — This field has a pre-generated path. You can change this
path by changing the EDI Root Directory.

e Trading Partner's Outbox — Mandatory setting. Click on the three-dots button to
access the "Select Folder" window. There you choose an existing folder or create a

new one.

¢ Processed Files Root — This field has a pre-generated path. You can change this
path by changing the EDI Root Directory.

¢ Trading Partner's Repository — Mandatory setting. Click on the three-dots button
to access the "Select Folder” window. There you choose an existing folder or create

a new one.

Once you have specified the directory settings, click on the "Create Folders Using Trading
Partner ID."
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EDI dertfiers | Remote FTP | Contact | Encoyption Folders |

Qutgoing Files Root Trading Partner's OQutbox
|CAI\Outbox y i

Processed Files Root

Trading Partner's Respository

[CATVProcessedFiles

\ [im

| Create Fokders Using Trading Partner ID

=
|

The "Create Folders Using Trading Partner ID" button

¢ File Naming Convention - Health Insurance Exchanges (HIX) demand that a carrier
adheres to more or less complex File naming conventions. Since these conventions
are often really complicated we decided to hard code several schemes. California,
Maryland, DC and the CMS scheme are among those currently configured and we will

add other schemes if needed.

Rle Naming Convention

Filenaming dropdown menu options

The Custom File Naming Convention option requires some additional setup. This is

covered in Custom File Naming Conventions.

CORE Tab

This tab stores settings for the use of CORE-Compliant SOAP- and MIME-enveloped

transactions. When using a Requester or similar application, these settings apply to the
information source. When using a Responder or similar application, these settings apply

to the information requester/receiver. Soap 1.2 or 1.1 will use the same options.
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EDI Identifiers | Options | Remote FTP| Contact | Encryption| Folders CORE

CORE Settings
UzerMame
Batch
Password MIME Submission Address Test

S5L Certificate MIME Retrieval Address

Real Time T—

est
MIME Address — SOAP Submission Address
SOAF Address SOAP Retrieval Address

E',O RE settings tab

e UserName - UserName portion of the username authentication token. Used to verify a
Trading Partner's Username token's Username or in your own Username token
authenticate yourself to a Trading Partner's CORE-compliant servi e.

e Password - Password portion of the username authentication token. Used to verify a
Trading Partner's Username token's Password or in your own Username token to
authenticate yourself to a Trading Partner's CORE-compliant service.

e SSL Certificate - Instead of Username tokens, use an SSL certificate to verify a
Trading Partner’s identity or access a Trading Partner's CORE-compliant service. Not
currently implemented.

¢ RealTime
0 MIME Address - Trading Partner's web address for MIME Real-Time transactions.
0 SOAP Address - Trading Pertner's web address for SOAP Real-Time transactions.
e Batch

0 MIME Submission Address - Trading Partner's web address for MIME Batch
transactions.

0 MIME Retrieval Address - Some Trading Partners may use a different address to
submit or retrieve batch transactions. Use this field for a retrieval-specific address.

0 SOAP Submission Address - Trading Partner's web address for SOAP Batch

© <2003> Martin Scholl Consulting, Inc.



395 HIPAA Claim Master

transactions.

0 SOAP Retrieval Address - Some Trading Partners may use a different address to
submit or retrieve batch transactions. Use this field for a retrieval-specific address.

12.4.2 Custom File Naming Conventions

Health Insurance Exchanges (HIX) demand that a carrier adheres to File naming
conventions. These file naming conventions enable a reader to quickly determine the
date, time, sender, recipient, etc. of a particular file among other files without the need
to open them individually. The custom File Naming Convention option enables you to

create a file naming convention scheme tailored to your (or your trading partner’s)
requirements.

Rle Maming Convention

Custom| =
- None - |
CA
CMS
DC
MD
FHH
OR

Custom File Naming Convention option highlighted

Selecting the Custom option in the File Naming Convention dropdown menu option and
clicking the Custom File Naming button below it:

Rle Naming Convention
[Custom) 7]

| Custom File Maming |

Custom File Naming button enabled

will bring up the screen pictured below. This screen is used to create file naming
conventions for a particular trading partner. These examples will use the 835 file type as
an example, but all file types the HIPAASuite product represents (as well as TA1s and
999s) can have their own file naming convention applied to each trading partner. The

following picture shows the file name customization screen with the default building
blocks for an 835 EDI file.

© <2003> Martin Scholl Consulting, Inc.



Using EDI Exchange Features 396

gl Customize File Name — O %

File Name for: [835 v]

Company Fie ID_|X | [ Datein YryymmpD' [ | [ Time in hhmmss' | || Fie Type ||| File Version [x ] | Trading Pattner ID x|

Available additional file name parts:
Yearin YYYY format | X | | Time in ‘hhmssf' [ | [ Company ID [ | [ Company EIN [ | Transaction ID ] | Transaction Type x|

Save file name Close

File Naming Customization screen with default custom file naming convention

Filetype

Here we can create a custom file naming convention for a specific file type. The file
types available will depend on the HIPAASuite product used to create the file naming
convention. To change the file type, select it from the file type dropdown menu:

B! Customize File Name

File Name for- |[E5 w Resth
o3

Company Fie ID | 3539 L Tx E
TA1

Changing the filetype

Creating the file naming convention

A coherent file naming convention can be created by clicking and dragging elements into
order. Present elements can be reordered by clicking and dragging them into position:

a5l Customize File Mame

File Name for: |E~35

Company File ID | X | | Datein Wm?mmmss ||| Fie Type |

Available additional file name paris:
Yearin YYYY'format | x | | Time in hhmmsst' | | | Company 1D || | Company EIN

Click-dragging an element into position
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Existing elements can be removed by clicking the X to the right of the element:

o5 Customize File Mame

File Name for: 835 | Restore default fi

Compary File 10 |X | | Time in ‘hhmmss’ | X | File Type |X | | File Version | X

Available additional file name parts:

Deleting an element

The greyed-out elements towards the bottom of the screen can be added to the custom
file naming convention by clicking and dragging them into place:

g5 Customize File Mame

File Name for: 835 v|

| Compary File |D |X| | Time in ‘hhmmss’ |X| | File Type

Available addiional file name parts:

Adding a file name element

To discard the current changes and start over with the default file naming convention,
click the Restore default file name button.

gl Customize File Name —_ O W

File Name for: [835 v|| Restore defauit file name |

Company Fie ID_[X | [ Datein "v¥yyMMpD' [X ][ Fie Type || [ Fie Version || | Trading Pariner D [X]

Available additional file name parts:

Save file name Close

Restore default file name button
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Saving or discarding

Finally, the custom file naming convention can be saved by clicking Save file name or
discarded by clicking Close.

gl Customize File Name — O %

File Name for: |335 v| Restore default file name

Company Fie ID_|X | [ Datein YryymmpD' [ x| [ Time in hhmmss' | || Fie Type | X || File Version [x] | Trading Pattner ID x|

Available additional file name parts:

I Save file name I Close

Save button on file name customization screen

12.4.3 Using Built-in FTP Client

EDI Exchange has a built-in FTP client. This utility allows you to drop-off and pick-up files
from a trading partner that you have defined in the "Trading Partners” menu (see Setting
up Trading Partners.)

Follow the instructions below to exchange EDI files with your Trading Partner.

1.To access the FTP client, select "FTP Client” under the "EDI Exchange” menu item.

Setup Log | EDIExchange | Heb
% Check EDI File
Trading Partners
Inbox Manager
FIP Clent b
SEF Fles

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
EDI Exchange License Informatbion
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The "FTP Client" menu item

2. The following window will appear.

=10 x|
FTP Server User Password: Directory
I | |
@ FTP [ Secure FTP
Connect To Trading Partner I Connect | Disconnect |  SFTP
Remote FTP Server: Local:
Decrypt | 3 My Comput
- Files [ o
[ 1A
—Gei=> | & En
5 F
<—Put<— |
Mot Connected
The built-in FTP client

3. Click the "Connect to Trading Partner” button on the FTP client window.

FTP Client

=10] x|
FTP Server User Password: Directory
| |
Gy & FTP |I” Secure FTP
| Connect To Trading Pariner D Connect | Disconnect | “ SFTP
Remote FTP Server: Local:
Decrypt | O3 My Computer
= Files aca
[ VAN
—>Get—> (==
B
=—Fut<— |
The "Connect to Trading Partner” button

4. The following screen opens.
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=T
 List of Trading Partner
Partner 1
Upload Download

i

Selecting a Trading Partner for FTP transfer

5. Highlight the trading partner that you want to connect to.

6. Click on the "Upload” button to connect to the "Put” directory that you set up in the

trading partner screen.

-0l
 List of Trading Partner
Partner 1
Upload | Download

The "Upload” button

Or click on the "Download” button to connect to the "Get" directory that you set up in

the trading partner screen.

~lofx)
~ List of Trading Partner
Parner 1
Upload | Download

b

The "Download” button

5. Once you have chosen a trading partner, the following fields will contain values derived
from the trading partner's properties. You can change them manually if you need.

e FTP server — IP Address or URL of the FTP server.

e Username

e Password
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e Directory — If you leave this value blank, the FTP root directory will be opened.

e Secure FTP — If you enable this option, then you can select between implicit
and explicit FTPs. See Setting up Trading Partners for an explanation of the two
secure methods:

e Explicit FTPS Connection

¢ Implicit FTPS Connection

Note: You can also fill in the connection information manually. In this case, the entered credentials
will not be saved once you close the FTP client window. Click on the "Connect” button to establish
connection to the FTP server.

FTP Server User Password: Directory

Ihp-}faunle.cm |example @gmail com [reesieree

& FTP [ Secure FTP
Connect To Trading Partner I Connect [ Disconnect | « SFTP |

Remote FTP Server: Local:
E- I Remate Directory /
@ fpaucta Files &ca
B htaccess & D
@ emorlog —>Get—> & En
) oet ar
B ndexpho <—Put<—
[®) beensebd
Q) pdf
e put
[®) 834 09ed
[ test_tested
B rezdme htmi

{
§ ;

4. Once connected, the content of the folder on the server is displayed. On the right
side, you can browse your local PC.

5.To upload a file to the server, select the file on your local PC and click on the "Put”

button.
=101 x|
FTP Server User Password: Directory
[ftp://example. con |example @gmail .com |
& FTP | Secure FTP
Connect To Trading Partner | Connect | Disconnect | © SFTP |
Remote FTP Server: Local: DAEDInbox
& T Remote Directory / = Decrypt | &3 My Computer 1bd
B fpquota r Files & ca 234 edi
[B htaccess 263 DA 834_09edi
[ emorog —>Get—> 3 SRECYCLEBIN
€ oot £ dvd
[®) mdexgho <—Put<— =6 Enl
[® beensebd (3 ErcryptedFies
8 pdf [ fad Inbanc
= pat €3 Outbax
[ 834_09ed 3 Processedfiles
[3) test tested €3 SuspendedFies
[® readme html £ e

The file will appear in the remote folder. You will receive the "File <filename>
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successfully uploaded’ message on the bottom status bar of the FTP client.

Remote FTP Server: Local: DAEDNnbox
= I Remate Directory / - Decrypt 3 My Computer 1kt
[ foqueta Files [=]e 834edi |
[B htaccess 21683 DA 634_09edi
B erorog —Get—> € SRECYCLEBIN test_test adi
Bou & dvd
B indexphp =6 Enl
@ hcensent 3 EncryptedFiles
0 pd & Inbox
= put 23 Outbax
[ 834edi 2 ProcessedFiles
[ 834_09edi 2 SuspendedFiles
[F) test_tested €3 Galery

Connected File 834,edi successiully uploaded I

6. To download a file from the server, select a file in the left side, and then click on the

"Get" button.
o [T
FTP Server User Password: Directory
[ﬂp:"fl:n.q)lum Il:xmq)ll:@;nn’l.ml |
& FTP |[" SecureFTP
Connect To Trading Partner | Connect | Drsconnect | " SFTP |
Remote FTP Server: Local: DAEDNnbox
= ! Remote Directory / = Decrypt 3 My Computer 1bd
B fipqueta r Files [ Lo 834 adi
[B htaccess 263 DA 234 09ed
[ erorlog —Get—> | | () SRECYCLEBIN
Bou £ dvd
B indexphe <Pute— =63 EDI
[E) bcensea 3 ErcoptedFies
) pdf > Inbax
=0 put € Outbax
BB 234 05e €3 ProcessedFies
(2 test test 60 SuspendedFies

The file will appear in the local folder. You will receive the "File <filename> successfully
downloaded" message on the bottom status bar of the FTP client.

Remote FTP Server: Local: DAEDNnbox
= | Remote Directory / = Decsypt | C My Computer [
B foqueta | Files [ oY 234 edi
B htaccess =8 DA 234 D9ed
@ emorlog —>Gel—> 5 SRECYCLEBIN test_test ed
S ot £ dvd
[B indexprp <Pute— =69 EDI
3 license bt €3 EncryptedFiles
8 po = lnbax
E-E put £ Outbax
(B 834 09ed €3 Processedfies
[2) test_test.ed €3 SuspendedFiles
& Galery

Connected File test_test.edi successfully downloaded

12.4.4 Creating a Trading Partner Automatically

When you process a file with EDI Exchange the sender’s ID is compared to the trading
partners on file. If the trading partner does not exist you have the opportunity to create
a rudimentary new trading partner record. Now you have the choice to either create this
new record, process the file without the trading partner record or to abort the
operation.
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MNew Trading Partner

The sender of this file with the |D of 'MDSCRIPTS' is not setup as Trading
Parner. Do youwant to create a new record?

w

[ Abort Processing

The "New Trading Partner” dialog box

If you abort the process, you still will get the EDI file analysis.

The file's further processing is suspended
346 warming messages were given.

Inbox Manager | (S e
Loading EDI Files into Inbox Processing Inbox
Download from FTP Server ] [ Process Inbox l
Allfiles in Inbox have been processed
Activity Log and Wamings
Filename: keyhealth.837 E‘
SEF file "HIPAAClaimMaster. SEF_Files_837_X098A1_SemRef SEF" loaded for transaction set: "004010X098A1" — |

The Transaction type is 837 . Version: 004010X098A1
The Trading Partner with the ID "MDSCRIFTS' is not set up.

The following Wamings with the X12 implementation were found:

Warming in Line 2 —> GS*HC*MDSCRIPTS*KEYHEAL TH*20121012*1607*00001*X*004010X098A1 at Position: 6: [DESCRIPTION:Lea
Waming in Line 6 —> REF*ZZ*264101398: [DESCRIFTION:Unexpected data segment 'REF" encountered in transaction setimessage '
Waming in Line 11 —> NM1*85*2*KEY HEALTH DEMO****** at Position: 8: [DESCRIPTION:No data in mandatory data element "66" ir
Waming in Line 11 —> NM1*85*2*KEY HEALTH DEMO****** gt Position: 9: [DESCRIPTION:No data in mandatory data element "67" ir
Waming in Line 14 —> REF* 1J* at Position: 2: [DESCRIPTION:No data in mandatory data element 127" in Data Segment "REF"_J[COL
Waming in Line 14 —> REF* 1J* at Position: 2: [DESCRIPTION:Conditional data element missing. Element="127", Position="2"][CODE:
Waming in Line 14 —> REF* 1J* at Position: 3: [DESCRIPTION:Conditional data element missing. Element="352", Position="3"][CODE:
Waming in Line 14 —> REF* 1J*: [DESCRIPTION:The REQUIRED rule syntax for data segment REF has been violated. At least one of
Warning in Line 14 —> REF* 1J*: [DESCRIPTION:Conditional syntax check failed for segment ‘REF’. Buffer="REF* 1.J** J[CODE:12459]
Waming in Line 15 —> PER*IC**TE* at Position: 2: [DESCRIPTION:No data in mandatory data element "93" in Data Segment "PER'_J[(
Waming in Line 15 —> PER*IC**TE* at Position: 4: [DESCRIPTION:No data in mandatory data element "364" in Data Segment 'PER"_]
Waming in Line 15 —> PER*IC**TE* at Position: 4: [DESCRIPTION:Conditional data element missing. Element="364", Position="4"][C(
Waming in Line 15 —> PER*IC**TE*: [DESCRIFPTION:The PAIRED rule syntax for data segment PER has been violated. All of the dat:z
Waming in Line 15 —> PER*IC™*TE": [DESCRIFTION:Conditional syntax check failed for segment 'PER’. Buffer="PER*IC™TE*"_]J[CODI
Waming in Line 24 —> NM1*QC* 1*DEMO*JOHN***MI* 123456789 at Position: 8: [DESCRIPTION:Value "123456789" not found in Datz _

2

1 Files processed

EDI compliance check results after further processing was aborted.

Files without a valid trading partner will be placed into the "suspended files" directory.
The final action taken after the analysis is recorded at the end of the results.

The file contains 4 Claims

on 10/17/2012 at 9:50 AM

WaImINg in Line 10/ — LIN N4~ 030£Y 1LZ0UUS 81 FOSIIOon:
Wamning in Line 167 —> LIN*N4**63629126003 at Position: 2: [DESCRIFTION:No data in mandatory data element 235" in Data Segm
Wamning in Line 168 —> SE*166*031111112 at Position: 2: [DESCRIPTION:Transaction set/Message header control number "0001" ds
Warmning in Line 169 —> GE*1*1 at Position: 2: [DESCRIPTION:Functional group header control number "00001" does not match traile

The file has 1 Interchanges. 1 Functional Groups and 1 Transaction Sets

The file was mowved to: H:\HIPAAsuite\HIPAAsuiteCommDir\Suspense\83keyhealth 837

12 [LUESLCHIF NN Uaa eement 5OU gesignaread nNOL usea conain aaic

m

1

This file's processing was aborted. The file was moved to the suspended files folder
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12.4.5 Certificate based authentication in SFTP

SFTP or FTP over secure shell as it is also known is deemed to be the most secure method
of file transport. There are 3 methods of authentication in Sftp.

1. with a user name and password
2. with a user name and a private key cryptographic certificate and

3. with a user name, a certificate and a password

When you select SFTP as the FTP protocol, you will see two check boxes appear.

@ SFTP
| User + password Auth

| private Key Auth

& Fy s

The sub choices when you select SFTP

Leaving both check boxes unchecked will result in the first option: Authentication with
user name and password. You can also check just the user name and password with the
same result.

In order to use the certificate based authentication you need to create and link to your
own certificate. The certification module that HIPAAsuite employs uses a so called private
key SSH2 certificate in pem format.

How do you create such a certificate? Here is one way:

The free secure shell program putty has the necessary tools. Download putty from
www. putty.org When you install the program you will see several program installed on
your computer.
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Organize v Include in library « Share with « Burn New folder

, Mezilla Maintenance Service = Mame . Date modified Type Size
b || LICEMCE 8/6/2013 6:12 PM File 2KB
sl it "Q pageant.exe 8/6/2013 6:12 PM Application 144 KB
| MyFree Codec @ plink.exe 8/6/2013 6:12 PM Application 304 KB
: M.YSQL @ pscp.exe 8/6/20136:12 PM Application 316 KB
! N?tro @' psftp.exe 8/6/2013 6:12 PM Application 328 KB
iR @ putty.chm 8/6/20136:12 PM Compiled HTML ... 438 KB
| Notepads+ || putty.cnt 8/6/2013 6:12 PM CNT File 32KB
e @ putty.exe 8/6/20136:12 PM Application 484 KB
- PeP @ putty.hip 8/6/20136:12 PM  Help file 644 KB
PuTTY E? puttygen.exe 8/6/2013 6:12 PM Application 180 KB
e [ README.txt 1/23/200712:38PM  Text Document 2KB
| RS ’;El unins000.dat 12/30/201312:30 .. GOM Media file(.d... 1KB
! Realtek ) a' unins000.exe 12/30/201312:30 ... Application 705 KB
S | [#] website 11/16/2004 11:14 ... Internet Shortcut 1KE
J Samsung |

The programs and files that come with putty

One of the programs is puttygen.exe. This program creates the necessary keys. When
you start it up, you can generate a key pair.

¥ 5
E PuTTY Key Generator | ? 2|
File Key Conversions Help
Key
Public: key for pasting into Open55H authorzed_keys file:
sghsa

AAAARINzaC lyc 2EAAAABJQAAAG EAGIBLNBRIKMOMOFP Sysh5CPhle TINENzo DHS |;|
" w3 TulScearsV =
+0rTr2Two3u5¥C In 8D Lpa Dor e Ald ULbedVCip TRXmnfg sV 3Basa Rgwf SRy TOm

OHm/ghulaGrMRVPjnZrkb SCFp0Ve PArWh RH Ta 26ub¥mXSEODHGgbuhikjOIkJJFHE -

Key fingerprint: sshsa 2048 69:2e:37:48:93:90:c2:33:39:2:0ab1:cc: 1 2:ed a3
Key comment: rsadeey-20131230
Key passphrase: Ty

Confimn passphrase: esssssssss

Actions

(Generate a public/private key pair [ Generate ]
Load an existing private key file [ Load ]
Save the generated key Save public key ] [ Save private key ]
Parameters

Type of key to generate:

(71 S5H-1 (R5A) i@ 55H-2 RSA (71 55H-2 DSA

Mumber of bits in a generated key: 2048
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Creating a public/private key pair with puttygen

You can save the public and private keys separately as .ppk files but that is not what we
need. But puttygen has also tool to convert the keys to pem files. The top menu has a

E PuTTY Key Generator

File Key | Conversions | Help
Key Import key |
Public e L's file:

ssh1sa Export Open55H key
o]l

AAAABS Export ssh.com key
u3d7Tuls
" . W +DrTr2Twg3usXC Ind 80 Lpaler e Akd U dWCip TRXmnfig
tab Conversions MHm faknMa G RY PR Zrkh S Fri= P AiAh R H T2 960 R

Converting the SSH key into a pem certificate

When we click on "Export OptnSSH key" we can then save the key with an .pem ending
and that is it.

12.5 Using Encryption

12.5.1 About Encrytion

EDI Exchange supports the Private Key Infrastructure (PKIl) encryption method. This
type of encryption is the most generally accepted method of protecting EDI Files from
being pried upon by unauthorized persons. Without going further into the details of PKI,
Public-key encryption is a cryptographic technique which enables users to securely
communicate on an insecure public network, and reliably verify the identity of a user via
digital signatures. Read more in Private Key Infrastructure.

A public-key infrastructure (PKI) is a system for the creation, storage, and distribution of
digital certificates which are used to verify that a particular public key belongs to a
certain entity. The PKI creates digital certificates which map public keys to entities,
securely stores these certificates in a central repository, and revokes them if needed.

A PKI consists of:
e A certificate authority (CA) that both issues and verifies the digital certificates.

¢ A registration authority which verifies the identity of users requesting information
from the CA.

e A central directory is a secure location to store and index keys.
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e A certificate management system.

EDI Exchange relies on other software to establish the PKI. It only uses the capabilities of
these programs through their Application Programming Interface (API). You need to
separately install either PGP Desktop or the open source GPG4Win programs and set them
up with the public keys of your trading partners and your own private key.

Setting up Encryption
EDI Exchange allows you to set up the encryption for your EDI files. Follow the steps

below.

1. Access the "Encryption Setup” window by selecting "Encryption Setup” under the "EDI
Exchange” menu.

Sebp  Log | EDIExchange | Help
3 Chedk EDI File

Trading Partriers
Inbox Manager
FTFP Chent

SEF Files

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log

EDI Send Log

Request EDI Exchange License

E EDI Exchange License Information
The encryption setup menu

2. The following window will appear.
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Encryplion Setup M=
General Encryption Oplions
Original Unencrypted Outbound Files Key Pair Information
Mame (e-mail) for Public Key
¥ Keepa copy inan "UnEnCrypiad’ Folder [
" Delete the original File Pass Phrase for Private Key
|
Crypto Program
* GnuPG ' PGP Deskiop
[ GnuPG
Pathto gpg.exe | e

The program didn't find GnuPG executable. Please specify path manually
or download GnuPG installation from hitp-www gnupg orgl

Ll _ Conced | s

The encryption setup screen

3. In this window define the following options:

General Encryption Options
¢ Original Unencrypted Outbound Files

e Keep a Copy in an 'Unencrypted’ Folder — When the HIPAAsuite program
creates an EDI file for a trading partner that has selected encryption, you can
keep an unencrypted copy in the "Outbox/[trading partner]/Unencrypted”
folder. This is useful when you need to go back to the file and check on

problems.

Note: Once you encrypt a file with the public key of your trading partner, you will not be able to
open it again. Only the owner of the private key can decrypt it and read it.

e Delete the Original File — If you do not want to keep the unencrypted copy,
select this option.
e Key Pair Information

e Name (e-mail) for Public Key — Enter name or e-mail that will be used to
encrypt files for you by your trading partners.

e Pass Phrase for Private Key — Enter passphrase here to decrypt files encrypted
previously with the pass phrase.

Note: The keys are identified by the email address of their owner.

¢ Crypto Program
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e GnuPG — Select this option if you have already installed the GnuPG software and
want to use it.

~ Crypto Program
GnuPG " PGP Deskiop
“]

GruPG
Path to gpg.exe | |C:\Program Files (x86\GNU\GnuPG\gpg2.exe

Save | Cancel y

The configuration using GnuPG

Note: When you select GnuPG, the program checks if the executable gpg. exe/ gpg2. exe is present
on your computer. If it is not found, you will have to specify the path manually or install the program

first.

* PGP Desktop — Select this option if you have already installed the PGP Desktop
program and want to use it. You will see a different lower half of the screen,
where you can indicate the location of the keys. PGP Desktop uses "key rings" —
encrypted folders that contain all your keys. The location of these two files is
very important for PGP Desktop.

— Crypto Program
T GnuPG @PEP Desktop

Key Rings
Public |

Frivate |

.
__save | _ Camcat |

The configuration using PGP Desktop

4. Once the settings are done, click the "Save" button.

(__swe D

The "Save" button

5. The following notification will appear. Click the "OK" button.
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Records Saved

Notification window

12.5.3 Using PGP Desktop

Pretty Good Privacy (PGP) is a data encryption and decryption computer program that
provides cryptographic privacy and authentication for data communication. PGP is often
used for signing, encrypting and decrypting texts, e-mails, files, directories and whole
disk partitions to increase the security of e-mail communications. PGP and similar
products follow the OpenPGP standard (RFC 4880) for encrypting and decrypting data.
For more information, see How PGP works.

EDI Exchange supports PGP encryption and works seamlessly with PGP Desktop and open
source Gpg4Win applications.

PGP Desktop (Symantec’s encryption solutions) is a comprehensive suite of encryption
applications which provides flexible, multi-layered encryption by bundling Drive Encryption
to secure the files stored on local hard drives, and Desktop Email Encryption to secure
confidential data in email. For more information, see PGP Desktop documentation.

PGP Desktop key features:

1. Hard drive encryption software locks down the entire contents of a laptop, desktop,
external drive, or USB flash drive, including boot sectors, system, and swap files.

2. Enables encrypted email and secure AIM® Instant Messages.

3. Creates storage-independent encrypted containers for transport and sharing of specific
files using included utilities; PGP Self-Decrypting Archive, PGP Virtual Disk, and PGP
Zip.

4. Includes PGP Shredder which can completely destroy unwanted disk-based files and
folders.

5. Drive Encryption can be centrally deployed and managed by Symantec Encryption
Management Server.

PGP Desktop key benefits:
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1. Secures email without burdening users, to improve compliance with policies and
regulations without hindering productivity.

2. Allows users to easily and transparently share encrypted files and folders, improving
data security without impacting user productivity.

3. Management by Encryption Management Server centralizes creation, deployment and
management of data security policies and reporting.

PGP Desktop bundles the following products:

1. Drive Encryption. See System Requirements.

2. Desktop Email Encryption. See System Requirements.

3. Encryption Management Server. See System Requirements.

Using GnuPG

GnuPG is an Open Source project for the implementation of the OpenPGP (Pretty Good
Privacy) protocols of encryption. GnuPG allows to encrypt and sign your data and
communication, features a versatile key management system as well as access modules
for all kinds of public key directories. GnuPG, also known as GPG, is a command line tool
with features for easy integration with other applications. Front-end applications and
libraries are also available. Version 2 of GnuPG also provides support for S/MIME.

GnuPG is a free software, so it can be freely used, modified and distributed under the
terms of the GNU General Public License.

We recommend Gpg4Win for encrypting of your files and emails. Gpg4Win supports both
relevant cryptography standards, OpenPGP and S/MIME (X.509), and is the official GhuPG
distribution for Windows. Gpg4Win contains Kleopatra as one of its Free Software
components. For more information, see Gpg4Win documentation available both in PDF
and HTML versions.
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[ ™ Kleopatra | =B &%
B = e W o)
Import Certificates  Export Certificates Redisplay Stop Operation Lookup Certificates on Server
Find: Wy Certificates - ]
My Certificates | Trusted Certificates | Other Certificates | E
Name E-Mail Valid From Valid Until Details Key-ID
Martin Sc... Martin.5chol... 2011-12-10 OpenPGP C1F4C4Cs

Kleopatra, a certificate manager for OpenPGP and X.509 (S/MIME) and common crypto dialogs

With Kleopatra, it is easy to manage your certificates and create your own ones. It
seamlessly integrates with GnuPG. You can manage the key that you receive from your
trading partners, because there is a screen to view the details of a key.

-

M Certificate Details ? P

Cwerview | User-IDs and Certifications | Technical Details | Chain | Dump|

This certificate is currently valid.
User-ID: Chiffaengine Co <chiffaengine@gmail com:=
Validity: from 2011-08-19 12:09 until forever
Certificate type: 2,045-bit RSA
Certificate usage: Signing EMails and Files, Encrypting EMails and Files, Certifying other Certificates
Key-ID: B399D4A0
Fingerprint: BC3FE3157D02D23E12DB8CADIABCBE922B399D4A0
Ownertrust:  unknown

Stored: on this computer
Photo Actions
At the moment, Kleopatra does not support photos Trust Certifications made by this Certificate. ..

in certificates. It has no support for adding, nor for
displaying them. This is for the following reasons:

* Photos give a false sense of security.
* Photos increase the size of certificates.

Close ] l Help

L A

Certificate details with Kleopatra
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12.6 Using EDI Exchange Features

12.6.1 Accessing Inbox Manager

Using the Inbox Manager you can access the most important functions of EDI Exchange.
Inbox Manager allows you to download EDI files into the "Inbox" folder and process these
files. This screen handles the post-processing of the EDI files, their compliance check and
auto-processing options.

1. To access the Inbox Manager, click the "Inbox Manager” under the "EDI Exchange”
menu.

N

Setp  Log | EDIExchange | Help

Check EDI File

EDI Exchange Satup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
EDI Exchange License Informatbion

The "Inbox Manager” menu item

2. The following screen will come up.
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Inbox Manager !EE
Cheack EDI File Loading EDI Files into Inbox Processing Inbox
| Selectand Check EDIFile | = Download from FTP Server | Process Inbox |
Activity Log and Wamings

The "Inbox Manager” window
Read more in:

¢ Downloading EDI Files From FTP Server

e Processing EDI Files

¢ Selecting and Checking EDI Files

12.6.2 Checking EDI Files

EDI file analysis based on the HIPAA standards. Compliance with HIPAA EDI rules is an
essential part of the exchange of EDI documents. The standards are the only agreed upon
rules that sender and receiver use to exchange data from completely different backend
systems. Strict adherence is therefore necessary to guarantee frictionless operation.

Unfortunately, HIPAA compliance is difficult and the truth is that many HIPAA EDI files
are truly bad. Syntax errors, omitted loops, missing elements, wrongly formatted
elements — these are the most common EDI errors. Without a true analysis, it is difficult
to say what data ends up in your system.

EDI Exchange has a built-in compliance engine that analyzes each incoming and outgoing
EDI transaction. Line by line, element by element, error reporting provides a powerful
tool to determine the quality of the incoming and outgoing EDI files. All HIPAA file
versions are supported. The compliance check creates a detailed report that lists every
compliance issue. Outgoing files can also be checked and individual transaction in
violation of HIPAA rules can be held back.

Note: You can enable automatic compliance check on outgoing and incoming EDI files. See Setting up
Incoming and Outgoing Files Options.
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Follow the instructions below to check EDI files for compliance.

1. Select "Check EDI File" under the "EDI Exchange” menu item.

A HipAa Enrollment Master - 32bit

: E - — Chedk EDI File y
: I
Trading Partners
F:"”;ﬂr‘m Inbox Manager
FTP Client
" Printer CEF Fies
£ Sproaddheat Fle EDI Exchange Setup
£ ASClI e Encryption Setup
" Image File Creats EDI Exchange Tables
Autoprocess Setup
[T Data Export Automatic Scheduler
~ Counter EDI Receive Log
Fes [ ] EDI Send Log
Records :l Request EDI Exchange License
I EDI Exchamge License Information

The "Check EDI File" menu item

Alternatively, you can click on the "Select and Check EDI File" button in the Inbox
Manager window. Read more in Accessing Inbox Manager.

Inbox Manager [_ (O] %]
Check EDI File —L fing EDI Files into Inbox ~ Pro ing Inbox
_Select and Check EDI File | Download from FTP Server | | Process Inbox |
Alfiles in Inbooe have been processed
| I
~ Activity Log and Wamings

Filename: 834_09 edi

Filename: test_test.edi

SEF file "HIPAAEnrolimentMaster. SEF_Files 834_X095A1_SemRef SEF" loaded for transaction set: "004010X095A1°

The file was not recognized as a valid EDI file.

Parser Error: Segment - I3A; Error - ISA segment has not enough elements.
It will not be processed

The file was moved to: C\3\SuspendedFiles\Otheritest_test edi

on 2/15/2013 at 3.58 PM

2 Files processed

The "Select and Check EDI File" button

2. In the opened file selection dialog, select an EDI file and click "Open.”
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3. In the Inbox Manager, you can see the result messages for the operation. The details
are displayed in the "Activity Log and Warnings" area.

S i
rCheck EDI File — 1 [ Loading EDI Files into Inbox i~ Processing Inbox

| Select and Check EDI File I Download from FTP Server ‘ Process Inbox

Readng EDI Document
T Activity Log and Wamings

Filename: 834_09.edi
SEF file "HIPAAEnrolimentMaster SEF_Files 834_X095A1_SemRef SEF' loaded for transaction set: "004010X095A1°
The Transaction type is 834 | Version: 004010X095A1
20 warning messages were given.
MNo Wamings found
Mo Errors found
The file has 1 Interchanges, 1 Functional Groups and 1 Transaction Sets
The file contains 1 Member records

C:\ProgramData\HIPAAsuite\HIPAA Enroliment M

The "Activity Log and Warnings" area displaying log messages

12.6.3 Downloading EDI Files From FTP Server

EDI Exchange Inbox Manager allows you to load EDI files into the "Inbox" folder and
process these files. Be sure you have setup FTP settings in the "Remote FTP" tab of the
Trading Partner window (see Setting up Trading Partners).

Follow the instructions below to upload EDI files into the "Inbox" folder.

1. Access the Inbox Manager by clicking the "Inbox Manager” under the "EDI Exchange”
menu.
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SEF Files

EDI Exchange Satup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
EDI Exchange Livense Informabion

The "Inbox Manager” menu item

2. Click the "Download from FTP Server" button.

Inbox Manager
Check EDI File

| Select and Check EDI File |

~ Loading EDI Files into Inbox

CDunioadi'omFl'PS-awer::)l

~ Processing Inbox
Process Inbox |

~ Activity Log and Wamings

The "Download from FTP Server" button

3. When the process has been finished, the "Activity Log and Warnings" area displays the

report.
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Inbox Manager M= E
CheckEDIFile — Loading EDI Files into Inbox ~ Pro ing Inbaox
Select and Check EDIFile | | Download from FTP Server | Process Inbox |
Actraty Log and Wamings

Checking FPT zervers at 3:40:15 PM
1 Trading Pariners are set up for FTP transfer
Checking for files at Trading Partner PARTNER 1
Successfully connected to PARTNER 1 s FTP directory
File: test_test edi deleted on server.
1 Files moved from FTP Servers into Inbox

ChProgramData\HIPAAsuite\HIPAA Enraliment v 1 Files mowed fram FTP Servers into Inbox

Activity Log and Warnings information

12.6.4 Processing EDI Files

EDI Exchange Inbox Manager allows you to process EDI files downloaded to the "Inbox"
folder beforehand.

Note: Once you have saved the auto-processing options (see Defining Auto-Processing Options), the
files will not only be analyzed but also processed according to the defined settings. The auto
processing enables you to combine and run multiple fulfillment steps together (for example, export,
saving, printing.)

1. Once Downloading EDI Files From FTP Server is completed, and no errors are displayed,
click on the "Process Inbox" button. This will autoprocess all files present in the EDI
inbox directory.

Inbox Manager M= E
[ Check EDIFile [ Loading EDI Files into Inbax ~ Pro ing Inbax
Select and Check EDIFile | [  Download from FTP Server | Process Inbox )
Activity Log and Warnings

Checking FPT servers at 3:40:15 PM
1 Trading Pariners are set up for FTP transfer
Checking for files at Trading Pariner PARTNER1
Successfully connected to PARTNER1's FTP directory
File: test_test edi deleted on server.
1 Files moved from FTP Servers into Inbox

Ch\ProgramData\HIPAAsuite\HIPAA Enroliment M 1 Files moved from FTP Servers into Inbox

The "Process Inbox" button
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2. Once the processing is completed, review the Activity Log and Warnings information.

Inbox Manager M=
[ Check EDIFile [ Loading EDI Files into Inbox ~ Pro ing Inbox
Selectand Check EDIFile | Download from FTP Server | | Process Inbox |

Alfiles in Inbox have been processed

Activity Log and Wamings:

Filename: 834_09 edi
SEF file "HIPAAEnrolimentMaster SEF_Files 834_X095A1_SemRef SEF loaded for transaction set: "004010X095A1°

Filename: test_test ed:

The file was not recognized as a valid EDI file.

Parser Error: Segment - ISA; Error - ISA segment has not enough elements.
It will not be processed

The file was moved to: CA3\SuspendedFiles\Dtheritest test.edi

on 2/15/2013 at 3:58 PM

2 Files processed

Activity Log and Warnings information

12.6.5 Accessing EDI Receive Log

EDI Exchange has a file log. Each processed file creates an entry in the Trans_Log table.
You can access the "EDI Log" window to query this table and see what files came in and
how they were processed. You can access the EDI Receive Log once the application has
been initialized. Follow the instructions below.

1. To open the "EDI Log" window, select "EDI Receive Log" under the "EDI Exchange” menu
item.
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Setup Log | EDIExchange | Help

% Chedk EDI File

- Trading Partners

Inbox Manager
FTP Clienit
SEF Fles

EDI Exchange Satup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
E EDI Exchange License Informabion
The menu for the EDI Receive Log

2. To display data, specify the time period and select trading partner.

e Time Period — Period of time when the file was processed. Choose one of the
available options:

e Receive Date
¢ Load Date

e Trading Partner Name — You can select your trading partner from the list. If
you select "---All---", all your trading partners will be included.

3. Click on the "Find Log Files" button to see the list of log files corresponding to your
query.
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eoton ~=loix|

— EDI Files

Specify the time period in which the file
was processed

' Time Pesiod
From | 2/26/2013 ~| & Raceive Date

To |z,rzs.'2c|13 -I " Load Date

Find Log Files

~ Trading Partner Name

Specifying the time period

4. The log will be displayed in form of a tree.

eottog =lojx

 EDI Rles:

8 Query

Specify the time period in which the file
was processed
~ Time Period
From | 2/26/2013 *| & Raceive Date

To IZ,I‘ZBJ'ZEHS vI " Load Date

Displayed log

5. You can open the folder icons and see details related to each file.
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EDI Log

— EDI Files

-2 Query
=& 1902930005  irt_claim_missing_DTP096.ed

Trans Type: 837

Trading Partner: -PLEASE FILL THIS RECORD-

Compliance Check Date: (4/27/°2012

Complance Check Time: 1:30 PM

Result: Waming in Line 16 => : [DESCRIPTION:Missing mandatory segment in EDI file. Segment PAT is eopecte
Waming in Ling 21 > CLM"A37YH556°3025.00713:A:1 & Posttion: 6: [DESCRIPTION:Mo data in mand
Waming in Line 21 > CLM"A3TYH556"3025.00713:A:1 at Position: 8; [DESCRIPTION:Mg data in mand
Warming in Line 21 -> CLM"A3TYH556°3025.00"13:A:1 &t Posttion: 3 [DESCRIPTION:Mo data in mand
Waming in Line 21 —> CLM"A37YHS5673025.00"13:A:1 & Postion: 18; [DESCRIPTION Mo data in man
Warming in Line 25 -> HI"BK:7840°ZZ: at Position: 2 at SubBlement: 2 [DESCRIPTION:No data in mand:
Warming in Line 28 —> NM1°T1°1="30C" 1285740290 &t Pestion: 3: [DESCRIPTION:MNo data in mandate
Waming in Line 2§ <> NM1°72°1===30{"12857402%0 a Posttion; 3: [DESCRIPTION:No data in mandatc
Waming in Line 259 > NM1°72° 1730 1285740230 at Postion: 4: [DESCRIPTION:No data in mandate
Waming in Line 37 > SBR™P=Group Name™ 38910 at Position: 3: [DESCRIPTION Value 38910 not f
Waming in Line 37 ~> SBR*P=Group Name™38310 at Position: 3: [DESCRIPTION: Maxdmum length of
Waming in Line 41 —> DMG"DE™19320706°F~RE5.E2 & Postion: 5: [DESCRIPTION: Nen-compaste data
Waming in Line 41 > DMGD8™19330706"F~R5:E2 at Position: 5: [D

Load Date:

Load Time:

Operator:

[ 0 Records. from to
-2 310747539  “TEST_EBMC_p_5010bd
€3 411479417 Tep0302p

I [ =]
Specify the time peniod in which the file
was processed
-~ Time Period
From | 2/26/2013 ~| & Receive Date

To |2."2€-J'2‘D13 vI  Load Date

Find Log Files
- Trading Partner Name

e

Details of the EDI Receive Log

If the records have been exported to the database, you can see the time, date and

record count.

12.6.6 Accessing EDI Send Log

This page contains instructions on how to access the "EDI Send Log" window. It becomes

available once EDI Exchange has been initialized.

1. Select "EDI Send Log" under the "EDI Exchange” menu.
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Setup Log | EDIExchange | Help

[ K Check EDI File

Trading Partners
Inioi Manager
FTP Chent

SEF Files

EDI Exchange Satup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatic Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
P EDI Exchange License Informabion
The "EDI Send Log" menu

2. The following window will appear:

EDI Send Log _ (O] x|
EDIFles |  Content | Specify the ime period in which the file
£ Query was processed
— Time Period

From | 2/13/2013 "I
To 21132013 "I

~ Trading Partner Name

mmm‘

PARTNER1

The "EDI Send Log" screen
3. To display the log data, select the time period and a trading partner.

e Time Period — Period of time when the file was processed. Choose one of the
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available options:
e Receive Date
¢ Load Date

¢ Trading Partner Name — Select a trading partner in the list. If you select "---
All---", all trading partners will be included.

4. Click on the "Find Log Files" button to display the list of log files corresponding to your
query.

12.6.7 Listing SEF Files

SEF (Standards Exchange Format) files are repositories of standards information that
define the format of EDI documents. SEF files are the basis for the compliance check
engine that EDI Exchange uses. These files contain all rules of the implementation guide
of a transaction. There is a SEF file for each transaction that EDI Exchange is licensed
for. For example, for 837 transactions we have SEF files for institutional, professional
and dental claims in 4010, 4010A1 and 5010A1 version and the 997 and 999 transactions.

1.To access the list of available SEF Files, select "SEF Files” under the "EDI Exchange”
menu.

Setup Log | EDIExchange | Help
li ; Check EDI File

Trading Partners
Inbox Manager

EDI Exchange Setup
Encryption Setup

Create EDI Exchange Tables
Autoprocess Setup
Automatc Scheduler

EDI Receive Log
EDI Send Log

Request EDI Exchange License
EDI Exchange Livense Informabion

The "SEF Files" menu item

2. The "SEF Files" window will appear.
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[ SEF Files HE=E

* Available Standard Exchange Format (SEF) Files

834_005010220A1. SemRef SEF
834_X095.3EF
834_X09541_SemRefSEF
997_4010.3EF
999_005010%231A1 5EF

A list of SEF files
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13

13.1

Bug Reporting and Program Update
Reporting an Issue

HIPAAsuite likes to make bug fixes fast and transparent. For this purpose we include n
Bug tracker with the HIPAA Eligibility Responder. btnet, Bugtracker in ASP.Net is an open
source project. HIPAAsuite implemented Bugtracker.Net in all its products to track bugs
and enhancements. One of the reason we liked btnet was the screen capture capabilities.
We adapted and included this facility.

1. You can reach the Issue Tracker under the Help menu. Click on Help » Report an Issue
in the main menu.

Setup  EDI Exchange (| Help |
| L]
| w¥ HIPAA Claim Master Help

Wiew Manisal

About
Check For Updates
Project History

|: Report an Issus Chrl+1
5 Die-Identify Utility

Features ard Licanses

The "Report an Issue” menu

Alternatively, you can use the ctr1 + 1 shortcut on your keyboard to call the Issue
Tracker. Some screens do not give you access to the menu while they are open, but
the key combination crt1 + 1 will call up the issue tracker report screen.

2. Click on "Capture” to snap a picture of your screen.
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ugTracker. creen Capture
B BugTracker.NET S Capt

{ Saveas..  CopytoClipboard | Draw with mouse while pressing any key [red arrow ¥| UndolLine

& Create new bug
| Update exitting bug

Bug IDé#: |

The "Capture” button

3. Using the mouse, select the area to make a screen-shot of and to attach to the bug
report.
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Selecting the area

. Once you release the mouse button, the screen capture image appears in the

program.
You can enhance your screen shot with drawings. By pressing any key and holding down
the mouse while over the canvas, you can highlight in yellow, free draw in red or make

red arrows.

You can highlight sections as shown further.

45331 02/21/2001
RN 00802 | 022172001 |
"""""" 99489 | 02/21/2001

High lighting a section

You can draw circles as displayed on the following screen-shot.
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Draw with mouse while pressing any key ’red marker j Undg
Bl |
&5 Sary Jaes 5 Sary |Unl
ke L
ek 1 e
Aepuacor 1 L]

Circling a section

You can point arrows to pinpoint your concerns.

Save as..  Copyto Clipboard | Draw with mouse while pressing any key | red arrow =

e . ]

45 Sarv Daes

5
02/21/2001 |1

W W g L3 hd =

W

Drawing an arrow

5. Then enter as much information into the Description field as possible.
6. Now enter your email address so that we can get in contact with you.
7. Indicate whether this is a new bug or a follow up on an existing issue.
8. Then click on "Send."

9. Once the bug information has been submitted successfully, you will receive a
notification. Click "OK."

10.Then you will get updates on the issue by email.

13.2 Updating the Program

Tip: An alert on version update will be available at the bottom right end section of the application.

By default, the program checks for updates automatically. When the new version is out,
you will see an update report on the "Changes in Versions" window. It shows which
changes have been made and displays all differences between your version and the
current version. To continue with update, click "Update.”
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rhal’ll_]l"i In Yersmons E

Version 4.0.49.755 of HIPAAClaimMasterd2 is now availalbe.
ou are using 4.0.48.1449. Do you want to download and install it?

[~ Changes in vessions
||‘.)I1ann ez in verzion: 4.0.49.0755

fixed bug with processed files

added CCITT4 and Packbits compression

new fields in header table

new figlds in details table: OralCavtyDesignation 1-5

added elerments SERDE and S¥311 to dwmamic array

new field in details table; AmbulancePatientCount

changed work waith log in command line

Cancel [ | Update ‘r'

= =

The "Changes in Versions" screen with highlighted "Update” button
Then you will need to re-certify the application.

Specify a location on you local PC where to download the new version.

Save As 7] %] |

Savein: | 1 My Computer [ [N By s N

B2 35 Floppy

e L] SYSTEM

o [D:] Noramres Qrcr.
2e (E:] Local Disk

e [F'] Local Digk

s [G:] CDv Dieive

Save a3 lppe: | =] Cancel |

The "Save as” window with the "Save"” button highlighted

Then the program will start downloading.
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Downloading HIPAAClaimM azter32

0
Downloading 1% Cancel |

The "Downloading HIPAAClaimMaster32" popup

Then you will need to install the application.

Manual Updates

432

To switch off automatic updates and stick with the version you have, go select Setup »

Options in the main menu.

=10] %
CodeSets Llogs Imagel| Setup |) EDIExchange Help

: |
v o S
e Clakn Poms
7 1 Configure Additional Info Pages

Company Setup
Create Company Setup Table

The "Options” meﬁu

Alternatively, you can click on the "Setup” button located on the main toolbar.

:',4. HIPAA Claim Master - 32bit

Fle Forms iew Search Claim Entry/Edit DataBase Codes
; =
= > (1]

" Pririer

The "Setup” button

The following screen will appear. Check the "Never check for update” option and click

"Save."
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B setup

* Processed Files

% Leave in Place

M= B

= Move to |
" Delete

- Lﬂg
r Keep alog of every file proceszed
™ Record errars only ta log. No Pap-ups

Print Additional Pages

™ additional Info
[ COB Info

~ Qutbox Directory Path

~ Update

W | Mever check for update

[ Document Color

[~ On Sereen
* Red
" Black

= 0n Paper
= Red
" Black

l

Help

Save

Browse

Cancel I p

The "Options” window

To update the application manually, go to Help » Check for Update in the main menu.

Setup  EDI Exchange (| Help I
Wk HIPAA Clair Master Help
Wiew Manisal

Abaut

Check For Updates

Project Histany

Report an Issue Chrl+l
De-Tdentify Uity

Feabures and Licenses

The "Check for Updates” menu item
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